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INTRODUCTION

Thank you for choosing this Icom product. This product is designed and built with Icom’s state of the art technology
and craftsmanship. With proper care, this product should provide you with years of trouble-free operation.

This product combines traditional analog technologies with Digital Smart Technologies for Amateur Radio
(D-STAR), for a balanced package.

ABOUT THE CONSTRUCTION OF THE MANUAL (As of July 2023)

You can use the following manuals to understand and operate this transceiver.
@ If necessary, you can download a glossary of HAM radio terms from the lcom website.

TIP: You can download each manual and guide from the Icom website:
https://www.icomjapan.com/support/
Enter “ID-50A" or “ID-50E” into the Search box on the site.

Basic manual (Comes with the transceiver) CI-V Reference Guide (PDF type)
Instructions for the basic operations and precautions. Describes the control commands used in remote
D-STAR GUIDE that explains registering your call sign control operation (serial communication using CI-V).

to a gateway repeater and D-STAR'’s basic operations

is also included. About the DV Gateway function (PDF type)

Advanced manual (This manual) Instructions for the system requirements or operations
to use the DV Gateway function.

Attaching accessories

¢ Using a microSD card

 Battery charging

« FM Radio operation

* D-STAR operation (ADVANCED)
* GPS operation (ADVANCED)

« VOICE TX function Using the GPS Logger function (PDF type)
« Recorder function

« Memory operation

e Scan operation

« Repeater and duplex operations
« SET mode

« Share Pictures function

¢ Other functions

» Updating the firmware

e Options

Updating the repeater list (PDF type)

Instructions for the steps to update the repeater list.

Instructions for operating the GPS Logger function
that saves location data from a GPS receiver onto a
microSD card as a log.
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Icom and the Icom logo are registered trademarks of lcom Incorporated (Japan) in Japan, the United States, the United
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Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.
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Microsoft and Windows are trademarks of the Microsoft group of companies.

Google, Google Play, and Android are trademarks or registered trademarks of Google, LLC.
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INTRODUCTION

FUNCTIONS AND FEATURES OF ADOBE® ACROBAT® READER®

The following functions and features can be used with Adobe Acrobat Reader.

* Keyword search

Click “Find” (Ctrl+F) or “Advanced

Search” (Shift+Ctrl+F) in the Edit

menu to open the search screen.

This is convenient when searching

for a particular word or phrase in this (s

manual.

® The menu screen may differ, u
depending on the Adobe Acrobat @
Reader version.

Click to open the find or
search screen or advanced
search screen.

File Y View Window Help

* Find screen

Previous Next

* Advanced search screen

Search - o x

Arrange Windows

Select All Ctrl+A

Where would you like to search?

Deselect All Shift+Ctrl+A

(@) In the current document
) All PDF Documents in

Copy File to Clipboard [ My Documents -
What word or phrase would you like to search for?

Take a Snapshot i ‘

[JWhole words only
[] Case-Sensitive

 Printing out the desired pages.
Click “Find (Ctrl+F)” or “Advanced Search

(Shift+Ctrl+F)” in the Edit menu to open the search

screen.

This is convenient when searching for a particular

word or phrase in this manual.

® The menu screen may differ, depending on the Adobe

Acrobat Reader version.

Check Spelling 4 e ——
[include Comments
Search
Q FEind Ctrl+F
Advanced Search Shift+Ctrl+F
Protection L
Accessibility 4

* Read Out Loud feature.

The Read Out Loud feature reads aloud the text in
this PDF.

Refer to the Adobe Acrobat Reader Help for the
details.

(This feature may not be usable, depending on your
PC environment, including the operating system.)

@ Select the “A4” size to print out the page in the original

manual size.

Rotate View 4
[ Edt View Window Help Page Navigation v
B Open... Ctrl+O
Page Display 4
Create PDF Online... £ =
Zoom 3
Save As... Shift+Ctrl+5§ Tools 4
Save as Other 4 .
Show/Hide 4
Send File »
Display Theme r
Close Ctrisw [%] Read Mode Ctrl+H
) |:| Eull Screen Mode Ctri+L
Properties... Ctrl+D
2
E Print... Ctrl+P F;l Tracker...
1 Read Out Loud 4

® The screen may differ, depending on the Adobe Acrobat Reader version.
ii




INTRODUCTION

ENTERING AND EDITING TEXT

Controls used for text entry:

[DIAL] (Rotate)
Selects a character

Y ——
Y
Selects the character
Cancels i) S Clears
Moves the S Moves the cursor to
cursor to the left J@\ the right

[ENT] Opensthe Opens the Entry
Sets character  Select window

< To insert a text, move the cursor to a place to enter,
and then rotate [DIAL] or push D-pad(i1).

 To clear a character, push [CLR].

< To consecutively clear characters, continuously
hold down [CLR].

To change the character type:

1. When not selecting text, or an entered text is
selected, push [QUICK].

2. Rotate [DIAL] to select the character type, and
then push [ENT].

Character Selectable characters and Character
type symbols conversion
ABC Ato Z,0to 9, (space) Ala
abc atoz, 0to9, (space) Ala
123 0to 9, (space) -

s V"#S% & ()*+,-./:1;<=> -
?@I[\]"_ {l} (space)

TIP: When the character type is “ABC” or “abc,” and
while entering a character, push [QUICK] to select
upper case or lower case letters.

TH MESSAGE

ABC

AV

TH MESSAGE

Push [QUICK]

ABC




INTRODUCTION

USABLE CHARACTERS

The usable characters and symbols and the maximum characters differ, depending on the item.
See the following list for detalils.

® The usable characters and symbols for each character type are described at the bottom of the page.

Maximum .
Category Iltem Character type characters Information
) Group Name [ABC] [abc] [123] ['"#] 16 -
FM Radio Memory
Name [ABC] [abc] [123] ['"#] 16 -
Group name [ABC] [abc] [123] ['"#] 16 -
Memory CH
Name [ABC] [abc] [123] [1"#] 16 -
Call CH Name [ABC] [abc] [123] [1"#] 16
) Name [ABC] [abc] [123] ['"#] 16 -
Your Call Sign -
Call Sign Ato Z,0t09,/, (space) 8 -
Group Name [ABC] [abc] [123] ['"#] 16 -
Name [ABC] [abc] [123] ['"#] 16 -
Repeater List Sub Name [ABC] [abc] [123] [1"#] -
Call Sign Ato Z,0t09,/, (space) -
GW Call Sign Ato Z,0to9,/, (space) -
Unproto Address [ABC] [abc] [123] ['"#] 56 E\,Io(\);?;g”ésli :Qia)racters
The number of characters you can
Comment [ABC] [abc] [123] ['"#] 43 enter differs, depending on the data
GPS TX Mode extension and altitude settings.
Object Name/ .
ltem name [ABC] [abc] [123] ["#] 9 -
GPS Message [ABC] [abc] [123] [!"#] 20 -
Group Name ABC] [abc] [123] ['""# 16 -
GPS Memory p [ABC] [abc] [123] [1"#]
Name [ABC] [abc] [123] ['"#] 16 -
P-Scan Edge Name [ABC] [abc] [123] [1"#] 16 -
Program Link Program Link name [ABC] [abc] [123] [!"#] 16 -
UR AtoZ,0t09,/, (space) -
CS screen R1 AtoZ,0t09,/, (space) -
R2 Ato Z,0t09,/, (space) 8 -
My Call Sign Call Sign AtoZ, 0109, /, (space) 12 (+1) | olces Tpetween the Call sign
My Station TX Message [ABC] [abc] [123] [1"#] 20 -
DTMF Memory DTMF code 0t09,A,B,C,D,* # 24 -
Save Setting [ABC] [abc] [123] [I"#] 23 ;”_e_gchfaraCterS:
SD Card |II. ' o :
Export [ABC] [abc] [123] ["#] 23 P aracters:
Direct Input (UR) AtoZ,0t09,/, (space) -
DR screen -
Direct Input (RPT) AtoZ,0t09,/, (space) -
Picture Receiver Ato Z,0to0 9, (space) -

[ABC]: Ato Z,0to0 9, (space)
[abc]: ato z,0to 9, (space)

[123]: 0 to 9, (space)

["#:1“#$% & ()*+,-./:;<=>?2@[\]"_"{]|}  (space)




INTRODUCTION

HOW TO ENTER TEXT

Example: Entering “Calling” as a Memory name.
[MENU] > MEMORY > Memory CH

1. Push [MENU].

2. Select “MEMORY” on the second page of the
MENU screen.

3. Select “Memory CH.”

4. Select a channel group where the memory
channel you want to edit is listed.

5. Rotate [DIAL] to select a Memory channel.

MEMORY CH 117

e 4
02: (Blank)r

v

GROUP OO 117

6. Push [QUICK].
7. Select “Edit.”

P T Sy 4 447
gl Edlit

Copy

Move

Clear

Ihzert
Delete (next CH mo

» The Edit screen is displayed.
8. Select “NAME.”

00-01CH 1/3

FREQUEMCY: ,
440.000.00

TS: ,
25 OkHz

v

MAME

ABC

9. Push [QUICK].
10. Select the character type.

~BL

® To enter symbols, select “I"#.”

11.

12.

13.

14.

Rotate [DIAL] to select a character, then push [ENT].

MAME
C

ABC

® Information

» To move the cursor forward, push D-pad(-).

» To move the cursor backward, push D-pad(+<).

» To insert a character, move the cursor to a place to

enter, then rotate [DIAL].

To clear a character, push [CLR].

« To consecutively clear characters, continuously hold
down [CLR].

* When the character type is “ABC” or “abc,” and while
entering a character, push [QUICK] to select upper
case or lower case letters.

Repeat steps 9 ~ 11 to enter a name, and push [ENT].

MNAME
Calling_

abc

» Returns to the Edit screen, and the entered name is
displayed.
Select “<<Overwrite>>."

TOME:

<< Dyerwrites=

A confirmation dialog is displayed.
Select “YES.”

00-01CH 3/3
-

T hIC.

Overwrite?

P T S 4 413

T Completed.

440.000

Calling
GRO0-01

. Tah, ol Lol F

* The Memory name is overwritten.



Section 1

ATTACHING ACCESSORIES

Attaching the antenna...............eoeiii e -
Attaching and detaching the battery............ccceeiie, -
Attaching and detaching the belt clip.........cccooveieiee e, -
Attaching the hand Strap...........cooiiii e -
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1 ATTACHING ACCESSORIES

Attaching the antenna

Insert the antenna into the base of the SMA antenna
connector and tighten the antenna.

TIP: Third-party high gain antennas may increase
transceiver performance. The optional AD-92SMA
antenna connector adapter enables you to use
antennas with a BNC connector. (p. 16-2)

1-2

Attaching and detaching the battery

To attach or detach the battery pack or battery case,

see the illustrations below. See page 3-8 for battery

case details.

® When attaching the battery case, slide it, and press firmly
until it is fixed with both latches.

® When detaching the battery case, turn OFF the
transceiver.

To attach: To detach:

Battery pack or
battery case

NOTE:

» Even when the transceiver is turned OFF, a small
current still flows in the transceiver. When not
using the transceiver for a long time, remove the
battery pack or case to prevent the batteries from
becoming exhausted.

» The battery protection function automatically
reduces power to Low1 power (0.5 W) when the
temperature is around 0°C (32°F) or below. In
addition, High, Mid, and Low2 power selections
are disabled.



1 ATTACHING ACCESSORIES

Attaching and detaching the belt clip

To attach or detach the belt clip, first remove the
battery pack or case, if it is attached. (p. 1-2) See

the illustration below.

To attach the belt clip, slide the belt clip in the
direction of the arrow until the belt clip locks in place,
and makes a ‘click’ sound.

To detach the belt clip, lift the tab up (@) and slide the
belt clip in the direction of the arrow (@).

To detach:
To attach:

Battery pack or
battery case

1-3

Attaching the hand strap

Slide the hand strap through the loop on the top of the
rear panel, as illustrated below.

Hand strap

A WARNING! NEVER swing the transceiver by
holding the hand strap. This could cause injury to
yourself or others.



Section 2 USING A microSD CARD

NOTE: See the Basic manual
Section 6 for details on how to
insert or remove a microSD card
and precautions.

About data saved on a microSD Card..........cccueeeieiieeeniniiiiiieieeeeee e 2-2
Saving settings onto @ MICroSD Card ..........coooviiiiiiiiiiiiieeee e 2-2
O Saving @S @ NEW fil€ ..o 2-2
Saving with a different file name.........cccccceeeiiiiiiiiiii 2-3
Loading the saved files on the microSD card..........cccccoevvecvvviveneeeeeeenn. 2-4
Backing up data saved on the microSD card onto a PC ..........cccceeeeen. 2-5
< About the microSD card’s folder..........ooviiiiiiiiini e 2-5
< Making a backup file on your PC........cccovviiiiiiiie e 2-6
Importing or exporting a CSV format file ..., 2-7
o 1101 o To] 1] o R TP PP PPPPUOPPPP 2-7
RO o o To ] 11 T USRS 2-8
About the SD Card MOAE ..........oeviiiiieieiiiiciee e 2-9
Check the free space and the recording time on the microSD card.....2-10

2-1



2  USING A microSD CARD

About data saved on a microSD card

The following data can be saved onto the card:

¢ The transceiver’s settings

« Communication/receive log and contents

» Automatic answering voice audio in the DV mode
« Voice audio for the Voice TX function

* Voice recorder

e Captured screens

¢ Memory channel contents

¢ FM Radio memory

Your (UR) call sign memory

* Repeater List

* GPS memory

Position data from the GPS receiver

Picture data for the Share Pictures function
Transmitted and received log of Share Picture

Saving settings onto a microSD card

The Memory channels, settings on the MENU screen,
and the Repeater List can be saved on a microSD
card.

Saving data on the card enables you to easily restore
the transceiver to its previous configuration, even if
you perform an All Reset.

You can save settings data as a new file, or you can
overwrite a current file.

<& Saving as a new file
[MENU] > SET > SD Card > Save Setting

1. Push [MENU].
2. Select “SD Card” in the “SET” menu.

SET 3/3

{5 Time Set ’
E SO Card

Others ’

3. Select “Save Setting.

SO CARD 1/2
Load Setting 4

Sawe Setting

Import/Export v
S0 Card Info ¢
Screen Capture YWie v
Firmware Update  »

4. Select “<<New File>>."

SAVE SETTING 14

» The file is named in the following format:
SetYYYYMMDD_xx
(YYYY: Year, MM: Month, DD: Day, xx: file number).
@ To change the file name, see page 2-3.

5. Push [ENT].

FILE MAME
Set2@230421_01

ABC
» The confirmation screen is displayed.
6. Select “YES.”
FILE MAME
o S e e, s B s | hA

|5ave file?

ABC

» While saving, a progress bar is displayed. When saving
is completed, the SD CARD screen is displayed.
® To exit the MENU screen, push [MENU].

Overwriting a current file:
To overwrite data in a current file, select the file you
want to overwrite in step 4 to the left.

SAVE SETTING 14

TIP: Data is saved in the “icf” file format. You can copy the
icf data on a PC and edit it using the CS-50 PROGRAMMING
SOFTWARE.




2  USING A microSD CARD

Saving with a different file name

[MENU] > SET > SD Card > Save Setting

1. Push [MENU].
2. Select “SD Card” in the “SET” menu.

SET 3/3
G Time Set ,

&8 Others ,

3. Select “Save Setting.

SO CARD 1/2
Load Setting

L3
Save Setting r
It part/ Expart ’
3D Card Info 4
Socreen Capture YWie »
Firmware Update »

4, Select “<<New File>>."

SAVE SETTING 141

<tMew Filex=

5. Hold down [CLR] to delete the characters.

FILE MAME

ABC

6. Enter a file name, and then push [ENT].

FILE MAME
MY DAT A

ABC

® See page iii on how to enter characters.
7. Select“YES."

FILE MAME

A T T A

Sawve file?

ABC

» While saving, a progress bar is displayed. When saving
is completed, the SD CARD screen is displayed.
® To exit the MENU screen, push [MENU].

2-3



2  USING A microSD CARD

Loading the saved files on the microSD card

The saved Memory channels, settings on the MENU 6. Select “YES” or “NO.”
screen, and Repeater List can be copied to the OAD FILE I
transceiver. T

This makes it easy to copy Memory channels or the Keep SKIF settings
Repeater List, to another ID-50A/ID-50E and operate
with the same data.

NOTE: Saving the current data is recommended
before loading other data into the transceiver.

* YES:
Example: Loading all the data in the The_skip settings of the Repeater List are
“Set20230421_01" file Llect;i_'”ed-
[MENU] > SET > SD Card > Load Setting The skip settings of the Repeater List are
1. Push [MENU]. cleared.
2. Select “SD Card” in the “SET” menu. 7. Select“YES.”
SET 33 LOAD FILE 141

T Time Set ’

Load file?

Others ’

3. Select “Load Setting.” « Starts checking and loading the data file.
<0 CARD 172 * After loading, “COMPLETED!” is displayed.

Load Setting

Save Setting 8. Restart the transceiver to operate with the new
I port/Export setting.

Socreen Capture YWie

1
»
*
3D Card Info *
L3
Firmware Update »

4. Select a data file to load into the transceiver.

LOAD SETTING _1/1
Se P

5. Select the loading content.

LOAD FILE 1/1

Except My Station
Repeater List Only

e ALL:
Loads all Memory channels, settings on the
MENU screen, and the Repeater List into the
transceiver.

* Except My Station:
Loads all Memory channels, setting on the
MENU screen except MY call signs, and the
Repeater List into the transceiver.

¢ Repeater List Only:
Loads only the Repeater List into the transceiver.

2-4



2  USING A microSD CARD

Backing up data saved on the microSD card onto a PC

A backup file enables easy restoration, even if the
data on the microSD card is accidentally deleted.

< About the microSD card’s folder

The folder in the microSD card contains the following:

OO O

ID-50 Capture GpsMemory

:
0

Csv MemoryCh

Di0 0
LY

e}
D g
- el
= [
< 1)
Q

a
X
=
o
«Q

¥

Setting
O T
Voice —|:YYYYMMDD
O
YYYYMMDD
O T
VoiceRec —|:YYYYMMDD
- -
VoiceTx YYYYMMDD

« |ID-50 folder

The folders created in the transceiver are contained

in this folder.

Capture folder
The captured screen data in the “bmp” format.

* Csv folder
The Repeater List, Your (UR) call sign memory,
GPS Memory folders, and so on.

GpsMemory folder
The GPS Memory in the “csv” format.

MemoryCh folder
The Memory channel contents in the “csv” format.

RadioMemory folder
The FM Radio memory contents in the “csv” format.

RptList folder
The Repeater List in the “csv” format.

YourMemory folder
The Your (UR) call sign memory in the “csv” format.

Gps folder
The GPS logging data in the “log” format.

Picture folder
The picture data in the “dat “ format that are used
with the Share Pictures function.

Private folder
The RX Picture History and TX Picture History.

Rx folder

The RX Picture History in the “dat” format.

® The RX Picture History contents are not displayed on
the PC.

Tx folder

The TX Picture History in the “dat” format.

® The TX Picture History contents are not displayed on
the PC.

Qsolog folder
The QSO log data in the “csv” format.

Reply folder
The automatic reply data in the “wav” format.

RxLog folder
The RX record log data in the “csv” format.

Setting folder
The transceiver’s setting data in the “icf” format.

Voice folder
The recorded QSO audio date folders.

VoiceRec folder
The recorded Voice recorder audio date folders.

YYYYMMDD folder

The recorded QSO audio data and the recorded
Voice recorder audio data is saved in the “wav”
format.

VoiceTx folder
The recorded voice audio data for the Voice TX
function in the “wav” format.



2  USING A microSD CARD

Backing up data saved on the microSD card onto a PC

<& Making a backup file on your PC

Windows 10 is used for these instructions. 5. Open a folder to copy a backup file, then right-

click, and then click “Paste.”
« Copies the card data onto your PC.

1. Insert the microSD card into the microSD card (Example: Copying into the “Backup” folder on the

drive or a memory card reader on your PC.

: “ : A C drive
2. Click the “Open folder to view files” option to )
access the card. M [ =1 Bsclup
Home Share View
Removable Disk (H:) « “ M [ ThisPC » Local Disk (C) » Backup
Choose what 1o do with remaovable drives. s Quick access Mame
m -IConﬂg..il.u ths drive for backup & OneDrive
i [ This PC View >
ﬂ .’nn:iqina storage settings I Desktop Sort by >
_ %] Documents Group by >
B .:;.uu:ll '0|JU 1o view Eles l C||Ck ‘ Downloads Refresh .
b Music Customize this folder..
. Take no action = Pictures porte | CIICk
Videos Paste shortcut
%, Local Disk (C:) Undo Rename Ctrl+Z
« ‘ID-50’ folder is displayed. = Remavable Disk Share with >
3. Right-click “Removable disk.” - RIE;:DV“‘E”““" New >
4. Click “Copy.” e Propertes
- |l [V =1 Drive Tools  Removable Disk (H
Fome | Share | Mimw | Hanage 6. To remove the card, click the remove media icon
Tim? Removblebutn » (i@ in the screenshot shown below) in the
3 Quick access Hame taskbar. Then, click “Eject Removable Disk.”
f@ OneDrive D-s0
5 Open Devices and Printers
[ This PC
I — . . USB3.0 Card Reader
@:‘ Right-Click - Eject Removable Disk (H:) 4—Click
& Network Open AutoPlay... cr 7
Open in new window
*& Homegroy Pin to Quick access
Share with >
Open as Portable Device
Include n brary > 7. When “Safe To Remove Hardware” is displayed,
Pin to Start
Format.. remove the card.
Fject
Cut o Safe To Remove Hardware
E3E. Click
Titem Rename

New >
Properties

TIP: When “USB Connect” is set to “SD Card Mode,”
and the transceiver is connected to the PC through a
USB data cable, you can directly access the microSD
card that is set in the transceiver from the PC.
(IMENU] > SET > Function > USB Connect)

2-6



2  USING A microSD CARD

Importing or exporting a CSV format file

Read this section before importing or exporting a 6. Select the CSV file to import.
Comma Separated Values (CSV) format file from the

microSD card. YOUR CALL SIoN_1 /1

You can import or export the following data: e

* Memory CH

* FM Radio Memory
* Your Call Sign
» Repeater List
* GPS Memory

« The confirmation dialog is displayed.

<¢lImporting TIP: When importing a Repeater List, “Keep
NOTE: ‘SKIP’ settings in Repeater List?” is displayed.
- Before importing, make a backup file of all the See step 6 on page 2-4 for details.
transceiver’s data to the card in case of data loss. . )
- The transceiver cannot display files that have a file 7. Select “YES.

name 24 or more characters. If necessary, rename

them using 23 characters or less. When exporting CSV
format files using the CS-50, BE SURE the names are I port file?
23 characters or less.

WOUR Call SIGH 101

Example: Importing the Your Call sign memory.
[MENU] > SET > SD Card > Import/Export > Import

* Starts importing.

1. Push [MENU]. + After importing ends, “COMPLETED!” is displayed.
2. Select “SD Card” in the “SET” menu. ) . )
8. To complete importing, restart the transceiver.
SET 3/3
T Time Set r

50 Card

BB Others ,

3. Select “Import/Export.”

S0 CARD 1/2
Load Setting
Sawve Setting

S0 Card Info
Screen Capture Vie

13
L3
I part/ Expart ¥
*
L]
Firmweare Update

4. Select “Import.”

IMPCRT/EHPCRT 14
I port ¥
Export 4
C5Y Format 4

5. Select “Your Call Sign.”
IMPORT 141

Mermory CH
Fii Fadio Memuaory

Fepeater List
GPS Memory

13
L3
Your Call Sign ¥
*
L]

2-7



2  USING A microSD CARD

Importing or exporting a CSV format file

<O Exporting

Saving as a new file:
Example: Exporting the Your Call sign memory.

[MENU] > SET > SD Card > Import/Export > Export

1. Push [MENU]. 6. Select “<<New File>>."
2. Select “SD Card” in the “SET” menu. VOUR Coll SN 171
SET 3/9 <<lewy Filex>
& Time Set ’
S0 Card
Others ’
« Displays the FILE NAME screen.
® The file is named in the following format:
3. Select “Import/EXport." Your*YYYYMMDD xx
5D CARD 1/2 (YYYY: Year, MM: Month, DD: Day, xx: file number).
Load Setting » * When you select the other items, each file is named
Save Setting ' as shown below.
I part/ Expart . « "
5D Card Info 3 :\:/'&”F]zoré'.cu' _ “gcg )
Screen Capture Vie » adio _emory. B a”IO
Firmware Update » Repeater List: Rpt
GPS Memory: “Gps”

4. Select “Export.”

® See page iii on how to enter characters.

IMFORT/EHPORT 141 7. Push [ENT].
Im port ¥
FILE MAME
CSY Format v four2ez3e424_@1
. ABC
5. Select “Your Call Sign.”
ERPORT 1 « The confirmation dialog is displayed.
Memary CH N 8. Select“YES.”
Fii Radio Memory  # FILE MAME
Your Call Sign H iR A d
Fepeater List : | Export file?

GPS Memory

ABC

» Exports the setting data.
@ To exit the MENU screen, push [MENU].

Overwriting the current file:
When you overwrite data in a current file, select the
file you want to overwrite in step 6.

WOUR CALL SIGH 1.1

<<New Filex>

2-8



2  USING A microSD CARD

About the SD Card mode

When “USB connect” is set to “SD Card Mode,” and NOTE: Before connecting the transceiver in the SD
the transceiver is connected to the PC through a USB Card mode to a PC with a USB cable, a microSD
data cable, you can transfer the files between the card must be inserted.

microSD card set in the transceiver and a PC. ® If the microSD card is not inserted, insert it with the
You can back up the setting data and recording data transceiver turned OFF, and then reconnect the USB
saved on the microSD card to a PC, and save the cable.

image data for the Share Pictures function and the

firmware data to the microSD card without inserting or TIP: In the SD Card mode, the transceiver works
removing it. not as a transceiver but as a data storage device. It

temporarily stops some functions as follows:
« Stops recording

[MENU] > SET > Function > USB Connect « Pauses the GPS Logger function and the RX History

1. Connect the transceiver to a PC using a USB Log function
cable. « Disables the Auto Power OFF function
2. Push [MENU].

3. Select “Function” in the “SET” menu. To exit the SD Card mode ,
4. Select “USB Connect.” @® This instruction manual is based on Windows 10.
1. Click @@ in the task tray.
FUNETION 3/ 2. Click “Eject Device.”
3. After “Safe to Remove Hardware” is displayed,
remove the USB cable from the PC.

Heterodyne 4
Battery Pack Select v

5. Select “SD Card Mode.”

IUSB Connect 14
Charge Only
Serialport

30 Card Mode

» The confirmation dialog is displayed.
6. Select “Yes.”

CLIRL TR Ll
TAfter connecting to
the PC, it stops
Itransceiver

EaTlcPy FaCk aelect F
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2  USING A microSD CARD

Check the free space and the recording time on the microSD card

[MENU] > SET > SD Card > SD Card Info

1. Push [MENU].
2. Select “SD Card” in the “SET” menu.
3. Select “SD Card Info.”

SO CARD 1/2

Load Setting
Save Setting
I'm port/Export

Screen Capture Vie

»
L3
L]
S0 Card Info r
*
Firmware Update

v

SO CARD IMFOD
Free space:
|
7516 EMB
(REC: 126h50m)
Capacity:
7527 .0MB

» The free space and the recording time on the
microSD card are displayed.
® To exit the MENU screen, push [MENU].
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3 BATTERY CHARGING

Battery information

< Battery life

The approximate battery life (operating time) as

shown below is calculated under the following

assumptions:

* Power save setting: Auto (Short)

e Duty cycle: TX: RX : Standby =1:1:8
(based on operating style)

The approximate battery life:

Battery pack FM mode
BP-271 4.5 hours
BP-272 8 hours
BP-307 12.5 hours

® See page 3-8 for the optional BP-273 battery
case battery life.

NOTE: BE SURE to replace the battery pack with
a new one approximately five years after purchase,
even if it still holds a charge. The material inside the
battery cells will become weak after a period of time,
even with little use.
The estimated number of times you can charge the
pack is between 300 and 500. Even when the pack
appears to be fully charged, the operating time of the
transceiver may become short when:

» Approximately five years have passed since the

pack was manufactured.
» The pack has been repeatedly charged.

TIP: Keep the battery terminals clean. It's a good
idea to clean them occasionally.

3-2

< Battery icon

The “51]" pattery icon is displayed when the battery
pack is attached to the transceiver.

Icon Battery status

{aua]

The battery has sufficient capacity.

]

The battery is exhausted a little.

1

The battery is nearing exhaustion.

The battery is almost fully exhausted.

® Immediately charge the battery pack.
Otherwise, the icon will soon start
blinking, “LOW BATTERY” will be
displayed, and the transceiver will
automatically turn OFF.

When an external DC power supply
(12 vV DC) is connected, the battery is
not being charged because:

« The battery is completely charged.

¢ “Charging (Power ON)” is set to “OFF.”

No icon

® The battery icon for the BP-273 cannot display the
capacity of the alkaline batteries. The battery icon always
displays “@lll,” and it does not reflect with the true battery
capacity.

To display the correct battery status

Select the attached battery pack in the following
item. (Default: BP-271/BP-272)

(IMENU] > SET > Function > Battery Pack Select)

To display the Battery Pack Select dialog every time you

attach the battery pack, set the following item to “ON.”
(IMENU] > SET > Function > Battery Pack Confirmation)




3 BATTERY CHARGING

Charging information

NOTE:

» Prior to using the transceiver for the first time, the
battery pack must be fully charged for optimum
life and operation.

* BE SURE to turn OFF the transceiver while
charging with the supplied battery charger.
Otherwise, the battery pack will not charge.

® While charging, the charging icon “._Il" and
“Charging....” are displayed.

® The icon and “Charging....” disappear when the
battery pack is fully charged.

< Charging through the [DC IN] jack

The approximate battery life (operating time) as
shown below is calculated under the following
assumptions:
* When using the optional CP-12L or OPC-254L, the
battery pack can be charged with the power ON.
(p. 3-7)
® To connect, see the illustration below.
e The BP-273 battery case has no charging capability
or socket.

Approximate charging time
e BP-271: 3 hours
e BP-272: 5 hours
* BP-307: 8 hours

~

BC-167S*!

To a cigarette
lighter socket
(12 V DC)

OPC-254L
Toal2V DC

%% power source
v
& Black: ©

White: ®

Turn OFF*2

To charge the battery pack:

» Use the supplied battery charger or optional cable.
» Use a USB cable (User supplied). (p. 3-4)

« Use the optional rapid charger. (p. 3-5)

Charging note:

» CAUTION: BE SURE to attach the battery pack
before connecting the DC cable.

e Turn OFF the transceiver when using the BC-167S.

» DO NOT charge the fully charged battery pack.
This may cause a shorter battery life.

*1 The shape is different, depending on the version.
*2 When using the BC-167S, turn OFF the transceiver.



3 BATTERY CHARGING

Charging information

< Charging with a USB cable

You can charge the battery pack with a USB cable (Type-C) while operating the transceiver.

)]

N

USB cable

To the [USB] port

NOTE:

* BE SURE to attach the battery pack to the transceiver.

» To use a mobile device or a PC as an external power

source, set the following item to “ON” (default).

([MENU] > SET > Function

> USB Power Input (Phone, Tablet, PC))

The battery pack is used as a power source while

transmitting, even when an external power source is

connected.

Therefore, you cannot transmit if the battery pack is

exhausted.

* You may not be able to charge:

- Depending on your USB cable or power adapter.

- When using a USB hub or connecting to a low output
USB port.

Charging time may differ, depending on the USB port.

e The S-meter may appear, or the noise may occur, due
to the influence of the USB power supply’s noise.
In that case, unplug the USB cable to disconnect the
transceiver from the USB power supply.

* When operating the transceiver while charging, the
charging may not be sufficient, and the battery pack
may be consumed, depending on the power adapter.

To a USB port

3-4

Power adapter
or external battery
(User supplied)

~ &2

PC,

TIP:

* When a USB cable is connected, the charging is
stopped when the battery is fully charged.
After that, the charging will resume when a certain
amount of capacity is consumed while connecting the
USB cable.

* You can change the operation when the transceiver is
connected to a PC through a USB cable.
(IMENU] > SET > Function > USB Connect)

Mobile device




3 BATTERY CHARGING

Charging with the BC-2021P2 optional rapid charger

The optional BC-2021P2 rapidly charges a battery

pack.

® When about 90% of the battery capacity is charged,
the BC-202IP2 stops charging and the charging
indicator lights green. Therefore, the battery life
will be a little shorter than when charging with the
transceiver.

Approximate charging time

e BP-271: 1.5 hours

e BP-272: 2.5 hours

« BP-307: 4 hours

® These are the time when the battery is exhausted, and
charging with the transceiver power off.

The following item is required.

e BC-123S (L-shaped type plug)
(A different type, or no power adapter is supplied,
depending on the charger versions.)

Transceiver + battery pack

BC-123S
(L-shaped type plug) % /,
The CP-23L or OPC-515L —

can also be used instead
of the power adapter.

BC-2021P2

Charging note:

» /A DANGER! NEVER use a battery pack that is
not manufactured or approved by Icom.

» CAUTION: DO NOT connect anything to the
[DC IN] jack or the [USB] port on the side of the
transceiver when placing the transceiver to the
rapid charger. This may cause the charger’s
malfunction. If the charging indicator blinks
orange, disconnect the power adapter from the
charger, and then reconnect it.

* BE SURE to turn OFF the transceiver. When the
transceiver power cannot be turned OFF because
of the battery exhaustion, detach the battery pack
from the transceiver. Then charge the battery pack
by itself.

» The BC-202IP2 RAPID CHARGER can only charge
the BP-271, BP-272, or BP-307 Li-ion BATTERY
PACK. Other types of rechargeable batteries, Ni-
Cd, or Ni-MH cannot be charged.

* If the charging indicator blinks orange, there may
be a problem with the battery pack or charger.
Contact your dealer if you have problems charging
a new battery pack.

Battery pack
BP-271, BP-272, or BP-307

(Self-tapping screws: 3.5 x at least 30 mm)
Purchase separately. Using screws is
recommended to secure the charger.

Charging indicator

« Lights orange: While charging

« Lights green: Charging is completed.
 Blinks orange: A charging error has occurred.
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3 BATTERY CHARGING

Charging with the BC-202IP3L optional rapid charger

The optional BC-202IP3L rapidly charges a battery Charging note:

pack. o » /A DANGER! NEVER use a battery pack that is
® When about 90% of the battery capacity is charged, not manufactured or approved by Icom.

the BC-202IP3L stops charging and the charging
indicator lights green. Therefore, the battery life
will be a little shorter than when charging with the
transceiver.

Approximate charging time

e BP-271: 2 hours

e BP-272: 3 hours

« BP-307: 5 hours

® These are the time when the battery is exhausted, and
charging with the transceiver power off.

The following item is required.
« BC-123S (straight type plug)

Battery pack
BP-271, BP-272,
or BP-307

AC outlet

BC-123S
(straight type plug)
® The CP-25H can also be

used instead of the power
adapter.

CAUTION: DO NOT connect anything to the

[DC IN] jack or the [USB] port on the side of the
transceiver when placing the transceiver to the
rapid charger. This may cause the charger’s
malfunction. If the charging indicator blinks
orange, disconnect the power adapter from the
charger, and then reconnect it.

BE SURE to turn OFF the transceiver. When the
transceiver power cannot be turned OFF because
of the battery exhaustion, detach the battery pack
from the transceiver. Then charge the battery pack
by itself.

The BC-202IP3L RAPID CHARGER can only charge
the BP-271, BP-272, or BP-307 Li-ion BATTERY
PACK. Other types of rechargeable batteries, Ni-
Cd, or Ni-MH cannot be charged.

If the charging indicator blinks orange, there may
be a problem with the battery pack or charger.
Contact your dealer if you have problems charging
a new battery pack.

Transceiver + battery pack

o
ko

)/ @ To connect the power adapter to the
charger, remove the charger’s left cover.



3 BATTERY CHARGING

Connecting BC-202IP3L together

You can connect up to 6 BC-202IP3L together.
1. Remove the charger’s right cover. (@)
2. Snap the DC power plug to the another charger’s

DC power jack. (@)

A WARNING! NEVER connect more than 6
chargers together. It may result in an electric shock,
cause a fire, overheating, or damage the chargers.
A WARNING! NEVER use other than the BC-228
AC adapter when connecting multiple BC-202IP3L
units. It may result in an electric shock, cause a fire,
overheating, or damage the chargers.

External DC power operation

Operating note:

* DO NOT connect over 16 V DC directly into the
[DC IN] jack of the transceiver. The power source
voltage must be between 10.0 V ~ 16.0 V DC.

* DO NOT transmit at high power for a long period
of time. The transceiver becomes hot, and it may
cause a burn.

* Use the optional CP-12L or OPC-254L when using
the external DC power.

» Confirm the correct polarity of the OPC-254L
supply connection. Connect the OPC-254L to an
external power source (user supplied).

* Use an external DC-DC converter to connect the
transceiver through the optional CP-12L or OPC-
2541 to a 24 V DC power source. Ask your dealer
for details.

» When the external power is used, the Power Save
function (p. 12-18) is automatically turned OFF.

» Depending on the external power voltage,
the battery pack may be used to operate the
transceiver, and the battery pack capacity is
consumed.

TIP: The battery pack can be charged even if the
transceiver is ON when “Charging (Power ON)” is
set to “ON” (default).

This operation may generate certain spurious
signals, and the S-meter may appear, or noise may
be heard.

When you operate the transceiver while charging,
and if you cannot receive signals correctly, set
“Charging (Power ON)” to “OFF.”

(IMENU] > SET > Function > Charging (Power ON))

3-7

To a cigarette
lighter socket
(12 v DC)

OPC-254L

Toal2V DC
power source

White: ®

CAUTION: BE SURE to attach the battery pack
before connecting the DC cable.

® The BC-167S cannot be used for external DC
power operation.



3 BATTERY CHARGING

About the optional battery case

The BP-273 uses three AA (LR6) size alkaline
batteries.
1. Remove the battery case top, as shown below.
2. Install three AA (LR6) size alkaline batteries.
@ Install only alkaline batteries.
® BE SURE to observe the correct polarity.
3. Attach the battery case. (p. 1-2)

Batteries cautions:

* When installing batteries, confirm that they are all
the same brand, type, and capacity. Do not mix
new and old batteries together.

» DO NOT incinerate used battery cells since the
internal battery gas may cause them to rupture.

» DO NOT expose a detached battery case to
water. If the battery case gets wet, BE SURE to
wipe it dry before using it.

* DO NOT use batteries whose insulated covering
is damaged.

» Keep the battery terminals clean. It's a good idea
to clean them occasionally.

» Remove the alkaline batteries when the battery
case is not used. Otherwise, the installed alkaline
batteries will be exhausted due to the built-in step-
up converter.

TIP:

* A built-in step-up converter in the BP-273
increases the voltage to 5.5 V DC. Approximately
100 mW of output power is possible using the
case. Also, the transmit output power selection is
disabled.

» The transceiver meets IPX4 requirements
for waterproof protection when the BP-273 is
attached.

» The batteries may seem to have low capacity
when used in low temperatures, such as —-10°C
(+14°F) or below. Keep the batteries warm in this
case.
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< Battery life

The approximate battery life (operating time), as

shown below, is calculated under the following

assumptions:

* Power save setting: Auto (Short)

e Duty cycle: TX: RX : Stand-by=1:1:8
(based on operating style)

The approximate battery life:
FM mode
8 hours

® The battery life may differ, depending on your
operating style, or the installed alkaline batteries.

< About the battery replacement

When the alkaline batteries are almost exhausted,

“LOW BATTERY” is displayed, and the battery icon

starts to blink. After 10 seconds, the transceiver power

is automatically turned OFF. In that case, replace all 3

batteries with new alkaline batteries.

® The battery icon for the BP-273 cannot display the
capacity of the alkaline batteries. The battery icon always
displays “llM " and it does not reflect with the true battery
capacity.



3 BATTERY CHARGING

Specifications for the battery charger and battery packs

O BP-271 Li-ion BATTERY PACK

« Voltage: 7.4V
Discharge Capacity: 1150 mAh (minimum)
Usable temperature range: —20°C ~ +60°C, —4°F ~ +140°F
Charging temperature range: 0°C ~ 40°C, 32°F ~ 104°F
Storage temperature range: —20°C ~ +50°C, —4°F ~ +122°F (within a month)
—20°C ~ +35°C, —4°F ~ +95°F (within 3 months)
—20°C ~ +20°C, —4°F ~ +68°F (within a year)
e Dimensions: 58 (W) x 86.9 (H) x 9.1 (D) mm, 2.3 (W) x 3.4 (H) x 0.4 (D) inches
(projections are not included)

O BP-272 Li-ion BATTERY PACK

Voltage: 7.4V
Discharge Capacity: 1880 mAh (minimum)
Usable temperature range: —20°C ~ +60°C, —4°F ~ +140°F
Charging temperature range: 0°C ~ 40°C, 32°F ~ 104°F
Storage temperature range: —20°C ~ +50°C, —4°F ~ +122°F (within a month)
—20°C ~ +35°C, —4°F ~ +95°F (within 3 months)
—20°C ~ +20°C, —4°F ~ +68°F (within a year)
« Dimensions: 58 (W) x 86.9 (H) x 14.2 (D) mm, 2.3 (W) x 3.4 (H) x 0.6 (D) inches
(projections are not included)

<O BP-307 Li-ion BATTERY PACK

Voltage: 7.2V
Discharge Capacity: 3050 mAh (minimum)
Usable temperature range: —20°C ~ +60°C, —4°F ~ +140°F
Charging temperature range: 0°C ~ 40°C, 32°F ~ 104°F
Storage temperature range: —-20°C ~ +50°C, —4°F ~ +122°F (within a month)
—20°C ~ +40°C, —4°F ~ +104°F (within 3 months)
—20°C ~ +20°C, —4°F ~ +68°F (within a year)
« Dimensions: 58 (W) x 86.9 (H) x 22.4 (D) mm, 2.3 (W) x 3.4 (H) x 0.9 (D) inches
(projections are not included)

<& BC-202IP2 RAPID CHARGER

* Power source requirement: 12V ~ 16 V DC or the specified lcom power adapter

¢ Charging temperature range: 10°C ~ 40°C, 50°F ~ 104°F

* Weight: Approximately 105 g, 3.7 oz (without power adapter)

¢ Dimensions: 88.0 (W) x 47.5 (H) x 72.5 (D) mm, 3.5 (W) x 1.9 (H) x 2.9 (D) inches
(projections are not included)

<& BC-202IP3L RAPID CHARGER

< Power source requirement: 12 V ~ 15V DC or the specified Icom power adapter

¢ Charging temperature range: 10°C ~ 40°C, 50°F ~ 104°F

* Weight: Approximately 120 g, 4.2 oz (without power adapter)

< Dimensions: 106.5 (W) x 52.5 (H) x 78.0 (D) mm, 4.2 (W) x 2.1 (H) x 3.1 (D) inches
(projections are not included)
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4 FM RADIO OPERATION

Basic operation

< Description

You can listen to FM Radio broadcasts.

While using the Dualwatch function, you can still listen
to the FM Radio on the pop up window.

Up to 500 FM Radio Memory channels can be
separately stored in the 26 groups for easy memory
management.

You can standby listening to FM Radio. Also, the
transceiver has the exclusive FM Radio mode, where
only the FM Radio functions. In this mode, the other
functions are disabled.

TIP: The FM Radio Memory channel contents,
described in this manual, may differ from your

transceiver’s preloaded contents.

The frequency range for the FM Radio:

FM: 76.0 MHz* to 108.0 MHz

* The usable frequency range differs, depending on the
transceiver’s version.

<& Turning ON the FM Radio

1. Push [QUICK].
2. Select “<<FM Radio ON>>."
» Returns to the standby screen, and the FM RADIO
window is displayed.
« “&g" is displayed.

<<FM Radio OMN=

|#=*FM Radio Mode [
1==GPS Logger Onl jf

g __ [a] *=———=w— Displayed when the FM
Radio is ON.

BBIOMHZ

4-2

TIP:
To turn OFF the FM Radio
Push [QUICK], and then select “<<FM Radio OFF>>."

To listen to the FM Radio while monitoring the
A/B bands

Push [CLR] to close the FM RADIO window.
* You can standby listening to FM Radio.

g [a] 4 w

12:00
1A 1N T

146.010

FEKIF

Lo

440,000

FZEIF

® To open the FM RADIO window again, push [QUICK],
and select “<<FM Radio>>."

ks

| =<FM Radio OFF>
=<FM Radio Mode
==GP5 Logoer Cnl

NOTE: If you turn ON the Band Scope function while
using the Dualwatch function, the FM Radio audio
output may be interrupted due to the AF Output
(DUAL/AIR Band) function.
In that case, set “Auto Mute” to OFF, or set “AF
Output (DUAL/AIR Band)” to OFF.
® When “AF Output (DUAL/AIR Band)” is set to ON, the
received audio is momentarily heard during a sweep,
and you will know that a signal is received without
looking at the display.
(IMENU] > FM RADIO > FM Radio Set > Auto Mute)
(IMENU] > SET > Scope > AF Output (DUAL/AIR Band))




4 FM RADIO OPERATION

Basic operation

¢ Selecting the FM Radio mode

1. When the FM RADIO window is displayed,
push [MR] to select between the Tuning and the
Memory modes.

2. Rotate [DIAL] to select a frequency or a memory
channel.

e Tuning mode

The FM Radio Tuning mode is used to set the desired

FM Radio frequency.

To save the selected frequency, hold down [MR] for 1

second.

 Enters it into the lowest memory channel of the selected
group.

) s 4 B 1200

Fil RADIO

Tuning mode

« Memory mode

The FM Radio Memory mode is very useful to quickly
select often-used frequency settings.

When the Memory mode is selected, “ER"” and the
selected memory channel group (A ~ Z) and number
are displayed.

o s 4 K 1200
[ e ———

88.1:

g FIM-A Station

Memory mode

TIP: Push [QUICK], and select “VFO” to select the
Tuning mode, or select “MR” to select the Memory
mode.

< Selecting the group in the Memory

mode
Up to 50 FM Radio Memory channels can be assigned
to each group for easy memory management.
If you change the group, other area channels can be
selected.

1. Push [MR] to select the Memory mode.

gm & A4 B 12:00
Fi RADIO

88-1 MHz

i FIM-A Station

FEKIF

« “BRA" and the selected memory channel number is
displayed.
2. Push [QUICK].
3. Select “Group Select.”

1

<<FM Radio Mode=

4. Select the desired group.

=] i B 1700

gm & & B 12:00
Frid BRallio

88-2MH2

i FM-E Station

» Returns to the standby screen, and the memory
channel in the selected group is displayed.
5. Rotate [DIAL] to select a memory channel.



4 FM RADIO OPERATION

Basic operation

¢ Searching for an FM Radio signal

While in the Tuning mode, hold down D-pad($5) to
start searching the broadcast signal.

| s -+ & 1200

~While searching, the frequencies are
.| sequentially displayed.

95.8.

88.0

FZEl

When a signal is received

* When you hold down D-pad(+), a down scan starts, and
when you hold down D-pad(—), an up scan starts.

« When a signal is received, the scan stops on the
frequency.

* To cancel the scan, push D-pad($5) or [CLR].

4-4

3. Select “ON.”
Ll 5 & B 1700
oFF
] S <4 B 1200
l'.l'm!l_..—

¢ Using the Attenuator function

The Attenuator prevents a desired signal from
becoming distorted when a very strong FM Radio
signal is near the frequency, or when a very strong
electric field, such as from a broadcasting station, is
near your location.

1. Push [QUICK].
2. Select “ATT.”

[l =] il | ] |’7'ﬂ2

f<<FM Radio OFF=>
MR

. <<FM Radio Mode=

[Fr'1]«— Displayed when
88.0 WHz the Attenuator is ON.

« “ATT" is displayed.
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Basic operation

< Setting a squelch level

The squelch enables the audio to be heard only while
receiving a signal that is stronger than the set level. A
higher level blocks weak signals, which enables you
to receive only stronger signals. A lower level enables
you to hear weak signals.

The squelch level that is set on the FM RADIO
window is only for the FM Radio.

While holding down [SQL], rotate [DIAL] to select the
squelch level.

] s & B 1200 ] S -+ & 1200

88.0w. | , | 88.0u

lsquetcH: auTo| } IsqueLcH: Leverz|

ESLTOICICE FERIF ESTCICICY FER

Automatic squelch Maximum squelch level

® Information
« Options: “OPEN,” “AUTO"” (default), and “LEVEL 1" ~
“LEVEL 3"

« “LEVEL 1" is loose squelch (for weak signals), and
“LEVEL 3" is tight squelch (for strong signals).

« “AUTQO” is an automatic level adjustment using a noise
pulse counting system.

* “OPEN" is the continuously open setting.
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¢ Using the Monitor function

The Monitor function is used to listen to weak FM
Radio signals without changing the squelch setting.

While holding down [SQL], the transceiver monitors
weak signals on the frequency.
» The squelch opens.

{mm] s -+ B 1200
e — — ————

88.0u.

The first segment blinks.

TIP: You can set the Monitor Hold function on the
MENU screen. The transceiver opens or closes the
squelch each time you push [SQL].

(IMENU] > SET > Function > Monitor)




4 FM RADIO OPERATION

FM Radio memory

¢ Using the FM Radio Memory ¢ Add an FM Radio memory

ﬁttaor:%lr?/f 26 groups are selectable for FM Radio Step 1. Adding an FM Radio memory and entering
You can assign up to 50 FM Radio memory channels the edit mode

to each group, for easy memory management. (A [MENU] > FM RADIO > FM Radio Memory

maximum of 500 memories can be assigned to the FM
Radio memory.)
Some area stations are preloaded into the FM Radio

1. Push [MENU].
2. Select “FM Radio Memory” in the “FM RADIO” menu.

memory for easy memory management. FMRADIO 11
Fi Radio Memory ¥
FM Radio Set *

TIP: The FM Radio memory contents, described <<FM Radio ON>>

. . . . , <<FM Radio Mode=>
in this manual, may differ from your transceiver’s

programmed memory.

3. Select a desired group.

FMd R&DIO MEMORY 275

6:
H: 4
I: ¥
iH 4
K2 4
L: ¥
v
FM RADIO GROUP G 1,1

-- Blank --

@ If there is no memory, “-- Blank --" is displayed.
4. Push [QUICK].
5. Select “Add.”

« The FM RADIO MEM EDIT screen is displayed.

TIP: To change the group name, push [QUICK], and
then select “Edit Name” in step 4.
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4 FM RADIO OPERATION

FM Radio memory

< Add an FM Radio memory

Step 2. Entering an FM Radio Memory name

Step 4. Selecting the skip setting

1. Select “NAME.”

FM RalDIo MEM EDIT 1,f2
GROUP: \
G
FREQUENCY:
2. Enter a name.
MAME
FM-G Station_
akc

® See page iii on how to enter characters.
3. After entering, push [ENT].

TIP: To change the FM Radio memory group, select
“GROUP,” then select the desired group.

Step 3. Entering a frequency
1. Select “FREQUENCY.”

Fhl RADIO MEM EDIT 1,2
MNAME: R

FM-35 Station
GROUP:

3

G

FRECILEMCY:

2. Rotate [DIAL] to enter the frequency.

FREQUEMNCY

53 Bz

® Push D-pad($5) to move the cursor.
® The usable frequency range differs, depending on the
transceiver’s version.
3. After entering, push [ENT].
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1. Select “SKIP.”

FM RADIO MEM EDIT 272

<<hdd Writex>

2. Select “OFF” or “SKIP."

SKIP 11
oFF |
SKIP

« OFF: You can select the memory in the Memory mode.
» SKIP:The memory is not displayed in the Memory
mode.
Step 5. Saving the FM Radio Memory

1. Select “<<Add Write>>."

Fi RADIO MEM ECIT 2/7
SKIP:

*

OFF

<chdd Write==

2. Select “YES.”

FM RADIO MEM EDIT 2.2

cusin. ]

Add write?

FM RADIO GROUP G 1,1

FI-G Station

» The entered contents are saved in the FM Radio
memory, and the display returns to the selected
group screen.

TIP: How to cancel the entered data:
1. Push [CLR].
2. Select “YES.”

MNAME

Tha Cwowi-.

Cancel edit?

ABC

« Cancels the entry, and returns to the selected group
screen.




4 FM RADIO OPERATION

FM Radio memory

<O Editing an FM radio memory

This function edits FM Radio memory contents. This
is useful when already-entered data is incorrect, has
changed, or new data should be added to the list.

[MENU] > FM RADIO > FM Radio Memory

1. Push [MENUL.
2. Select “FM Radio Memory” in the “FM RADIO” menu.

Fi RADIO 141

Fi Radio Memory

FM Radio Set 4
<<FM Radio ON=>
<<FM Radio Maode>>

3. Select a group that includes the memory you want
to edit.

FM RADIC MEMORY  1/5

Divrea 2
Divrea 3
L Area d
Dhrea B
DArea B

AL
B
o
]
E
F

- v w v v

4. Select the memory to be edited.

FM RADIC GROUP & 1,1

FM-4 Station
FM-B Station 4
FM-C Station *

® DO NOT push [ENT].
5. Push [QUICK].
6. Select “Edit.”

[ N o P I S R B2

iSKIF'
Add
Mlawe
Delete

7. Select an item, then edit it.
® See page 4-7 for details.
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After editing, select “<<Overwrite>>."

Fi RADIO MEM ECIT 242
SKIP:

*

OFF

<<fcd Write==
<< Dverwriterr

Select “YES.”

Fi RADIO MEM ECIT 2/7

=R I]

| Qverwrite?

» The memory contents are overwritten, and returns to
the selected group screen.



4 FM RADIO OPERATION

FM Radio memory

¢ Deleting an FM Radio memory

All the contents of an FM Radio memory can be
deleted.

NOTE: Deleted memories cannot be restored.

[MENU] > FM RADIO > FM Radio Memory

1. Push [MENU]. 7. Select“YES.”
2. Select “FM Radio Memory” in the “FM RADIO” menu.

FM R&DIO GROUP G 101

Fi RADIO 171

Fii Fadio Memary ¥
FM Radio Set *
<<FM Radio OM=>
<<FM Radio Mode==

3. Select a group that includes the memory you want
to delete.

FM RADIO GROUF G 101

-- Blarnk -
Fhl RaDIc MERMORY 2]5
G:
H: 4
I: +
1z 4
E= ' » The selected FM Radio memory is deleted.
. L]

4. Select the memory to be deleted.

FM RADIO GROUF G 101

Fr-G Station

® DO NOT push [ENT].
Push [QUICK].
6. Select “Delete.”

o

[ R s P n P I L W B |

iSKIF’

Add
Edit
Move
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4 FM RADIO OPERATION

FM Radio memory

¢ Rearranging the display order of the

FM Radio memories

You can move the entered FM Radio memories to
rearrange their display order in the selected FM Radio

memory group.

[MENU] > FM RADIO > FM Radio Memory

1. Push [MENU].

2. Select “FM Radio Memory” in the “FM RADIO” menu.

Fi RADIO

Fr Radio Memary
Fr Radio Set

<<FM Fadio OMN=>
<<FM Fadio Modex>

11

3

to move.

Select a group that includes the memory you want

D Area 2
DArea 3
PArea q
rArea B
PArea &

™ om0y 00 ey

Fi RADIO MEMORY

1/5

¥
3
L3
3
3
3

Select the memory

to be moved.

FM RADIC GROUP & 101

Fr-& Station
FI-B Station
FII-C Station

® DO NOT push [ENT].

5. Push [QUICK].
6. Select “Move.”

[T ot Pt Pt I

484

iSKIF‘
Add
Edit

[ielete
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7. Select a memory to insert the memory you want to

move above it.

DESTIMNATION 141
Fr-4 Station *
FI-B Station 4
FI-C Station

<<Move End>>

FM R&DIO GROUP A 1/
FIA-B Station 4

FM-C Station *

FiA-4 Station

» The selected memory is inserted above the
destination memory.

@ If you select “<<Move End>>,” the memory is moved
to the bottom of the group.



4 FM RADIO OPERATION

FM Radio memory

< Skip setting for the FM Radio

memory

You can set memories as skip memories. The
selected memories are not displayed in the Memory
mode.

[MENU] > FM RADIO > FM Radio Memory

1. Push [MENUL. 7. Select “SKIP.”
2. Select “FM RADIO.” r o e
3. Select “FM Radio Memory.”

Fi RADIO 171

Fii Fadio Memary ¥
FM Radio Set *
<<FM Radio OM=>
<<FM Radio Mode==

v
FM RADIO GROUP & 1f1
4. Select a group that includes the memory you want Fi-4 Station
to set the skip setting on. FM-E Station ’
FrA-C Station ¢
Fi RADIC MEMORY 1,5
i 3
B Ares 2 r
C:hrea 3 ’ o
D: Area 4 ' » “SKIP” is displayed on the selected memory.
E: Area & . ® Push [QUICK], and then select “SKIP” again to
F: Area & v cancel the skip setting.

5. Select the memory to be skipped.

TIP: When displaying the FM RADIO window in the
FM RADIO GROUP & 1/1 Memory mode, push [QUICK], and selecting “SKIP”
also sets the skip setting.

Fh-4& Station
FI-B Station r
FII-C Station ¢

ol =1 wii= ] I‘?'ﬂg
l=<FM Radio OFF=>
YFO

Group Select 3

1ATT o
=<FM FRadio Mode=

® DO NOT push [ENT].
6. Push [QUICK].
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4 FM RADIO OPERATION

Using the FM Radio mode

The transceiver has an exclusive FM Radio mode
where only the FM Radio functions.

1. Push [QUICK].
2. Select “<<FM Radio Mode>>."

[l S & B 4700

f<<FM Radio OFF==
YFO
Group Select 3

BBIOMHZ

2023/05/02(Tue)

» The FM Radio mode screen is displayed.

TIP: To cancel the FM Radio mode
1. Push [QUICK].
2. Select “<<Normal Mode>>."
@ In the exclusive FM Radio mode, the other modes
are in a sleep state. To operate the transceiver in a
normal way, cancel the FM Radio mode.
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4 FM RADIO OPERATION

FM RADIO items

FM Radio Memory

Earphone Antenna (Default: Not Used)

[MENU] > FM RADIO > FM Radio Memory

Atotal of 26 groups are selectable for FM radio
Memories.

You can assign up to 50 memories to each group,

for easy memory management. (A maximum of 500
memories can be assigned to the FM Radio Memory.)

FM Radio memory contents

The name of an FM Radio memory
channel

NAME ® Enter a name of up to 16 alphanumeric
characters for each memory.
GROUP The group letter and the name of the group
Entered frequency
FREQUENCY @ The usable frequency range differs,
depending on the transceiver’s version.
Shows the skip status.
SKIP ® The Skip channels are not displayed in
the Memory mode.
Auto Mute (Default: 2sec)

[MENU] > FM RADIO > FM Radio Set > Auto Mute

Selects whether or not to mute the FM Radio audio in

the background* while receiving a signal on the A or B

band.

® The FM Radio audio is muted while transmitting,
regardless of this setting.

* See “To listen to the FM Radio while monitoring the A/B
bands” on page 4-2 for details.

¢ OFF: The Auto Mute function is OFF. The FM Radio

audio is not muted even if the transceiver

receives a signal on the A or B band. The FM

Radio audio is muted when the transceiver

transmits.

The FM Radio audio is automatically muted

when the transceiver transmits or receives

on the A or B band. After transmitting or

receiving, the Auto Mute timer starts. After the

timer period ends, you can listen to FM Radio

again.

®The FM Radio audio is muted when a
signal is received during a sweep by the
Band Scope function.

¢ 0to 10sec:
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[MENU] > FM RADIO > FM Radio Set >
Earphone Antenna

Selects whether or not to use the earphone antenna
for FM radio.

* Not Used: An earphone antenna is not used.

e Use: An earphone antenna is used.

Power Save (FM Radio) (Default: ON)

[MENU] > FM RADIO > FM Radio Set >
Power Save (FM Radio)

Sets the power save function to reduce the current

drain and conserve battery power when the FM Radio

is ON.

« OFF: The power save function is OFF.

¢ ON: When the FM Radio is ON, and no signal is
received for 5 seconds, this function is activated in
a 1:3 ratio (300 : 900 milliseconds).

NOTE: This function is disabled when an external
power source is used.

<<FM Radio ON>>

[MENU] > FM RADIO > <<FM Radio ON>>

Turns ON the FM Radio.

When the transceiver receives on the MAIN band and

SUB band, you can still listen to the FM Radio.

When the FM Radio is ON, <<FM Radio OFF>> is

displayed on the FM RADIO screen. To turn OFF the

FM Radio, select <<FM Radio OFF>>.

® In the Quick Menu window, selecting <<FM Radio OFF>>
also turns OFF the FM Radio.

<<FM Radio Mode>>

[MENU] > FM RADIO > <<FM Radio Mode>>

The transceiver enters an exclusive FM Radio mode

where only the FM Radio functions.

While in the FM Radio Mode, <<Normal Mode>> is

displayed on the FM RADIO screen. To exit from the

FM Radio mode, select <<Normal Mode>>.

@ In the Quick Menu window, selecting <<Normal Mode>>
also exits from the FM Radio mode.
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< Deleting Your Call SigN.......cocviiiiiieiiie e 5-42
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» The repeater list, described in this manual, may differ from your transceiver’s preloaded contents.
 Although Japanese repeaters are used in the setting examples, the Japanese repeater node (port) letters
are different from other country’s. BE SURE to add the repeater node letter in the 8th digit of the call sign,

according to the frequency band shown below.
1200 MHz: A (B in Japan)

430 MHz: B (A in Japan)

144 MHz: C (no repeaters in Japan)

To begin the Digital mode communication using other than the D-STAR Repeater (DR) function

To begin Digital mode communication using other
than the DR function, you can use the VFO mode,
Memory mode, or Call Channel mode.

This manual description focuses on the DR function
operation, which can be easily set up. If you want to
use other than the DR function, see the procedures
as described to the right, or select the repeater in a
Memory channel.

For a Local area call or Gateway call:

1. Setthe access repeater’s frequency. (p. 11-2)

2. Set the Duplex direction and frequency offset.
(p. 11-4)

3. Setthe call signs (UR/R1/R2). (p. 12-8)

For a Simplex call:
1. Setthe operating frequency.
2. Setthe call signs (UR/R1/R2). (p. 12-8)
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5 D-STAR OPERATION (ADVANCED)

“FROM?” (access repeater) setting

Your access repeater must be set in “FROM” when you make a call on the DR screen.
You have 5 ways to select the access repeater.

By rotating [DIAL]
Select the preset repeater on the DR screen by rotating [DIAL].

] 4 B 1200

o+
ETSDS COlz131 /2147 dg—!

—Displayed while
rotating [DIAL]

440.000 ...

* When you know your access repeater

From the repeater list (p. 5-4) FROM SELECT 141

When your access repeater is in your transceiver’s repeater list, you can Repeater List

select it by selecting the repeater area and name, if entered, or call sign. ?}iaﬁﬁ:pfﬁter '
1stary *

* When you do not know which repeaters you can access

Search for a repeater using the DR scan (p. 5-5)
The Normal DR scan searches for output repeater frequencies of nearby

repeaters. The scan stops when a signal is detected. The scan also stops
MNear Repeater (AL

on Simplex signals. Mear Repeater (D)
I|Mear Repeater (FM Scan items

The Near Repeater scan searches for output repeater frequencies of
nearby repeaters by using your location and the repeater’s location, if it
is entered in the Repeater List. The DR scan starts scanning and stops
when a signal is detected.

You can also find only FM repeaters using the Near Repeater (FM) scan.

Search for near repeaters (p. 5-6)
The transceiver scan searches for near repeaters by using your location
and the repeater’s location, if it is entered in the Repeater List.

FROM SELECT 141
Repeater List ¥

Mear Repeater
The nearest repeaters in your transceiver’s repeater list are displayed as TH History v
selectable options.

You can select the nearby DV or FM repeater type.

*« When “FROM” data is saved in the TX History.

Select from the TX History (p. 5-7) FROM SELECT  1/1
Select a repeater that you have accessed before from the TX History Repeater List v
record. Mear Repeater 4
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5 D-STAR OPERATION (ADVANCED)

“FROM” (access repeater) setting

<& Using your transceiver’s repeater list

When your access repeater is in your transceiver’s
repeater list, you can select it from the list. By just
selecting the repeater from the list, the repeater call
sign, its frequency, duplex setting, and frequency
offset are automatically set, for easy operation.

Example: Selecting the “Kirkland” repeater in
Washington state in the USA from the
repeater list.

1. Hold down [DR] for 1 second to display the DR 5. Select your access repeater.
screen. RPT LIST GRF 20 31,24
2. Push D-pad(!) to select “FROM,” and then push Federal Flay
[ENT]. Federal Way
Graham
(o] - B 1200
(=10} o—
J% COCQcy Kirkland
ﬁ Herne Bay Wazhingt MTIH E
M 30 450 cETIc B
l'lflhb 000 » Returns to the DR screen, and the selected repeater
L FSKIF

name is displayed in “FROM.”
® The repeater list, described in this manual, may differ
from your transceiver’s preloaded contents.

3. Select “Repeater List.

FROM SELECT 141

Fepeater List
Mear Fepeater 4
T Histary v

TIP:

When you select an FM repeater:

When an FM repeater is in your transceiver’s
repeater list, you can select it from the list.

When selecting an FM repeater, the “TO” setting is

REPEATER GROUP  4/4 not necessary, and a “——" is displayed in “TO.”
19: USA Southeast »
200 LISA

211 Simplex N

4. Select the repeater group where your access
repeater is listed.

When selecting an FM repeater.

] & 1200
FM D— TOME

o i mi

145110 KaSkKEH
E e

440.000 ...

How to change the repeater group:
To change the repeater group on the DR screen,
push [QUICK], then select “Group Select.”

ATT ,
I DTMF Tx ,
IWoice TH a3

GPS Information
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5 D-STAR OPERATION (ADVANCED)

“FROM” (access repeater) setting

¢ Using the DR scan

The DR scan scans frequencies to find a signal on a
repeater, or on a simplex frequency.

You can use 2 kinds of DR scans, Normal scan and
Near Repeater scan.

Normal scan:
To quickly find a repeater, the Normal scan skips
repeaters that are not set as an access repeater.
® The “USE (FROM)” setting (p. 5-33) is set to “NO” on the
repeater list.
(IMENU] > MEMORY > Repeater List)

Near Repeater scan:

The Near Repeater scan searches for up to 20 nearby
repeaters within 160 kilometers (100 miles) by using
your location and the repeater’s entered position data,
and then lists the repeaters.

® The Near Repeater scan continues, even if you turn OFF

the transceiver, and then turn it ON again during the scan.

@ If your own position data is not being received from GPS
satellites, the last received position data is used.

NOTE: Even if your transceiver receives a repeater
signal, the repeater may not receive your signal,
because the repeater’s output power is higher than
your transceiver’s, and your signal does not reach
the repeater.

TIP: The DR scan scans the simplex frequencies in
the repeater list, in addition to D-STAR repeaters.

5-5

Example: Selecting an active repeater using the DR
scan.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Hold down [SCAN] for 1 second.

Fr
Mormal
Mear Repeater (AL
Mear Repeater (D)

I|Mear Repeater (FM

» The DR scan setting window is displayed.
3. Select the scan type.
* Normal:
Searches for repeaters whose “USE (FROM)” setting
is set to “YES.”
Near Repeater (ALL):
Searches for up to 20 each of nearby DV or FM
repeaters. (Total 40 repeaters)
* Near Repeater (DV):
Searches for up to 20 nearby DV repeaters.
* Near Repeater (FM):
Searches for up to 20 nearby FM repeaters.

The selected scan starts.

« In the DR scan, the repeaters are sequentially
displayed by distance, in descending order.

® The scan resumes the same as other scans. (p. 12-5)

o) + B
=

(=37
4% Cacacy

12:00

Santa Vhez 1
M 447.040  KKEGFX B «—The rep?atersl are
SL0
= sequentially displayed.
440.000 ...

4. When the transceiver receives a signal from a
repeater, the scan stops. Push [SCAN].

o] -+ B

(=31 O+
T
a cacaca
Kirkland
443575 NTIH B
manm

12:00

SLo

440.000

FSEIF

* The DR scan is canceled, and the repeater is set to
“FROM.”

{m] + B

oW O+
T
A cQeoca
Kirkland

443.575
)

440.000

12:00

N7IH B

F=kIF




5 D-STAR OPERATION (ADVANCED)

“FROM” (access repeater) setting

<& Using the Near Repeater Search function

The transceiver searches for the nearest repeaters by
using your location and the repeater’s entered position
data.

The nearest repeaters in your transceiver’s repeater
list are displayed as selectable options.

NOTE:

* When using the Near Repeater Search function, BE
SURE first to receive your own GPS position data, or
manually enter your position data.

« If no repeater is found within a 160 kilometers
(100 miles) range, “No Repeater Found” is displayed.

« If the last received position data can be used, “GPS is
invalid. Search by last valid position” is displayed.

Example: Selecting a nearby repeater from the Near
Repeater list.

Step 1: Receiving your own location from the GPS
satellite

Confirm the GPS receiver is receiving the satellite
signals.
« The GPS icon blinks when searching for satellites.

- % % _, (Noicon)

* The GPS icon stops blinking when the minimum needed
number of satellites is found.
&

@ It may take only a few seconds to receive, or it may take
a few minutes, depending on your operating environment.
If you have difficulties receiving, we recommend that you
try a different location.

@ If your own location is not being received, the last
received position is used for your location.

Step 2: Selecting the access repeater from the
Near Repeater list
1. Hold down [DR] for 1 second to display the DR
screen.
2. Push D-pad(!) to select “FROM,” and then push
[ENT].

g

- &
=

oY
TO
a2 cacgca
Kirkland

443 575 MTIH E
SLO s

440.000

12:00

F=EIF

3. Select “Near Repeater.”

FROM SELECT 14
Fepeater List ¥

lear Fepeater

T History 3

5-6

4. Select the type of nearby repeater to display.

MEAR REPEATER. 1/1

MNear Repeater [ALL)Y
Mear Repeater (DW) »
MNear Repeater (FM) »

* Near Repeater (ALL):
Displays up to 20 nearby DV and FM repeaters.
(A total 40 repeaters)
* Near Repeater (DV):
Displays up to 20 nearby DV repeaters.
* Near Repeater (FM):
Displays up to 20 nearby FM repeaters.
5. Select the repeater to use as your access
repeater, considering the distance from your
location to the repeater.

MESR REPEATER {aLL} 174

Cheney
Cle Elum <«—“FM" is displayed for the FM
Edmonds=

repeaters.

Federal Way

{») 5.5mi | MRTSZ B <€—Repeater call sign

Distance and direction from
your location to the repeater*

* When the “POSITION” setting (p. 5-34) is set to
“Approximate” on the repeater list, the direction data
is not displayed if the distance to the repeater is less
than 5 kilometers.

« Returns to the DR screen and the selected repeater

is set in “FROM.”

(] A+ &

To o D+
an cqQcacaq
Everett

440.350
EL0

440.000

12:00

MRTZS B

FZEIF




5 D-STAR OPERATION (ADVANCED)

“FROM” (access repeater) setting

<O Using TX History

The TX History saves up to 10 of the latest access TIP: When you push [QUICK] in step 5, you can

(From) repeaters you transmitted on. You can select a display the REPEATER DETAIL screen or delete the
repeater from TX History as your access repeater. TX HISTORY screen’s repeater information.

Tl T T oma g St 4 44

Example: Selecting the “Hirano” repeater from TX f[Detail |
History. Delete

Delete All

1. Hold down [DR] for 1 second to display the DR

screen. -wasnlngt MR=s B
2. Push D-pad(!) to select “FROM,” and then push
[ENT].
] + B 12100
meRrey o- 00
A CACaCa
derne Bay

$39.450 GBYIC B

440.000 ...

3. Select “TX History.”
FROM SELECT 1/

Fepeater List 4
Mear Fepeater 4

4. Select the TX History (DV) or TX History (FM).
TH HISTORY 1/1

TH Histary (D)
T¥ Histary (FI) »

» TX History (DV): Displays the TX History of the DV

repeaters.

« TX History (FM): Displays the TX History of the FM
repeaters.

5. Select the repeater to use it as your access repeater.

TH HISTORY (DW} 101

Everett

Kirkland

Hirano

Osaka JPEVHH &

» Returns to the DR screen and the selected repeater
is set in “FROM.”

(] -+ B 12:00
ov  O-

T
o cQcacqg

Hirano

439 390 JP3YHH &
o N o

440.000 ...
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5 D-STAR OPERATION (ADVANCED)

“TO” (Destination) setting

“CQCQCQ,” the destination repeater, or station call
sigh must be set in “TO” when you make a DV mode
call. You have 9 ways to set the destination.

By rotating [DIAL]
Rotate [DIAL] to select the repeater or Your Call
Sign displayed on the DR screen. (This operation is
disabled when “CQCQCQ" is set.)

To make a Local Area CQ call
Set “CQCQCQ" in “TO” (Destination). (p. 5-9)

To make a Gateway CQ call
Select a repeater from the Repeater List, if you
want to make a Gateway call. (p. 5-9)

To make a call to a specific station
Select the station call sign in the Your Call Sign list.
(p. 5-10)

To make a call through a Reflector
Select a reflector you want to call through. (p. 5-14)

To select from RX History

When you receive a call, repeater or caller station
data is saved in RX History.

Select the destination from the record. (p. 5-10)

To select from TX History
When you make a call, the destination repeater or
called station data is saved in TX History.

Select the destination from the record. (p. 5-11)

Directly enter the destination station’s call sign.
(p. 5-11)

Directly enter the destination repeater’s call sign.
(p. 5-12)

To directly enter the destination repeater call sign

J
?
J

N

J

N

J

N

J

N

To directly enter the destination station call sign

5-8

TIP: After you receive the individual station or
repeater’s signal, the call sign can be captured by
holding down the Call Sign Capture key ([RX—CS]),
and you can quickly and easily reply to a call.

T SELECT 142

Local CQ
Gateway CO)
Your Call Sign
Reflector

Fx History

TH Histary

* v ¥ v

TIP: How to change the repeater group:
When “Local CQ” or “Gateway CQ" is
selected, you can change the repeater
group.

To change the repeater group on the DR
screen, push [QUICK], then select “Group
Select.”

GPS Information

T SELECT 22
Direct Input (LIR)
Direct Input (RPT) *»




5 D-STAR OPERATION (ADVANCED)

“TO” (Destination) setting

<& Making the “Local CQ” (Local Area call) < Making a “Gateway CQ” (Gateway call)

When “Local CQ” is selected on the TO SELECT When “Gateway CQ" is selected on the TO SELECT
screen, “CQCQCQ"is setin “TO.” screen, you can select the repeater to make a
gateway call to.
Example: Making a Local area call by accessing the
“Kirkland (1A)” repeater. Example: Making a Gateway CQ call to the “Hirano”
repeater from the “Kirkland (1A)” repeater.
1. Hold down [DR] for 1 second to display the DR

screen. 1. Hold down [DR] for 1 second to display the DR
2. Push D-pad(1) to select “TO,” and then push [ENT]. screen.
2. Push D-pad(1) to select “TO,” and then push [ENT].

-+ & 12:00

O+ o 4 B 12:00
LTty FoTRRTY

reom Kirkland
L et o Elirkland

440.000 ...

SLO

440.000 ...

3. Select “Local CQ."

3. Select “Gateway CQ.”

TO SELECT 1/2

Local CQ T SELECT 1}’2

Gateway CQ ¢ Local COQ

Your Call Sign 4 M

Reflector ¢ *

¥ History r Reflector 3

T Histary r R History *
T¥ Histary *

* Returns to the DR screen, and “CQCQCQ" is

displayed in *TO." 4. Select the repeater group where your destination

repeater is listed.

REFEATER GROLUF 274

07: Europe - Southerr
08: Europe - Western»

09: Germany 4
10: Islands *
112 ltaly *
12: lapan ¥

5. Select the destination repeater.

RPT LIST GRP 12 12/16
MNagaoka

Miigata

Kurashiki

Ginowan

Hirano

Osaka JPIVHH &

® Each repeater has a correct node (A, B, or C band)
that you want to transmit on. See page 5-2,
“IMPORTANT” for band letter details.

« Returns to the DR screen, and the selected repeater
name is displayed in “TO.”

TIP: After selecting a destination repeater, you can
select another repeater preset in your repeater List
by rotating [DIAL].

o] -+ B 12:00
[TAAIN] T+

o KirH T2d /2147

SLO

5-9



5 D-STAR OPERATION (ADVANCED)

“TO” (Destination) setting

<& Using “Your Call Sign”

The “Your Call Sign” memory saves individual or
repeater station call signs. When you select the call
sign for the “TO” (Destination) setting, you can make
a Gateway call. When you call an individual station
through a gateway, the signal is automatically sent to
the last repeater that the individual station accessed.
Therefore, even if you do not know where the
individual station is located, you can make a call.

NOTE: If the repeater, set in “FROM” (access
repeater), has no Gateway call sign, you cannot
make a gateway call.

Example: Selecting “Rick” from “Your Call Sign.”

1. Hold down [DR] for 1 second to display the DR
screen.

2. Push D-pad(?1) to select “TO,” and then push [ENT].

o) -+ B 12:00
Lo L FoIR

FraM Hirano
SLD

440,000 ...

3. Select “Your Call Sign.”

TO SELECT 1/2

Local CQ
Gateway 0

L3
Your Call Sign Y
Reflector *
R Histary 4
TX Histary 4

4. Select a destination name or call sign.

WOUR CaLl SIGN 1.1

WA ZLE

» Returns to the DR screen, and the selected name is
displayed in “TO.”

<& Using RX History

When a call is received in the DV mode, the call data
is saved in the RX History.

Up to 50 callers, and only the last called call signs, a
total of 51 histories can be saved.

Example: Selecting “Rick” in the RX History.

1. Hold down [DR] for 1 second to display the DR

screen.
2. Push D-pad(1) to select “TO,” and then push [ENT].
& 12:00
cacaca
M Hirano

SLO

440.000 ...

Select “RX History.”

TO SELECT 1/2

Local COQ

Gateway CO *

YWour Call Sign *

Reflector *
L]
3

T¥ History

4. Select a destination name or call sign.

RX HISTORY 141

Rick v

A1 ZLE

» Returns to the DR screen, and the selected name is
displayed in “TO.”

® The “*” (asterisk) is displayed at the beginning of the
called station’s call sign. (p. 5-19)

TIP: After selecting a destination, you can select
another station preset in your transceiver by rotating
[DIAL].

] A B 12:00
1.1 o
O R

& JMIZLE

rrom Hirf 21724

=L

TIP: To add an RX HISTORY data to the “Your Call
Sign” memory, push [QUICK], then select “Add To
Your Memory.”

[a AR N [l ol w ¥ At
i Add To Your Memo

LT i




5 D-STAR OPERATION (ADVANCED)

“TO” (Destination) setting

<& Using TX History

TX History saves the repeater and station name and
call sign of up to 20 “TO” (Destination) settings used
when you made the calls.

NOTE: Until you make a call in the DV mode, you
cannot select “TO” (destination) from the TX History.

Example: Selecting the “Kirkland (IA)” repeater in the
TX History.

1. Hold down [DR] for 1 second to display the DR
screen.

2. Push D-pad(?1) to select “TO,” and then push [ENT].

-+ B
o—

12:00

FroM Hirano
ZLo

440.000

FZEIF

3. Select “TX History.”

T SELECT
Local CQ
Gateway C0] 4
Your Call Sign 4
Reflector *
R+ Histary 4
L

1/2

T¥ Histary

4. Select a destination repeater.

TH HISTORY
Kirkland
Melbourne
Wienna

141

Washingt |/NTIH B

f

The Sub name is
displayed when a
repeater is selected.

» Returns to the DR screen, and the selected repeater
name is displayed in “TO.”

TIP: You can add the TX HISTORY data to memory,
or delete it from the TX HISTORY screen.
Push [QUICK], then select the option.

T LS C

il 4cdd To RPT List

A4

Delete All

< Directly entering (UR)

The destination station call sign can be directly entered.
Example: Directly entering the call sign “JIM1ZLK.”
1. Hold down [DR] for 1 second to display the DR

screen.
2. Push D-pad(1) to select “TO,” and then push [ENT].

FraM Hirano
SLD

FZEIF

440.000

3. Select “Direct Input

2/2
Direct Input (IR ¥
Direct Input (RPT) »

(UR).”

T2 SELECT

4. Enter a call sign of up to 8 characters, including
spaces.

DIRECT INPUT(UR)
IMAZLE,

® See page iii on how to enter characters.
5. After entering, push [ENT].
|

# B
= O D-
i 112K

12:00

rraM Hirano
ZLo

440.000

FSEIF

* Returns to the DR screen and the entered call sign is
displayed in “TO.”

@ After entry, you can edit the call sign in the DIRECT
INPUT (UR) screen.

® The entered call sign remains on the DIRECT INPUT
(UR) screen until you enter a new call sign.

TIP: If the entered call sign is duplicated in the “Your
Call Sign” memory, the name is displayed.

(Only when the name has been entered.)

] + B
7o Y

[ IM1ZLE

FRIM Hirano
SLO

12:00
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5 D-STAR OPERATION (ADVANCED)

“TO” (Destination) setting

< Directly entering (RPT)
The destination repeater call sign can be directly
entered.

NOTE: BE SURE to include a node letter as the 8th
digit. See page 5-2 “IMPORTANT” about the node
letters.

Example: Directly entering the call sign “JP3YDH A.”

1. Hold down [DR] for 1 second to display the DR
screen.
2. Push D-pad(?1) to select “TO,” and then push [ENT].

12:00

FraM Hirano
ZLo

440.000 ...

3. Select “Direct Input (RPT).”

T2 SELECT 242
Direct Input (UR)

Direct Input (RPT) ¥

4. Enter a call sign of up to 8 characters, including
spaces.

DIRECT INPUT(RPT)
IP2YDH A

® See page iii on how to enter characters.
5. After entering, push [ENT].

* Returns to the DR screen and “JP3YDH A" is
displayed in “TO.”

@ After entry, you can edit the call sign in the DIRECT
INPUT (RPT) screen.

® The entered call sign remains on the DIRECT INPUT
(RPT) screen until you enter a new call sign.

TIP:

« If the entered call sign is duplicated in the repeater list,
the name is displayed in “TO” (Only when the name has
been entered).

« When directly entering the repeater call sign, including a
“/" at the beginning is also correct.

5-12



5 D-STAR OPERATION (ADVANCED)

REPEATER DETAIL screen

Depending on the content, such as position data or
UTC offset, the distance between your location and
the repeater, or the repeater time can be displayed on
the REPEATER DETAIL screen.

The detail screen can also be entered from the FROM
SELECT screen.

Example: Displaying the “Hirano” repeater detalil
screen

1. Hold down [DR] for 1 second to display the DR

screen.

Push D-pad(T) to select “TO” then push [ENT].

- B
Ow  O-—

12:00

M Hirano
SLO

440.000

FEKIF

Select “Gateway CQ.”

T SELECT 1/2
Local CQ
Your Call Sign
Reflector

F¥ History

T Histary

- = « = Kl

Select “13: Japan.”

REPEATEFR GROUP 2)’4
: Europe - Souther
08: Europe - Western»
09: Germany *
10: Islands 4
11: ltaly 4
12 r

Select “Hirano.”
® DO NOT push [ENT].

1218

RPT LIST GRP 12
Magaoka
Miigata
Kurashiki
Ginowah

Osaka JPZVHH &

o

Push [QUICK].
Select “Detail.”

r\n'rlri-'r Pt ] I Rl AT 04
) Detail ]
Add
Edit
Delete

JZaka TFZvAH

Push [ENT].
» Returns to the previous screen.

5-13

The REPEATER DETAIL screen

Repeater frequency Call sign

REPEATIER|DETAIL
Hirano v
Osaka yIPEWHH &

GRF1Z  439.390

Repeater name —»
Sub name —»
Group number —»

ouUp - «— Duplex

H . setting
Direction from —p- U’ff\:ﬁg DET:5. Bmi T
your position* ";Esj TIME:17:03 Distance
| from.your
Repeater time position

* When the “POSITION” setting (p. 5-34) is set to
“Approximate” on the repeater list, the direction data
is not displayed if the distance to the repeater is less
than 5 kilometers.

@ If there is no position data, the distance and direction
from your position are not displayed. See page 6-3 to
confirm your position.

® When selecting an FM repeater, either of “FM” or “FM-N"
and the tone setting are displayed.

TIP: You can display the REPEATER DETAIL screen
when the DR screen is displayed.

When you set the repeater as shown below, push
[QUICK], then select “Repeater Detail.”

o] -+ B

To (=3 (=t
P cacacao
Hirano
459,390
o

JP3YHH A
440.000

12:00

F=EIF

GP3 Information

* The REPEATER DETAIL screen is displayed.
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Connecting to a reflector

D-STAR OPERATION (ADVANCED)

OWhat is a reflector?

A reflector is a special server connected to the Internet and running a version of the D-Plus software. If the D-Plus
software is installed on your access repeater, it provides various functions including gateway and reflector linking
capabilities (It is known as the D-STAR reflector system). The D-STAR reflector system enables a nhumber of
D-STAR repeaters anywhere to link to a reflector. This means that when you transmit through a D-STAR repeater

linked to a reflector, your voice can be heard on other repeaters linked to the reflector, and you can hear other
stations that are connected to the reflector.

D-STAR reflector system

Access
repeater

Reflector

<& Unlinking a reflector

Before trying to link to another reflector, BE SURE to
unlink the currently connected to the repeater.

NOTE: If a reflector is already connected, ask on the
air whether or not you can change reflectors and wait
for responses. BE SURE to reconnect back to the
same reflector when you finish your conversation.

1.

2.

Hold down [DR] for 1 second to display the DR

screen.

Push D-pad(?) to select “TO,” and then push [ENT].

« Displays the TO SELECT screen.

Select “Reflector.”

TO SELECT 1/2

Local CQ
Gateway CO
Your Call Sign

Fx History
T History

3
L3
Feflector ¢
»
L3

« Displays the REFLECTOR screen.

AUS

5-14

4. Select “Unlink Reflector.”

REFLECTOR 11
Lse Reflector

Link to Reflector *
Unlink Reflector

Echo Test
Repeater Information

* Returns to the DR screen, and “Unlink Reflector” and
“U” are displayed in “TO.”

] & 1200
ow  O—

ETi:EIl UnIinkUReflectc-r

reom Hirano
SLD

440.000 ...

5. Hold down [PTT] to unlink the reflector.
* The TX/RX indicator lights red.



5 D-STAR OPERATION (ADVANCED)

Connecting to a reflector

< Linking to a reflector

If your repeater is not currently linked to a reflector, or
if you want to change it to another reflector, follow the
steps below. Before linking to another reflector, BE
SURE to unlink the current reflector. (p. 5-14)

Direct inputting a reflector
Example: Directly enter “REF030CL.”

1. Push D-pad(t) to select “TO,” and then push [ENT]. 6. Push [ENT].
) 4 B 1200 aml 4 B 12:00
o oy oW OF
COCcQca To I
o Iﬁépgaiégl_ﬂeﬂectnr
M Kirkland rrom Kirkland
440,000 ... 440.000 ...

* Returns to the DR screen, and “Link to Reflector” and

2. Select “Reflector. “REF030CL” are displayed in “TO.”

TO SELECT 142 7. Hold down [PTT] to link to the Reflector.

Local CQ

Gateway CQ 8 Using TX History

.|,|. =Ll TX History saves up to 5 reflectors that your access
R History b repeater linked to before.

TH History ' Example: Select “REFO30CL" in TX History.

1. Push D-pad(t) to select “TO” then push [ENT].

[am 4 B 1z:00
[I D+

3. Select “Link to Reflector.”

REFLECTOR 141
Jse Feflector C
Link to Reflector ¥ rram Kirkland
Unlink Reflector sLo

Echo Test 4&5-000 FSKIP

Repeater Information

* The TO SELECT screen is displayed.

4. Select “Direct Input.” 2. Select "Reflector. .
_ The REFLECTOR screen is displayed.
Link to Reflector _1/1 3. Select “Link to Reflector.”

Direct Input

The Link to Reflector screen is displayed.
4. Select the Reflector that you want to link to.

Link to Reflectar 141
Direct Input 4
REF@&ZGCL

5. Push D-pad to move the cursor, and select the
reflector type, reflector number, or module letter.

Link to Reflector

» Returns to the DR screen, and “Link to Reflector” and
“REFO030CL” are displayed in “TO.”

REFOZOMEL qm 4+ B 1200
BB oy o+ 000

o+

W
R | inlk to Reflector
& REFEzACL

rrom Kirkland
SLD

440.000 ...

o

Hold down [PTT] to link to the Reflector.
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5 D-STAR OPERATION (ADVANCED)

Connecting to a reflector

¢ Using a reflector ¢ Requesting repeater information
1. Push D-pad(t) to select “TO,” and then push [ENT]. When you send the repeater information command,
« The TO SELECT screen is displayed. an ID message is sent back.
2. Select “Reflector.”
The REFLECTOR screen is displayed. 1. Push D-pad(t) to select “TO,” and then push [ENT].
3. Select “Use Reflector.” « The TO SELECT screen is displayed.
2. Select “Reflector.”
» The REFLECTOR screen is displayed.
Link tn Reflectar 3. Select “Repeater Information.”
Unlink Reflector
Echa Test REFLECTOR 141
Repeater Information Lze Reflectar
Link to Reflector 4
Unlink Reflector
Echo Test
* Returns to the DR screen, and “Use Reflector” and Repeater Information
“CQCQCQ" are displayed in “TO.”
am] - B 1200
e UDS: F{;Iectnr * Returns to the DR screen, and “Repeater
IS cococ Information” and “I” are displayed in “TO.”
rrom Kirkland
{mm] B 1200
B
440.000 e oF epeatelr nformat

rrom Kirkland

Lo

440.000 ...

4. Hold down [PTT] to transmit.

< Reflector Echo testing 4. Hold down [PTT] to transmit the repeater
To confirm that your signal is correctly getting into the Information command.
repeater, you can transmit a short message as a trial. 5. Release [PTT] to hear the repeater ID message.

After releasing [PTT], your message will be played back.
1. Push D-pad(t) to select “TO,” and then push [ENT].
* The TO SELECT screen is displayed.
2. Select “Reflector.”
The REFLECTOR screen is displayed.
3. Select “Echo Test.”

REFLECTOR 11

lse Reflector

Link to Reflector *
Unlink Reflector
Echo Test

Fepeater Information

* Returns to the DR screen, and “Echo Test” and “E”
are displayed in “TO.”

(o] # B 1200
o o+

W] Echo Test

2E E

rrom Kirkland
ZLD

440.000 ...

4. Hold down [PTT] and speak into the microphone.
5. Release [PTT] to hear your message.

5-16



5 D-STAR OPERATION (ADVANCED)

Message operation

You can save up to 5 short messages in the
transceiver’'s memory to transmit in the DV mode.
Each message can be up to 20 characters.

<O Entering a TX message

[MENU] > SET > My Station > TX Message

Example: Entering “JAPAN TOM” into TX message
memory number 1.

1. Push [MENU].

2. Select “My Station” in the “SET” menu.

SET 1/3
Ty DUP/TOME. .

M Scan

M Scope

& My Station
wif DV Set

L3
»
*
Be: Call Sign ’
1
»

3. Select “TX Message.”

Y STATION 141
My Call Sign 4
TX Meszage

4. Select a TX Message memory number.

T MESSAGE  1/2
OFF

2

® DO NOT push [ENT].
5. Push [QUICK].
6. Select “Edit.”

7. Enter a message of up to 20 characters.

TH MESSAGE
JAPAN TOM_

ABC

® See page iii on how to enter characters.
8. After entering, push [ENT].
¢ Returns to the TX MESSAGE screen.
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¢ Transmitting a message
You can transmit a preset TX message by pushing

[PTT] in the DV mode. First, select a TX message which

also turns ON the Message Transmission function.
[MENU] > SET > My Station > TX Message

1. Push [MENU].
2. Select “My Station” in the “SET” menu.

SET 1/3
P DUPSTOME...
& Scan

M Scope

s Call Sign

X M Y Station
wif DV Set

3. Select “TX Message.

MY STATION 141

My Call Sign ¥
T Meszs

4. Select a TX Message memory humber.

TH MESSAGE  1/2
OFF

T:JAPAN TOM

® To not transmit any message, select “OFF.”
® To exit the MENU screen, push [MENU].

® Information

* The message is transmitted with your voice signal.

* The message is transmitted each time you push [PTT].

« When continuously transmitting, the selected TX
message is transmitted every 30 seconds.

TIP: RX call sign and message display

As the default, the received call sigh and message
are automatically displayed and scrolled.

To not display and scroll them, set RX Call Sign to
“OFF.”

(IMENU] > SET > Display > RX Call Sign)




5 D-STAR OPERATION (ADVANCED)

Message operation

O Deleting a TX message

[MENU] > SET > My Station > TX Message

Example: Deleting the entered TX message “JAPAN
TOM” from TX message memory number 1.

1. Push [MENUL.

2. Select “My Station” in the “SET” menu.

SET 1/3

Sy DUR/TOME. ..
M Scan

M Scope

Be: Call Sign

L3
3
L3
L3
3
L3

& My Station
wif DV Set

3. Select “TX Message.”

MY STATION 141
My Call Sign 4

T¥ Meszage

4. Select a TX Message memory number.

T MESSAGE  1/2
OFF

1 JAPAN TOM

® DO NOT push [ENT].
5. Push [QUICK].
6. Select “Clear.”

Tl RACTE b T 455

| Edlit

» The confirmation dialog is displayed.
7. Select“YES."

TH MESSAGE 142

T

Clear?

» The entered message is cleared.
@ To exit the MENU screen, push [MENU].
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5 D-STAR OPERATION (ADVANCED)

Viewing received call signs

When you receive a DV call, the calling station and the repeater call signs are saved. Up to 50 calls can be saved.
When you receive the 51st call, the oldest call history is deleted.
® Even if the transceiver is turned OFF, the RX records are not deleted.

< Viewing the call signs on the RX History screen

1. Hold down [CD] for 1 second.
2. Select an RX history memory to view the details.

® Information

 The first page of the “RX HISTORY” screen displays the
latest RX record of the MAIN band. The second page or later
displays the record according to the received date and time,
regardless of the band it was received on.

* The RX history number, the caller’'s name (or call
sign), destination, RX message, RX date and time,
“GW,” and “GPS” are displayed.

* “GW" is displayed when the Gateway call is received.

« “GPS” is displayed when the received call includes
position data.

« “UP” is displayed when the repeater uplink signal is
received.

* In the Quick Menu window, you can select the
following options.
RX>CS: Temporarily enters the received

call sign into “TO.”

The received data is displayed in

the Call Sign Display mode.

Call Sign Display:

Name Display: The received data is displayed in
the Name Display mode.

Delete: Deletes the selected RX history.

Delete All: Deletes all RX history.

RX HISTORY screen (RX01):

D-PRS TX

Displayed when format icon*!

a Gateway call is
received.

Called station
(“CQCQCQ"is

RA{ HISTOWY Y 12:00) 5% <
History ———» R¥01: GEWIGFE Isplayed It you
number IM1ZLK received a CQ call.)
—IAZYI A |

HELLO COQ D-3TAR
RPT: JPEYHH A
(2023/04/11  13:21)

<+—RX message

Received date
and time

Caller station*?
® A note may be
displayed after “/.”

*1 The displayed icon differs, depending on the D-PRS
TX format.
GPS: Position OBJ: Object
ITEM: ltem WX: Weather

*2\When a name is entered in the MEMORY, the name
is also displayed.
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3. Push [ENT].

« Displays the RX history detail screen.
® Push D-pad({t) to view the content.

<lst page>
e CALLER:

* CALLED:

<2nd page>
* RXRPT1:

* RXRPT2:

Displays the caller station’s call

sign*? and any note entered after

the call sign.

Displays the called station’s call

sign*2,

® “CQCQCQ" is displayed when receiving
a Local Area call or Gateway call.

RH HISTORY 01
CALLER:
IM1ZLK

12:00

CALLED:
LAZY LA

Displays the repeater’s call sign*?
that was accessed by the caller
station.

If the received call was a Gateway
call, this item displays the gateway
call sign of the repeater you
received the call from.

Displays the repeater’s call sign*?
you received the call from.

® The operating frequency is displayed instead of the
above items when the call was not through a repeater
(Simplex call).

RX HISTORY 01
RMRPT1:
JPEYHH G

12:00

CALLED:
JP3YHH A




5 D-STAR OPERATION (ADVANCED)

Viewing the received call signs

< View the call sighs on the RX History screen TIP: To delete RX HISTORY data
<3rd page> . On the RX HISTORY or the detail screen, push
* RXMESSAGE: Displays any message [QUICK)], then select “Delete” or “Delete All.”
included in the received call if —
entered. TR=cs »
* RX TIME: Displays the date and time ddTD Tour Mem -
:
the call was received.
RH HISTORY 01 12:00
MESSAGE:
HELLC CQ D-5TaA
]
R¥ TIME: a ” : - :
5023 /06,/05 (Mon] TIP: “RX RPT1” setting may differ, depending on the
120911 way the call was made.
<4 ~ 6th page> Example 1: When a Local area call is received.

Displays position data of the caller station. If a
received signal has no data, then no position data ”
is displayed. \”"”mfifql

X
R¥ HISTORY 01 1Z:00
[oCh 1 i = | €
U.I“"E - I
Sgnd  GLIPM74SP

ALT:Z6Ft
&% DETH107mi

IMTZLE=4

Example 2: When a Gateway call is received.

R HISTORY 01 12200 JM1ZLK calling from
o u JP1YIU portA...
COURSE : 205 i, _
SPEED: 1. Tmph 149 o b
. ’ b AN
(13:51) "0 o IN’%II?%ET
A4

RH HISTORY 01 12:00

GPS MESSAGE:
HELLO CQ D-3TA
R

@ To exit the MENU screen, push [MENU].
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5 D-STAR OPERATION (ADVANCED)

BK mode communication

The Break-in (BK) function enables you to break into a 4. Select “BK.”
conversation, where the 2 stations are communicating OV SET 272
with Digital Call Sign squelch (DSQL) enabled. OV Auto Detect  »
® The BK function is automatically turned OFF when you R¥ Record (RFT) »
turn OFF the transceiver. }CS] Key d
1 H
[MENU] > SET > DV Set > BK EMPR .
. . D EMP AF Level
1. While 2 stations are communicating in the DV i '
mode, hold down [RX—CS] for 1 second. “ "
« After releasing [RX—CS], the calling station’s 5. Select "ON.
call sign or the repeater’s call sign is set to “TO” BK 141
(Destination). OFF
» Beeps sound, and the calling station’s call sign is
announced.
® When a call sign is not received correctly, error beeps
sound, and no call sign is set.
2. Push [MENU].
3. Select “DV Set” in the SET menu. 6. Push [MENU].
SET 13 [ 1n_|:|
S DURSTOME . v oV o- K
& Scan r b R?Ck
M Scope ’ Hirano
o Coll Sign Ml icse0_sron »
& My Stati v )
ser W 440.000 ...

» Returns to the Standby screen and “BK” is displayed.
7. When both stations are in standby, push [PTT] to
transmit.
® “BK” blinks when receiving a Break-in call.
® To cancel the BK mode, select “OFF” in step 5, or
turn OFF the transceiver.

How to use Break-in?

While using the Digital Call Sign squelch (DSQL), the squelch never opens (no audio is heard) even if a call is
received, unless the call is addressed to your call sign.

However, when a call including the “BK ON” signal (break-in call) is received, the squelch opens, and audio is
heard even if the call is addressed to another station.

Station C calling to Station A with “BK OFF” Station C calling to Station A with “BK ON”
Station A and B are communicating using the Digital Station A and B are communicating using the Digital
Call Sign squelch. Call Sign squelch.

ﬁ ;

Station A / Station B Station A \ / Station B
Station C Station C
Station B does not hear that Station B also hears that
Station C is calling Station A. Station C is calling Station A.
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EMR communication

The Enhanced Monitor Request (EMR) communication
function can be used in only the DV mode. Using the
EMR function, no call sign setting is necessary.

® Information

« All transceivers that can receive an EMR signal
automatically receive the signal. DO NOT use this function
except in the case of an emergency.

* When an EMR signal is received, the audio (voice) is
heard at the set level, even if the volume setting level is
set to the minimum level.

« The EMR communication function is automatically turned
OFF when you turn OFF the transceiver.

[MENU] > SET > DV Set > EMR

Example: Transmitting from the “Hirano” repeater
using the EMR function.

1. Push [MENUL.

2. Select “DV Set” in the “SET” menu.

SET 1/3

Ty DUPSTOME. . 4
& Scan r
M Scope r
L3
»
*

s Call Sign
& My Station

3. Select “EMR.”

O SET 22
DY Auto Detect 4
R¥ Record (RPT) »
[R¥=C5] Kew ’
=18 4

L

*

EMIF.
EMPA AF Level

4. Select “ON.”

EMP: 1/1
OFF

5. Push [MENU].

4 B 1700
O o-—

Sl Fic:

&l 1M1 2LK
rroM Hirano
ZLo

440.000 ...

» Returns to the Standby screen and “EMR” is displayed.
Push [PTT].

* The TX/RX indicator lights red while transmitting.

® “EMR” blinks on a station that receives the EMR
signal. The audio (voice) is heard at the set level, or
the [VOL] level, whichever is higher.

® To cancel the EMR mode, select “OFF” in step 4, or
turn OFF the transceiver.
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< Adjusting the EMR AF level

The audio output level when an EMR signal is
received is adjustable between 0 and 39.

When an EMR signal is received, the audio is heard at
the preset level, or the [VOL] control level, whichever
is higher.

To turn OFF the setting, set to “0.”

[MENU] > SET > DV Set > EMR AF Level

1. Push [MENU].
2. Select “DV Set” in the “SET” menu.

SET 143

Ny DUP/TOME. .
M Scan

M Scope

Be: Call Sign

& My Station

Select “EMR AF Level.”

O SET 2/2
D Auto Detect *
R¥ Record (RPTY
[RE=C5] Kew *
Bk *

*

L]

EM R

EMP AF Level

Rotate [DIAL] to adjust the EMR audio output level
between 0 (OFF) and 39 (maximum). (Default: 19)

EMR AF Level

® To exit the MENU screen, push [MENU].
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Automatic DV detection

If you receive an FM signal while in the DV mode, the

“DV” and “FM” icons alternately blink to indicate the

received signal is FM.

When the DV Auto Detect function is ON, the

transceiver automatically selects the FM mode to

monitor it temporarily. (Default: OFF)

® Regardless of this setting, the “DV” and “FM” icons
alternately blink if you receive an FM signal while in the
DV mode.

NOTE: When Digital Call Sign squelch (DSQL),

or Digital Code squelch (CSQL) is selected, the
transceiver does not receive FM signals, even if this
function is ON. You can silently wait for calls from
others.

When an FM signal is received while in the DV mode

[MENU] > SET > DV Set > DV Auto Detect

1. Push [MENU].
2. Select “DV Set” in the “SET” menu.

SET 1/3

Ty DUPSTONE...
& Scan

M Scope

Bles Call Sign

& My Station

R Record [ 1
[R¥=CS] Key

BK

EME

EMPE AF Level

4. Select “ON.”

DY Auto Detect 141
OFF

® To exit the MENU screen, push [MENU].

® When an FM signal is received while in the DV mode,
the “DV” and “FM” icons sequentially blink, and the
transceiver receives the signal in the FM mode.

DV Auto Detect function: OFF
The “DV” and “FM” icons alternately blink, but the
audio cannot be heard.

) m D-:- B 1200
O -
e (ST ] S
Kirkland
443575 WIIH B .
e [A
SLO = | /
440.000 .... e
Thei ——
eicons e ?
alternately blink.

4+ 8 12:00 You can_not hear
mggg COTWCO the audio.

e Kirkland

Bl 143575 MTIH B
SO e

440.000 ...
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DV Auto Detect function: ON
The “DV” and “FM” icons alternately blink, and the
audio can be heard.

mms] - B 1200
E =

a% CaLacn

Kirkland
43575 NTIH B| —

R | =) Thanks for
440.000 FRIF the nice QSO!
The icons ?\

. AV
alternately blink.

w1200 You_can hear the
TO

ar COTTICA audio!

- Kirkland

Bl 143575 MTIH B
SO

440.000 ...
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Automatic Reply function

When a call addressed to your call sign is received,
the Automatic Reply function sounds beeps and
automatically replies with your call sign.

(Default: OFF)

Depending on the setting, a recorded message may
be transmitted with the call sign.

NOTE: The Automatic Reply function temporarily
sets the received call sign to “TO” (destination).

TIP: To record the Auto Reply message

You can record the Auto Reply message. See page
5-25 for details.

(IMENU] > RECORD > DV Auto Replay)

[MENU] > SET > DV Set > Auto Reply

1. Push [MENU].
2. Select “DV Set” in the “SET” menu.

SET 1/3
By DUP/TOME. ..
& Scan

M Scope

s Call Sign

& My Station

3
L3
3
L3
L3
3

3. Select “Auto Reply.

DY SET 1/2
Tone Contral *

Auto Reply ’
OV Data TH 4
L% Fast Data ¢
Digital Monitor *
Digital Repeater Se v

4. Select an option.

Auto Reply 141

O

Yoice

Paozition

* ON: Automatically replies with your own

call sign. (No audio reply is sent)

* Voice: Automatically replies with your own
call sign and an Auto Reply message
recorded on the microSD card (up to
10 seconds).

® If no SD card is inserted, or no message

is recorded, replies with only your own
call sign (No audio reply is sent).

« Position: Automatically replies with your call
sign and your position data using the
internal GPS receiver.
® When “GPS Select” is set to “OFF” or

“Manual,” the internal GPS receiver is
temporarily turned ON.

Push [MENU].

* Returns to the Standby screen, and displays “n.42.”

® When “ON” or “Voice” is selected, the Automatic
Reply function is automatically turned OFF when you
push [PTT].
When “Position” is selected, the Automatic Reply
function remains ON, when you push [PTT].

Example: After receiving a call from “JM1ZLK,” beeps

sound, and the transceiver automatically
sends a reply call.

o] + B n_
o HAA

aas COCOCT

0 4441 m@

UR:JM17LK

440.000 ...

The “TO” setting does not change, but “UR:
JM1ZLK (Caller’s call sign)” is displayed.
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Automatic Reply function

¢ Recording an Auto Reply message The DV AUTO REPLY screen

You can record the Auto Reply message that is saved
on a microSD card to reply to the call with your voice.

Dw AUTO REPLY

&
NOTE: Confirm a microSD card is in the card slot. 0:05/ 0:10

REC Lewel:
mm

@Efrec A
Audio level is Adju'st the Mic gain so that the REC

[MENU] > RECORD > DV Auto Reply
1. Push [MENU].

2. Select “DV Auto Reply” in the RECORD menu. displayed Level does not reach to this range
VOICEMEMO 171 (IMENU] > SET > Function > MIC Gain
050 Recarder \ (Internal), MIC Gain (External))
Yoice Fecarder ¥

DY Auto Reply

TIP: To delete the recorded message, push [QUICK]
on the DV AUTO REPLY screen, then select “Clear.”

M A LI e n s

3. Hold down [PTT] to start a recording, release it to
stop recording.

D AUTO REPLY

————

REC Lewel:

[P TT [zl [ENT[SIENY

® Information

¢ The maximum recording time is 10 seconds.

« Hold the microphone 5 ~ 10 cm (2 ~ 4 inches) from your
mouth, then speak at your normal voice level.

* Only 1 message can be recorded. The current contents are
overwritten if you record again.

4. To exit the MENU screen, push [MENU] twice.
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Automatic Reply function

< Auto Position Reply function

When you receive a call addressed to your call sign,
but are in a situation that makes it difficult to operate
the transceiver, this function sounds beeps and
automatically replies with your call signh and transmits
your position data.

After receiving the Auto Position Reply call, the
caller’s position data is displayed in a window.
® Icom transceivers* display the position after receiving a
call.
® You can turn OFF the caller’s position display. (p. 12-26)
(IMENU] > SET > Display > Reply Position Display)
* Except for the ID-31A/E, 1C-9100, ID-880H/E880,
IC-80AD/E8OD, IC-92AD/E92D, I1C-2820H/E2820, ID-
800H, IC-91AD/E91, IC-V82, IC-U82

When no valid position data is received

1. Acall addressed to your
call sign.

- /@
Destination
2. Your position data  (ID-50A/E)

is automatically |

Your station transmitted.

3. After receiving, the position data

is displayed on the

destination’s transceiver. I o TASYUA
i \_E 35°00,00° N
| et 135700, 00 E
| s DST:41.6mi f
. "
RE 1 JAZYUA

f

Scrolls your call sign or the TX message.
® Your status message may be displayed.

4 B 1700

After receiving a call addressed to your call sign,

the internal GPS receiver is temporarily turned ON

for approximately 5 minutes to receive your position

data, even if “GPS Select” is set to “OFF” or “Manual.”

Then, the transceiver automatically replies with a

message, as described below.

(IMENU] > GPS > GPS Set > GPS Select)

® When the internal GPS receiver is temporarily ON, and
valid position data is received, the transceiver transmits
your position data if a call addressed to your call sign is
received again.

Reply message list when no valid position data is
received

{am] = “ B 1200
146.010_
MSG:No Posi & G

440.000 ...

TIP:

» The position data is transmitted according to the
“GPS TX Mode.” (p. 6-12)

* When the “GPS TX Mode” settings are incorrect
for the Automatic Reply function, the transceiver
automatically corrects them to reply to a call.

* When “GPS TX Mode” is set to “OFF,” “D-PRS” is
automatically selected.

Message Status
No Position Whe_n no position data is
received.
0Old Position 2 minutes or more has passed

since receiving position data.

The internal GPS receiver is
temporarily turned ON but has
not received your position data
yet.

No Posi & GPS Start

The internal GPS receiver is

temporarily turned ON, and 2
minutes or more have passed
since receiving position data.

Old Posi & GPS Start
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Data communication

In addition to digital voice communication, you can < Data communication application
send and receive data. Also, you can use the DV Fast

Data function for data communication (p. 5-28) setting
To send and receive data, a USB cable (user Set the communication software, as shown below.
supplied) and a data communication software (user
supplied) are required. * Port: The COM port number that is used by the
® Confirm your USB cable is usable for data transfer and transceiver *

not for Charging 0n|y_ * Baud rate: Your desired Speed
® Confirm that the USB cable’s driver is installed on your * Data: 8 bit

PC. * Parity: none

. « Stop: 1 bit

NOTE: “DV Data TX” is set to “Auto” as the * Flow control: Xon/Xoff
default setting. When you enter text data into your * Depending on the PC environment, the COM port number
communication software, the transceiver may used by the transceiver may be higher than 5. In that case,
automatically transmit it, depending on the software use an application that can set it to higher than 5.

and the software settings.

< Sending data

1. Set your call sign, the destination call sign, and

¢ Connection the repeater call sign.
Connect the transceiver to your PC using a USB 2. Follow the instructions of your data communication
cable, as shown below. application software.

3. When you enter text data into your communication
software, the transceiver may automatically
transmit it, depending on the software and its
settings.
® When “DV Data TX” is set to “PTT,” pushing [PTT]

transmits the text data and a voice signal. (p. 12-10)

USB cable (IMENU] > SET > DV Set > DV Data TX)
(User supplied) ® Before transmitting the data, the transceiver sends a
carrier sense signal approximately 500 milliseconds.
[ — ]3]
NOTE:
To the To the » Only ASCII code can be used for data
[USB] port USB port communication.
_ _ _ * The transceiver also has the Message
@ Confirm your USB cable fits the transceiver’s USB port Transmission function that transmits up to 20

(Type-C) and your PC’s USB port. characters. (p. 5-17)

» Depending on the combination of your PC and

NOTE: Before you start sending data, BE SURE to your communication software, some data may be

set the following items. lost.

* Set “GPS Out (USB Port)” to “OFF " » While receiving voice or data through the Internet,
(IMENU] > GPS > GPS Set > GPS Out (USB Port)) some packets may be lost due to network error

* Set "USB Connect” to “Serialport,” (poor data throughput performance) In such a
(IMENU] > SET > Function > USB Connect) case, an “L” is displayed on the screen to indicate

» Set “USB Serialport Function” to “DV Data.” that packet loss has occurred.

(IMENU] > SET > Function > USB Serialport Function)
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About the display type

<DV Fast Data function You can enlarge the characters, such as the repeater

name displayed by the DR function.

® This setting can be used only when the Single band
display is selected.

1. Display the Main screen that you want to change

To send data using the DV Fast Data function, follow

the instructions below.

® DV Fast Data communication can be made by only the
following lcom transceivers (As of July 2023).

. IC-705 in the Single band display.
¢ |C-905 = 4 B 1z:00
[ o o e——
* |C-9700 T CQCQCo
+ ID-31A/E PLUS £
T Hirano
¢ IDA100AE B o
« ID-51A/E (PLUS, PLUS2, 50th Anniversary model) 2022 /05/12(Fri)
» ID-52A/E
*.UID_EPA/El hen fi ions CPU M 1.10 2. Push [QUICK].
sable only when firmware versions .1V, “Ey; ”
S 1.00, C 1.10, and DSP 1.10 or later are installed. 3. Select "Display Type.
e B 17700
NOTE: If you want to send GPS data to other | GPS Pasition
transceivers that can receive only slow-speed data, il Y 1 S
set “GPS Data Speed” to “Slow.” (p. 12-11) D.50L ;I
(IMENU] > SET > DV Set > DV Fast Data > GPS Data Speed) J=KIF
1Home CH Set 3
T LR U]

[MENU] > SET > DV Set > DV Fast Data > Fast Data

1. Push [MENU]
2. Select "DV Set” in the “SET” menu. iy

.
Mormal

4. Select “Large.”

4 B iz

SET 1/3 |
P DUPR/TOMNE. .. *
M Scan 4
M Scope ’
EcsCaIISign N 1 T T 1]
& My Station ¢
. '
3. Select “DV Fast Data.” w15
D SET 1/2 EE% CQCQCQ
Tane Contral * Hirano
Auto Reply 4 439,390 IP3YHH A
DY Data TH 4 SLO s
DV Fast Data ¥ 2023;«)5;’1 2(Fr|)
Digital Monitor 4
Digital Repeater Se ¢ « The characters, such as the repeater name, are
displayed larger.
4. Select “Fast Data.”
O Fast Data 14
GPS Data Speed 4
T¥ Delay (PTT) »

5. Select “ON.”

Fast Data 141
OFF

 To exit the MENU screen, push [MENU].
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Digital squelch functions

The digital squelch opens only when you receive a ¢ The Digital Code Squelch setting
signal addressed to your own call sign or a signal that 1. Push [QUICK]

includes a matching digital code. « "
. ; 2. I D.SQL.

You can silently wait for calls from others. Select'D.SQ

You can independently set the Digital squelch function

[l e B |’7'F]
GPS Position

in the VFO mode, Memory mode, Call channel mode, [Weather Alert  »
or DR function. ! Display Type 'IL
.. . . 15KIP :
< The Digital Call Sign squelch setting Home CH Set  »
1. Push [QUICK]. —
2. Select “D.SQL.” 3. Select“CSQL.”
[l - B |")'F] -
[GPS Position o 4 B 1700

|Weather Alert 3
! Display Type rIL

1=KIP :
Haome CH Set 3

3. Select “DSQL.” A 4

B 1700

= 4= _1z:00 CSOL” is displaved
B o D-l-CSQL " " is displayed.
ETSD% COCOCT Q pay
Kirkland

443 575 HW7IH B

SLo

440,000 ...

v 4. Push [MENU].
= = 1700 5. Select “DUP/TONE...” in the “SET” menu.
BNy Te pil=e [+———"DSQL” is displayed. 6. Select “Digital Code.”
Kirkland DUP/TOME...  1/1
smﬁmﬂ"‘ B Offset Freg v

Digital Code

440.000 ...

* When the received signal includes a matching call
sign, the squelch opens, and you can hear the audio.

® When the received signal does not include a 7. Rotate [DIAL] to select a digital code.
matching call sign, the digital call sign squelch does _
not open. However, the S/RF meter displays the Digital Code
received signal level.
NOTE: 00]

» DO NOT use the Digital Call Sign Squelch
function when communicating with 2 or more
stations, because it opens only when receiving a

signql addressed to your call sign. Ther?fore _the « When the received signal includes a matching code,

function can be used when communicating with the squelch opens, and you can hear the audio.

only 1 station. ® When the received signal does not include a matching
» Even if the squelch is closed by the Digital Call code, the digital code squelch does not open.

Sign Squelch function, you can receive data in the However, the S/RF meter displays the signal level.

DV mode. @ To exit the MENU screen, push [MENU].

NOTE: Even if the squelch is closed by the Digital
Code Squelch function, you can receive data in the
DV mode.
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Repeater list

You can save repeater information for quick and Example: “Hirano” repeater information

simple communication in up to 2500 repeaters

(repeater list) in up to 50 Groups. f:i_’e‘ET_ER =T 15
Data must be in the repeater list to use the DR DV Repeater
function. MAME: _
You can add and edit repeater content and groups in Hirano
) SUB MAME:
the repeater list. Oisaka
You can enter 4 types of frequencies into the repeater
list, as shown below:
+ DV Repeater L b AR
« DV Simplex JPZYHH A
* FM Repeater GW CALL SIGN:
* FM Simplex JP2YHH G
GROUP:
TIP: 12 lapan
* For easy operation, the repeater list is preloaded
into your transceiver. However, if you do an CEPEATER LIST 5
All Reset, the CPU deletes all setting data, the USE (FROM)-
Memory channels, and the repeater list. We YES
recommend that you back up the memory data to FREQUEng%“’égO 0
a microSD card or save it to a PC using the CS-50 DUP-: Tt
PROGRAMMING SOFTWARE. D p-
» The repeater list can be downloaded from the Icom
website. See “Updating the repeater list” that can
. REFEATER LIST 4/5
be downloaded from the Icom website about how OFFSET FREQ.
to update the repeater list using a microSD card. £.000.00
https://www.icomjapan.com/support/ POSITION:
Approximate
LATITUDE:
. 34741 .40'M
< Repeater list contents
The following contents are ipcIL_Jded in the repeater list: CEPEATER LIoT 5/5
* TYPE: Communication type (p. 5-32) LONGITUDE.
* NAME: Repeater name (p. 5-32) 136°20 60'E
« SUB NAME: Repeater sub name (p. 5-32) UTC OFFSET:
» CALL SIGN: Repeater call sign and port letter + 800
(p. 5-32)
* GW CALL SIGN: Gateway repeater’s call sign and port “G”
(p. 5-32)
* GROUP: Repeater group (p. 5-33)

* USE (FROM): access repeater use (p. 5-33)
« FREQUENCY: access repeater’s frequency (p. 5-33)

* DUP: Duplex direction (p. 5-33)
* OFFSET FREQ: Frequency offset (p. 5-33)
* MODE: Operating mode (p. 5-34)
* TONE: Tone setting (p. 5-34)

» REPEATER TONE: Repeater tone (p. 5-34)

« POSITION: Position data accuracy level (p. 5-34)
« LATITUDE: Latitude of the repeater (p. 5-34)

* LONGITUDE: Longitude of the repeater (p. 5-35)

e UTC OFFSET: UTC Offset (p. 5-35)
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5 D-STAR OPERATION (ADVANCED)

Entering new information into the repeater list

This section describes how to manually enter new
repeater information into the repeater list.

The required setting items differ, depending on your
communication usage. Confirm the required items, as
shown below.

NOTE: To enter repeater information into the
repeater list, the repeater’s call sign must be entered
first.

¢ Required items for the communication cases

Repeater list Used as an access _Usgd asa Used as an FM Simplex (FROM)
contents repeater destination repeater repeater

TYPE DV Repeater DV Repeater FM Repeater DV Simplex FM Simplex
NAME (@) (@) (@) (@) @)
SUB NAME @) @) ©) (©) ©)
CALL SIGN [ ] (] (@) N/A N/A
GW CALL SIGN (Fora Ga:eway call [ ] N/A N/A N/A
GROUP (@) (@) (@)
USE(FROM) [ ] (@) [ ]
FREQUENCY ([ ] (@) ()
DUP ® (@) [ N/A N/A
OFFSET FREQ ® (@) ([ ] N/A N/A
MODE N/A N/A @) N/A ©)
TONE N/A N/A (@) N/A @)
$§EEATER N/A N/A @) N/A ©)
POSITION (@) (@) (@) (@) (@)
LATITUDE @) @) (@) ©) ©)
LONGITUDE (@) (@) (@) (@) (@)
UTC OFFSET ©) @) ©) (©) (©)

o Must be entered
O: Possible to enter
N/A: Not Applicable
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Entering new information into the repeater list

¢ Entering new information into the repeater list

Step 1. Selecting the repeater group

Step 4. Entering the repeater sub name

[MENU] > MEMORY > Repeater List

1. Push [MENU].

2. Select “MEMORY” on the second page of the
MENU screen.

3. Select “Repeater List.”

MEMORY 141

remory CH

Call CH
Your Call Sign

Fepeater List

4. Select a repeater group to add a repeater to.

REPEATER GROUP 2/9
07: Europe - Southerr
08: Europe - Western»
09: Germany 4
10: Islands 4
115 Italy v

¥

12: lapan

« Displays the repeater list of the selected repeater group.

RPT LIST GRF 12 1/16

Chika

Fukuoka Fukuoka-
Gifu Gifu-city
Gifu Kamo-gun
lapan IMWESG C

¥
3
¥
3
3

5. Push [QUICK].

6. Select “Add.”
LOT 1 TeT Amn A 4 44
iSKIF’
Edit
SKIP All ON
SKIP All OFF
I Move
Tapan TH7ES &

* The REPEATER LIST EDIT screen is displayed.

Step 2. Selecting the communication type

1.
2.

3.

Select “SUB NAME.”

Enter a sub name of up to 8 characters.
® See page iii on how to enter characters.
After entering, push [ENT].

Step 5. Entering the repeater call sign

® When Step 2. Selecting the communication type

1.
2.

3.

is set to “DV Simplex” or “FM Simplex,” go to Step
7. Changing the repeater group.
Select “CALL SIGN.”
Enter the repeater call sign of up to 8 characters,
including spaces and the node letter.

CALL SIGM
TP A

NOTE: BE SURE to add the repeater node letter
in the 8th digit of the call sign, according to the
frequency band shown below. Note that there
are almost always different node letters between
Japanese D-STAR repeaters and repeaters in
other countries.

Cross band operation between different nodes at
the same repeater site can be made.

* 1200 MHz: A (B in Japan)

* 430 MHz: B (Ain Japan)

* 144 MHz: C (no repeaters in Japan)

After entering, push [ENT].

Step 6. Entering the gateway repeater call sign

1. Select“TYPE.”
2. Select the communication type.

« DV Repeater: Repeater operation in the DV mode.

» DV Simplex: Simplex operation in the DV mode.

* FM Repeater: Repeater operation in the FM mode.

* FM Simplex: Simplex operation in the FM mode.

Step 3. Entering the repeater name

1. Select “NAME.”

2. Enter a name of up to 16 characters.
® See page iii on how to enter characters.

3. After entering, push [ENT].

® This item is displayed when Step 2. Selecting the

communication type is set to “DV Repeater.”

® The 8th digit in the call sign entered in Step 5.

=

3.

Entering the repeater call sign is automatically
set to “G” as the gateway port, so you can skip this
setting and go to the next item.

Select “GW CALL SIGN.”

Enter a gateway repeater call sign of up to 8

characters, including spaces.
® Only a space or “G” can be entered in the 8th digit.

GW CALL 5IGHN
IP1YYY 3

After entering, push [ENT].
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Entering new information into the repeater list

< Entering new information into the repeater list

Step 7. Changing the repeater group

Step 10. Selecting the Duplex direction

® The repeater group that is selected in Step 1.
Selecting the repeater group is displayed. You can
skip this setting and go to the next item. To change
the group, follow the steps described below.

1. Select “"GROUP.”
2. Select the repeater group. (01 ~ 50)

REFEATEFR GROUP 2)’9
: Europe - Southerr
: Europe - Western»
» Germany v
lslands *
:ltaly 4

*

2: lapan

Step 8. Setting “USE(FROM)” to be used as an
access repeater

® You can use the entered repeater as an access
repeater when using the DR function. When not
using as an access repeater, select “NO,” and go
to Step 15. Selecting the position data accuracy
level. In that case, the entered repeater is not
displayed in “FROM” on the DR screen.

1. Select “USE(FROM).”
2. Select "“YES” to use the repeater as an access
repeater.

USE (FROM)
NO
VES

141

Step 9. Entering the access repeater frequency

1. Select “FREQUENCY.”
2. Rotate [DIAL] to enter the repeater frequency.

FREQUEMCY

439.240.00

® Push D-pad($5) to move the cursor.
3. After entering, push [ENT].
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® When Step 2. Selecting the communication type
is set to “DV Simplex” or “FM Simplex,” this item is
not displayed.

® “DUP-"is automatically set when the access
repeater frequency is entered in Step 9. Entering
the access repeater frequency. If necessary, you
can change the Duplex direction.

1. Select “DUP.”
2. Select a Duplex direction.

DUF 111

OFF

DUP+

e OFF: Turn the duplex function OFF.

* DUP-: The transmit frequency shifts down from the
receive frequency by the offset amount.

* DUP+: The transmit frequency shifts up from the

receive frequency by the offset amount.

Step 11. Entering the frequency offset

® When Step 2. Selecting the communication type
is set to “DV Simplex” or “FM Simplex,” this item is
not displayed.

® The offset value* is automatically set when the
access repeater frequency is entered in Step
9. Entering the access repeater frequency. If
necessary, you can change the frequency offset.
* The default value differs, depending on the transceiver

version.

Select “OFFSET FREQ.”
2. Rotate [DIAL] to enter the frequency offset
(0.000.00 ~ 59.995.00 MHz).

OFFSET FREQ

=

5.000.00

@® Push D-pad(5) to move the cursor.
3. After entering, push [ENT].
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Entering new information into the repeater list

< Entering new information into the repeater list

Step 12. Setting the FM mode

Step 15. Selecting the position data accuracy level

® When Step 2. Selecting the communication type
is set to “DV Repeater” or “DV Simplex,” this item is
not displayed.

1. Select “MODE.”
2. Select “FM” or “FM-N.”

MODE 11

FM-M

Step 13. Setting the tone

® When Step 2. Selecting the communication type
is set to “DV Repeater” or “DV Simplex,” this item is
not displayed.

1. Select “TONE.”

2. Select an option.

TOME 141

oFF |

TOMNE

TsaL

e OFF: Turn OFF the Tone function.

« TONE: Select when the repeater requires an access
tone

e TSQL: Select when you want to use the tone

squelch in simplex operation.

Step 14. Selecting the repeater tone frequency

® When Step 2. Selecting the communication type
is set to “DV Repeater” or “DV Simplex,” this item is
not displayed.

® This setting is required when Step 13. Setting the
tone is set to “TONE” or “TSQL.”

1. Select “REPEATER TONE.”
2. Rotate [DIAL] to select the repeater tone
frequency, and then push [ENT].

REPEATER TOME
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® When the Near Repeater Search function is not
used, or the distance between your location and
a repeater is not needed, select “OFF,” and go to
Step 18. Setting the UTC offset.

1. Select “POSITION.”
2. Select the position data accuracy level.

POSITION 11

Mone

Approximate

Exact

* None: Select when the repeater has no

position data.
* Approximate: Select when the entered position data
is approximate.
Select when the entered position data
is exactly correct.

Step 16. Entering the latitude

e Exact:

® This item is displayed only when Step 15.
Selecting the position data accuracy level is set
to “Approximate” or “Exact.”

1. Select “LATITUDE.”
2. Rotate [DIAL] to enter the latitude.

LATITUDE

Eoooon

® Push D-pad($5) to move the cursor.
® To enter a north latitude, select “N,” and to enter a
south latitude, select “S.”
3. After entering, push [ENT].
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Entering new information into the repeater list

< Entering new information into the repeater list

Step 17. Entering the longitude

Step 19. Saving the repeater list

® This item is displayed only when Step 15.
Selecting the position data accuracy level is set
to “Approximate” or “Exact.”

1. Select “LONGITUDE.”
2. Rotate [DIAL] to enter the longitude.

LOMNGITUDE

W 00 00w

® Push D-pad($5) to move the cursor.
® To enter an east longitude, select “E,” and to enter a
west longitude, select “W.”
3. After entering, push [ENT].

Step 18. Setting the UTC offset

® Universal Time Coordinated (UTC) offset is the time
difference between UTC and repeater local time.
This is a useful function to know the repeater’s local
time before you make a call. (p. 5-13)

1. Select “UTC OFFSET.”
2. Rotate [DIAL] to set the time difference between
UTC and the local time, then push [ENT].

UTC OFFSET
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1. Select “<<Add Write>>."
« The confirmation dialog is displayed.
2. Select“YES.”

REPEATER LIST ECIT 5/5

LRI T,

Add write?

<< Overwrites>

« The entered contents are saved to the repeater list,
and the display returns to the selected repeater group
screen.

TIP: To cancel the entered data
1. Push [CLR] to display the “Cancel edit?” window.
2. Select “YES.”

REPEATER LIST EDIT 5/5

(el Ahad s ol ]

| Cancel edit?

VES
[ MO |

<= (Jwerwritess

« Cancels the entry and returns to the selected

repeater group screen.
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D-STAR OPERATION (ADVANCED)

Repeater list operation

O Editing repeater data

You can edit repeater data. This is useful when
already-entered data is incorrect, has changed, or

< Deleting repeater data

[MENU] > MEMORY > Repeater List

some data needs to be added to the list. 1. Push [MENU].
. 2. Select “MEMORY” on the second page of the
[MENU] > MEMORY > Repeater List MENU screen.
1. Push [MENU]. 3. Select “Repeater List.”
2. Select “MEMORY” on the second page of the MEMORY T
MENU screen. Memary CH v
3. Select “Repeater List.” Call CH g
Your Call Sign 4
MEMORY 141 \
Memory CH *
CallCH ' 4. Select a repeater group where the repeater you
ATl IREI T want to delete is listed.
REFEATER GROUF 274
4. Select a repeater group where the repeater you 07: Eurape - Sautherr
want to edit is listed. 08: Europe - Western»
09: Germany *
REPEATER GROUP  2/4 102 Islands "
07: Europe - Southerr 13 ltaly s
08: Europe - Western 12: Japan H
09: Germany 4
10: Islands *
1 ltaly . 5. Select the repeater to be deleted, and then push
12: Japan * [QUICK].

6. Select “Delete.”
5. Select a repeater you want to edit, and then push

oT L TET S 4 A4
[QUICK]. Delete |
6. Select “Edit.” |

LOT L TET Sl 4 44

1skIP

| Add

:

SKIP Al ON

SKIP All OFF o -
{Mave  The confirmation dialog is displayed.

vy 7. Select“YES.”

7. Select an item, and then edit it.
® See pages 5-32 ~ 5-35 for details.
8. After editing, select “<<Overwrite>>."

RPT LIST GRF12 1,16
N,

I Delete?

REPEATER LIST EDIT 55

<<bdd Write== T T
Py A

cDiyepw Fitess

» The selected repeater contents are deleted from the
repeater list and return to the selected repeater group
screen.

® To exit the MENU screen, push [MENU].

« The confirmation dialog is displayed.
9. Select “YES.”

REPEATER LIST EDIT 5/5

N T ]

NOTE: The currently selected repeater on the DR
screen cannot be edited or deleted. To edit or delete
the repeater, select another repeater on the DR screen.

I Civerwrite?

» The edited contents are saved to the repeater list and
return to the selected repeater group screen.
@ To exit the MENU screen, push [MENU].
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Repeater list operation

¢ Rearranging the display order of the repeaters

You can move the entered repeaters to rearrange their

display order in the selected repeater group.
[MENU] > MEMORY > Repeater List

1. Push [MENUL.
2. Select “MEMORY” on the second page of the

MENU screen.
3. Select “Repeater List.”

MEMORY 141
Mermory CH *
Call CH r
Your Call Sign 4
Fepeater List ¥

4. Select a repeater group where the repeater you
want to move is listed.

REFEATER GRCUF 4,“1
19: USA Southeast »

200 US4 West

21: Simplex 4

Select the repeater to be moved.

RPT LIST GRE 20 32,24

Morth Bend
San luan lsland

L3
»
San Juan Island r
Seattle 4

L

Snohomish
Wazhingt KGTOFUE

® DO NOT push [ENT].
Push [QUICK].
7. Select “Move.”

o

[OT L TeT e e ataWia]

SKIP Al ON
SKIP Al OFF

8.
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Select the position to insert the repeater you want
to move the repeater above.

DESTINATION 32/34
Morth Bend

San Jluan lsland
San Juan Island
Seattle
Snohomish

Washingt w7

® While moving, “DESTINATION?" blinks at the top of

the screen.

v

FFT LIST GRF 20 32,/34
Maorth Bend

*
Snohamish H
San Juan lsland *
San Juan Island *
Seattle *
Washingt KG7aPUE

» The selected repeater is inserted above the
destination repeater name.

@ If “<<Move End>>" is selected, the repeater is moved
to the bottom of the group.

@ To exit the MENU screen, push [MENU].
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Repeater list operation

<& Adding new repeater information from RX History

1. Hold down [CD] for 1 second. 8. Select “YES.”
* The RX HISTORY screen is displayed.

2. Push D-pad(!1) to display the repeater you want to
add to the repeater list, then push [ENT]. Add write?

REPEATER LIST ECIT 5/5

R¥ HISTORY  12:00

REOT:
IM1ZLEK
—JAZYLLA,

HELLO CQ D-5TAR _
RPT: IPZYHH A » The repeater contents are added to the repeater list,

(2023/04/11  14:21) and the display returns to the RX HISTORY screen.
® To exit the RX HISTORY screen, push [MENU].

« Displays the RX history detail screen.
3. Push D-pad(i1) to display “RXRPT1"” and “RXRPT2.”

R¥ HISTCRY 01 12:00
RHRPT1:
JPEYHH G

CALLED:
JP3YHH A

4. Push [QUICK].
5. Select “Add To RPT List.”

[T fon X WA Ame A7

i Add Ta RPT List

LRI

6. Select the repeater call sign that you want to add
to the repeater list.

AT A7

HIFaFig

« Displays the REPEATER LIST EDIT screen. The
selected repeater call sign is automatically entered.
@ If the selected repeater is already in the repeater list,
“Duplicate Call Sign” is displayed.
® See pages 5-32 ~ 5-35 to edit the contents.
7. Select “<<Add Write>>."

REPEATER LIST EDIT 5/F

=<Add Write==

 The confirmation dialog is displayed.
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Repeater list operation

< Skip setting for the DR scan

You can set repeaters as scan skip repeaters. The

selected repeaters are skipped for faster scanning.

You can set the skip setting to all repeaters in the

selected repeater group or individual repeaters.

® When a repeater is set as a skip repeater, its “USE
(FROM)” setting is automatically set to “NO.” In that
case, the repeater cannot be selected in “FROM” (access
repeater) on the DR screen.

<Individual skip setting>
[MENU] > MEMORY > Repeater List

1. Push [MENU].

2. Select “MEMORY” on the second page of the
MENU screen.

3. Select “Repeater List.”

MEMORY 141

Mermory CH
Call CH
Your Call Sign

L3
L3
L3
H

Repeater List

4. Select a repeater group where the repeater you
set the skip setting is listed.

REFEATER GROLUF 244

07: Europe - Souther
08: Europe - Western»

09: Germany 4
10: Izlands ¢
110 Italy ¥
12: lapan ¥

5. Select the repeater to be skipped, and then push
[QUICK].
6. Select “SKIP.”

SKIP All OM
SKIP All OFF
IMove

Eamagawa JF1wJR &

@ Displays “SKIP” by the selected repeater.

RPT LIST GRF 12 3716
Takamatsu ¥
Ebina EE,
Kohoku-ku *
Shonan-IT 4
Yokoharma 4
Kanagawa JP1wIH &

@ Select “SKIP” again to cancel the skip setting.
@ Select “SKIP All ON” to set the skip setting to all
repeaters in the group.
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<Group skip setting>
1. Onthe REPEATER GROUP screen, select a
repeater group, as described to the left.
2. Push [QUICK], then select “SKIP All ON” to skip
the group’s repeaters during the DR scan.
@ To cancel the skip settings in the group, select “SKIP
All OFF.”

TIP:

« When you select “Repeater List” on the FROM SELECT
screen, you can set the skip setting as described to the
left.

* When “FROM” is selected on the DR screen, push
[QUICK] to set the skip setting, as shown below.

]
I5PS Position
Weather Alert +
I Display Type v
1D.50L

‘(EHIE
Home CH Set 3

v

| -+ & 12100
O+

D
T
a8 cacgcao
Kirkland
443 575 MWTIH —=
ZEIF

s

440.000 ...

® Displays “SKIP” in the “FROM” field.
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Repeater list operation

<O Entering or editing a repeater group name
[MENU] > MEMORY > Repeater List
1. Push [MENU]. 8. After entering [ENT].

2. Select “MEMORY” on the second page of the
MENU screen.

REFEATER GROUP 4/9
19: USA Southeast »

3. Select “Repeater List.” 20z US4 West .
21: Simplex 4
MEMORY 141 22: My Hometown ¥
Mermory CH 3 73- '
Call CH 4 4 "
Your Call Sign 4
Fepeater List H
¢ Sets the entered name.
@ To exit the MENU screen, push [MENU].

4. Select a Repeater group that you edit the name.

REFEATER GROUP 449
19; USA Southeast »

200 USA West r
2 Simplex 4
23: r
4 4

® DO NOT push [ENT].
@ If you select an already named group, the name is
overwritten.

5. Push [QUICK].
6. Select “Edit Name.”

Il ol e f o Wt m P W Y LI

Q| Edlit Name

7. Enter a group name of up to 16 characters.

GROUP NAME
My Hometown_

abc

Selectable characters and symbols

AtoZ,atoz,0t09,!"#$% & ()*+,-./:;<=>7?
@[\]1"_"{I}" (space)

® See page iii on how to enter characters.
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Your Call Sign

< Entering Your Call Sign 9. Select “CALL SIGN.”
You can manually enter a Your (destination) Call Sign. vouR call s1on 01T 171
When a Your Call Sign is entered into “TO,” you can MNAME: ,
make a call to the station, even if you do not know Rick
where the station is currently located. CALL SIGN:
Up to 300 “Your Call Signs” can be entered. ey T —
[MENU] > MEMORY > Your Call Sign 10. Enter a call sign of up to 8 characters, including
Example: Entering “Rick/IM1ZLK” to the Your Call spaces.
Sign memory. CALL SIGN
JIMAZLE,
1. Push [MENUL.
2. Select “MEMORY” on the second page of the
MENU screen.
3. Select “Your Call Sign.”
MEM O RY 141 11. After entering, push [ENT].
Memory CH ' 12. Select “<<Add Write>>.”
Call CH '
Your Call Sign ¥ WOUR CALL SIGH ECIT 1,41
Repeater List 4 I AME:
Rick’
CALL SIGN: A
IMAZLK
4. Push [QUICK] on the YOUR CALL SIGN screen. il Writers
5. Select “Add.”

 The confirmation dialog is displayed.
im 13. Select “YES.”

WOUR CALL SIGM ECIT 1‘-"1
RlARAC,

| Add write?

6. Select "NAME.”

WOUR CaLL SIGHN ECIT 1,"1

Call SIGN: WOUR Call SIGH 1.1

<<Add Writex>

7. Enter a station name of up to 16 characters.

1 ELEK
MAME
Rick_ » “Rick JM1ZLK" is entered into the Your Call Sign
memory.

® To exit the MENU screen, push [MENU].

abc

® See page iii on how to enter characters.
8. After entering, push [ENT].
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Your Call Sign

< Entering Your Call Sign

TIP:
To cancel the entered call sign

2. Select “YES” to cancel the entry and return to
the YOUR CALL SIGN screen.

CALL SIGM

| Cancel edit?

To edit the entered call sign

To edit the entered call sign, select “Edit” in step 5.
This is useful when already-entered data is incorrect,
has changed, or some data needs to be added to the
list.

L N W A N B 2 A S

| Add
|
Move
Dielete

Ik

1. Push [CLR] to display the “Cancel edit?” window.
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< Deleting Your Call Sign

[MENU] > MEMORY > Your Call Sign

1. Push [MENUL.
2. Select “MEMORY” on the second page of the

MENU screen.

3. Select “Your Call Sign.”

MEMORY 141
Mermory CH
Call CH

Your Call Sign

Fepeater List

3
L3
¥
3

4. Select a call sign you want to delete.

WOUR Call SIGN 1/1

Kate 4
Ecdy ¢

I ZLE

® DO NOT push [ENT].

5. Push [QUICK].
6. Select “Delete.”

R R R N B ol Pt Y | 4 04
i;‘-\dd

Edit
Mlawve

Tl 2L

A confirmation dialog is displayed.

7. Select “YES.”

WOUR CALL SIGH 111

Delete?

VES
ND

I ZLE

v

IL2%RP

» The selected call sign is deleted from the Your Call Sign
list and the returns to the YOUR CALL SIGN screen.
® To exit the MENU screen, push [MENU]I.

NOTE: The currently selected Your Call Sign on the
DR screen cannot be edited or deleted. To edit or
delete the Your Call Sign, select another Your Call
Sign on the DR screen
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Your Call Sign

¢ Rearranging the display order of
Your Call Signs

You can move Your Call Signs to rearrange their
display order.

If the stations you often communicate with are moved
to the top of the list, it is easy to find them.

[MENU] > MEMORY > Your Call Sign

Example: Moving “Rick” above “Eddy.”
1. Push [MENU]I. 7. Select the position to insert the Your Call Sign you
2. Select “MEMORY” on the second page of the want to move the call sign above.

MENU screen.
3. Select “Your Call Sign.”

DESTINATION 111

Rick
MEMORY 1/1 Eddy
Memory CH
Call CH <<Mlove End==

Your Call Sign

Fepeater List

L3
3
M
L3

IL3YRP

® While moving, “DESTINATION” blinks at the top left
of the screen.

v

WOUR CaLL SIGH 171
Ecidy ’ Edldy ’
Kate * Rick

4. Select a Your Call Sign to be moved.

WOUR CaLL SIGH 1.1

Kate *

WA ZLE

I ZLE

® DO NOT push [ENT].
5. Push [QUICK]. » The selected call sign is inserted above the

6. Select “Move.” destination call sign.
’ ’ @ If “<<Move End>>" is selected, the Your Call Sign is

[T moved to the bottom of the group.
| 'E\c?ift’ ® To exit the MENU screen, push [MENU].
Delete
IWlTELE
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Are your settings correct?

If you make a Local Area call with a gateway repeater
still selected in “TO,” the destination repeater will be
busy while you transmit.

The stations that want to use the repeater as their
access repeater cannot access it, as shown below.

BE SURE to set CQCQCQ in “TO” on the DR screen
when you intend to make a Local Area call or finish a
Gateway call.

Example: JA3YUA wants to make a Local Area call.

through JP3YHH port A for a local call...

CQ D-STAR Hirano, this is JA3YUA
His setting is wrong!

X | can’t access the repeater!
e
Caller INTERNET,
(JA3YUA)
Hirano area Chuou-ku area
JA3YUA's setting NOTE: With this setting, you can make a Local Area
For + B _1z00 call, but the destination Repeater, selected in “TO,”
Chusu-ku is also busy while you transmit.
JPIVIL A The stations that want to use the repeater as their

ream Hirano
SLO

Access Repeater cannot access it.
FH
440.000 ...

The destination (“TQO") setting is incorrect.

Correct setting

o] -+ B 12:00

ream Hirano
SLO

440,000 ...

To make a Local Area call, set the destination (“TO")
to “CQCQCQ.” See page 5-9 for details.
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6  GPS OPERATION (ADVANCED)

GPS operation features

D-PRS Extension function (p. 6-4)

The D-PRS Extension function enables you to transmit or receive Object, Item, and Weather information in addition
to Position data. With this extension, you can simultaneously transmit or receive earthquake information, traffic
accident information, emergency information, or weather information, and so on, along with voice audio in the DV
mode.

GPS Memory (p. 6-22)

You can enter up to 300 GPS Memories in the transceiver. By adding destination position information in a GPS
Memory, you can effectively use the GPS Alarm function. The position information that you acquired can also be
entered in a GPS Memory.

Editing GPS Memories using
a PC is easier than using
the transceiver!

o O [ | can enter the location information
° of the mountain I'm going to hike!

o

GPS Alarm function (p. 6-27)

When a target station comes into the set alarm area, or when you approach an entered GPS Memory position, the
function can sound an alarm. With this function, you can know that you are approaching the destination.

GOAL! i \

” S I'm almost there!

GPS Logger function

The GPS Logger function enables you to save the position data from a GPS receiver into a microSD card as a log.
If you use this GPS Logger while driving, you can check your driving history on a mapping software program.

| can track my GPS log in a
mapping software program.
This is how | traveled...interesting!

See “Using the GPS Logger function” that can be downloaded from the Icom website about using the function.
https://'www.icomjapan.com/support/

6-2



6 GPS OPERATION (ADVANCED)

Before starting GPS operation

NOTE: Before using the GPS function, read “IMPORTANT NOTES” about the GPS receiver in the Basic manual.

The transceiver has a built-in internal GPS receiver.
The GPS receiver’s position data can be received in
any mode.

NOTE: Transmit or receive position data that can be
transmitted in only the DV mode.

< Confirming the GPS signal receiving

Confirm the GPS receiver is receiving satellite signals.

The GPS icon blinks when searching for satellites.
- — 4 — & — (Noicon)

The GPS icon stops blinking when the minimum
number of satellites needed is found.

&=

® Information
« It may take only a few seconds to receive, or it may take

a few minutes, depending on your operating environment.

If you have difficulties receiving, we recommend that you
try a different position.

* When “GPS Select” is set to “Manual,” the icon is not
displayed.
(IMENU] > GPS > GPS Set > GPS Select)

6-3

NOTE: Continuously using the Internal GPS mode
causes the transceiver’s battery to be exhausted
quickly. Turn ON the Power Save mode if needed.
See page 6-30 for details.

(IMENU] > GPS > GPS Set > GPS Option

> Power Save)

TIP: To prolong the battery life in the GPS mode
Manually update your location with the received GPS
data.

1. Set“GPS Select” to “ON,” and receive your
position from the internal GPS receiver.
(IMENU] > GPS > GPS Set > GPS Select)

2. Open the MANUAL POSITION screen, and then
push [QUICK].

(IMENU] > GPS > GPS Set> Manual Position)

3. Select “Capture From GPS.”

PRI s o o it 8 B P,

Pk
| Edit

Capture From GP3

Set From GPS Mem
Default

« Your current position is now memorized and
displayed on the MANUAL POSITION screen.
4. Set“GPS Select” to “Manual.”
(IMENU] > GPS > GPS Set > GPS Select)
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GPS TX mode and TX format types

GPS position data has 2 TX modes, D-PRS, and Example: When the caller’s TX format is D-PRS
NMEA. Moreover, with the D-PRS mode data, 5 Position (Mobile)
position formats, Position (Mobile station/Base (IMENU] > GPS > GPS Position)
station), Object, Item, and Weather, are selectable.
GPS POSITION  2/5 GPS POSITION  3/5
2 34737 34" N COURSE : 907
i geet 135734 40°F SPEED:E. Onph
Yool GLIPMPASP £12:00)
ALT: 33t
& DSTH107ni
R IM1ZLK-4 R

D-PRS is a function that simultaneously sends position data received from the
internal GPS receiver, using the slow speed data packet space, along with voice.

A station operating from a vehicle, or other position, away from its normal base

D-PRS

Position (Mobile)

position.
Position (Base) A station operating at home or in a building.

Transmitting Object data such as earthquake information, satellite tracking
Object information, and so on.

An Object contains a time stamp.

Transmitting Item data such as a traffic accident, lighthouse, antenna, or DV
ltem access point position, and so on.
An Item does not contain a time stamp.

Weather A station transmitting weather information received from a weather device.
NMEA A station transmitting position data (NMEAO0183) received from the internal GPS
receiver.

Difference between older models

(As of July 2023)
* The GPS TX mode, “GPS (DV-G)” and “GPS-A (DV-A),” are now called as “NMEA (DV-G)” and “D-PRS (DVA).”
GPS (DV-G) — NMEA (DV-G)
GPS-A (DV-A) — D-PRS (DV-A)
For users who have one of the following models:
ID-800H, IC-91AD/E91, IC-U82, IC-V82, IC-7100, ID-51A/E, ID-31A/E, IC-9100, IC-80AD/ESOD, ID-880H/E880,
IC-92AD/E92D, IC-2820H/E2820
When you receive a D-PRS position (Base), Object, Item, or Weather information, their data is not displayed.
Only the ID-51A/E PLUS, ID-51A/E PLUS2, ID-31A/E PLUS, ID-52A/E, ID-5100A/E, ID-4100A/E, IC-R30, IC-
9700, IC-705, IC-905, and ID-50A/E can receive Power, Height, Gain, and Directivity data.
For users who have one of the following models:
IC-9100, IC-80AD/E8OD, ID-880H/E880, IC-92AD/E92D, IC-U82, IC-V82
If you transmit with the Altitude setting ON, the character string is included in a comment on the products that
cannot display the altitude.
Set the GSV sentence to OFF when sending the GPS message to conventional digital transceivers (IC-2820H/
E2820, ID-800H, IC-91AD/E91, IC-V82, IC-U82, IC-2200H). The GSV sentence is incompatible with them.
They will not display GPS messages properly if sent as a GSV sentence from the ID-50A/E.
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6  GPS OPERATION (ADVANCED)

When a received signal

contains position data

When a received signal contains position data, the
caller’s position data is displayed on the RX position
screen.

Example: When the signal from JM1ZLK contains
position data.

s B

1700

W E 34°00,00°N
* ~4 135700, 00" B
ﬂ AM1ZLK

GPE  DET:87mi

R D IM1ZLK(Rick)

When you receive the signal, the RX
position data is displayed in the RX position
window.

v

After a few seconds, the window
disappears.

12:00

435 350

S0

MSG: CQ D-ST l
440.000

[¥] <+—RX position icon

FEEIF

When the received signal contains position
data, the RX position icon is displayed, as
shown above.

@ You can turn OFF the caller’s position data display.
(IMENU] > SET > Display > RX Position Display)

® You can turn OFF the RX position icon indication.
(IMENU] > SET > Display > RX Position Indicator)
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Checking your location

You can check your current location.
This section is described using received position data.
® The screens are just examples.

< Displaying Position Data
1. Push [QUICK].
2. Select “GPS Position.”
« Opens the GPS POSITION screen.
3. Rotate [DIAL].
» Changes between the MY (My position), RX
(Received position), MEM (GPS Memory position), or
ALM (GPS Alarm position) screen.

GP5 POSITION  1/5
337 ATN
‘ 135734, 27
x\“ GL : PH7ASP
0" ALT:7Ft
SPEED: 2. 3uph
TIME: 7:33:27

?

The displayed icon depends on the type of
screen (MY, RX, MEM, or ALM).

4. To close the GPS POSITION screen, push
[MENUL.

NOTE: Latitude, longitude, and altitude data may
differ, depending on your received GPS signal.

TIP:

« If you transmit with the GPS POSITION screen open,
the screen closes. To check the location, push [QUICK],
and then select “GPS Position” while transmitting.

* On the MY screen or RX screen, you can enter the
displayed position information in a GPS Memory by
pushing [QUICK] and select “GPS Memory.”

« See page 6-22 about the GPS Memory function and
see page 6-27 about the GPS Alarm function.
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Checking your location

O GPS POSITION screens and their meanings

® Information

» Pushing to [QUICK], change the compass direction.
(p. 6-10)

« About the Course (p. 6-8)

« About the Grid Locator (p. 6-9)

MY screen (Your position information)

:

+ R

Your station

Speed: 2.3 mp

107 mi

-

Course: 0 degrees

h

GPS Memory:
Tokyo Skytree

248 mi
®

Call station
(D-PRS: mobile)

Example for the GPS POSITION screens:

|

YY

GPS Alarm:
Tokyo Big Sight

Course: 90 degrees

Speed: 5.0 mph

When “GPS Select” is set to “Manual,” the compass
heading and course direction are not displayed.
(p. 6-30) ((MENU] > GPS > GPS Set > GPS Select)

GPS POSITION  1/5
N 34737, 47 N —Latitude
Your course Uf [‘g 13534, 27'F l—Longitude
heading || ./ GL:PH7ASP < Grid Locator
Course direction—» 0 ALT:7ft - Altitude
SPEED: 2. 3mph < Speed
M TIME: 7:38:27 Received
time

RX screen (Caller’s position information)

Depending on the caller's GPS TX Mode and TX

format, the displayed item’s meanings may differ, and

some data may not be displayed. (p. 6-7)

Example: The caller station’s GPS TX Mode is “D-PRS,”
and its TX format is “Position (Mobile).”

GPS POSITION _ 2/5
o Moy 3TN |
e e
y ot GLIPM7ASP
ALT:33ft Distance from
D-PRS symbol —> @&  LsT:107mi< your location
R JMIZLE-A |

Caller’s call sign with SSID

GPS POSITION
Caller's Course — . r[lJR=E - 90"
direction SPEED: 5. Onph <
Time the caller ——{12:00} |
acquired the

position data

3/5

Caller’s speed

R¥

MEM screen (GPS Memory’s information)

location

Direction from your{

GPS POSITION

4/5

" 342507 H ]

139748, 65" E
GL 2 PHISYR
DT 251 mi

=
i

MEM Tokyo Skytree <

ALM screen (GPS Alarm’s information)

Distance from your
position

1

GPS POSITION

5/5

M 353N |

139747, 667 E
GL - PHISYP
DET=248mi

=
i

&L Tokyo Bigzite <

A
] x

* When a name is not entered in the GPS Memory

channel, date and time are displayed instead of the
name. You can change the GPS Memory or GPS
Alarm in the GPS POSITION screen in the Quick
Menu window. (p. 6-9)
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Checking your location

¢ About the RX screen

TX format:
D-PRS

Position (Mobile)

Position (Base)

GPS POSITION 275 GPS POSITION 345 GPS POSITION 275 GPS POSITION  3/%5
r 34737, 34N COURSE s 90” N 34737, 407N POWER: 4W
.;ff N,‘E 13534, 407 E SPEED: 5. Omph Jf:-;i‘; 135747, A0° E HEIGHT: 12 t
Ysd GLIPH7ASP {12:00) Sgod GLIPH7ASD G4IN:BdB
ALT:33f ¢ ALT:47F 1 DIRECT 2 Cnni
& DET07mi A  DST:37mi [12:00)
R}{* JHTZLE-A R R}{+ JMTZLE-4 R¥ T

Moving symbol

For a mobile station, Base station symbol

Course and Speed
are displayed.

For a base station, Output
power, Antenna height,
Antenna gain, and Antenna
direction are displayed.

Object Iltem
GPS POSITION 245 GPS POSITION 35 GPS POSITION  2/5 GPS POSITION 345
" 34737.38' N IW1ZLE-4 M 34 ATN JW1ZLE=-A
l{:.;‘\E 135°34. 31°F POWER: G0W U{‘% 139°47. 30°F POWER: BOW
bond BLIPHPASO HEIGHT:B3f t Yond  GLIPMIBSO HEIGHT=83F t
ALT: 23f1 GAIN:BdB ALT:Oft G4 Nz BdB
ﬁ DST:27mi DIRECT : Omni [‘ﬁ’] DST: 742mi DIRECT = Cwnii
R HiM FESTA R (12:DD)<—| R Repeater R
[
Time that the caller . . . .
sent the Object's data ® For an Item station, Time is not displayed.
Weather

GFS POSITION /6| |GFS FOSITION 375
v 3L IPN 77°F 0%
uf:b:l 135" 34, 37 RAIN: 0. 03 in/h
L GL:PH74SO WINDDIR : 230°
WINDSPD: 2. Znph
BARD: 20, ZinHg
{12:03

f

Time that the caller
acquired the weather data.

@ DET223mi
R JWTZLE R

@ Call sign is displayed with an SSID.
® When the Object or Item is disabled, “KILLED” is displayed.

TX format:
NMEA

GPS POSITION  2/5
N 30737, 40N
Uf:‘:l 136°47. 40°E
Sond GLIPM74SD
ALT:27F
DST: 240mi

R IMTZLEK R

GPS POSITION 3/
COURSE: 275°
SPEED: 22. Onph
{12:00:00)

® A symbol or SSID is not displayed when the TX format is NMEA.
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Checking your location
<O Setting the display type (MAIN/SUB)
You can select the display type of the RX screen.

1. Push [QUICK] when the RX screen is displayed.
2. Select “Display Select (MAIN/SUB).”

GPS Memory
Compass Direction v

3. Select the item you want to switch.

Latest (MAIN/SUB): Displays the target station’s
latest location information
regardless of the MAIN band or
the SUB band.

* MAIN: Displays only the latest location
information of the target station
received in the MAIN band.

* SUB: Displays only the latest location

information of the target station
received in the SUB band.

6-8

¢ About the Course

The course displayed on the GPS POSITION screens
is indicated in degrees.

00
|
315° N 45°
270° —W E—90°
225° S 135°
|
180°
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Checking your location

< About the Grid Locator ¢ Changing the GPS Memory or Alarm
Grid Locator (GL) is a position compressed into a 6 You can change the GPS Memory or GPS Alarm in
character code, calculated by the longitude and the the GPS POSITION screen.
latitude.
The locator is simply calculated by dividing the earth’s 1. While selecting the MEM screen or ALM screen,
surface into squares. push [QUICK].
It is used to find the location of a transceiver station. 2. Select “GPS Memory Select,” or select “Alarm
Select.”
GPS POSITION _1/5
o 4737, 42N Field
l{)\k‘j 135734, 27 C [_% MEM screen
GL:PHP4SP
o ALTiFft PM74SP GPS POSITION 45
SPEED: 2. 3mph o s P 2542, 50'N
mv  TIME: 7:38:27 g & 130748, 55" E
Square Subsquare Rt
DST: 25Tmi
The grid locator map of Japan MEM Tokyo Skytree
ALM screen
GPS POSITION  5/5
N 2537 78N
m@ { :} 120°47. 66"
08 | 18 |28 i 6L : PHOGYP
47157 671771 o 17 |27 DST: 248mi
E{g’la 9606 |16 | 26
% gi ]] alm Tokyo Bigsite
09 03 [13 |3
(42758 i
mE'l cefoe e e 3. Select the GPS Memory or GPS Alarm to display

on the GPS POSITION screen.
® Adding or editing a GPS Memory: p. 6-22
® Setting the GPS Alarm: p. 6-27
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6 GPS OPERATION (ADVANCED)

Checking your location

¢ Changing the Compass Direction < Saving your own or a received

You can set the compass direction to Heading station’s position

Up. North Up, or South Up. You can save the position of your station or the

position of the caller station.

The transceiver has 300 GPS memories, and the
memories can be assigned to one of 27 banks, A~ Z,
and (No Group).

1. While displaying the GPS POSITION screen, push
[QUICK].
2. Select “Compass Direction.”

O DTS I T TR (=2
1&larm Select
Compass Direction v 1. Select the screen that you want to save.

® To save your own position: MY screen
® To save a received position: RX screen
2. Push [QUICK].
3. Select “Add To GPS Memory.”

. . Pl Ul sl Bl a0 A8
3. Select the compass direction. i odd To GPS Memo
falul=Mnltalwli el i) (= GPS Memory
THeading Up | Compazs Direction »
Morth Up

® See pages 6-22 ~ 6-24 for entering details.
4. Select “<<Add Write>>."

GPS MEMORY EDIT  3/3

Heading Up North Up South Up GROUP:

(Mo Grou p]r

A—E M = <<fdd Writex>
Wb T T
WA 2 i i
w—" ]5\,5,/*)[ \’\-\H#’J
The top is always The top is The top is ® To select the destination group to be saved, select
your course direction.  always north. always south. “GROUP.”

5. Select “YES.”

GPS MEMORY EDIT  3/3
-

alatailinl

Add write?

» Saves the data in the GPS Memory, then returns to
the GPS POSITION screen.
6. To close the GPS POSITION screen, push
[MENUL.

TIP: The position is saved in the selected group in
the GPS MEMORY EDIT screen. (Step 4)
(IMENU] > GPS > GPS Memory)
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Checking GPS information (Sky view screen)

This screen is used to view GPS satellite information
when the GPS icon does not stop blinking for a long
time.

The GPS Information displays the quantity, signal
power, and position of the satellites.

The sky view screen displays the position of the
satellites. The screen also displays each satellite’s
direction, elevation angle, satellite numbers, and their
receiving signal strength status.

1. Push [QUICK].
2. Select “GPS Information.”

i B

1200

. GPS INFO
SAT @ 4

o
fvoice T
GPS Information

GPS Position
Weather Alert 3

1Home CH Set 8 29f 1
Yaoltage 34737, AN
135°34. 40°E

About the display:

e O Untracking satellite.

«11: Tracking satellite with a weak signal, shown
by the satellite number.

- M3 Tracking satellite with a strong signal, shown
by the satellite number.

e SAT: The quantity of tracking satellites.

« Altitude: The altitude of your station. The altitude is

only displayed when 4 or more satellites
are tracked. When 3 or less satellites are
tracked, “------ ft” is displayed.

» Longitude/Latitude:
Longitude and Latitude of your station.

TIP: The following satellite number is assigned to
the each satellite system.

* GPS: 01~32
* SBAS: 33~71
* GLONASS: 65 ~ 96
* QZSS: 193 ~ 202

3. To close the GPS INFORMATION screen, push
[MENUL.
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M GPS IMFO Tracking
SAT @ 4 «+—satellite
quantity

Sky view screen

0 29f <+ Altitude
437N ‘<—Latitude
135°34. 40" E <—Longitude

Satellite /l 0 <«s—Untracking satellite
number 11's ——>"’Tr-$.-.9
[ 0

signal is weak.

®&——Elevation angle
0 degree line

Satellite number
06's signal is
strong.

Elevation angle
30 degree line

Elevation angle
60 degree line

Elevation angle
90 degree line
(Zenith)

The image of satellite number 06:

Elevation angle
90 degree line (Zenith) Elevation angle

60 degree line
Elevation angle
30 degree line

Elevation angle
0 degree line
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Transmitting D-PRS data

When D-PRS is selected as the GPS TX mode, you

can transmit D-PRS data.

When operating in the D-PRS mode, the following

codes are transmitted to the PC.
D-PRS code is based on APRS® code.

NOTE:

« If “GPS select” is set to “Manual,” the manually entered
position data in “Manual Position” is changed to the
D-PRS data format to transmit.

(IMENU] > GPS > GPS Set > GPS Select)

« Note that if “GPS Auto TX" is set to any other setting than
“OFF,” it is transmitted according to the set time.
(IMENU] > GPS > GPS Auto TX)

(APRS®: Automatic Packet Reporting System)

¢D-PRS

D-STAR Packet Reporting System (D-PRS) is a mode
that simultaneously sends position data received from
the internal GPS receiver, using the slow speed data
packet space, along with voice audio in the DV mode.
In the Analog mode, you can transmit or receive only
voice audio or data at one time. However, a D-PRS
capable radio can transmit or receive message data
or GPS position data simultaneously when voice is
being transmitted or received. An I-GATE is required
to send position data to the APRS server.

The image of D-PRS

<Using a Repeater>

Voice, Messages, and
D-PRS positions/

Voice, Messages, and
D-PRS positions

D-STAR Repeater

D-PRS positions é

APRS server

Information from
an APRS network

D-PRS
positions

<Simplex>
—INTERNET-

==
)

You can check the
position on a map site!

Voice, Messages, and
D-PRS positions

T~~~

Voice, Messages, and

D-PRS positions

/

< Operating in the D-PRS mode

To transmit D-PRS data, follow the steps below.
For more details, see the pages listed along with the

steps.
1. Enter “MY” (Your own call sign).
(Basic manual D-STAR GUIDE)

2. Confirm the GPS signal is receiving.
3. Set GPS TX mode to “D-PRS.” (p. 6-14)
4. Set TX information.

® You must set “SSID” and “Symbol.”

(IMENU] > GPS > GPS TX Mode > D-PRS)

l

b D-PRS positions é
]

I-GATE

TIP: In the D-PRS mode, you can transmit
earthquake or weather information, in addition to
position data.

(IMENU] > GPS > GPS TX Mode > D-PRS > TX Format)

TX format of D-PRS
» Position (Mobile/Base):
Used to transmit position data.

« Object: Used to transmit specific position data.
(Contains a time stamp.)

e |tem: Used to transmit specific position data.
(Does not contain a time stamp.)

* Weather: Used to transmit weather information.

Complete! You can transmit in the D-PRS mode.
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Transmitting D-PRS data

¢ Displayed items

Depending on the TX format, the setting items and displayed order of the items differ.

D-PRS
Position Object ltem
= =
= =
© o
2 g
a a
I= I=
3 8
2| 2 ? | B
() [=)) [} [=))
Q_ - — Q_ - —
- 0T
| o B
L 3| 3| x| 3|3
@] (@) o (@) (@) o
i) i) i) i) i) i)
0 0 (2] ()] [0} (%]
= = (= (= c c
2 2 g g D D .
x x x x x x (O]
fo) () () () () (3) (@) <
9 ) iz = e e i = ©
=) o] © © © © ] ] Q
S| m | o| o | aoa|lao ool =2
Unproto Address v v v v v v v v 4
Comment v v v v v v v v v
Altitude v v
Object Name/
v
Iltem Name
Data Type v v v v
Position information
(Latitude/Longitude/ v v v v v v
Altitude)
Data Extension v v v v v v v v
Course v v
Speed v v
Power v v v
Height v v v
Gain v v v
Directivity v v v
Symbol v v v v v v v v v
SSID v v v v v v v v v
Time stamp v v v v v v
v: Displayed

6-13



6 GPS OPERATION (ADVANCED)

Transmitting D-PRS data

¢ Setting D-PRS Position (Mobile/Base)

Set to transmit as a D-PRS Position (Mobile/Base).
® See page 6-31 for details.

1. Setting the GPS TX Mode to D-PRS

9. Setting the Data Extension

[MENU] > GPS > GPS TX Mode > D-PRS

2. Checking the Unproto Address

You should use the default address, and editing is not
recommended.

3. Setting the TX format to “Position”

Set “TX Format” to “Position.”

4. Selecting the Symbol

Select the Symbol that indicates your operating
situation.
® See page 6-31 to directly enter the Symbol.

5. Selecting the SSID

To help identify your station’s type, select the APRS®
(Automatic Packet Reporting System) based SSID
after the D-PRS data call sign. (p. 6-32)

6. Entering a comment

Enter a comment, and transmit it with the D-PRS
position data.
® The number of characters you can enter differs,
depending on the data extension and altitude settings.
(p. 6-32)

Select “Comment.”

Push [QUICK].

Select “Edit.”

Enter a comment.

After entering, push [ENT].

Push [ENT] again.

ok wbdpE

7. Setting the Time Stamp

Set the Time Stamp function to transmit the received
time data in UTC (Universal Time Coordinated) time.
(p. 6-32)

8. Setting the Altitude

Set whether or not to transmit the altitude data
acquired from the GPS receiver. (p. 6-33)

NOTE: If you transmit with the altitude setting ON,
the character string is included in a comment on the
products that cannot display the altitude. (p. 6-4)
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Set the data extension of your station’s information.

® Set “Data Extension” to “Course/Speed” to transmit as a
mobile station.

® Set “Data Extension” to “Power/Height/Gain/Directivity” to
transmit as a base station.

When you set “Data Extension” to
“Power/Height/Gain/Directivity”:
9-1. Setting the TX power

Select the TX power level of the base station to
transmit along with the position data.

9-2. Setting the antenna height

Select the height of the base station’s antenna to
transmit along with the position data.

9-3. Setting the antenna gain

Select the gain of the base station’s antenna to
transmit along with the position data.

9-4. Setting the antenna directivity

Select the direction the base station’s antenna was
pointing to transmit along with the position data.

10. Exiting the POSITION screen

To close the POSITION screen, push [MENU].
» Returns to the standby screen, and then “D'w'4” is
displayed.




6 GPS OPERATION (ADVANCED)

Transmitting D-PRS data

¢ Setting D-PRS Object/Item

Set to transmit as a D-PRS Object or Item.
® See page 6-31 for details.

1. Setting the GPS TX Mode to D-PRS

9. Setting the Data Extension

[MENU] > GPS > GPS TX Mode > D-PRS

2. Checking the Unproto Address

You should use the default address, and editing is not
recommended.

3. Setting the TX format to “Object” or “Iltem”

Set “TX Format” to “Object” or “Item.”

4. Entering Object name or Item name

Enter an Object or Iltem name, such as event information or
location.

5. Selecting Data type

Set the Object or Iltem’s status.

® For example, if you want to transmit finished event
information as an Object, set the Date type to “Killed
Object.”

6. Setting the Symbol

Select the Symbol that indicates an Object or Item.
® See page 6-31 to directly enter the Symbol.

7. Entering a comment

Enter a comment to transmit as an Object or Item.
® The number of characters you can enter differs,
depending on the data extension and altitude settings.
(pp. 6-34, 6-36)

Select “Comment.”

Push [QUICK].

Select “Edit.”

Enter a comment.

After entering, push [ENT].

Push [ENT] again.

oukrwnE

8. Entering the Position data

Enter the position data of an Object or Item.

® For example, if you want to transmit traffic accident
information as an Item, enter the position data where the
accident happened.
If the position data is in the GPS memory, you can easily
set the position data from the memory.
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Set the data extension of an Object or Iltem’s

information.

® Set “Data Extension” to “Course/Speed” to transmit as a
mobile station.

® Set “Data Extension” to “Power/Height/Gain/Directivity” to
transmit as a base station.

When you set “Data Extension” to
“Course/Speed”:

9-1. Entering the Course

Enter the Object or Item’s course when the station
moves.

9-2. Entering the Speed

Enter the Object or ltem’s speed.

When you set “Data Extension” to
“Power/Height/Gain/Directivity”:

9-3. Setting the TX power

Select the Object or Item’s TX power level if the
station is a repeater, node, access point, and so on,
and an antenna is installed.

9-4. Setting the antenna height

Select the height of the Object or Item’s antenna.

9-5. Setting the antenna gain

Select the gain of the Object or Item antenna.

9-6. Setting the antenna directivity

Select the direction the base Object or Item’s
antenna is pointing.

10. Selecting the SSID

To help identify your station’s type, select the APRS®
(Automatic Packet Reporting System) based SSID
after the D-PRS data call sign. (p. 6-32)

11. Setting the Time Stamp

® This item is displayed when the TX format is
“Object.”

Set the Time Stamp function to transmit the received

time data in UTC (Universal Time Coordinated) time.

(p. 6-35)

12. Exiting the OBJECT or ITEM screen

To close the OBJECT or ITEM screen, push [MENU].
» Returns to the standby screen, and then “D'w'4” is
displayed.



6  GPS OPERATION (ADVANCED)

Transmitting D-PRS data

¢ Setting D-PRS Weather

Set to transmit as a D-PRS Weather station.
® See page 6-31 for details.

1. Setting the GPS TX Mode to D-PRS
[MENU] > GPS > GPS TX Mode > D-PRS

2. Checking the Unproto Address

You should use the default address, and editing is not
recommended.

3. Setting the TX format to “Weather”

Set “TX Format” to “Weather.”

4. Selecting the Symbol

Select the Symbol that indicates the weather station.
® See page 6-31 to directly enter the Symbol.

5. Selecting the SSID

To help identify your station’s type, select the APRS®
(Automatic Packet Reporting System) based SSID
after the D-PRS data call sign. (p. 6-32)

6. Entering a comment

Enter a comment to transmit as a D-PRS Weather
station.

Select “Comment.”

Push [QUICK].

Select “Edit.”

Enter a comment.

After entering, push [ENT].

Push [ENT] again.

ok wnE

7. Setting the Time Stamp

Set the Time Stamp function to transmit the received
time data in UTC (Universal Time Coordinated) time.
(p. 6-38)

8. Exiting the WEATHER screen

To close the WEATHER screen, push [MENU].
» Returns to the standby screen, and then “D'wW'4” is
displayed.
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6 GPS OPERATION (ADVANCED)

Transmitting D-PRS data

O Weather station transmission

When you transmit as a weather station, you should
set the weather station’s settings and input the
weather data into the [USB] port.

You can input the weather data from a third party’s
weather device by converting it to the APRS weather
format in your PC or microcomputer.

After completing the weather station’s settings and
inputting the weather data, you can transmit as a
weather station.

NOTE: To input the Weather data into the [USB]
port, set “USB Connect” to “Serialport,” and set “USB
Serialport function” to “DV Data.”

(IMENU] > SET > Function > USB Connect)

(IMENU] > SET > Function > USB Serialport function)

If the weather data is not input into the [USB] port,
you cannot transmit as a weather station.

e
< i
o
e
T II"II
Tl

Microcomputer

Weather
device

< Application setting
Configure the communication software as follows.

* Port: The COM port number that is used by the
transceiver.*

e Baud rate:  Your desired speed

« Data: 8 bit

* Parity: none

* Start: 1 bit

« Stop: 1 bit

 Flow control: none

* Depending on the PC environment, the COM port number
used by the transceiver may be higher than 5.
In that case, use an application that can set it to higher
than 5.
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< Confirming the weather data input

You can confirm whether or not the weather data is

input into the [USB] port.

1. Set“GPS TX Mode” to “D-PRS,” and “TX format”

to “Weather.” (p. 6-16)

2. On the Standby screen, push [QUICK].

3. Select “Weather Information.”

@ Displays the WEATHER INFORMATION screen if the
weather data is entered correctly.

® When the weather information is displayed, you can
transmit as a weather station. If “-” is displayed on the
screen, the weather data is not entered. In that case,
check the entered data settings.

4 B
fi6. 9°F
0.03in/h

1200

f

I TEMP:
Fuah [N

WINDDIR: 230°

WINDSPD: 2. Zmph

: 29 YinHg

H1i

<© About the weather data content

The weather data should be input according to the
format (based on the APRS® Weather Data), shown
below.

Example:
220/004 g005 t077 r000 p000 POOO h50 b09900 End code

1 2 3 4 5 6 7 8 9

=

No. Item Value Unit
1 |Wind direction 000 to 360 °
Wind speed 000 to 999 mph
Gust speed g000 to g999 mph
4 Temperature t-99 to t-01, °F
t000 to t999
Rainfall r000 to r999+*! inch
Rainfall (24 Hours) | p000 to p999*! inch
Rainfall (Midnight) P00O0 to P999*! inch
8 Humidity ho0o, h01 to h99 %
(h00 indicates 100%.)
9 Barometric pressure |b00000 to b99999*2 trwnFt’)a,

*1 The last two digits indicate the one decimal place and the
two decimal places.

*2 The last digit indicates the one decimal place.

@ If you have no data, enter a space or “.” (period) instead
of a number.
(Example: “.../...9...t077r000p...P...nh50b.....")

@ Enter <CR>, <LF>, or <CR><LF> for an end code.



6  GPS OPERATION (ADVANCED)

Transmitting D-PRS data

< Displaying your location using mapping software

If you transmit to an I-GATE station, and then enter
the call sign information on the Internet map website,
the selected symbol is displayed.

Example: Check your location on the APRS i site.

1. Display a free APRS® related map site on the
Internet. (Example: http://aprs.fi/ )

2. Enter your call sign in the “Track callsign” field.

3. Click <Search>.

» The icon (D-PRS symbol) is displayed on the map site.

You can check it on the Internet!

PC Smartphone
d

Goigle | SUMINGE WARD o

>
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-1

§ | MisHiInAR
d warof [ &

r

Enter your call sign,
and then click <Search>.

Track callsign: Clear

Search | ?

Track callsign: Clear
Search | ¥

e H% HOMd

MIYAKOJIMA Y|
WARD

L BRE 1 Search| *

5 show last:

| [24hours /| [Shaw a8
= z

=lc Track tai lengeh:

Thour

— X=
Updated: {n
Position: 34440.57' K 136928.91' €

(2015 (2018 (2017 4= =

v @ - P+ By -
rewe - Linking to apre i - AIS
fatus  Databuse statistics «
Tachoical dutady -
98 log + Planeed changes -
thanks - Terms Of Service
a/Bad APRE

WRE

1 Wi

f%— Your symbol and your call sign



6  GPS OPERATION (ADVANCED)

Transmitting D-PRS data

TIP:
D-PRS data content

D-PRS data content are shown below.

<Position (Mobile)
(e.g) JASYUA-A>API50,DSTAR*:/002338h3437.38N/13534.29E>090/002/A=000012|D-50 OP.SATOH
® ® ® @ @ é) é) @ ® [7)

<Position (Base)

(e.g) JA3YUA-A>API50,DSTAR*:/002338h3437.38N/13534.29E-PHGSl320P.SATOH
® @ ® @ é é @

<O Object

(e.g) JASYUA-A>API50,DSTAR*;;HAM FESTA*01234523437.38N\13534.29Eh2023.06.06 am10-pm4
© @ ® @ 6 ® 0 3 $

Oltem

(e.g.) JASYUA-A>API50,DSTAR*))REPEATER!3454.00N/13536.00ErPHG5132439.39MHZ DV RPT JP3YHH A

® @ ® @ 6 © S E @
<OWeather
(e.g.) JABYUA-A>API50,DSTAR*:/01234523454.00N/13536.00E_220/0049005t077r000p000P000h50b09900
® © ©) @ O GTD é) ® ® @ ® @ @ @
®call sign @Data Extension(PHG codes)
@ssID PHG codes definitions
(®Unproto Address 0 1 2 3 4 5 6 7 8 9
@D-PRS Data type First: Power 0 1 4 9 16 25 36 49 64 81 w)
/'Position with time stamp Second: Height| 10 20 40 80 160 | 320 | 640 | 1280 | 2560 | 5120 | (feet)
? g%?g(':‘t’“ without time stamp Third: Gain 0 1 2 3 4 5 6 7 8 9 (dB)
; Iterjn Fourth: Directivity| omni | 45°NE | 90°E | 135°SE | 180°S | 225°sw| 270°w |315°Nw| 360°N | - -
(®O0bject Name/ltem Name
(®Data Type @Altitude (9Rainfall (24 Hours)
* Live Object —99999 ~ 999999 feet 0.00 ~9.99 inch
I Live ltem (@Comment @)Rainfall (Midnight)
_ Killed Object/Killed Item ®Wind direction/Wind speed 0.00 ~9.99 inch
@Time Stamp (UTC) Wind direction:0 ~ 360° @DHumidity
h Hour Minute Second Wind speed: 0 ~ 999 mph 1~ 99%, 00=100%
z Day Hour Minute (®Gust speed @2Barometric pressure
(®Latitude 0~ 999 mph 0.0 ~9999.9 hPa
©®Symbol (@ Temperature
@Longitude -99 ~ 999°F
{Data Extension (Course/Speed)  @@Rainfall
Course:0 ~ 360° 0.00 ~9.99 inch

Speed:0 ~ 999 knots
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6 GPS OPERATION (ADVANCED)

Transmitting NMEA data

Set a GPS sentence to transmit GPS data in the DV
mode.

¢ Setting the GPS data sentence
[MENU] > GPS > GPS TX Mode > NMEA > GPS Sentence

1. Push [MENU]. 6. Repeat step 5 to set the GPS sentence.
2. Select “GPS TX Mode” in the “GPS” menu. ® Up to 4 GPS sentences can be set at a time.
3. Select “NMEA.” 7. To close the “GPS Sentence” screen, push [MENU].
4. Select “GPS Sentence.” * Returns to the standby screen, and then “Dw'#" is
displayed.
MNMEA SET 141
GFS Sentence
GPS Message * NOTE:
« Set “GSV Sentence” to “OFF” when sending the GPS
message to conventional digital transceivers. (p. 6-4)
* If “GPS Select” is set to “Manual,” the transceiver
automatically sets the NMEA sentence and transmits
5. Select the GPS Sentence. it along with the manually entered position data in
“Manual Position.”
GPS Sentence 1/ (IMENU] > GPS > GPS Set > GPS Select)

(IMENU] > GPS > GPS Set > Manual Position)
Note that if “GPS Auto TX" is set to any other option

O GLL . . X .
O wTG than “OFF,” data is automatically transmitted according
O GSa to the set time.

O Gsv (IMENU] > GPS > GPS Auto TX)

@ If “GPS Select” is set to “OFF” or “Manual,” the GPS

- Displays “@" when the sentence is set to ON. Automatic Transmission function is not activated.

® The selectable GPS sentences are RMC, GGA, GLL,
VTG, GSA, and GSV. The GGA sentence is set to
ON as the default GPS sentence.

@ To reset to the default setting, push [QUICK], and
then select “Default.”

Contents of GPS sentence

Lon Date 2D COG SOG
Sentence ILat Alt uTC (UTC) Status /3D (True)  (knot) Others

RMC 4 v v v v 4 Magnetic variation, Mode Indicator
Number of satellites in use, HDOP,

GGA 4 4 4 4 Geoidal separation, Age of Differential
GPS data, Differential reference station ID

GLL v v v Mode Indicator

VTG v v COG (Ma_gnetlc north), SOG (km/h),
Mode Indicator

GSA v v PRN number of satellites used in

solution, PDOP, HDOP, VDOP

Total number of sentences, Sentence
number, Total number of satellites in
view, Satellite information (1D, Elevation,
Azimuth, S/N)

GSV
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6  GPS OPERATION (ADVANCED)

Transmitting NMEA data

¢ Setting a GPS message

Enter a GPS message to be transmitted with the
position data.

Example: Entering “OSAKA Suzuki”

[MENU] > GPS > GPS TX Mode > NMEA >
GPS Message

Push [MENU].

Select “GPS TX Mode” in the “GPS” menu.
Select “NMEA.”

Select “GPS Message.”

PonE

MNMEA SET 11

GPS Sentence ¥

GPS Message

o

Push [QUICK].
6. Select “Edit.”

7. Enter a GPS message of up to 20 characters.

GPS Meszage
Cszaka Suzuki_

abc

® See page iii on how to enter characters.
8. After entering, push [ENT].

GPS Meszage
Ozaka Suzuki

* You can confirm the entered message.
9. To close the “GPS Message” screen, push
[MENUL.

GPS Automatic Transmission

NOTE:

» Use the GPS Automatic Transmission function in only
the Simplex mode.

« Using the function through a Repeater may interfere
with other communications.

You can set the GPS Automatic Transmission function
in the following menu.

[MENU] > GPS > GPS Auto TX

If you set this function, GPS data is automatically

transmitted according to the set time.

@ This function is not activated if your call sign (MY) is not
entered in the transceiver.

@ If “GPS Select” is set to “OFF” or “Manual,” this function is
not activated.
(IMENU] > GPS > GPS Set > GPS Select)



6 GPS OPERATION (ADVANCED)

GPS Memory

You can add GPS data to GPS Memory.

You can add your own position, other station’s
position, or any entered positions manually.
You can save up to 300 GPS memories, and

conveniently saved in up to 27 groups, from A~ Z and

“(No Group).” The Ato Z groups can also be named.

<& Adding a GPS Memory
Example: Add “HOME” into (No Group).

1. Adding a GPS Memory and entering the edit mode

| GPS Memory | S;;);r:)lr;ames are just

—| (No Group) |

— A ICOM |7-| lcom Osaka HC |

—| Ilcom America |

—| B: HAM festa Ii-l Tokyo Big Sight |

—| C: Railroad | -| Dayton Hamventio |

-| Friedrichshafen |

[z |

2. Entering a GPS Memory name

[MENU] > GPS > GPS Memory

1. Push [MENU].

2. Select “GPS Memory” in the “GPS” menu.

GPS

GPS Set

GPS T Mode
GPS Information
GPS Pozition

GPS Memuory

GPS Alarm

1/2
3
3
L3
[
¥
¥

» The previously added GPS Memories are displayed
on the GPS MEMORY screen.
3. Select “(No Group).”

Az 2O

B: HAM FESTA
C: Railroad

D Mt Fuji

E:

GPS MEMORY

1/5

r r v v -

4. Push [QUICK].
5. Select “Add.”

Delete All In Group

* The GPS MEMORY EDIT screen is displayed.

TIP: To edit the previously saved GPS Memory,
select “Edit” in step 5. You can enter the content in
the same way as described above.
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1. Select “NAME.”
2. Enter a GPS Memory name of up to 16
characters. (Example: HOME)

MAME
HOME,

ABC

® See page iii on how to enter characters.
3. After entering, push [ENT].

GPS MEMORY EDIT  1/3
MAME:

HOME
DATE: A
2023/05/29 (Man)
TIME:

13:50:11"




6 GPS OPERATION (ADVANCED)

GPS Memory

< Adding a GPS Memory (Continued)

3. Entering the GPS Memory date 5. Entering the GPS Memory latitude
1. Select “DATE.” 1. Select “LATITUDE.”

2. Push D-pad($) to move the cursor. 2. Push D-pad($) to move the cursor.
3. Rotate [DIAL] to enter the date. 3. Rotate [DIAL] to enter the latitude.

® Set between 2000/01/02 and 2099/12/30.

Inf ti
4. Repeat steps 2 and 3 to enter the date. ® Information

» Set between 0°00.00" and 90°00.00".

DATE * You can change the unit.

(IMENU] > SET > Display > Display Unit >

Latitude/Longitude)

EFEE /05 /29 (Wan) + To enter a north latitude, select “N,” and to enter a
south latitude, select “S.”

4. Repeat steps 2 and 3 to enter the latitude.

LATITUDE

5. After entering, push [ENT].

GPS MEMORY EDIT  1/3
MNAME:

HOME"

1355:10" 5. After entering, push [ENT].

GRS MEMORY EDIT 273
LATITUDE:

. Entering the GPS Memory time 34
LONGITUDE:
Select “TIME.” 0700 00

4
1.
2. Push D-pad($) to move the cursor.
3. Rotate [DIAL] to enter the date.

® Set between 00:00:00 and 23:59:59. 6. Entering the GPS Memory longitude
4. Repeat steps 2 and 3 to enter the time. 1. Select “LONGITUDE.”
TIME 2. Push D-pad($) to move the cursor.

3. Rotate [DIAL] to enter the longitude.

5011 ® Information

» Set between 0°00.00" and 180°00.00".

* You can change the unit.
(IMENU] > SET > Display > Display Unit >
Latitude/Longitude)

5. After entering, push [ENT]. « To enter an east longitude, select “E,” and to enter a
7 west longitude, select “W.”
GPS MEMORY EDIT .
NANIE. 4. Repeat steps 2 and 3 to enter the longitude.
: 3
HOME LOMGITUDE
DATE:

2022/05/29(Man)’

5. After entering, push [ENT].

GPS MEMORY EDIT  2/3

LATITUDE: .
34°37.23'N
LONGITUDE:
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6 GPS OPERATION (ADVANCED)

GPS Memory

< Adding a GPS Memory (Continued)

7. Entering the GPS Memory altitude 9. Writing the GPS Memory
1. Select “ALTITUDE.” 1. Select “<<Add Write>>."
2. Rotate [DIAL] to select plus or minus. P MEMORY EDIT 373
3. Push D-pad($) to move the cursor. GROUP:
4. Rotate [DIAL] to enter the altitude. (No Group)”
® Set between —32808 and +32808 feet. <<Add Write>>
5. Repeat steps 3 and 4 to enter the altitude.
ALTITUDE
« The confirmation dialog is displayed.
t0006ft ® ‘I‘f you edit a prevulously added GPS Memory, select
<<Overwrite>>.
2. Select“YES."
GPS MEMORY EDIT  3/3
et Rz ]
6. After entering, push [ENT]. IAdd write?
GPS MEMORY EDIT  2/3 .
LATITUDE: ,
34°37.23'N
LOMGITUDE: )
135°34.17'E
UDE: l | 4
Mo Group 11

8. Selecting a GPS Memory group
1. Select “GROUP."

GPS MEMORY EDIT 3/3
GROUP:  The data is added to the GPS memory, and then the
selected GPS Memory group screen is displayed.

@ To exit the MENU screen, push [MENU].

TIP:

To view the entered content:

Select the GPS Memory channel. Rotate [DIAL] to
check the whole content.

(Mo Group)

“chdd Writex>

2. Select the group between (No Group) and A ~ Z.

GRS MEMORY__1/S GPS MEMORY 143
Az 1COM » MNAME: HOME
B: HAM FESTA v
C: Railroad ' DATE:

. - 2023/05/23(Mon)
Dz At Fuji 3
£ . TIME:

12:55:10

@ You can save up to 300 Memories in each group. To cancel the entered data:

While entering or editing the GPS Memory, push [CLR]
to display the confirmation dialog, as shown below.
Select “YES” to cancel entering, and the display
returns to the GPS Memory group screen.

GPS MEMORY EDIT  1/3

| Cancel edit?

ND
135510"
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6 GPS OPERATION (ADVANCED)

GPS Memory

< Entering the GPS Memory group name
You can enter a name for each GPS Memory group.
[MENU] > GPS > GPS Memory

1. Push [MENUL.
2. Select “GPS Memory” in the “GPS” menu.

GP3 1/2
GPS Set r
GPS T Mode ¥
GPS Information  »
GPS Pozition +

13

F

GPS Memory

GP3 Alarm

3. Select the group that the name to be entered.

GPS MEMORY
(Mo Group) v
Az ICOM ¥
B: HAM festa 4
C: Railroad 4
Dz Mt Fuji ¥

1/5

® DO NOT push [ENT].
4. Push [QUICK].
5. Select “Edit Name.”

A

o RACKR AT
j|lEdit Mame
Delete All In Group

6. Enter a group name of up to 16 characters.

GROUP MAME
HOME AREA

ABC

® See page iii on how to enter characters.
7. After entering, push [ENT].

GPS MEMORY
(Mo Group)

145

F

A 1COM '
F

F

F

13

B: HAM festa
C: Railroad

Dz Mt Fuji
E: HOME AREA

® To exit the MENU screen, push [MENU].
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¢ Deleting the GPS Memory

You can delete the GPS Memories.
There are 2 ways to delete the Memories:
 Deletes all GPS Memory in a group.
 Deletes a specific GPS Memory.

NOTE: Deleted GPS Memories cannot be restored.

[MENU] > GPS > GPS Memory

Example: Deleting all in Group E.

1. Push [MENUL.

2. Select “GPS Memory” in the “GPS” menu.

3. Select the group where the GPS Memory to delete
is saved.

GPS MEMORY  1/5
(Mo Grougp)

A COM
B: HAM festa

[
1]
k
C: Railroad ]
D: Mt Fuji 4
E: HOME AREA ¥

@® DO NOT push [ENT].
4. Push [QUICK].
5. Select “Delete All In Group.”

e R A TR AT D 4

[Edit Mame

« The confirmation dialog is displayed.
6. Select “YES.”

GPS MEMORY

[ P P |
Delete all in
group?

1/5

T
E: HOME AREA

I

« All GPS Memory in the selected group are deleted,
then returns to the GPS MEMORY screen.
@ To exit the MENU screen, push [MENU].

TIP: Deleting a specific GPS Memory
1. Select the GPS Memory to delete, then push
[QUICK].
2. Select "Delete.”
if";dgl [N )
Edlit
M oeve
Delete

Delete &1l In Group

L]

« The confirmation dialog is displayed.

3. Select“YES.”
* The selected GPS Memory is deleted.




6 GPS OPERATION (ADVANCED)

GPS Memory

< Rearranging the display order of the GPS data

You can move the entered GPS Memories to

rearrange their display order in the selected GPS

Memory group.

® To move the GPS Memory out of their assigned Memory
group, select the Memory group in the GPS MEMORY
EDIT screen, and then save.

[MENU] > GPS > GPS Memory

1. Push [MENUL.
2. Select “GPS Memory” in the “GPS” menu.

GP3 1/2
GPS Set k
GPS TH Mode ¥
GP3 Information  »
GPS Pozition r

L]

F

GPS Memory

GPS Alarm

3. Select the group where the GPS Memory you
want to move is saved.

GPS MEMORY  1/5

(Mo Group)
Az 1O
B: HAM festa

Dz Mt Fuji
E: HOME AREA

1
F
F
: Railroad H
3
F

4. Select the GPS Memory to move, and then push
[QUICK].

GROUP C 141
To ation
Shinagawa Statio
Shin Ozaka Stati
Hakata Station

H
3
3
L3

5. Select “Move.”

Pl a DA A4

iAdd

Delete All In Group

v

141

Shin Ozaka Stati
Hakata Station
=<Mlove End==

» “DESTINATION” blinks at the top left of the screen.
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6. Select the position to insert the Memory you want
to move.

DESTINATION 14
Tokyo Station
Shinagawa Statio
Shin Osaka Stati
Hakata Station

<zMove End>=

v

GROUP C 11

Shinagawa Statio
Shin Oszaka Stati

~rEl~ -

Hakata Station

* The selected Memory is inserted above the
destination Memory name.

@ If you select “<<Move End>>," the Memory is moved
to the bottom of the group.

@ To exit the MENU screen, push [MENU].
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GPS Alarm

The transceiver can sound a GPS Alarm when a target station or position comes into the alarm area.
This function can be set to a caller station, all GPS Memories, a selected GPS Memory group, or a selected GPS
Memory.

Alarm Area (Group) (Setting plural stations)
When “All Memories” or a GPS Memory group is selected:

. N
Point A | 025 b 025 |
ﬁ —
| .
\ N
‘ o
Your location ——————#&-————- —A——\
3
o
Point Bﬁ Y
Point C
Sounds 3 beeps.
Alarm Area (RX/Memory) (Setting specific station)
When a specific GPS Memory is selected:
Extended range N

approximately 500'm, 547 Y

Your location / ﬁi)
S

-
Target m

station T

Sounds a beep.  Sounds 3 beeps.

approximately:1 km, 1094.Y
Limited range
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GPS Alarm

< Setting the GPS Alarm function to All Memories (all GPS Memories)

[MENU] > GPS > GPS Alarm
1. Push [MENUL.

@ Information

2. Select “GPS Alarm” in the “GPS” menu. « When either one of the group’s stations enters the set
GPS 1/2 range, the alarm sounds 3 times.
GPS Set v * When the transceiver sounds a GPS Alarm, “GPS
GPS T Mode ’ ALARM" is displayed on the screen, and “ iz-:1 " blinks.
GPS Information  » . .
GPS Pasition R See the illustration below.
GPS Memary . « To cancel the GPS Alarm function, select “OFF” in step
GRS AL N 4 to the left.
3. Select “Alarm Select.” Bk
. Selec arm Select. :
) — 12:00
GPS ALARM 141 1 45.000
. [OFS ALARH ¥
Alarm Area (Group) v =
Alarm Area (R¥/Mer 433.000 ...
“GPS ALARM” is displayed on the screen
4. Select “Group.” and the alarm sounds 3 times.
Alarm Select 141 TIP: When selecting “All Memories,” “No Group,” or
OFF a GPS Memory group (A ~ Z) in step 5 to the left,
R'}{ 13 ”
(Group » you also have to set “Alarm Area (Group)” to use the
Memory ' GPS Alarm function. (p. 6-43)
(IMENU] > GPS > GPS Alarm > Alarm Area (Group))

5. Select “All Memories.

GROUP 1/5

All Memories
(Mo Group)
Az T O

B: HAM festa
C: Railroad
Dz Mt Fuji

v

Alarm Area (Group) v
Alarm Area (R¥/Mer

* Returns to the GPS ALARM screen.

@ If you want to set the alarm to a specific GPS
Memory group, select “(No Group)” or “A” to “Z.”

® To exit the MENU screen, push [MENU].
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GPS Alarm

< Setting the GPS Alarm function to RX (a caller station)

[MENU] > GPS > GPS Alarm

1. Push [MENU].
2. Select “GPS Alarm” in the “GPS” menu.

GP3
GPS Set 4
GPS TH Mode ¥
GP3 Information  »
GPS Pozition r
GPS Memory ¥

k

GPS Alarm

3. Select “Alarm Select.”

GPS ALARM

141

Alarm Area (Group) v
Alarm Area (R¥/Mer

4. Select “RX.”

Alarm Select
OFF

R
Group 3
Mermory r

v

GPS ALARM

Alarm Select

141

¥

RX
Alarm Area (Group)
Alarm Area [RX/Me

* Returns to the GPS ALARM screen.

@ If you want to set the alarm to a specific GPS
Memory group, select “Memory” and then select a
GPS Memory in a GPS Memory group.

® To exit the MENU screen, push [MENU].
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® Information

* When a station with its GPS Alarm set enters within an
approximate 1 kilometer (1094 yards) range, it sounds
once. When it enters within an approximate 500
meters (547 yards) range, the alarm sounds 3 times.

* When the transceiver sounds a GPS Alarm, “GPS
ALARM" is displayed on the screen, and “ iz-x1 " blinks.
See the illustration below.

« To cancel the GPS Alarm function, select “OFF” in step
4 to the left.

Blinks

o 12:00
W—

145.000
<., [OPS ALARI 4

433.000

F=KIF

“GPS ALARM” is displayed on the screen
and the alarm sounds 3 times.

NOTE: Even if “RX” is selected in step 4, when the
received signal has no position data, the GPS Alarm
does not sound.

TIP: When selecting “RX” or a specific GPS Memory
in step 4 to the left, you also have to set the “Alarm
Area (RX/Memory)” to use the GPS Alarm function.
(p. 6-44)

(IMENU] > GPS > GPS Alarm > Alarm Area (RX/Memory))
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NOTE: The default settings shown below are for the USA version. The default settings may differ, depending
on your transceiver version. To return to your transceiver version’s default settings, push [QUICK] and select

“Default.”

GPS Select (Default: ON)

Power Save (Default: Auto)

[MENU] > GPS > GPS Set > GPS Select

Selects how to capture position data.

® When “GPS Time Correct” is set to “Auto,” set this item to
“ON” to automatically correct the time by a received GPS
sentence. (p. 12-30)

* OFF: A GPS receiver is not used.

* ON: Position data of the internal GPS receiver
is used for the GPS functions.

e Manual: Manually enter the current Latitude,
Longitude, and Altitude in “Manual
Position.”

SBAS (Default: OFF)

[MENU] > GPS > GPS Set > GPS Option > SBAS

Turns the SBAS (Satellite Based Augmentation

System) function ON or OFF.

® When turning ON this function, the GPS position accuracy
can be improved, but the transceiver’s battery is quickly
exhausted.

e OFF: Turns OFF the function.
¢ ON: Turns ON the function.
GLONASS (Default: OFF)

[MENU] > GPS > GPS Set > GPS Option > GLONASS

Selects whether or not to use the data from

the GLONASS (GLObal'naya NAvigatsionnaya

Sputnikovaya Sistema) satellites.

® When turning ON this function, the GPS position accuracy
can be improved, but the transceiver’s battery is quickly
exhausted.

* OFF: Does not use the data from the
GLONASS satellites.
¢ ON: Uses the data from the GLONASS

satellites.
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[MENU] > GPS > GPS Set > GPS Option >
Power Save

Selects whether or not to use the Power Save function
for the internal GPS receiver.

When this function is ON, and if the GPS receiver
does not receive signals from a satellite for 5 minutes,
the function turns OFF the GPS receiver for this set
period of time.

e OFF: The GPS receiver is always turned ON.
1,2, 4, 8min:

When the receiver cannot receive signals
from a satellite for 5 minutes, the GPS
receiver is turned OFF for the selected
period of time. (1, 2, 4, or 8 minutes).
After this period, the receiver resumes
receiving.

When the receiver cannot receive signals
from a satellite for 5 minutes, the GPS
receiver is turned OFF for 1 minute.

After this period, the receiver resumes
receiving. The Power Save interval time
extends to 2, 4, and then 8 minutes
when receiving no signals for another 5
minutes, respectively.

e Auto:

Satellite Information Out
(Default: GPS/QZSS/GLONASS)

[MENU] > GPS > GPS Set > GPS Option >
Satellite Information Out

Selects whether or not to output the data from the

QZSS (Quasi-Zenith Satellite System) satellites and

the GLONASS satellites.

* GPS/QZSS/GLONASS:
Outputs the data from the GPS satellites,
the QZSS satellites, and the GLONASS
satellites.

* GPS Only: Outputs the data from only the GPS
satellites.

Manual Position
(Default: LATITUDE: 0°00.00'N,
LONGITUDE:0°00.00'W, ALTITUDE:

[MENU] > GPS > GPS Set > Manual Position

Manually enter the latitude, longitude, and altitude of

your current position.

® You can capture position data from the GPS receiver if
“Capture From GPS” is selected.
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GPS Out (USB Port) (Default: OFF)

Symbol (Default: Person)

[MENU] > GPS > GPS Set > GPS Out (USB Port)

Selects whether or not to output the position
information to the USB port.

e OFF: Does not send the position information to
the USB port.

* ON: Send the position information to the USB
port.

GPS TX Mode (Default: OFF)

[MENU] > GPS > GPS TX Mode

Selects a GPS transmission mode to send GPS
position data while in the DV mode.

« OFF: Does not transmit GPS data.

* D-PRS: Transmits GPS data in the D-PRS format.
* NMEA: Transmits GPS data in the NMEA format.

Unproto Address (Default: API50,DSTARY)

[MENU] > GPS > GPS TX Mode > D-PRS >
Unproto Address

Displays an unproto address of up to 56 alphanumeric
characters.

NOTE: You should use the default address, and
editing is not recommended.
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[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Symbol

Selects the symbol that indicates your operating
situation. The selected symbol channel’'s symbols (1 ~
4) are transmitted with position data.

<Editing a symbol with a 2 character symbol code>
1. Select a symbol channel.

@® DO NOT push [ENT].

Push [QUICK].

Select “Edit Symbol.”

Push [QUICK].

Select “Direct Input.”

Rotate [DIAL] to edit the first digit.

Push D-pad(—) to select the second digit.

Rotate [DIAL] to edit the second digit.

ONoOA~WN

Selectable characters and symbols
<For the first digit>/,\,0t0 9,Ato Z

<For the second digit>Ato Z,atoz,0t0 9, ! “ #
$%& ()*+,-./:;<=>2@[\]1"_"{I}"

9. After editing, push [ENT].
 Sets the symbol into the symbol channel selected in
step 1.

<Selecting a preset symbol>

1. Select a symbol channel.

® DO NOT push [ENT].

Push [QUICK].

Select “Edit Symbol.”

Select a symbol.

 Sets the symbol into the symbol channel selected in
step 1.

n
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GPS items

SSID

(Default: ---)

Comment

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > SSID

Selects an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
® The SSID’s additional methods differ, depending on
whether the call sign includes a space or not.
The space in call sign is converted to
@ If no text is entered after space, space will
be deleted, and space is not converted to
Example: JASYUA — JA3YUA
JA3YUA A — JA3YUA-A
No SSID is added.
@ If a call sign includes a space, any text or
digit after space will be deleted.
Example: JASYUA — JA3YUA
JA3YUA A — JA3YUA

* (-0):

e -1~-15:
® Example: SSID is “-9.”

JA3YUA — JA3YUA-9

JA3YUA A — JA3YUA-9
Adds an SSID of -Ato -Z to your call sign.
® Example: SSID is “-Z.”

JA3YUA — JA3YUA-Z

JA3YUA A — JA3YUA-Z

e -A~-Z:

Adds an SSID of -1 to -15 to your call sign.

TIP: About the SSID

According to a common guideline, to help identify a
station’s type, designated call sign SSIDs are used
in D-PRS (or APRS®).

The guideline may be changed when the
infrastructure environment, such as a product or
network, is changed. Check the latest guideline

in the web site related to D-PRS and APRS® and
correctly set.

http://aprs.org/aprs11/SSIDs.txt
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[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Comment

Enter a comment to transmit it with the D-PRS
position data.

You can enter up to four comments.

The number of characters you can enter differs,
depending on the Data Extension and Altitude settings.

Characters
Data Extension Altitude entered

(maximum)

OFF OFF 43 (Default)
OFF ON 35
Course/Speed OFF 36
Course/Speed ON 28
Power/Height/Gain/Directivity OFF 36
Power/Height/Gain/Directivity ON 28

The symbol “1” displays the transmittable comment
range. Note that the characters that exceed the range
will not be transmitted.

Comment
|D- 1

ABC

Transmittable comment range display
(Example: up to 28 characters)

(Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Time Stamp

Time Stamp

Selects the transmitting time stamp type.

The time stamp is transmitted with the position

data in the D-PRS mode, and UTC (Universal Time

Coordinated) time is used.

® When your position is manually set, time stamp data is
not transmitted.

e OFF: Does not transmit the time information.

e DHM: Transmits the time stamp in the Day,
Hour, and Minute format.

* HMS: Transmits the time stamp in the Hour,

Minute, and Second format.
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GPS items

Altitude (Default: OFF)

Height (Default: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Altitude

Selects whether or not to transmit altitude data with

the position data in the D-PRS mode.

® The number of characters you can enter in “Comment”
differs, depending on the “Altitude” and “Data Extension”

settings.
e OFF: No altitude data is transmitted.
¢ ON: Transmits altitude data with position data.

Data Extension (Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Data Extension

Selects whether or not to transmit the Course/Speed
data or the Power/Hight/Gain/Directivity data with the
position data in the D-PRS mode.
® The number of characters you can enter in “Comment”
differs, depending on the “Altitude” and “Data Extension”
settings.
e OFF: Does not transmit any information.
* Course/Speed:
Transmits the course and speed data
with the position data.
® The course and speed data are not transmitted
when your location is manually set.
® When transmitting with this setting, your
station is regarded as a mobile station.
* Power/Height/Gain/Directivity:
Transmits the TX power level, height,
antenna gain, antenna direction, and
position data.
® The Power, Height, Gain, and Directivity
data are transmitted even if your location is
manually set.
® When transmitting with this setting, your
station is regarded as a base station.

Power (Default: OW)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Power

Selects the TX power level of the base station to

transmit along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

e Select 0, 1, 4, 9, 16, 25, 36, 49, 64, or 81 W.
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[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Height

Selects the height of the base station’s antenna to

transmit along with the position data.

® This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

» Select 10, 20, 40, 80, 160, 320, 640, 1280, 2560, or
5120 feet.*
* |f the Altitude/Distance unit is set to “m,” select 3, 6, 12,

24, 49, 98, 195, 390, 780, or 1561 meters.

Gain (Default: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Gain

Selects the gain of the base station’s antenna to

transmit along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

¢ Select between 0 and 9 dB.

Directivity (Default: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Directivity

Selects the direction the base station’s antenna was

pointing to transmit along with the position data.

® This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

« Select Omni, 45° NE, 90° E, 135° SE, 180°S, 225°
SW, 270° W, 315° NW, or 360° N.

Object Name

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Object Name

Sets an Object’'s name of up to 9 characters.

Data Type (Default: Live Item)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Data Type

Selects the Object’s status.
e Live Item: The Item station is valid.
« Killed Item: The Item station is invalid.

Symbol

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Symbol

(Default: Transceiver)

The symbol is an icon that indicates the Object’s
means of transportation or location. The saved symbol
is transmitted along with the position data while in the
D-PRS mode.

® See page 6-31 for details of editing a symbol.
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GPS items

Comment

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Comment

Enters a comment to transmit it with the D-PRS
position data.

You can enter up to four comments.

The number of characters you can enter differs,
depending on the Data Extension and Altitude settings.

Characters
Data Extension Altitude entered

(maximum)

OFF — 43 (Default)
OFF Entered 35
Course/Speed — 36
Course/Speed Entered 28
Power/Height/Gain/Directivity — 36
Power/Height/Gain/Directivity Entered 28

The symbol “1” displays the transmittable comment
range. Please note that the characters that exceed the
range will not be transmitted.

Comment
|1D- 1

ABC

Transmittable comment range display
(Example: up to 28 characters)
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Position
(Default: LATITUDE: 0°00.00'N,
LONGITUDE:0°00.00'W, ALTITUDE:

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Position

Displays the position information of the Object.
Push [QUICK] to open the Quick Menu window shown
below.

Capture From GFS
Set From GPS Mem

Default

TIP: When you select “Capture From GPS” or “Set
From GPS Memory,” you can capture the position
from the GPS or set the Item’s position from the
GPS memory.

Entering the position information manually
1. Select “Edit” on the Quick Menu window.
« The POSITION EDIT screen is displayed.
2. Select “LATITUDE.”
3. Enter a latitude.
® Select “N/S” to switch the north latitude and the
southern latitude.
Select [ENT].
5. Select “LONGITUDE.”
6. Enter a longitude.
® Select “E/W” to switch the east longitude and the
west longitude.
7. Select [ENT].
8. Select “ALTITUDE.”
9. Enter an altitude.
@ After entering, select [+/-] to switch “+” and “-.”
10. Select [ENT].
11. Select “<<Write>>."
12. Select “YES.”
» The position information is entered.
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GPS items

Data Extension (Default: OFF)

Gain (Default: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Data Extension

Selects whether or not to transmit the Course/Speed
data or the Power/Hight/Gain/Directivity data with the
position data in the D-PRS mode.
® The number of characters you can enter in “Comment”
differs, depending on the “Altitude” and “Data Extension”
settings.
e OFF: Does not transmit any information.
« Course/Speed:
Transmits the course and speed data
with the position data.
« Power/Height/Gain/Directivity:
Transmits the TX power level, height,
antenna gain, antenna direction, and

position data.
Course (Default: 0°)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Course

Sets the Object’s course to between 0° and 360°
@ This item is displayed when “Data Extension” is set to
“Course/Speed.”

Speed (Default: Omph)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Speed

Sets the Object’s speed to between 0 and 1150 mph.*
* |f the Speed unit is set to “km/h,” set to between 0 to
1850 km/h, or set to “knots,” set to between 0 and

999 knots.
@ This item is displayed when “Data Extension” is set to
“Course/Speed.”

Power (Default: OW)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Power

Selects the TX power level of Object to transmit along

with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

* Select 0, 1, 4, 9, 16, 25, 36, 49, 64, or 81 W.

Height (Default: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Height

Selects the height of the Object’'s antenna to transmit

along with the position data.

® This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

 Select 10, 20, 40, 80, 160, 320, 640, 1280, 2560, or
5120 feet.*
* |f the Altitude/Distance unit is set to “m,” select 3, 6, 12,

24, 49, 98, 195, 390, 780, or 1561 meters.
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[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Gain

Selects the gain of the Object’s antenna to transmit

along with the position data.

® This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

 Select between 0 and 9 dB.
Directivity (Default: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Directivity

Selects the direction the Object’s antenna was

pointing to transmit along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

e Select Omni, 45° NE, 90° E, 135° SE, 180°S, 225°
SW, 270° W, 315° NW, or 360° N.

SSID (Default: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > SSID

Selects an SSID based on APRS® to add to your call

sign, to show your operating style to other stations.

® The SSID’s additional methods differ, depending on
whether the call sign includes a space or not.

® See page 6-32 for details of the SSID.

The space in call sign is converted to “-.

e (-0): No SSID is added.

e -1~-15: Adds an SSID of -1 to -15 to your call
sign.

e -A~-Z: Adds an SSID of -A to -Z to your call
sign.

Time Stamp (Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Time Stamp

Selects the transmitting time stamp type.

The time stamp is transmitted with the position

data in the D-PRS mode, and UTC (Universal Time

Coordinated) time is used.

® When your position is manually set, time stamp data is
not transmitted.

e DHM: Transmits the time stamp in the Day,
Hour, and Minute format.
e HMS: Transmits the time stamp in the Hour,

Minute, and Second format.
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GPS items

Item Name Position
(Default: LATITUDE: 0°00.00'N,
LONGITUDE:0°00.00'W, ALTITUDE: ------ ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Position

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > I[tem Name

Sets the Item station’s name of up to 9 characters.

Data Type (Default: Live Item) Displays the position information of the Item.
[MENU] > GPS > GPS TX Mode > D-PRS > Push [QUICK] to open the Quick Menu window shown
TX Format > Item > Data Type below.
Selects the Item station’s status. . mi
« Live Item:  The Item station is valid. gapt“re From GPS
. . .. . et From GPS Mem
« Killed Iltem: The Item station is invalid. Default
Symbol (Default: Transceiver)

[MENU] > GPS > GPS TX Mode > D-PRS >

|G IS = el = SyTilool] TIP: When you select “Capture From GPS” or “Set From
Selects the symbol that indicates the Item’s means GPS Memory,” you can capture the position from the
of transportation or location. The selected symbol GPS or set the Item'’s position from the GPS memory.
channel’'s symbols are transmitted with position data
while in the D-PRS mode. ® See page 6-34 when you want to enter the position
® See page 6-31 for details of editing a symbol. information manually.
Comment Data Extension (Default: OFF)
[MENU] > GPS > GPS TX Mode > D-PRS > [MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Comment TX Format > Item > Data Extension
Enters a comment to transmit it with the D-PRS Selects whether or not to transmit the Course/Speed
position data. data or the Power/Hight/Gain/Directivity data with the
The number of characters you can enter differs, position data in the D-PRS mode. _
depending on the Data Extension and Altitude settings. ® The number of characters you can enter in “Comment”
differs, depending on the settings.
Characters e OFF: Does not transmit any information.
Data Extension Altitude | entered « Course/Speed:
(maximum) Transmits the course and speed data
OFF — 43 (Default) with the position data.
OFF Entered 35 * Power/Height/Gain/Directivity:
Course/Speed _ 36 Transmits the TX power !eve!, height,
antenna gain, antenna direction, and
Course/Speed Entered 28 position data.
Power/Height/Gain/Directivity — 36 Course (Default: 0°)
Power/Height/Gain/Directivity Entered 28

[MENU] > GPS > GPS TX Mode > D-PRS >

The symbol “1” displays the transmittable comment TX Format > ltem > Course

range. Please note that the characters that exceed the

range will not be transmitted. Sets_th_e Ite_m’s_ course to between 0° an_d 36_50°
® This item is displayed when “Data Extension” is set to
Comment “Course/Speed.”
I1D- 1
Speed (Default: 0°)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Speed

ABE Sets the Item’s speed to between 0 and 1150 mph.*
Transmittable comment range display * |f the Speed unit is set to “km/h,” set to between 0 to
(Example: up to 28 characters) 1850 km/h, or set to “knots,” set to between 0 and
999 knots.
® This item is displayed when “Data Extension” is set to
“Course/Speed.”

6-36



6  GPS OPERATION (ADVANCED)

Power (Default: OW)

SSID (Default: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Power

Selects the TX power level of Item, to transmit along

with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

* Select 0, 1, 4, 9, 16, 25, 36, 49, 64, or 81 W.

Height (Default: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Height

Selects the height of the Item’s antenna to transmit

along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

« Select 10, 20, 40, 80, 160, 320, 640, 1280, 2560, or
5120 feet.*
* |f the Altitude/Distance unit is set to “m,” select 3, 6, 12,

24, 49, 98, 195, 390, 780, or 1561 meters.

Gain (Default: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Gain

Selects the gain of the Item’s antenna to transmit

along with the position data.

® This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

» Select between 0 and 9 dB.

Directivity (Default: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Directivity

Selects the direction the Item’s antenna was pointing

to transmit along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

e Select Omni, 45° NE, 90° E, 135° SE, 180°S, 225°
SW, 270° W, 315° NW, or 360° N.
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[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > SSID

Selects an SSID based on APRS® to add to your call

sign, to show your operating style to other stations.

® The SSID’s additional methods differ, depending on
whether the call sign includes a space or not.

® See page 6-32 for details of the SSID.

The space in call sign is converted to “-.

e (-0): No SSID is added.

e -1~-15: Adds an SSID of -1 to -15 to your call
sign.

e -A~-Z: Adds an SSID of -A to -Z to your call
sign.



6  GPS OPERATION (ADVANCED)

Symbol (Default: WX Station)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > Symbol

The symbol is an icon that indicates the weather
station’s means of transportation or location.
The saved symbol is transmitted along with the
position data while in the D-PRS mode.

® See page 6-31 for details of editing a symbol.

SSID (Default: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > SSID

Selects an SSID based on APRS® to add to your call

sign, to show your operating style to other stations.

® The SSID’s additional methods differ, depending on
whether the call sign includes a space or not.

® See page 6-32 for details of the SSID.

o - The space in call sign is converted to “-.”

e (-0): No SSID is added.

e -1~-15: Adds an SSID of -1 to -15 to your call
sign.

e -A~-Z: Adds an SSID of -Ato -Z to your call
sign.

Comment

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > Comment

Enter a comment to transmit it with the D-PRS
position data, up to 43 characters.

Time Stamp (Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > Time Stamp

Selects the transmitting time stamp type.

The time stamp is transmitted with the position

data in the D-PRS mode, and UTC (Universal Time

Coordinated) time is used.

* OFF: Does not transmit the time information.

* DHM: Transmits the time stamp in the Day,
Hour, and Minute format.

* HMS: Transmits the time stamp in the Hour,
Minute, and Second format.
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GPS items

GPS Sentence (Default: GGA) GPS Message
[MENU] > GPS > GPS TX Mode > NMEA > [MENU] > GPS > GPS TX Mode > NMEA >
GPS Sentence GPS Message
Selects sentences to be transmitted in the GPS mode Enter a GPS message of up to 20 alphanumeric
to transmit position data. Set to between RMC, GGA, characters. (p. 6-21)

GLL, VTG, GSA, and GSV. NOTE: When you do not want to send a message,
NOTE: Set the GSV sentence to OFF when delete the entered message.

sending the GPS message to conventional digital
transceivers. (p. 6-4) GPS Information
The GSV sentence is incompatible with them.

[MENU] > GPS > GPS Information

® Information Displays the GPS satellite direction, elevation angle,

» Up to 4 GPS sentences can be set at a time. satellite number, and receiving status. (p. 6-11)
« Displays “&#" when the sentence is set to ON.

* “VTG,” “GSA,” and “GSV” sentences are not transmitted
when your position has been manually set.

TIP: Contents of GPS sentence
The Time Stamp is displayed based on the UTC (Universal Time Coordinated) time.
GPS Time
Sentence Lon/Lat Alt Stamp Date Status 2D/3D coG SOG
(UTC) (True) (knot)
(uTC)
RMC 4 4 v v (4 v
GGA v 4 4 4
GLL 4 v 4
VTG 4 v
GSA 4 v
GSV
Sentence Others
RMC Magnetic variation, Mode Indicator
Number of satellites in use, HDOP, Geoidal separation, Age of Differential GPS data,
GGA . . .
Differential reference station ID
GLL Mode Indicator
VTG COG (Magnetic north), SOG (km/h), Mode Indicator
GSA PRN number of satellites used in solution, PDOP, HDOP, VDOP
GSV Total number of sentences, Sentence number, Total number of satellites in view,
Satellite information (ID, Elevation, Azimuth, S/N)
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GPS items

GPS Position

[MENU] > GPS > GPS Position

Your current position, received position, GPS Memory,
or GPS Alarm position information is displayed.

(p. 6-6)

Rotating [DIAL] to select the MY, RX, MEM, and ALM
screens.

MY screen (MY Position)

Compass* Displays your direction.
Course Displays your direction heading.
Latitude Displays your latitude.
Longitude Displays your longitude.
Displays the grid locator based on
GL the latitude and longitude of your
location.
ALT Displays your own altitude.
SPEED Displays your speed over the ground.
TIME Displays current time received from

the GPS.

® When “GPS Select” is set to “Manual,” the screen
displays only latitude, longitude, altitude, GL (Grid
locator), and time (internal clock).

RX screen (Received position data of the other station)
Depending on the caller’s TX mode or TX format, the
displayed items and these meanings are different. The
following lists describe the items for each category.

No data is displayed when no position data is received
on your transceiver.

<1. When the caller’s TX mode is NMEA>
Displays the caller’s direction from

Compass* .

your location.
Latitude Displays the caller’s latitude.
Longitude Displays the caller’s longitude.

Displays the grid locator based on
GL the latitude and longitude of the
caller’s location.

ALT Displays the caller’s altitude.

Displays the caller’s distance from

DST .
your location.

Call sign Displays the caller’s call sign.
COURSE Displays the caller’s direction over
the ground.

SPEED Displays the caller’s speed.

Displays the time that the caller

SIS S acquired the position data.

<2. When the caller’s TX format is D-PRS Position
(Mobile station)>

Displays the caller’s direction from

Compass* .
your location.
Symbol Displays the caller's D-PRS
symbol.
Latitude Displays the caller’s latitude.
Longitude Displays the caller’s longitude.

Displays the grid locator based on
GL the latitude and longitude of the
caller’s location.

ALT Displays the caller’s altitude.
Displays the caller’s distance from

DST .
your location.

. Displays the caller’s call sign

g (with SSID).

COURSE Displays the caller’s direction over
the ground.

SPEED Displays the caller’s speed.

Displays the time that the caller

CE LI SELY acquired the position data.

* You can change the display type in the Quick Menu
window.
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GPS items

GPS Position (continued)

<3. When the caller’s TX format is D-PRS Position

<4. When the caller’s TX format is D-PRS Object/

(Base station)> ltem>
Compass* Displays the caller’s direction from Compass* Displays the OI:“)Ject/Item s direction
your location. from your location.
Symbol Displays the caller's D-PRS Symbol Displays the Object/ltem’s D-PRS
symbol. symbol.
Latitude Displays the caller’s latitude. Latitude Displays the Object/Item’s latitude.
Longitude Displays the caller’s longitude. Longitude Displays the Object/ltem’s longitude.
Displays the grid locator based on Displays the grid locator based on
GL the latitude and longitude of the GL the latitude and longitude of the
caller’s location. Object/Item’s location.
ALT Displays the caller’s altitude. ALT Displays the Object/Item’s altitude.
Displays the caller’s distance from Displays the Object/ltem’s distance
DST . DST -
your location. from your location.
. Displays the caller’s call sign Object/Item name Displays the Object/ltem’s hame.
Call sign ith SSID
(wi )- Calllsion Displays the caller’s call sign
POWER Displays the caller’s TX power level. g (with SSID).
HEIGHT Displays the caller’s antenna height. COURSE Displays the Object/ltem’s direction
GAIN Displays the caller’s antenna gain. over the ground.
Displays the direction of the caller's SPEED Displays the Object/ltem’s speed.
DIRECT e : - ;
antenna was pointing. POWER Displays the Object/ltem’s TX power
; ; level.
GPS Time Stamp Dlsplgys the tlme_ Fhat the caller : : ’
acquired the position data. Displays the Object/ltem’s antenna
HEIGHT .
height.
GAIN D|§plays the Object/ltem’s antenna
gain.
DIRECT Displays the direction that the

Object/Item’s antenna was pointing.

GPS Time Stamp

Displays the time that the caller
sent the Object’s data.

® When the Object or Item is disabled, “KILLED” is

displayed.

* You can change the display type in the Quick Menu

window.
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GPS items

GPS Position (continued)

<5. When the caller’s TX format is D-PRS Weather>

MEM screen (GPS memory position)

Displays the caller’s direction from

Displays GPS Memory channel’s

* *
Sompess your location. Sompess direction from your location.
Svmbol Displays the caller's D-PRS Latitude Displays GPS Memory channel’s
y symbol. latitude.
Latitude Displays the caller’s latitude. Longitude Displays GPS Memory channel’s
Longitude Displays the caller’s longitude. longitude.
Displays the grid locator based on Displays the grid locator based on
GL the latitude and longitude of the GL the latitude and longitude of the
caller’s location. GPS Memory channel.
Displays the caller’s distance from DST Displays GPS Memory channel's
DST your location. distance from your location.
Call sian Displays the caller's call sign GPS memory name Displays the caller’s call sign (with
9 (with SSID). SSID).
Temperature Displays the temperature of the @ You can change the GPS Memory in the Quick Menu
P caller station’s area. window.
Humidi Displays the humidity of the caller .
umidity station’s area. ALM screen (GPS alarm position)
Displays the rainfall of the caller Compass* Displays GPS Alarm area’s
RAIN station’s area. direction from your location.
Displays the wind direction of the Latitude Displays GPS Alarm area’s latitude.
WIND DIR . - ;
caller station’s area. Longitude Displays GPS Alarm area’s
WD S Displays the wind speed of the longitude.
caller station’s area. Displays the grid locator based on
BARG Displays the barometric pressure of GL the latitude and longitude of the
the caller station’s area. GPS Alarm area.
. Displays the time that the caller Displays the GPS Alarm area’s
GPS Time Stamp achl)Jier the position data. DU distance from your location.
Displays “RX,” GPS memory
GPS Alarm group name, or GPS memory

name specified for the GPS Alarm
function.

@ You can change the GPS Alarm in the Quick Menu

window.

* You can change the display type in the Quick Menu

window.
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GPS items

GPS Memory

Alarm Select

(Default: OFF)

[MENU] > GPS > GPS Memory

The transceiver has 300 GPS memories to save the
received position data, or often-used position data,
with an alphanumeric memory name.

The channels can be divided into the “(No Group)”
group and each Memory group (A to Z) for easy
Memory management.

The display of the GPS MEMORY screen

(No Group)

GPS Memories not assigned to any
group

A~ Z: Group Name

GPS Memories assigned to the
selected group.

GPS Memory Groups (A~ Z)

GROUP NAME

GPS Memory Group name
(Up to 16 alphanumeric characters)

® You can edit the GPS Memory Group hame. (p. 6-25)

GPS Memories

GPS memory name

Al (Up to 16 alphanumeric characters)
DATE Saved date

TIME Saved time

LATITUDE Saved position (latitude)
LONGITUDE Saved position (longitude)
ALTITUDE Saved altitude

GROUP The group letter and the name of

the group

® When you save the received position data on the GPS
POSITION screen, the received station’s call sign is used
as the GPS Memory name.

@ In the Quick Menu window, you can edit the GPS Memory
contents, such as the GPS Memory name.
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[MENU] > GPS > GPS Alarm > Alarm Select
Selects the target positions for the GPS Alarm

function.

¢ OFF: Turns OFF the function.

* RX: The GPS Alarm sounds when a target
(the last received position) enters
your active alarm range.

e Group: The GPS Alarm sounds when a target
(positions in the GPS Memory, or the
selected GPS Memory Group) enters
your active alarm range.

* Memory: The GPS Alarm sounds when a target
(the entered position in the GPS
Memory) enters your active alarm
range.

Alarm Area (Group) (Default: 0.25")

[MENU] > GPS > GPS Alarm > Alarm Area (Group)

Sets the GPS active alarm range.

When a target enters this set active alarm range, the

GPS Alarm sounds, and the GPS Alarm icon blinks.

® When “Alarm Select” is set to “Group,” this setting is
enabled.

Ranges differ, depending on the Latitude/
Longitude unit setting.

e Latitude/Longitude = ddd°mm.mm’
Ranges: 00.08' to 59.99' (0.01' steps)
« Latitude/Longitude = ddd°mm'mm”
Ranges: 00'05" to 59'59" (0'01" steps)
« Latitude/Longitude = ddd.dddd®
Ranges: 0.0014° to 0.9999° (0.0001° steps)
® Pushing D-pad($) moves the cursor to the tenths and
hundredths place digits, or the thousandths and ten
thousandths place digits.

Example:
When a target enters the active alarm range, the GPS
Alarm sounds, and the GPS alarm icon blinks.

Point A i

i3

Your location

Point Bﬁ

Point C
Sounds 3 beeps.
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GPS items

Alarm Area (RX/Memory)

(Default: Both)

GPS Logger (Default: ON)

[MENU] > GPS > GPS Alarm >
Alarm Area (RX/Memory)

Selects the GPS active alarm range.

When a target enters the active alarm range, the GPS

Alarm sounds, and the GPS alarm icon blinks.

® When “Alarm Select” is set to “RX” or “Memaory,” this
setting is enabled. (p. 6-43)

* Limited: The transceiver sounds 3 beeps, and
the GPS Alarm icon blinks when the
target enters the 500 meters range.
The transceiver sounds 3 beeps, and
the GPS Alarm icon blinks when the
target enters the 1-kilometer range.
The transceiver sounds a beep, and
the GPS Alarm icon blinks when the
target enters the 1-kilometer range
and sounds 3 beeps, and the icon
blinks when it enters the 500 meters
range. When the target exits the
500 meters range but is still in the
1-kilometer range, the icon continues
to blink, but no beeps sound.

* Extended:

* Both:

Example:

When a target station enters the active alarm range
(500 meters or 1 kilometer range, depending on the
setting), the GPS Alarm sounds, and the GPS Alarm

Extended range
approximately: 1, km, 1094 Y

Limited range
approximately 500'm, 547 Y:

Your location A)
S

Target m

icon blinks.
i fLNk

station T

Sounds a beep.  Sounds 3 beeps.
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[MENU] > GPS > GPS Logger

Turns the GPS Logger function ON or OFF.

This function logs the position, altitude, course, speed,

and number of satellites being used.

¢ OFF: Turns OFF the function.

¢ ON: The transceiver automatically logs GPS data.
Once this function is turned ON, the GPS
data will be continuously logged until turning
it OFF, even if the transceiver power is turned
OFF, then ON again.

® This function requires a microSD card (User supplied).

® When “GPS select” is set to “OFF” or “Manual,” this

function does not save the log.

TIP: The log data is saved on the microSD card. The
file name is automatically created, as shown below:
 Log start date and time: 6th June 2023 15:30:00

¢ Filename: 20230606 _153000.csv

Record Interval (Default: 10sec)

[MENU] > GPS > GPS Logger > Record Interval

Sets the GPS Logger function record interval to 1, 5,
10, 30 seconds, or 1, 5, or 10 minutes.

Record Sentence
(Default: [v] RMC/ [v] GGA/ [v]VTG/ [v] GSA)

[MENU] > GPS > GPS Logger > Record Sentence

Sets the GPS Logger function record sentence to
RMC, GGA, VTG, or GSA.
« Displays ‘&#]" when the sentence is set.

NOTE: Select at least one sentence, otherwise an
error beep will sound.

<<GPS Logger Only>>

[MENU] > GPS > GPS Logger >
<<GPS Logger Only>>

You can turn ON the GPS Logger Only mode.
Only the GPS Logger is functioning in this mode, and
the transceiver does not transmit or receive it.

® Information

* BE SURE to insert a microSD card.

» Set “GPS Select” to “ON.” (p. 6-30)

* To cancel the mode, restart the transceiver.
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GPS Auto TX (Default: OFF)

[MENU] > GPS > GPS Auto TX

Selects an option for the GPS automatic transmission
function.

This function automatically transmits the current
position data received from a GPS receiver and any
entered GPS message at the set interval.

* OFF: Does not automatically transmit the position
data. (When you push [PTT], the transceiver
transmits the position data.)

30 sec to 30 min:

Transmits the current position data at the
selected interval (30 seconds, or 1, 3, 5, 10,
or 30 minutes).
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7 VOICE TX FUNCTION

Voice TX function

The Voice TX function transmits the recorded audio
that is on the microSD card, one time or repeatedly,
for up to 10 minutes at the set interval.

This function is convenient to repeatedly call CQ, or
for other events.

You can assign the [Voice TX] key function to an
optional microphone key. (p. 12-18)

NOTE: BE SURE to insert a microSD card into the
transceiver.
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¢ Recording the voice audio

[MENU] > VOICE > Record

1. Push [MENU].
2. Select “VOICE.”
3. Select “Record.”

WOICE T

TH Zet

<<Single TH=x
<<Repeat THx>

141

v

VOICE T RECORD

REC Lewel:

[P TT [z

————

[ENT [N

4. Hold down [PTT] to record.

Displayed

while recording ~

Recording time

VOICE TH RECORD

A
[ N —
— 0:07/ 1:00

REC Lewel:

H—Audio level

[PTT i

® Information

* Hold the microphone 5 ~ 10 cm (2 ~ 4 inches) from
your mouth, then speak at your normal voice level.

* The maximum record time is 1 minute.

* Only 1 voice memory can be recorded.

TIP: On the VOICE TX RECORD screen,

push [QUICK], then select “Clear” to clear the
recorded audio.

« The voice is played back.

VOICE TH RECORD

Displayed ——» = m—————

while playing

REC Lewel:

Em=Tor

0:05/ 0:09 <

Push [ENT] to confirm the recorded voice.

Total time

—Play back time

@ If you hold down [PTT], the recording starts again.
In this case, the previous recorded audio will be
overwritten.

® To exit the MENU screen, push [MENU].
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Voice TX function

< Transmitting the recorded voice audio

NOTE: BE SURE to insert a microSD card into the
transceiver.

[MENU] > VOICE > <<Single TX>>

[MENU] > VOICE > <<Repeat TX>>

1. Push [MENU].
2. Select “VOICE.”
3. Select “<<Single TX>>" or “<<Repeat TX>>."
e <<Single TX>>:
The recorded voice audio is transmitted only once.

WOICE TH 141
Record 4
TH Set r

<<Single T
<zFepeat TH==

* <<Repeat TX>>:
The recorded voice audio is repeatedly transmitted.

WOICE TH 141
Record 4
TH Set *

<<Single THz=
<zFepeat -

m + o[0] €===—Blinks
([T TR

146.010

FEEIF

440.000 ...

v

4ul 1z2:00| Transmission is

=
- paused
146.010
(Voie T Waiting ]

440.000 ...
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® Information

* While transmitting, the SD card icon blinks.

* When you select “<<Repeat TX>>,” the transceiver
repeatedly transmits the recorded voice audio for up to 10
minutes at the interval set in “Repeat Time.”

(IMENU] > VOICE > TX Set > Repeat Time)

Repeat Time 1/3

1sec
Zsec
Zsec
dzec

Gsec

Any of the following action cancels the transmission.

- Pushing [PTT]

- Turning OFF the transceiver, then turning it ON again.

- Pushing any key (except for [VOL] and [()])

After the second transmission, the transmission continues
pausing, if receiving a signal, even if “Busy Lockout” is set
to “ON.”

([MENU] > SET > Function > Busy Lockout)

However, if the squelch is manually opened in the

FM mode, the voice audio is repeatedly transmitted,
according to the “Repeat Time” setting.

You can select whether or not to output the TX voice
audio from the speaker.

(IMENU] > VOICE > TX Set > TX Monitor)

T Maonitar 11
OFF
C—

TIP: To transmit the recorded voice audio in the
Quick Menu window, push [QUICK], then select
“Voice TX."

Voice TH

GP3 Information
GP3 Pozition
Weather Infarmati

(Weather Alert |l
Home CH Set 3
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VOICE items

Record

<<Single TX>>

[MENU] > VOICE > Record

Up to 1 minute of audio can be recorded onto a
microSD card for voice transmission. (p. 7-2)

The transceiver can save only 1 voice audio.

® BE SURE to insert a microSD card.

® While recording a QSO, you cannot use this function.

Repeat Time (Default: 5sec)

[MENU] > VOICE > TX Set > Repeat Time

Sets the Repeat Time to between 1 and 15 seconds
(in 1 second steps).

The transceiver repeatedly transmits the recorded
voice audio for this set interval.

NOTE: The recorded voice audio is repeatedly
transmitted for up to 10 minutes. If 10 minutes
passes while transmitting, the transceiver
continues to transmit until the complete voice audio
transmission is finished.

TX Monitor (Default: ON)

[MENU] > VOICE > TX Set > TX Monitor

Turns the TX Monitor function ON or OFF.

¢ OFF: The TX voice audio is not heard from the
speaker.

¢ ON: The TX voice audio is heard from the speaker.
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[MENU] > VOICE > <<Single TX>>

The transceiver transmits the recorded voice audio
only once.
® You can also select “Single TX” in the Quick Menu
window.
([QUICK] > Voice TX > Single TX)

<<Repeat TX>>

[MENU] > VOICE > <<Repeat TX>>

The transceiver repeatedly transmits the recorded
voice audio for up to 10 minutes, according to the
“Repeat Time” setting.

® Information

* You can also select “Repeat TX” in the Quick Menu
window.

([QUICK] > Voice TX > Repeat TX)

« If 10 minutes passes while transmitting, the transceiver
continues to transmit until the complete voice audio
transmission is finished.

« Any of the following action cancels the transmission.

- Pushing [PTT]
- Turning OFF the transceiver, then turning it ON again.
- Pushing any key (except for [VOL] and [()])
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8 RECORDER FUNCTION

Recording a QSO audio

You can record the QSO audio on the MAIN band.

NOTE:

e You must insert a microSD card into the transceiver
before recording audio.

» The recording function is continuously ON, even if the
transceiver is turned OFF then ON again.

To start recording

To stop recording

1. Push [QUICK].
2. Select “<<REC Start>>."

<<Fh RaloON>
|==FM Radio Mode J
<<GPS Logger Onl ||

o] 1l
Fr

12:00

Recording started.

u FZEIF

» “Recording started.”
standby screen.

is displayed, then returns to the

m_-*E]K‘--—“— Recording standby

146.010

FEKIF

440.000

FSHIF

v

g ——2[e8]<=22-The recording starts when you
1 46 01 0 transmit or the squelch opens.
While recording, the SD card icon
=R blinks.

440,000

FEKIF

® Information

« The recording pauses while no signal is received, and
resumes when a signal is received again.

« The recording continues until you manually stop
recording, or the card becomes full.

« If the recording file’s content reaches 2GB, the
transceiver automatically creates a new file, and
continues recording.
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1. Push [QUICK].
2. Select “<<REC Stop>>."

<R EC Stope=

<<FM Fadio OM=
|=<FM Radio Mode §I

<GPS Logger Onl ||

] # B
FH

12:00

Fecording stopped.

I Iu'uuu FZEIF

TIP:

When “RX REC Condition” is set to “Always,” the
recording automatically starts when

“<<REC Start>>" is selected. In that case, recording
continues, even when no signal is received.*

(p. 8-15)

(IMENU] > RECORD > QSO Recorder

> Recorder Set > RX REC Condition)

* The recorded file contains no sound.




8 RECORDER FUNCTION

Playing back a recorded audio

NOTE: Insert the microSD card that contains the
recorded audio file into the transceiver’s slot.

[MENU] > RECORD > QSO Recorder > Play Files

1. Push [MENU].
2. Select “RECORD.”
3. Select “QSO Recorder.”

YOICE MEMO___1/1
Recorder

Yoice Recorder r
O Auto Reply 4

4. Select “Play Files.”

Q30 RECORDER 1/1

<<REC Start=>

Reorder Set *
Flayer Set 4

5. Select the folder that contains the audio file to play.

PLAY FILES 3/3

£ 20230605 ’
] EDEBDEDE v

® The folder is named in the following format:
YYYYMMDD (YYYY: Year, MM: Month, DD: Day)
6. Select the audio file to play.

Recorded time

£ 20230608 141

2023,/06/08 16:35:18
2023;"’06;"08 16 35 26

439,330 ¥ T® 011 | <«—Total playback time
f LTX/Rx
Operating mode

Operating frequency

* The VOICE PLAYER screen is displayed, and the file
starts to play.

8-3

The VOICE PLAYER screen description

The number of the file being played back/
The total number of recorded files.

Recording start
date and time ‘ MOICE PLAYER 3/3
‘ 2023/06/08 16:36:02
439,390 DY Ti<e— TX/RX
[ ee—
n:02/ 0:11 «+— Play back time/

‘ Total time

_Operatin_g
information

——[RX—CS]
Plays the previous file

e—[LO] Fast forwards

[ENT] Pauses or plays
[DR] Plays the next file

Fast forward [LO]/Rewind [CD]
 Hold down to continuously fast forward, or rewind the file.
» The default skip time is 10 seconds. If you want to
change it, see page 8-16 for details.
* You can fast forward or rewind the file by rotating
[DIAL]. The fast forward/rewind time is 1/20 of the total
file time, regardless of the skip time setting.
If you push [CD] within the first 1 second of the file, the
end of the previous file is played back.

Playing the previous file [RX—CS]

* While the oldest file in the folder is playing back,
pushing [RX—CS] plays back the same file.

» While the file is paused, pushing [RX—CS] moves to
the beginning of the previous file.

Playing the next file [DR]
While the latest file in the folder is playing back,
pushing [DR] plays back the same file.

Operating information
The operating frequency, mode, and audio category
(RX/TX audio) are displayed.




8 RECORDER FUNCTION

Changing the QSO recorder settings

You can change the recording settings.
See pages 8-15 and 8-16 for detalils.

Continue to record, even while the squelch is

closed Change the Skip Time
[MENU] > RECORD > QSO Recorder > [MENU] > RECORD > QSO Recorder >
Recorder Set > RX REC Condition Player Set > Skip Time
R REC Condition 141 Skip Time 141
A s Fzen
Sguelch Auto Bsec
Z0zec
® The default setting is “Squelch Auto” (Records only while ® The default setting is “10sec.”

the squelch is open).

Record the QSO audio as one file

[MENU] > RECORD > QSO Recorder >
Recorder Set > File Split

File Split 141

oM

® The default setting is “ON” (transmit and receive audio
are separately recorded in different files).

® When “RX REC Condition” is set to “Squelch Auto,” an
audio file is created every time the squelch opens. The
received audio is recorded in a separated file.

Synchronize the recording to PTT

[MENU] > RECORD > QSO Recorder >
Recorder Set > PTT Auto REC

FTT Auto REC 141
ofF |

oM

® The default setting is “ON” (Recording is synchronized to
PTT).

TIP: When “PTT Auto REC” is set to “ON”

« Starts recording not only when [PTT] is pushed, but also
when switched to transmit by a speaker microphone, by
a ClI-V command, or by the VOX function.

¢ Asignal that is received within 10 seconds after the
squelch is closed is recorded in the same file.
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8 RECORDER FUNCTION

Deleting the audio folder/file

NOTE: A deleted audio file can NOT be recovered.

< Deleting an audio folder
NOTE: All audio files in the folder are deleted.

[MENU] > RECORD > QSO Recorder > Play Files

1. Push [IYIENU]. ) TIP: To delete all folders
2. Select “RECORD. Select “Delete All Folders” in step 7.
3' SeleCt “QSO Recorder" [T o T fa¥s

YOICE MEMO _ 1/1 I B'jelfifer Information

250 Recarder

Delete All Folders

Yoice Recarder *
O Auto Reply 4

4. Select “Play Files.”

Q50 RECORDER 11

<<FEC Start=>

Recorder Set 4
Flayer Set 4

5. Select the folder to delete.

£ 20230606 ’
£ 20230603 r

® DO NOT push [ENT].
Push [QUICK].
7. Select “Delete.”

[T B SR ol WO = Ca s
i Falder Infarmation
Delete

Celete All Folders

o

» The confirmation dialog is displayed.
8. Select “YES.”

PLAY FILES 3/3

Celete folder?

 The folder is deleted.
® To exit the MENU screen, push [MENU].
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8 RECORDER FUNCTION

Deleting the audio folder/file

< Deleting an audio file

[MENU] > RECORD > QSO Recorder > Play Files

1. Push [MENU].
2. Select “RECORD.”
3. Select “QSO Recorder.”

VOICE MEMO 141

2150 Recorder
Yoice Recorder 4
DY Auto Reply 3

4. Select “Play Files.”

Q50 RECORDER 1/
<<REC Starte>

Recorder Set ¢
Flayer Set *

5. Select the folder that contains the audio file to delete.

3/3

£ 20230606 v
7 20230603 ’

6. Select the audio file to delete.

£ 20230605 141
i ‘05 11:46:23
2023/06/05 11:46: 2

2023/06/05 11:46:38

435,300 DY TH 0i02

® DO NOT push [ENT].
Push [QUICK].
Select “Delete.”

© N

A AnTanEnc At

I File Information

Delete All

4200 all L ! L4 1

« The confirmation dialog is displayed.

8-6

9. Select “YES.”

£ 20230605 141

Delete file?

435,300 DY TH 0:02

* The file is deleted.
@ To exit the MENU screen, push [MENU].

TIP: To delete all files
Select “Delete All” in step 8.

[ o G [ T = 4 44
i File Information
Delete

Delete All

a0, ol LY I [LH ]




8 RECORDER FUNCTION

Viewing the file information

The recorded audio file contains the recording data.
See page 8-8 for the recorded contents.

[MENU] > RECORD > QSO Recorder > Play Files 8. Select “File Information.”
1. Push [MENU] i:'l'latil:lrl Hi
2. Select “RECORD.” I Deiete
3. Select “QSO Recorder.” Delete All
VOICE MEMO 1/

FRecarder

Vaoice Recorder 3 L3000 T T ()

D% Auto Reply v

v

Ao anaananc A4 44

| FrES:45. 300
WODE:DY  TX
4. Select “Play Files.” POMER: S-Low
START: 2023/06/105
11:46:23

Q50 RECORDER 1/
<<REC Start=>

Fecorder Set r
Flayer Set 4

©

Rotate [DIAL] to change the screen.
® To exit the MENU screen, push [MENU]I.

5. Select the folder that contains the audio file to

TIP: To view the folder information
view the information.

Push [QUICK] in step 5, and then select “Folder

FLAY FILES 373 Information” to view the folder information.
] 05

LD [ LYl N i) Ll
£ 20230606 r

Folder Information
£ 20230608 r Delete

Delete All Folders

Select the audio file to view the information.

£ 20230605 171
2023/06/05 11:46:23 v

6y 3 FLAY FILES 3/3
2023/06/05 11:46:26 [T —
2023/06/05 11:46: 39 NAME : 20230505 < Folder name

FILE:2(107KE) < Total files (total size)
DATE : 2023/06/05]

- . — 1
TR M:86:22 | Created date and time

® DO NOT push [ENT].
Push [QUICK].
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8 RECORDER FUNCTION

Viewing the file information

File information examples
® Depending on the recording status, some data may not be displayed.
® The file is named in the following format: YYYYMMDD_hhmmss
(YYYY: Year, MM: Month, DD: Day, hh: hour, mm: minute, ss: second)

» TX audio file information * RX audio file information
= ;%Eanjlna% e a 44 Operating information (TX) £ Anmneon 4t Operating information (RX)
+aad i i jl| FREQ:439.390 i i
| MODE<DY T Recording date and time I MDDE:D\-‘ o Recording date and time
POMER: S-Low S-MET:54
START: 2023/06/03 START: 2022/06/09
18:35:18 10:35: 40

= mannncan 44 MY station position = annnnenn ata MY station position
ihw POSITION: (WY POSITION:
LAT: 34°37.76°N | LAT: 247397, 7' N
LOM:135° 34, 20°E LOW: 135734, 41'E
GL 2 PH74SP GL 2 PH74SP
AT BFL ALT: 811

-+d!:l. o0 RA TS

= nnnnnson A4 DR setting & Annanenn ata Caller and received repeater
i il CALLER:
[ | :
COCQCca IMAZLE
— Rick
. R¥RPT:
JPEYHH A JPEYHH A
Hirano

| Hirano i
dod, a0 LY R HAE

== Az on P File data £ Anmmnenn a4 RX station position
[[1HE : 608163518 j{Fx POSITION:
SIZE: 7EKE | LAT: 34°37.63°N
DWTE: 2023/06/08 LON:135° 34, 31°E
16:35: 22 GL:PH7ASP
ALT:20Ft

DET:37mi

S AnTETNE O A2 File data

i hAME @ 2623R669_1035¢

S1ZE:B0KE

DATE: 2023/06/09
10:35:44

Gad. gl LY R 1Y

8-8



8 RECORDER FUNCTION

Using the Voice Recorder function

The microphone audio, including audio from an ® Depending on the microSD card capacity, you may
external microphone, can be recorded for your continuously record up to a maximum of about 37 hours.
convenience. If the file size exceeds 2 GB, a new file is automatically
created in the same folder, and the recorded voice audio
NOTE: You must insert a microSD card into the is saved there.

transceiver before recording audio.

< To start recording

NOTE: You cannot record a voice while recording 5. Push [PTT] to start recording.

a QSO. In that case, push [QUICK] in the standby * The microphone audio recording starts.
screen, and then select “Stop Recording” to stop the VOICE RECORDER

QSO recording. REC Tirner:

# 0:00:08 «——Recording time

- Remain 136h40
[MENU] > RECORD > Voice Recorder > Record cee Laanain o

1. Push [MENU]. nmmn, <————— Microphone input level

PTTIS
2. Select “RECORD.” G
3. Select “Voice Recorder.”

6. Push [PTT] again to stop.

YOICE MEMO 1/ ® To exit the MENU screen, push [MENU].
50 Recorder v

Yaice Recorder

DV Auto Reply ' TIP: Even if the external microphone is connected,
the internal microphone’s voice audio is recorded
when the transceiver’s [PTT] is pushed.

To record the external microphone’s voice audio,
4. Select “Record.” hold down the external microphone’s [PTT].

Vaice RECORDER. 1/1 To change the microphone gain level
Push [QUICK] in the VOICE RECORDER screen,
and then select “MIC Gain.”

(et lal ol a intalal i nl sl

Flay Filesz
Fecorder Set
Flayer Set

- v

v

VWOICE RECORDER
REC Tirner:
0:00:00
Remain 12&h40 <€——Remaining time
REC Lewel: ﬂ——Microphone gain level

EIRIREC

» The VOICE RECORDER screen is displayed.
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8 RECORDER FUNCTION

Using the Voice Recorder function

¢ Playing back a recorded audio

NOTE: You cannot play back a recorded audio while The VOICE PLAYER screen description
recording a QSO. In that case, push [QUICK] in the The number of the file being played back/
standby screen, and then select “Stop Recording” to The total number of recorded files.
stop the QSO recording. v

WOICE PLAYER 3/3

- - Recording start
[MENU] > RECORD > Voice Recorder > Play Files date and time T 2023/06/08 16:36:02
1. Push [MENU]. [ —] ;
Play back time/

2. Select “RECORD.” 0:0z2/ D:H‘_TO?ZI ti?]:e Ime
3. Select “Voice Recorder.”

YWOICE MEMOD 11
50 Recorder ¢ ——[RX—CS]
Plays the previous file

Yoice Recarder

D% Auto Reply v

[CD] —e [jY—[LO] Fast forwards

[ENT] Pauses or plays
[DR] Plays the next file

4. Select “Play Files.”

Q50 RECORDER 141

“<REC Starte- Fast forward [LO]/Rewind [CD]

» Hold down to continuously fast forward or rewind the file.

» The default skip time is 10 seconds. If you want to
change it, see page 8-16 for details.

* You can fast forward or rewind the file by rotating
[DIAL]. The fast forward/rewind time is 1/20 of the total

5. Select the folder that contains the audio file to play. file time, regardless of the skip time setting.
* If you push [CD] within the first 1 second of the file, at

Fecorder Set *
Flayer Set 4

PLAY FILES 3/ . -
£ 20230605 v the end of the previous file is played back.

Playing the previous file [RX—CS]

« While the oldest file in the folder is playing back,
pushing [RX—CS] plays back the same file.

» While the file is paused, pushing [RX—CS] moves to
the beginning of the previous file.

£ 20230606
2 il

@ The folder is named in the following format:

YYYYMMDD (YYYY: Year, MM: Month, DD: Day) Playing the next file [DR]
6. Select the audio file to play. While the latest file in the folder is playing back,
* The VOICE PLAYER screen is displayed, and the file pushing [DR] plays back the same file.

starts to play.

Recorded time

£ 20230603 14
2023/06/08 16:35:18
2023/06/08 16:35:26
2 08 36:02

439.390 ¥ T 0:11-<—Total playback time

8-10



8 RECORDER FUNCTION

Using the Voice Recorder function

< Deleting an audio folder

NOTE: TIP: To delete all folders

¢ All audio files in the folder are deleted. Select “Delete All Folders” in step 7.
* Adeleted audio file can NOT be recovered.

Ml 4w T e 4 M
iFnIder Infarmation

. . Del
[MENU] > RECORD > Voice Recorder > Play Files B naa—

1. Push [MENU].
2. Select “RECORD.”
3. Select “Voice Recorder.”

YOICE MEMO 141
050 Recorder ¥

Yoice Fecorder

O Auto Reply 4

4. Select “Play Files.”
Q50 RECORDER 1/1

<<FEC Start=>

Recorder Set 4
Flayer Set 3

5. Select the folder to delete.

PLAY FILES 3/3
£ 20230605
£ 20230606
£ g
1 20230609

3
L3
¥
L3

@® DO NOT push [ENT].
Push [QUICK].
7. Select “Delete.”

DA C e 4 f4
i Folder Information
Delete
Celete All Folders

o

« The confirmation dialog is displayed.
8. Select “YES.”

PLAY FILES 11

Delete folder?

» The folder is deleted.
@ To exit the MENU screen, push [MENU].
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8 RECORDER FUNCTION

Using the Voice Recorder function

< Deleting an audio file
NOTE: A deleted audio file can NOT be recovered.

[MENU] > RECORD > Voice Recorder > Play Files

1. Push [MENU]. 9. Select“YES.”
3. Select “Voice Recorder.”

WQICE MEMO 1/
50 Recorder v

Delete file?

Yoice Recorder

O Auto Reply 4 075

* The file is deleted.
® To exit the MENU screen, push [MENU].

4. Select “Play Files.”

050 RECORDER 171 TIP: To delete all files

<<REC Starte> Select “Delete All” in step 8.
== intalnul-iulnl 4 44

Recorder Set 3 I File Informatian

Flayer Set 3 Delete
Delete All

5. Select the folder that contains the audio file to delete. -2
PLAY FILES 3/3
£ 20230805 v

(=1 2023060

£ 20230608
£ 20230609

L3
J
L3

6. Select the audio file to delete.

£ 20230608 11
2023,/06/08 16:35:18

2023,/06/08 16:35: 26
202 ‘08 36:02

429,390 DY TH 0011

@® DO NOT push [ENT].
Push [QUICK].
Select “Delete.”

© N

[ |n b (ul i uln] A M
i File Infarmation
Delete

Delete All

il

» The confirmation dialog is displayed.
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8 RECORDER FUNCTION

Using the Voice Recorder function

< Viewing the file information
[MENU] > RECORD > Voice Recorder > Play Files

1. Push [MENU]. TIP: To view the folder information
2. Select "RECORD.” Push [QUICK] in step 5, and then select “Folder
3. Select “Voice Recorder.” Information” to view the folder information.

[ LI Y ol O i) 4 44
Folder Information

YWOICE MEMOD 141 K
050 Recorder 4 I Delete
Delete All Folders

Yoice Recorder

DY Auto Reply 3

4. Select “Play Files.” A 4
050 RECORDER 1/1 PLAY FILES 111
==REC Start== W
NAME : 20230600 <& Folder name
Recorder Set ' FILE:2(580KE} < Total files (total size)
Plaver Set . DATE:2023/06/09 | || .
Y 9:48:10 Created date and time

5. Select the folder that contains the audio file to
view the information.

PLAY FILES 3/3
£ 20230605 ’

£ 20230606
iy 12

L3
H
3

& 2023060

6. Select the audio file to view the information.

£ 20230608 141
2023,/06/08 16:35:18
2023/06/08 16:35:26

JO3 16236202

439,380 D% TR 11

® DO NOT push [ENT].
7. Push [QUICK].
8. Select “File Information.”

e NN nn 4 f4
i File Infarmation
Delete
Delete All

L ¥is}
[ SalvialtanlTuln] L]
i NAKE @ 28238663 _16350 i
SIZE:302KE
DATE: 2023,/06/08
16:36:02
il

® To exit the MENU screen, push [MENU]I.
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8 RECORDER FUNCTION

Playing back the recorded audio on the PC

You can play back the recorded audio on your PC.
® Operation data is not displayed.
® Windows 10 is used for these instructions.

Example: Playing back the audio file on the microSD
card on your PC.

1. Insert the microSD card into the memory card slot 5. Double-click the folder that contains the audio file
or memory card reader on your PC. to play it back. (Example: “20230609")
I [ [ = | Voice
Home Share View
« - A # USB Drive (H:) » ID-50 » Voice
Name -
3 Quick access
20230606
3 @ OneDrive 20230608 .
i _”ﬂ“ I This PC < — Double-Click
microSD To the . . .
card card reader PC 6. Double-click the file to play it back.
(Example: “20230609_103540.wav”)
2. Click the “Open folder to view files” option to | A [ = | z0zs0609
access the card. fome st Ve
« v o > USB Drive (H) » ID-50 > Voice » 20230609
Removable Disk (H:) . Name -
Quick access .
Choose what 1o do with removable drives 4—— DO u ble-cl | Ck
@ OneDrive || ZUZ305US_ 1U30US.Wav
m :onlic_,uu fw. drive for backup 1 e pC o] 20230809 _103629.wav
ﬂ Configure storage settings B 3D Objects
| E Open folder to view tes | Click ® See the instruction manual of your player for
- operation details.
8§ ® The audio file may not play back, depending on the
player.

3. Double-click the ‘ID-50] folder.

TR — TIP: When “USB Connect” is set to “SD Card Mode,”
Home  Share  View | DimeTools and the transceiver is connected to the PC through a
4 [ > USEDive (H) USB data cable, you can directly access the microSD
_— - card that is set in the transceiver from the PC.
 Quickaccess 4__ Double-Click (IMENU] > SET > Function > USB Connect)
@ OneDrive

4. Double-click the ‘Voice’ folder.

|4 [} = 1ID-50
Home Share View
€« v » USB Drive (H) » ID-50 »
Name
3t Quick access
Capture
@ OneDrive Cav
8 This PC G
15 0B Picture
t
’ et Qscleg
[ Desktop Reply
[ Documents RuLog
& Downloads Settina
b o [ ]<——Double-Click
&] Pictures VoiceRec
W vid VoiceT
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8 RECORDER FUNCTION

RECORD items

<<REC Start>>

RX REC Condition (Default: Squelch Auto)

[MENU] > RECORD > QSO Recorder >
<<REC Start>>

After selecting “<<REC Start>>,” starts QSO
recording.
» “Recording started.” is displayed.

® Information

« BE SURE to insert a microSD card.

* While recording, “<<REC Stop>>" is displayed on the
QSO RECORDER screen. To stop recording, select
“<<REC Stop>>."

» Once a recording has started, the recording will continue,
even if the transceiver is turned OFF and then ON again.

Play Files

[MENU] > RECORD > QSO Recorder > Play Files

Displays saved voice data folders.
® BE SURE to insert a microSD card.

Playing back:

1. Select a folder that contains the file you want to
playback.

2. Select afile to playback.
» The VOICE PLAYER screen is displayed and starts

playing back the audio.

® See page 8-3 for details.

3. Push [MENU] to exit the VOICE PLAYER screen.

NOTE:

« The folder is automatically named, as shown below:
(Example)
Recording date: 12th June 2023
Folder name: 20230612

« The file is automatically named, as shown below:
(Example)

Recording date and time: 12th June 2023 09:30:00
File name: 20230612_093000

* The voice audio is recorded onto a microSD card, and
saved in the “wav” format. (“.wav” is not displayed on
the transceiver’s screen.)

* The recorded voice audio can also be played back on a
PC.

[MENU] > RECORD > QSO Recorder >
Recorder Set > RX REC Condition

Selects whether or not the squelch status affects the
received voice audio recording.

* Always: The transceiver always records the
receive voice audio regardless of the
squelch status.

¢ Squelch Auto: The transceiver records the receive
voice audio only when a signal is
received (the squelch is opened).
When the squelch closes while
recording, the recording will continue
for 2 seconds, and then pause.

File Split

[MENU] > RECORD > QSO Recorder >
Recorder Set > File Split

Turns the File Split function ON or OFF.

¢ OFF: Once a recording starts, the transceiver

continues to record on the same file.

@ If the file size exceeds 2 GB, a new file is
automatically created in the same folder, and the
voice audio is recorded there.

During recording, if transmission and

reception, or squelch status* (open and close)

is changed, a new file is automatically created
in the same folder, and the voice audio is
saved into a new file.

* Only when “RX REC Condition” is set to

“Squelch Auto.”

(Default: ON)

¢« ON:

PTT Auto REC

[MENU] > RECORD > QSO Recorder >
Recorder Set > PTT Auto REC

Turns the PTT Automatic Recording function ON or OFF.
® Transmitting from a speaker microphone, using the
VOX function, or sending a CI-V command also starts
recording.

(Default: ON)

¢ OFF: Turns OFF the function.
¢ ON: The recording automatically starts when you
push [PTT].
The recording stops when:
* No signal is transmitted for 10 seconds after releasing [PTT].
* No signal is received for 10 seconds after releasing [PTT].
® When the transceiver receives a signal within
10 seconds after releasing [PTT], the recording
automatically starts.
« The operating frequency, Frequency Selecting mode,
or operating mode is changed after releasing [PTT].
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8 RECORDER FUNCTION

RECORD items

Skip Time (Default: 10sec)

Skip Time (Default: 10sec)

[MENU] > RECORD > QSO Recorder >
Player Set > Skip Time

Sets the Skip Timer to 3, 5, 10, or 30 seconds to
rewind or skip forward for this set period of time when
you push the fast-rewind or fast-forward key while

playing the recorded QSO audio.
® See “The VOICE PLAYER screen description” for
forwarding or rewinding. (p. 8-3)

Record

[MENU] > RECORD > Voice Recorder >
Player Set > Skip Time

Sets the Skip Timer to 3, 5, 10, or 30 seconds to

rewind or skip forward for this set period of time when

you push the fast-rewind or fast-forward key while

playing the recorded voice audio.

® See “The VOICE PLAYER screen description” for
forwarding or rewinding. (p. 8-10)

DV Auto Reply

[MENU] > RECORD > Voice Recorder > Record

Push [ENT] to display the VOICE RECORDER
screen, and then push [PTT] to start a voice
recording. While recording, push [PTT] again to stop
the recording. (p. 8-9)

® Information

* BE SURE to insert a microSD card.

 This function cannot record a QSO.

* While recording a QSO, you cannot use this function.

Play Files

[MENU] > RECORD > Voice Recorder > Play Files

Plays back the voice audio that is recorded on the
VOICE RECORDER screen.

Push [ENT] to display the folders that contain the
recorded voice audio files.

® BE SURE to insert a microSD card.

MIC Gain (Default: 3)

[MENU] > RECORD > Voice Recorder >
Recorder Set > MIC Gain

Sets the internal microphone sensitivity to between 1
(minimum sensitivity) and 4 (maximum sensitivity) for
the Voice Recorder function. Higher values make the
microphone more sensitive to your voice.

8-16

[MENU] > RECORD > DV Auto Reply

Up to 10 seconds of audio can be recorded for the
Automatic Reply function.

® BE SURE to insert a microSD card.

® See page 5-25 for details.
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9 MEMORY OPERATION

General description

The Memory mode enables you to quickly select
often-used frequencies, modes, and other parameters.
While operating in the Memory mode, you can
temporarily change the operating frequency, mode,
and so on, without overwriting the memory channel

NOTE: Memory content may be accidentally
cleared by static electricity, electric transients,

and other causes. In addition, it may be cleared

by a malfunction, or during repairs. Therefore, we
recommend that you backup the Memory content or

contents. save it onto a microSD card* or a PC.
*User supplied
Group Memory Descriptions ® The CS-50 PROGRAMMING SOFTWARE can also be used
channel to backup your memory content. See its instruction

Regular memory channels. manual for details.

Up to 500 channels can be
separately stored in the 100
memory channel groups.

144 CO/C1 | Call channels each of the 144 and
430 CO/C1 | 430 bands.

00t0o 99 | 00to 99

CALL CH

<& Memory channel content

The following information can be entered into the
Memory channels:

« Operating frequency

» Duplex ON/OFF

 Duplex direction (DUP+ or DUP-)

« Duplex frequency offset

* Memory name

» Scan skip setting

Tuning step

Operating mode

Subaudible tone encoder, tone squelch, or DTCS squelch
ON/OFF

Subaudible tone frequency, tone squelch frequency, or
DTCS code with polarity

Digital code

Digital Call sign squelch or Digital code squelch ON/OFF
« UR station call sign

R1/R2 call signs

9-2



9 MEMORY OPERATION

Selecting a Memory channel

In the Memory mode, you can select the Memory
channels by rotating [DIAL].

1. Push [MR] to enter the Memory mode.

- B 12:00

146.010

CR@00-00

440.000 ...

@ For only the ID-50A, pushing [MR] each time selects

the Memory and Weather Channel modes.
2. Rotate [DIAL].

» Selects a Memory channel.

® Blank channels are not selected.

® To select a Memory Group, push [QUICK], and then
select “Group Select.”

® The Memory channels are commonly used for the A
and B bands. On the B band, if you select a memory
channel that is out of the selectable frequency range,
“d X" is displayed, and the signal cannot be received.

TIP: To sequentially select a channel in a
different group

1. Push [QUICK].

2. Select “Channel Select Group Range.”

3. Select “All Groups.”

frml 4 B 1%
I The Current Group

All Groups

9-3

Selecting a Call channel

Call channels are used for quick recall of most often
used operating frequencies.

Factory default frequencies and operating modes are
entered into the Call channels. Change these to suit
your operating needs.

1. Hold down [CALL] for 1 second to enter the Call
Channel mode.

o) A B 12:00
[T Fra

FM Call CH

146 520
144C1

440.000 ...

2. Rotate [DIAL].
» Selects a Call channel.



9 MEMORY OPERATION

Entering Memory channel contents

After selecting a frequency in the VFO mode, you can
enter it into a selected channel or an automatically
selected blank channel.

< Entering into a selected channel

Example: Entering 146.030 MHz/FM mode into
Channel 11 in Group 01.

1. Push [V/MHZ] to enter the VFO mode. 10. Push [ENT].
2. Push [MODE] to enter the FM mode.  The confirmation dialog is displayed.
3. Rotate [DIAL] to set a frequency to 146.030 MHz. 11. Select “YES.”
= 4 B _1z:00 WRITE
1 46 030 Write to a blank
. channel?
FSKIF YES
R MO
440000 ... {(Blank CH)

» Beeps sound and the Memory contents are briefly

4. Hold down [MW] for 1 second. displayed, then returns to the VFO mode.

» Ashort and a long beep sound.
5. Select “Write to New CH.”

= = 3 om TIP: In step 7, you can select the following options.
U["rite to Mew CH * NAME:
mg;‘; fﬂ'—‘nﬁzﬁ c Displays the Memory name edit screen. (p. 9-11)
« SKIP:
Displays the SKIP setting items.
e Group Select:
Displays the GROUP SELECT screen.

6. Push [QUICK]. o <<Write>>:
7. Select “Group Select.” Enters into the selected Memory channel.
s » <<Insert Write>>:
| WAME Inserts a Memory channel above the selected
=4l ‘ channel.

Group Select
iipite==
<<|nsert Write==

TETank LH)

8. Select Group “01.”

GROUP SELECT 1,17

9. Rotate [DIAL] to select Channel “11.”
WRITE

146.030

I‘_LID;:
CHIll:

(Blank CH)

9-4



9 MEMORY OPERATION

Entering Memory channel contents

< Overwriting to the selected channel <O Entering to a blank channel

You can write a frequency into a pre-entered channel.
Example: Entering 441.100 MHz/FM mode into a

Example: Entering 146.330 MHz/FM mode into blank channel.
Channel 11 in Group 01. 1. Push [V/IMHZ] to enter the VFO mode.
1. Push [MR] to enter the Memory mode. 2. Push [MODE] to enter the FM mode.
® For only the ID-50A, pushing [MR] each time selects 3. Rotate [DIAL] to set a frequency to 441.100 MHz.
the Memory and Weather Channel modes. + 8 1700
2. Rotate [DIAL] to select Channel 11 in Group 01. sy

-+ & 1200 441 100

IEE]II—
146.030 B0
440.000 ...

ER01-11

440,000 ...

4. Hold down [MW] for 3 seconds.

® To select a Memory Group, push [QUICK], and then am 4 B 1700
select “Group Select.” allihd
3. Push [V/IMHZz] to enter the VFO mode. Cnmgrlftg?;oo
4. Rotate [DIAL] to set a frequency to 146.330 MHz. ; FREQ: 441.100 .
T i LU U0 ) —
L} FEKIF
PP « The Memory contents are briefly displayed for 2
q&hb 000 seconds, then returns to the VFO mode.
L FSKIF

5. Hold down [MW] for 1 second.
« Ashort and a long beep sound.
6. Select “Write to Selected CH.”

4 B 1700

| erte to NE-W CH

Manage Memnry

v

WRITE
146.330

DD1

CHlEl: ™
i: 146020

7. Push [MR].
8. Select “YES.”

WRITE
FH

Overwrite?

rae UsU

« Beeps sound and the Memory contents are briefly
displayed, then returns to the VFO mode.
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9 MEMORY OPERATION

Copying Memory content to the VFO

It is convenient when you want to operate on a
channel frequency near a Memory or Call channel.

Example: Copying Memory Channel 11 in Group 01
to the VFO.
1. Push [MR] to enter the Memory mode.
@ For only the ID-50A, pushing [MR] each time selects
the Memory and Weather Channel modes.
2. Rotate [DIAL] to select Channel 11 in Group 01.

-+ B 12:00

146.330

CE01-11

440.000 ...

® To select a Memory Group, push [QUICK], and then
select “Group Select.”
3. Hold down [MW] for 1 second.
» Ashort and a long beep sound.

4. Select “Copy to VFO.”

[l & B 1700

Co py to VEO

Manage Memoary

5. Select“YES.”

o) A B 12:00
EFRT Fra

Copy to WFO?

u F=KIF

v

] - & 1200
1T

146.330

F=EIF

440.000 ...

» Beeps sound and copies the selected Memory
contents to the VFO, then returns to the VFO mode.
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9 MEMORY OPERATION

MEMORY screen

On the MEMORY screen, you can easily manage the ¢ Viewing the Memory channel contents
Memory or Call channel content. You can view the Memory channel contents on the
MEMORY screen.

O Tree view of the MEMORY screen

—| Memory CH I——| Group 00
MEMORY !
1

1

Example: Viewing the contents of Channel 01 in
Group 00.

[MENU] > MEMORY > Memory CH

1. Push [MENU].
2. Select “MEMORY” on the second page of the
MENU screen.
@ In the VFO, Memory, or Call Channel mode, you can
Group 99 open the MEMORY screen by holding down [MW] for
1 second, then selecting “Manage Memory.”
3. Select “Memory CH.”
4. Select Group “00.”

S: SKIP CH"

sz

Hcalch  F1aaco | WEMORY CH_1/17
e 3
1a4C1 0z: (Blank)»
03: {Blank)»
430 CO 0a: (Blanki
05: {Blank)r
430 C1

5. Select Channel “01.

Your Call Sign GROUP Q0 117
00:146.010  FM
01:440.000  FM

*
H
Repeater List 02:441.000  FM -
*
*
L3

03:
04:

* Skips the set frequency during a scan. 05

(While a VFO scan is paused and if you want to skip
the frequency, holding down [MW] for 1 second sets A 4
the frequency as the Skip channel.)

00-01CH 143
M AME:

FREQUEMCY:
44000000
TS:

25 OkH=z

» Channel contents are displayed.
® Rotate [DIAL] to scroll the screen.
@ To exit the MENU screen, push [MENU].

TIP: To edit, copy, or clear the memory content.
1. Push [QUICK] in step 5.
2. Select “Edit,” “Copy,” or “Clear.”

oA L LI
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9 MEMORY OPERATION

Copying Memory contents to another Memory channel

You can copy the memory content to another Memory
channel.

Example: Copying Channel 01 in Group 00 to
Channel 06 in Group 00.

[MENU] > MEMORY > Memory CH

1. Push [MENU]. 8. Select the destination channel.
2. Select “MEMORY." DESTINATION _2/20
3. Select “Memory CH.” on:
4. Select Group “00.”
5. Select Channel “01.”
GROUP QO 1417 oa:
O0: 146,010 FH » 0
01 440,000  FH *
02:441.000 FH v
03: ’
Eln'l: 3 Falm Wt Bl W aTa) R E bl
05 " I Completed.
®DO NOT push [ENT]. 440.000
6. Push [QUICK].
7. Select “Copy.” 08
faln Tl Bl uiatel A 443 - i
| Edit .
| » Beeps sound, and the contents are copied to the
Mlove destination channel.
ﬁ':::t ® If the selected channel is not blank, a confirmation
Delete fnext CH mao dialog is displayed. When you select “YES,” the
e ¥ Memory contents are overwritten.
v

TIP: To copy the channel to a different group
DESTINATION 1/20 In step 6, while “DESTINATION” is displayed, push

gg 1.0 [QUICK] and select “Group Select.”

MECT IR A TSR A4 A=
b Group Select

01: 440,000 FMW
02: 441.000 FM

03:
04: |

¢ The GROUP SELECT screen is displayed.
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9 MEMORY OPERATION

Moving the Memory contents to another channel in a different group

You can move the memory content to another Memory
channel in a different group.

Example: Moving Channel 01 in Group 00 to Channel
00 in Group 02.

[MENU] > MEMORY > Memory CH

1. Push [MENU]. 11. Select the destination channel.
2. Select “MEMORY.” DESTINATION 1420
3. Select “Memory CH.” o
4. Select Group “00.” _
5. Select Channel “01.” g;_

GROUP 00 117 03:

O00: 146,010 FM  » 04:

01 440,000  FH *

02: 441.000 FH » A 4

03: 4

04: ' GROUP 02 1417

05: * 00: 440,000  FM M

® DO NOT push [ENT]. 02 N
6. Push [QUICK]. 0 '
7. Select “Move.” o .

[l a Tl N s Wt 4447

» Beeps sound, and the contents are moved to the
destination channel.
® Channels other than the one that you moved will

Insert
Delete (next CH mo move up.
. ¥
A 4 TIP: To rearrange the display order in the
selected group
E)DE.STWAT'ON 121 In step 7, while “DESTINATION?” is displayed, go to
00: 146,010 FM step 11.
0: 440,000 FH
02: 441,000 FM
03:
04:

8. Push [QUICK].
9. Select “Group Select.”

§| Group Select

10. Select the destination group.

GROUFP SELECT 1421
GROLUP

ao:

03: (Blank)
04: (Blank)
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9 MEMORY OPERATION

Inserting a blank channel

You can insert a blank channel between 2 Memory
channels. This function is convenient to organize your
memory channels.

Example: Inserting a blank channel between Channel
00 and 01 in Group 00.

[MENU] > MEMORY > Memory CH

1. Push ['Y'ENU]- ) TIP: To insert a blank group
2. Select “MEMORY- . On the Memory Group screen, select a group and
3. Select “Memory CH. push [QUICK], then select “Insert Group.”
4. Select Group “00.” T T
5. Select Channel “01.” {Edit Name
GROUP 00 1417 'tJ:'j
U: 146, FH * Clear Thiz Group
01: 441,000 FH ¥ Delete Group
0z: 4
03: 4 Jupan4 TETan T
0a: 4 .
05: 440,000 FH  » » Ablank group is inserted above the selected group.
@® DO NOT push [ENT].
6. Push [QUICK].
7. Select “Insert.”

P T Sy 4 413

Delete (next CH mao

v

GROUP OO 1417
00: 146,010 FH *

02: 441,000 FM
03:
04:
05:

L3
L3
3
L3

» Beeps sound, a blank channel is inserted above the
selected channel.

@ If you select channel 99 in step 5, a confirmation
dialog is displayed. When you select “YES,” channel
99 is deleted.
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9 MEMORY OPERATION

Entering a group/memory name

You can assign a name of up to 16 characters to each
channel group (00 ~ 99) and memory channel.

Example: Entering “Calling” as a Memory name to
Channel 01 in Group 00.

[MENU] > MEMORY > Memory CH

1. Push [MENU]. 10. After entering, push [ENT].
2. Select “MEMORY.” 00-01CH 173
3. Select “Memory CH.” ]
4. Select Group “00.” Calling
«q FREQUEMCY:
5. Select Channel “01. 440,000 00"
GROUP 00 1417 TS \
O0: 146,010 FH » 25 0kHz
01 440,000  FH *
gg : 11. Select “<<Overwrite>>.”
04: ' 00-01CH 3/3
05: ' TOME: ,
OFF
@® DO NOT push [ENT]. < Oyerwritess
6. Push [QUICK].
7. Select “Edit.”

12. Select “YES.”
00-01CH 3/3
e

T hIr.

Celete (next CH mo Overwrite?
ujae ¥

8. Select “NAME.”

1/3

v

[alulal Bl Watel A543

FREQUEMCY:

440.000.00" {Completed.
T5: , I e
25 OkHz 440.000

Calling

v GRO0-01

] ¥

MAME

» Beeps sound, then returns to the Memory channel
screen.

TIP: To enter a group name
On the Memory Group list screen, select a group
and push [QUICK], then select “Edit Name.”

ABC

9. Enter a name.

[lﬂl‘hﬂﬂl'\'\.l’ fad W | 4443
MAME I Edit Mame
Calling Inzert Group
h IMaove Group

Clear This Group
Delete Group

[iia TETSFEF

abc

* The Group Name edit screen is displayed.

® See page iii on how to enter characters.
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9 MEMORY OPERATION

Selecting a memory name display

While in the memory mode, the entered memory TIP: There are 3 types of Memory name displays.
name can be displayed in different styles. You can
select a display type. « Freq (Name OFF):

Displays only the frequency.
Example: Selecting “Name” in the Single band

. o] - & 12:00
display. *
1. Push [MR] to select the Memory mode. 440.000
@ For only the ID-50A, pushing [MR] each time selects
the Memory and Weather Channel modes. o —
2. Push [QUICK]. 20230616 (Fri)

3. Select “Display Type.”

frml .
eather Alert * Freq' .
Home CH Set Displays the large font sized frequency and small font

Display Type sized Memory name.

-+ B 12:00

Band Scope 3
==REC Start>>

= 440.000

. Calling
4. Select a display type.
= = & 1o SO, E@O0-01
MFreq (Mame OFF) | 2023/06/16(Fri)
Freq
* Name:

Displays the small font sized Memory name and small
font sized frequency.

IR=ATmE

for & B 1200

v “FM

Calling

I S WP 140 000
Calling SO EBOO-O1
440 000 2023 /08 16 (Fri)

SO E@O0-01
202206 /16(Fri)

® "“Freq (Name OFF)” is set as the default.

9-12



9 MEMORY OPERATION

Clearing a Memory contents

Contents of entered memories can be cleared

(erased), if desired.
® The cleared channel becomes a blank channel.
@ You can also clear the Skip channels (Group “S”).

NOTE: Cleared memory channel contents cannot be
restored.

Example: Clearing channel 01 in group 00.
[MENU] > MEMORY > Memory CH

Push [MENU]. TIP: To Delete a memory channel

Select "MEMORY.” In step 7, select “Delete (next CH moves up).”
Select “Memory CH.”

Select Group “00.”
Select Channel “01.”

GROUP O 1417

Il N i n et 4447

agprwbPE

00: 146,010  FM ]
Delete (next CH mof

- 440,000  FH
0z:
03:
04:
05:

® DO NOT push [ENT].
Push [QUICK].
Select “Clear.”

e The selected channel is deleted.
® You can also delete Memory groups.
Select a group, then select “Delete Group.”

L3
H
3
L3
3
3

N o

[adaTal Nl aWatel 443
| Edlit
|Copy
Move

Insert
Delete (next CH ma
i ¥

8. Select “YES.”
GROUP 00 1417
.

Ahe 442 nan i

I Clear?

05: *

» Beeps sound, and the contents are cleared.
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10 scAN OPERATION

Scan Type

Scanning is a versatile function that can automatically search for signals. A scan makes it easier to locate stations
to contact or listen to, or to skip unwanted channels or frequencies.

O VFO scan

The VFO scan searches for signals within the
specified frequency range.

Full scan (ALL):
Repeatedly scans the entire band.

ID-50A/E ID-50A/E
RX frequency RX frequency
lower end upper end
| |

I
P SKIP  Scan P SKIP
‘ U

Band scan (BAND)
Repeatedly scans the selected band.

Band edge frequency
lower end

Band edge frequency
upper end
|

Program scan (P00 ~ P24):
Repeatedly scans the selected Program Scan range
(P-Scan Edge 00 ~ 24).

Lower edge Upper edge
| Scan range |
! PSl(IP Scan PSl(IP !

® At least one Program Scan range (P-Scan Edges) must
be entered to start a Program scan.
(IMENU] > SET > Scan > P-Scan Edge)
See page 10-7 for more details.

Program Link scan (P-LINK 0 ~ 9):

Sequentially scans the Program Scan ranges. The
links are set on the MENU screen.

(IMENU] > SET > Scan > Program Link)

® See page 10-8 for more details.

Program scan edges (Example: POO ~ P10)
Scan

10-2

<o Memory scan

The Memory scan searches signals on the
preregistered memory channels.

ALL scan (ALL):
Repeatedly scans all memory channels.

Memory Groups (00 ~ 99 and S: Skip CH)

@@ :
’

Jump

Empty groups are skipped

Selected band scan (BAND):
Scans all memory channels on the same frequency
band as the selected channel.

Mode scan (MODE):
Scans memory channels that are entered with the
same operating mode as the currently selected mode.

® The Mode scan scans all memory groups.
(Group 00 ~ 99, S: SKIP CH)

Example: Scanning AM mode
Memory group 02

Modes other than AM are skipped

Group link scan (GROUP LINK):
Sequentially scans the memory groups that are set to
link on the MENU screen.

Memory Groups (00 ~ 99 and S: Skip CH)
Scan

J
Unchecked groups are skipped um

® At least 2 groups must be checked to start a Group Link
scan. ((MENU] > SET > Scan > Group Link)
See page 10-10 for more details.

Group scan (GROUP 00 ~ 99):
Scans the Memory channels in the selected group.



10 scAN OPERATION

Duplex (DUP) scan:

The Duplex scan searches for signals on both TX

and RX frequencies used in duplex operation

(p- 11-4).

® “D-" or “D+" is displayed in the Duplex mode.

® A Duplex scan does not start when the frequency offset
is set to “0.000.00 MHz.”

Tone scan:

The Tone scan searches for signals with tone

frequencies or DTCS codes from stations using the

Tone Squelch function.

® A Tone scan is usable in any VFO, Memory, or Call
channel mode.

® During a scan, rotate [DIAL] to change the scan
direction.

® See pages 15-8 and 15-9 about the Tone Squelch
function and DTCS Code Squelch function.
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About Scans

< [DIAL] operation during a scan

» Rotate [DIAL] to change the scan direction during a scan.
* When the scan is paused, rotate [DIAL] to resume the
scan.

< Squelch setting for a scan

You can change the squelch level to suit your

operating needs. Set the squelch level to open the

squelch, according to the received signal strength.

® During a scan, rotate [DIAL] while holding down [SQL]
to adjust the squelch level. The scan resumes after
adjusting.

4 B 12:00

; Blinks

SOUELCH: ALTO

440,000

F=EKIF

< Tuning step for a VFO scan

The selected tuning step is applied to the scan.

For a Program scan or Program Link scan, set the
tuning step in the Program Scan Edge ranges (P-Scan
Edge).

< Scan Skip function

The skip function speeds up scanning by not scanning
those frequencies set as skip channels.
® These settings can be separately set to A band and B band.

In the VFO mode
The frequencies that are set as “PSKIP” are skipped
during a scan. (p. 10-6)

In the Memory mode

The frequencies that are set as skip channels “PSKIP”

and “SKIP” are not scanned. (p. 10-10)

® You must enter 2 or more Memory channels to start a
memaory scan.

TIP: When “Program Skip” is set to OFF, you cannot
use the Program Skip scan function. (p. 12-5)
(IMENU] > SET > Scan > Program Skip)

10-4

< Operating mode during a scan

« The VFO scan uses the selected operating mode.
« During a Memory mode scan, the operating mode
entered into the channel is used.

<&When a signal is received

When a signal is received, the scan pauses for this
set period of time. (p. 12-5)

When a received signal disappears, the scan resumes
for this set period of time. (p. 12-5)

® These settings can be separately set to A band and B band.

[MENU] > SET > Scan > Pause Timer
[MENU] > SET > Scan > Resume Timer

4 B 12:00
I.'EE!]I]—

146275

B j Blinks
ALL

F=EKIF

440.000

< Scan Stop Beep function

The Scan Stop Beep function sounds a beep when a
signal is received.
This function can be turned ON or OFF on the MENU
screen. (p. 12-29)

[MENU] > SET > Sounds > Scan Stop Beep
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VFO Scan

1. Push [V/MHZ] to enter the VFO mode. < Scan Type
2. Push [MODE] to select the operating mode. . ALL: Full scan
3. Hold down [SCAN] for 1 second. « BAND: Band scan
» Opens the Scan Type Select window. « DUP: Duplex scan
4. Select a scan type. (Displayed only when Duplex is set)
= = % oo * P-LINKO ~9: Program Link scan
JALL * POO ~ 24: Program scan
EJTPNDKO « TONE: Tone scan
PO: 144 000-450.000 (For the Tone Squelch scanning)
[P0z 144.000-148.000 (| ® Information
PUZ: 450, 000-450.000 » The frequencies that are set as a Skip channel
(PSKIP) are skipped during a scan. (p. 10-6)
v * When “Program Skip” is set to “OFF,” the Skip channel
frequencies are not skipped. (p. 12-5)
o] 4 B 1z:00 (IMENU] > SET > Scan > Program Skip)
1L o .
1 46 n75 » To set a Program Link scan, see page 10-8.
== . » To set a Program scan, see page 10-7.
------ Blinks
mmmm | A
FH
440,000 ... TIP:
e « During a scan, rotate [DIAL] to change the scanning
direction.
* The scan starts. , « During a scan, push [MODE] to select the operating
» The decimal point and the selected Scan Type icon mode.
blink. o ] ] « During a scan, hold down [=Q)] to turn the Lock
® When receiving a signal, the S-meter displays the function ON or OFE.
received signal strength. « The scan continuously runs, even if you push [MENU]
5. Hold down [SCAN] for 1 second. or [QUICK] during a scan.
y Canc_els the scan. * You can select a scan type by rotating [DIAL] while
® Pushing [CLR] also cancels the scan. holding down [SCAN]. Release [SCAN] to start the
scan.
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VFO Scan

<& About a Program scan name ¢ Storing the skip frequencies

When a Scan name is entered to a Program scan, the You can skip unnecessary frequencies during a scan.

name is displayed in the Scan Type Select window. While a scan is paused and if you want to skip the

(p. 10-5) frequency, you can store it into the Skip channels

® The name is not displayed during a scan. group S (00 ~ 99) as a Skip channel (PSKIP).

® To enter the name, see page 10-7. The Scan Skip function speeds up a scan.

When the Scan name is entered: 1. While a VFO scan is paused, hold down [MW] for
1 second.

» The window, as shown above, is displayed.
2. Select “Adds to SKIP MR Group.”
e » Two short beeps sound.
» The frequency is stored in the Skip channels group.
« After storing, the scan resumes.
PO0: 144.000-450.000 @ If there is no blank channel, an error beep sounds,
’ ' and the frequency is not stored.

When the Scan name is not entered:

frr
TaLL

TIP: Once a frequency is set as a Skip channel, the
frequency is skipped until you clear the skip setting.

<O About a Program Link scan name To clear the skip setting, see page 10-10.

. . . ® The skip setting is also cleared when the Memory
When a Program Link scan name is entered, it is channel set as a Skip channel is cleared.
displayed in the Scan Type Select window.
(p. 10-5)
® The name is not displayed during a scan.
® To enter the name, see page 10-8.

When a Program Link name is entered:

4 B 1700

| TOME

10-6
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VFO Scan

¢ Entering Program Scan Edges

You can enter the upper and lower frequency edges
for a Program scan.

Each Program Scan range has its tuning step and
operating mode setting.

You can enter up to 25 Program Scan ranges (P-Scan
Edge) on the MENU screen.

[MENU] > SET > Scan > P-Scan Edge

1. Push [MENU].
2. Select “Scan” in the “SET” menu.
3. Select “P-Scan Edge.”

SCAN 12
Fause Timer *
Resume Timer 4

Temporary Skip Ti »
Frogram Skip *
Group Link 4
P-Scan Edge *

4. Select a blank Program scan range “00” ~“24.”

P-Scan Edge 2/9

04:

05:

® DO NOT push [ENT].
Push [QUICK].
6. Select “Edit.”

o

[y

» The edit screen is displayed.
7. Select “FREQ LOW” or “FREQ HIGH" to enter the
lower edge and higher edge, and then push [ENT].

® Information

* Rotate [DIAL] to select the item, and push [ENT] to

enter the edit screen.

Set the lower edge and higher edge by rotating

[DIAL].

Push [V/IMHZz] to select the 1 MHz tuning step.

When the “NAME” is entered, it displays on the Scan

Type Select window.

See page iii on how to enter characters.

* When the “TS” (Tuning Step) and/or “MODE” is
blanked, they have used the current setting on the
VFO mode.

The “TS” and “MODE" must be set to match with your
desired signals.

10-7

8. After editing contents, select “<<Write>>."

« The confirmation dialog is displayed.

9. Select “Yes.”

P-Scan Edge

T

22

¥rite?

P-Scan Edge 2/9

® To exit the MENU screen, push [MENU].

TIP:

« To clear the Program scan range, select “Clear” in step 6.
« When scanning a range where the set “TS” or “MODE”"
cannot be used, the preset “TS” or “MODE” setting on

each band is applied.
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VFO Scan

< About the Program Link Scan

This item sets the Link function for 2 or more
Program Scan ranges to sequentially scan during a
Program Link scan. The Program Link scan scans all
frequencies in the scan ranges.

Example settings of the Program Link:

Program Scan Program Scan
lower edge upper edge

00— 01:144.000-440.000 )
L(Edit Name] L( Delete ]

{Program Link

Program Scan range (p. 10-7)
Program Link number (0 to 9)

® Information

* The Program Link Number screen displays the frequency
range.

* You can add a Link setting by pushing [QUICK] when 2 or
more Program Scan ranges (P-Scan Edge) are entered.

* When there is no Program Scan range (P00 ~ P24)
entered, “Add” is not displayed after pushing [QUICK].

10-8

¢ Setting the Program Link function

[MENU] > SET > Scan > Program Link

1. Push [MENU].
2. Select “Scan” in the “SET” menu.
3. Select “Program Link.”

2/2

SCAM

Frogram Link
DUP Check During *

Select a Program Link number “0” ~ “9.”

Program Link 1/2

[ R
r v r v v

« The Program Link Number screen displays the
preregistered Program Scan ranges.

® When no Program Scan range is selected, “— Blank —"
is displayed.

Push [QUICK].

Select “Add.”

7. Select the Program Scan range that you want to add.

S N P PO A A4
01:144.000-145. 000

[
I 02:430.000-450.000

8. Repeat steps 6 and 7 until all Program scan ranges that
you want are added.

9. Push [ENT] to save the Program Link.
@ To exit the MENU screen, push [MENU].

TIP:

« To edit the name of the Program Link, push [QUICK]
and select “Edit Name” at above step 4.

« To delete the registered Program Scan range from the
Program Link, select “Delete” at above step 6.
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Memory Scan

NOTE: You must enter 2 or more Memory channels
that are not set as Skip channels to start a Memory

scan.
1. Push [MR] to enter the Memory mode.
® For only the ID-50A, pushing [MR] each time selects
the Memory and Weather Channel modes.
2. Hold down [SCAN] for 1 second.
» Opens the Scan Type Select window.
3. Select a scan type.
JGROUP LINK
TGROUP 0O
GROUP 01
v
- B 1200
146010
}ﬁj—BlinkS
440.000 ...
» The scan starts.
» The decimal point and “@@" blink.
® When receiving a signal, the S-meter displays the
received signal strength.
4. Hold down [SCAN] for 1 second.

 Cancels the scan.
® Pushing [CLR] also cancels the scan.

<& Scan Type

e ALL: Full scan

* BAND: Band scan

« MODE: MODE scan
* DUP: Duplex scan

(Displayed only when Duplex is set)
* GROUP LINK: Group Link scan
« GROUP 00 ~99: Group scan
* TONE: Tone scan
(For the Tone Squelch scanning)
® When 2 or more Memory channels that are not set as
Skip channels are entered, the Memory scan is usable.
® The channel set as a Skip channel (PSKIP or SKIP) is
skipped during a scan. (p. 10-10)

TIP:

« During a scan, rotate [DIAL] to change the scanning
direction.

» During a scan, hold down [=Q)] to turn the Lock
function ON or OFF.

¢ The scan continuously runs, even if you push [MENU]
or [QUICK] during a scan.

¢ You can select a scan type by rotating [DIAL] while
holding down [SCAN]. Release [SCAN] to start the
scan.

<& About a Group scan name

When a group name is entered to a Memory channel
group, the name is displayed in the Scan Type Select

window. (p. 10-9)
® The name is not displayed during a scan.
® To enter the name, see page 9-11.

When the Group name is entered

10-9
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< Setting the Group Link

You can sequentially scan the memory groups which
are set to link on the MENU screen.
® In the default setting, all groups are set to link.

[MENU] > SET > Scan > Group Link

1. Push [MENU].
2. Select “Scan” in the “SET” menu.
3. Select “Group Link.”

SCAN 1/2
Fause Timer
Resume Timer
Temporary Skip Ti
Frogram Skip

Group Link
P-Scan Edge

4. Selectagroup, “00” ~“99,” “S: SKIP CH.”

Group Link 117

M01:
M0z
WA03:
M0a:
MA05:

5. Push [ENT] to turn the Link function ON or OFF.
« ‘4" is displayed when the function is set to “ON.”
® Push [QUICK] to quickly turn all the groups ON or

OFF.

@ To exit the MENU screen, push [MENU].

10-10

¢ Setting the skip channel

You can set or clear a Skip Channel setting.
The channels that are set as a Skip channel are
skipped during a scan.

1.

aprwdn

Push [MR] to enter

the Memory mode.

® For only the ID-50A, pushing [MR] each time selects
the Memory and Weather Channel modes.

Select the memory
Push [QUICK].
Select “SKIP.”
Select an option.

channel to be skipped.

-+ B 1200

146.330

e EROTETT
440000 ...

| «<—When a Skip channel is set,
“SKIP” or “PSKIP” is displayed.

* OFF: Cancels the Skip Channel setting.
e SKIP: Skipped during a Memory scan.
e PSKIP: Skipped during both VFO and Memory

scans.
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Temporary skip function

This function temporarily skips unwanted frequencies
(or memory channels) during a scan for the set
period of time or condition, without changing the Skip
Channel setting.

1. While a scan is paused, hold down [MW] for 1
second.
2. Select “Temp Skip Set.”

o & B 1700
I idds to SKIP MR 5
Temp Skip Set

« Sets the frequency or Memory channel as a Skip
Frequency or Channel.
» The scan automatically resumes.

TIP:

« Up to 20 Temporary Skip frequencies or Memory
channels can be set. When the 21st frequency
or Memory channel is set, the oldest setting is
automatically deleted.

* You can also set the Temporary Skip function in the
Quick Menu window.

« The Temporary Skip function is canceled when the
Temporary Skip Timer (Default: 5 min) has passed, or
when selecting “Temp Skip Cancel” in the Quick Menu
window.

(IMENU] > SET > Scan > Temporary Skip Timer)

10-11
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FM Repeater operation

A Repeater receives signals and on one frequency,
and then retransmits them on a different frequency.
When using a Repeater, the transmit frequency is
shifted from the receive frequency by a frequency
offset.

A Repeater can be accessed using the Duplex
function by setting the transceiver’s offset to the same
value as the Repeater’s offset.

See Section 5 for details on accessing a D-STAR
Repeater.

¢ Setting the Repeater frequency

1. Push [V/MHZ] to enter the VFO mode.
2. Push [MODE] to select the FM mode.

# B
mm

146.010

FEERIF

12:00

440.000

FSEIF

3. Rotate [DIAL] to set the frequency received from a
repeater.

4 B

1 45.500

FSEIF

12:00

FSEIF

440.000

TIP: For only the USA version
The Auto Repeater function (p. 11-5)
automatically sets the repeater settings (duplex
ON/OFF, duplex direction, tone encoder ON/
OFF). When the function is ON, steps 4 ~ 8 are
not necessary.
® You can turn OFF the function and manually set the
repeater settings.
(IMENU] > SET > Function > Auto Repeater)

4. Set the offset frequency and the Duplex direction.
(p 11-4)

- B 1200
Mi

145500

FSEIF

440.000

FSEIF

» The Duplex icon is displayed.

5. Set the Repeater tone. (Default: 88.5 Hz)
(IMENU] > SET > DUP/TONE... > Repeater Tone)
(p. 12-4)

6. Push [MENU] to exit the MENU screen.
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Repeater
RX: 144.900 MHz
TX: 145.500 MHz

Station A
RX: 145.500 MHz
TX: 144.900 MHz

Station B
RX: 145.500 MHz
TX: 144.900 MHz

~

Push [QUICK].
8. Select “TONE” and turn ON the Repeater Tone.

I 12:00

1 45. 500

FEERIF

FSEIF

440.000

* The TONE icon is displayed.
9. Hold down [PTT] for 2 seconds.
« If your transmit signal reached the repeater, after
releasing [PTT], you can hear the repeater’s call sign
in morse codes or its announcement.

Accessing Receiving from
a Repeater a Repeater
Push [PTT] for Receives the

2 seconds. Repeater’s call sign

10. Operate in the same way as a simplex call,
alternately transmit and receive.

Receive frequency Transmit frequency

-+ B 12:00
MFM D— TOME

145.500

FZEKIF

-+ B 12:00
MFM D— TOME

144.900

FZEIF

Shifts by the
offset amount

—

440.000

FZEIF FZEIF

440.000

TIP:

« When the repeater tone frequency or the frequency
offset is changed, the tone or offset for Auto Repeater
function is also changed.

« If the offset value causes the transmit frequency to be
out of the band, “OFF BAND” is displayed on the display
when you push [PTT], and transmit is inhibited. (p. 11-5)
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FM Repeater operation

< Checking the Repeater input signal

You can check whether or not that another station’s
transmit signal can be received directly (not through a
repeater), by listening to the repeater input frequency.

Hold down [SQL] to listen on the repeater input
frequency.

Display while monitoring

o] -+ B 12:00
BB Fm 0 ToME

144.900

FZEKIF

440.000 ...

® Information

« While monitoring, the status indicator lights green, and an
S/RF meter dot blinks.

« While monitoring, the displayed frequency automatically
changes to the transceiver transmit frequency (repeater
input frequency).

« When the other station’s signal can be directly received,
move to a non-repeater frequency, and use simplex.
(Duplex OFF)

11-3

<© 1750 Hz tone burst

A 1750 Hz tone is required to access many European
repeaters.

For only the ID-50E:
Push [PTT] briefly and release, and then hold down
[PTT] to transmit a 1750 Hz tone burst signal.

1. Push [MENU].
2. Select “DTMF/T-CALL” in the “SET” menu.

SET

2/3

B SPEECH N
HEDTMF/T-CALL

|
QS0/R¥ Loy v
R Function -
O Dizplayw 4
F Sounds >

3. Select “DTMF Memory.”
141

DTMF/T-CALL

DTMF Memory
DTMF Speed 3

4. Select “T-CALL.”

DTMF MEMORY 1/3

5. Push [MENU] to exit the MENU screen.

6. Rotate [DIAL] to set the frequency received from a
repeater.

7. Set the offset frequency and the duplex direction.
(p. 11-4)
» The duplex icon is displayed.

8. While holding down [PTT] to transmit, push [SQL]
to transmit a 1750 Hz tone signal.
« Accesses the repeater with a short tone burst.

9. Operate in a normal way.
® In the same way as a simplex call, alternately

transmit and receive.
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Duplex operation

The duplex operation shifts the transmit frequency
up or down from the receive frequency by an offset
amount.

¢ Setting the frequency offset

NOTE: The frequency offset cannot be changed
when using the DR function.

[MENU] > SET > DUP/TONE... > Offset Freq

1. Push [MENU].
2. Select “DUP/TONE..

SET 143
, DUP/TOME..

."in the “SET” menu.

MScan

M Scope

s Call Sign
& My Station
v OV Set

r v w v = Rl

3. Select “Offset Freq.”

DUP/TOME. ..

142

Offset Freg
Fepeater Tone
TSOL Freg
Tone Burst
OTCS Code
DOTCS Palarity

M
L3
3
L3
L3
L3

4. Rotate [DIAL] to set the offset.
Cffzet Freg

060000

® Information

» Set to between 0.000.00 and 59.99500 MHz.

» The selected tuning step in the VFO mode is used to
set the offset.

 To exit the MENU screen, push [MENU].

TIP: If the offset value causes the transmit frequency
to be out of the band, “OFF BAND” is displayed
when you push [PTT], and transmit will be inhibited.
(p. 11-5)
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¢ Setting the duplex direction

1. Push [QUICK].
2. Select “DUP.”

3. Select the duplex direction.
« OFF: For simplex operation (the receive and
transmit frequencies are the same).
* DUP-: The transmit frequency shifts down from the
receive frequency by the offset amount.
« DUP+: The transmit frequency shifts up from the
receive frequency by the offset amount.

12:00
m- TONE

145.500

FEKIF

440.000

FZEIF

« Displays “D-"or “D+.”

< Duplex operation

1. Hold down [SQL] to listen to the transmit
frequency to check whether another station is
transmitting on it, or not.

» The shifted transmit frequency is displayed.

2. Operate in a normal way.

@ In the same way as a simplex call, alternately
transmit and receive.

NOTE: When the Auto Repeater function is ON, and
the operating frequency is set out of the repeater
output frequency range, the Duplex mode is
automatically canceled.

(IMENU] > SET > Function > Auto Repeater)
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Auto Repeater function

When the operating frequency falls within the
Repeater output frequency range, the Auto Repeater
function automatically sets the Repeater settings
(Duplex ON/OFF, Duplex direction, Tone encoder ON/
OFF). The Auto Repeater function uses the preset
repeater tone frequency and frequency offset.

NOTE for the USA version:

When turned ON, the Auto Repeater function

has priority over the manual duplex setting. If the
transmit frequency changes after setting, the Auto
Repeater function may have changed the duplex
setting.

[MENU] > SET > Function > Auto Repeater

1. Push [MENU].
2. Select “Function” in the “SET” menu.

SET

B SFEECH

3 DTMF/T-CALL
Q50/Rx Log
R Function

/3

O Display
P Sounds

Select “Auto Repeater.
FUMCTION 144

Fower Save *
Monitor
Dial Speed-LUP

Remote MIC Key
Key Lock

L3
L3
Auto Repeater H
L3
3

Select the option to turn ON the Auto Repeater
function.

141

Auto Repeater
OFF

oM (DUP)
oM (DUP, TOME)

» OFF:
+ ON (DUP):

Turns OFF the function.

Turns ON only the duplex

operation. (Default)

* ON (DUP, TONE): Turns ON the duplex operation
and Tone encoder.

® To exit the MENU screen, push [MENU].

Frequency range and offset direction

Frequency range Shift direction
145.200 ~ 145.495 MHz “DUP-"is set
146.610 ~ 146.995 MHz “DUP-"is set
147.000 ~ 147.395 MHz “DUP+" is set
442.000 ~ 444.995 MHz “DUP+" is set
447.000 ~ 449.995 MHz “DUP-"is set
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Off band indication

If the transmit frequency is out of the amateur band,
the off band indication, “OFF BAND,” is displayed
when you push [PTT]. Check the frequency offset or
duplex direction in this case. (p. 11-4)

(] - B 12:00
AT F M-t

1 - N
CFF BAMND

FZEIF

440.000

F=EKIF
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Selecting an item

You can open the MENU screen by pushing [MENU].
You can use the MENU screen to set infrequently
changed values or function settings.

In addition to this page, see pages 12-4 through 12-32
for details of each item’s options and default values.

O MENU screen operation

Selects an item or option.

Switches between the Goes to the
MENU screen and | previous tree
the standby screen\@ fﬂ@ m level.
Goes to the Goes to the
previous tree ‘/L‘EJ ‘ H next tree level.
level.
oom°°°° ‘ “ Returns to the
default setting.

[ENT]  Selects an
Sets an option.  item or option.

Simplified description—'Select’ operation

In this manual, the user’s ‘Select’ operation is
simplified, as described below.

Simplified description:
1. Push [MENUL.
2. Select “30min.”

Operation:

1. Push [MENU] to open the MENU screen.

2. Push D-pad(!t) to select “30min,” and then push
[ENT].

TIP: The MENU screen is constructed in a tree
structure. You may go to the next tree level, or go
back a level, depending on the selected item.

MEMNLI /3

N

SET MEMORY

SET 1/3

Y DUPSTOME... ¥
M Scan 3
F
3
F
F

(M Scope

ez Call Sign
& My Station
wf D% Set

3

q ¥
2 DTMF/T-CALL »
iod OSO0/RY Loy »
R Function C
O Dizplay v
$ Sounds v

v

SET 3/3

& Time Set
B sD Card 3
Others v
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Selecting an item

¢ Selecting an item
Example: Set “Auto Power OFF” to “30 min.”

TIP: To return to the default setting

[MENU] > SET > Time Set > Auto Power OFF 1. Push [QUICK] in step 5.
1. Push [MENU] 2. Select “Default.”
2. Select “SET.” crc 1
3. Select “Time Set.” Default
SET 3/3
G Time Set
B 50D Card v
Others r

* The setting returns to the default.

4, Select “Auto Power OFF.”

TIME SET 141
Date/Time

GPS Time Correct
UTC Offzet

Auto Power OFF

L3
L3
L3
M

5. Select “30min.”

Auto Power OFF 1/
OFF

Z0min
BOmin
A0min
120min

* Sets the option, then goes back to a tree level.
(The TIME SET screen is displayed.)
@ To exit the MENU screen, push [MENU].
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NOTE: The default settings shown below are for the USA version. The default settings may differ, depending on

your transceiver version.

DUP/TONE...

Offset Freq (Default: 0.600.00%)

DTCS Code (Default: 023)

[MENU] > SET > DUP/TONE... > Offset Freq

Sets the frequency offset for Duplex (repeater)

operation to between 0.000.00 and 59.995.00 MHz.

® Push [VIMHZ] to select the 1 MHz tuning step.

® The Duplex shift direction (DUP—/DUP+) (p. 11-4) or the
tuning step is set in the Quick Menu window.

® When the DR function is ON, editing is disabled.

* The default value may differ, depending on the frequency
band (selected as the MAIN band before entering the
MENU screen) and the transceiver version.

Repeater Tone (Default: 88.5)

[MENU] > SET > DUP/TONE... > Repeater Tone

Selects a repeater tone frequency for repeater access
and other functions.
You can select 50 tone frequencies (67.0 ~ 254.1 Hz).

TSQL Freq (Default: 88.5)

[MENU] > SET > DUP/TONE... > TSQL Freq

Selects a CTCSS tone frequency for the Tone Squelch
function.
You can select 50 tone frequencies (67.0 ~ 254.1 Hz).

e Selectable Repeater Tone/TSQL frequencies
(Unit: Hz)

67.0 88.5 | 1148 | 151.4 | 177.3 | 203.5 | 250.3
69.3 91.5 | 1188 | 156.7 | 179.9 | 206.5 | 254.1
71.9 94.8 | 123.0 | 159.8 | 183.5 | 210.7
74.4 97.4 | 127.3 | 162.2 | 186.2 | 218.1
77.0 | 100.0 | 131.8 | 165.5 | 189.9 | 225.7
79.7 | 103.5 | 136.5 | 167.9 | 192.8 | 229.1
825 | 107.2 | 141.3 | 171.3 | 196.6 | 233.6
854 | 1109 | 146.2 | 173.8 | 199.5 | 241.8
Tone Burst (Default: OFF)

[MENU] > SET > DUP/TONE... > Tone Burst

Turns the Tone Burst function ON or OFF in the FM
mode when using the Tone Squelch function.

¢ OFF: When you transmit a signal that superimposes
the CTCSS tone, the other station may hear

a short burst of noise from their receiver, just
after you stop transmitting.

When you transmit a signal that superimposes
the CTCSS tone, the function mutes the noise
from being heard in the other station’s receiver.

¢ ON:

12-4

[MENU] > SET > DUP/TONE... > DTCS Code

Selects a DTCS (both encoder/decoder) code for the
DTCS Squelch.
You can select a total of 104 codes (023 ~ 754).

* Selectable DTCS codes

023 | 072 | 152 | 244 | 311 | 412 | 466 | 631
025 | 073 | 155 | 245 | 315 | 413 | 503 | 632
026 | 074 | 156 | 246 | 325 | 423 | 506 | 654
031 | 114 | 162 | 251 | 331 | 431 | 516 | 662
032 | 115 | 165 | 252 | 332 | 432 | 523 | 664
036 | 116 | 172 | 255 | 343 | 445 | 526 | 703
043 | 122 | 174 | 261 | 346 | 446 | 532 | 712
047 | 125 | 205 | 263 | 351 | 452 | 546 | 723
051 | 131 | 212 | 265 | 356 | 454 | 565 | 731
053 | 132 | 223 | 266 | 364 | 455 | 606 | 732
054 | 134 | 225 | 271 | 365 | 462 | 612 | 734
065 | 143 | 226 | 274 | 371 | 464 | 624 | 743
071 | 145 | 243 | 306 | 411 | 465 | 627 | 754

DTCS Polarity (Default: Both N)

[MENU] > SET > DUP/TONE... > DTCS Polarity

Selects the DTCS polarity to use for transmitting (TX)
and receiving (RX).

< Both N: Normal polarity is used for both TX and RX.
¢ TN-RR: Normal polarity is used for TX, Reverse
polarity for RX.

Reverse polarity is used for TX, Normal
polarity for RX.

Reverse polarity is used for both TX and
RX.

* TR-RN:

* Both R:

Digital Code (Default: 00)

[MENU] > SET > DUP/TONE... > Digital Code

Selects the digital code for Digital Code Squelch.
You can select a total of 100 codes (00 ~ 99).
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Scan

Pause Timer (Default: 10sec)

Program Skip (Default: ON)

[MENU] > SET > Scan > Pause Timer

Selects the Scan Pause Timer. When receiving a
signal, the scan pauses for this set period of time.

@ Individually selectable for A band and B band.

e 2sec ~ 20sec: When a signal is received, the scan
pauses for 2 ~ 20 seconds (in 2
second steps).

The scan pauses on a received
signal until the signal disappears.

e HOLD:

Resume Timer (Default: 2sec)

[MENU] > SET > Scan > Program Skip

Turns the Program Skip Scan function ON or OFF for

a VFO scan. This function enables the transceiver to

skip the unwanted frequencies that are entered as a

Memory channel and are set to “PSKIP.”

@ Individually selectable for A band and B band.

¢ OFF: The transceiver scans all frequencies.

¢ ON: The transceiver does not scan frequencies set
as “PSKIP” frequencies.

Group Link  (Default: [v] 00 ~ [v] 99/v] S: SKIP CH)

[MENU] > SET > Scan > Resume Timer

Selects the scan Resume Timer. When a received
signal disappears, the scan resumes for this set
period of time.

@ Individually selectable for A band and B band.

 Osec: The scan resumes immediately after
the signal disappears.

The scan resumes 1 ~ 5 seconds after
the signal disappears.

The scan remains paused for the
“Pause Timer” setting, even if the
signal disappears.

NOTE: Rotate [DIAL] to resume the scan.

e 1sec ~ 5sec:

* HOLD:

Temporary Skip Timer

[MENU] > SET > Scan > Temporary Skip Timer

Selects the effective time of the Temporary Skip

function.

@ Individually selectable for A band and B band.

@ This timer is activated for the VFO scan, Memory scan,
and DR scan.

¢ 5min/10min/15min: The Temporary Skip channels

are skipped for the set period

of time.

The Temporary Skip channels

are skipped until the Scan is

stopped.

The Temporary Skip channels

are skipped until the

transceiver is turned OFF.

(Default: 5min)

« While Scanning:

* While Powered ON:
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[MENU] > SET > Scan > Group Link

Selects groups to be scanned during a Group Link
Scan. The Group Link function scans all channels in
the selected groups.

Select a group, A ~ Z, and then push [ENT] to turn the
Link function ON or OFF.

@ Displays “¢¥” when the function is set to ON.

@ Individually selectable for A band and B band.

P-Scan Edge

[MENU] > SET > Scan > P-Scan Edge

You can delete, copy, or edit the upper and lower

frequencies for programmed scans.

The transceiver has a total of up to 25 frequency

ranges (00 ~ 24), and you can set the scan name,

tuning step, and operating mode for each scan edge.

® The default setting may differ, depending on the
transceiver version.
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Scan

Program Link

[MENU] > SET > Scan > Program Link

Sets the link function for two or more Program Scan
Edge ranges to be sequentially scanned during

a Program Link Scan. The link function scans all
frequencies in the scan range.

Default settings of the Program Link:

01: 144.000-148.000 j

02: 430.000-450.000

[Program Link

Program Link number (0to 9)  Program Scan Edge range

® The default setting may differ, depending on the
transceiver version.

® When only one Program Scan Edge range is entered, or
there is no Programmed Scan Edge is left, “Add” is not
displayed after pushing [QUICK].

DUP Check During MR Scan (Default: OFF)

[MENU] > SET > Scan > DUP Check During MR Scan

During a Memory scan, selects whether or not to scan
the offset frequency if Duplex is set on the channel.

« OFF: The offset frequency is not scanned.

* ON: The offset frequency is also scanned.
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Scope Mode (Default: Center)

AF Output (DUAL/AIR Band) (Default: OFF)

[MENU] > SET > Scope > Scope Mode

Selects the Band Scope display mode.

e Center: Displays signals around the
operating frequency within the
selected span.

The operating frequency is always
displayed in the center of the screen.
Displays signals within a specified
frequency range.

Displays signals within a specified
frequency range. When the operating
frequency moves outside of the
screen, the displayed frequency
range is automatically shifted.

e FIX:

« Scroll (FIX):

Waterfall Function (Default: ON)

[MENU] > SET > Scope > Waterfall Function

Selects whether or not to use the waterfall display in
the single display when the Band Scope function is
ON.

e OFF: Turns OFF the Waterfall display.

¢ ON: Turns ON the Waterfall display.

Waterfall Speed (Default: Fast)

[MENU] > SET > Scope > Waterfall Speed

Selects the waterfall speed.
« Slow: Sets the Waterfall speed to Slow.
» Fast: Sets the Waterfall speed to Fast.

FIX Mode Center Frequency

[MENU] > SET > Scope > FIX Mode Center Frequency

Sets the center frequency of the FIX mode Band

Scope for each band.

® The selected tuning step in the VFO mode is used to set
the center frequency. To select the tuning step, open the
Quick Menu window on the Standby screen.

® To return to the default setting, push [QUICK], and
then select “Default” on the “Center Freq. (FIX)” or
“FREQUENCY” screen.

® The default setting may differ, depending on the
transceiver version.
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[MENU] > SET > Scope > AF Output (DUAL/AIR Band)

Selects whether or not to momentarily output the

received audio during a sweep by the Band Scope

function, when using the Dualwatch function or

selecting the AIR band.

e OFF: No audio is output during the sweep.

* ON: The received audio is momentarily output
during the sweep.



12 seT MODE

Call Sign

Call Sign

Step 2. Gateway “R2” setting

[MENU] > SET > Call Sign

Set or view the “UR,” “R1,” “R2,” and “MY"” call signs
to use in the DV mode.

When not using the DR function, sets the call signs on
this screen.

For Simplex operation (DV mode)
You can set the “UR” and “MY” call signs.

For Duplex (repeater) operation

(DV mode/DR function)

You can set only the “MY” call sign when the DR
function is ON.

<To manually set the Duplex (repeater) operation>

Example: Making a gateway CQ call to Kirkland
repeater (N71H B) from the Hirano repeater
(JP3YHH A), in the DV mode.
® Before starting to set the call sign, set the frequency of
your Access repeater and duplex direction on the standby
screen.

TIP: When the Digital Repeater Set function is ON,
the repeater call sign is automatically set.

(IMENU] > SET > DV Set > Digital Repeater Set)

Step 1. Setting the call sign “R1”

1. Select “R1.

® DO NOT push [ENT].

Push [QUICK].

3. Select “Edit.”

Rotate [DIAL] to enter the first character.

® Selectable characters are alphanumeric characters

and symbol (“/").

5. Push D-pad (%) to move the cursor.

6. Repeat steps 4 and 5 to enter the repeater call
sign of up to 8 characters, including a space.
(Example: JP3YHH A)

7. After entering, push [ENT].

» Saves the entered repeater call sign.

N
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1. Select“R2."
® To manually enter a call sign, push [QUICK], then
select “Edit.”
2. Select “GW.”

About the RPT2 SELECT screen

NOT USED* For local area calls

To select the gateway call sign from the

i repeater list.

To select the repeater that has the

LR R same gateway as the “R1” repeater.

Step 3. Destination “UR” setting

1. Select “UR.”
® To manually enter a call sign, push [QUICK], then
select “Edit.”
2. Select “Gateway CQ.”
3. Select a repeater group where your destination
repeater is listed.
4. Select a destination repeater.

About the YOUR SELECT screen

To select “CQCQCQ" to make a non-

CRELQ call sign specific call.
Gateway CQ* To_select Gateway_CQ to make a call
using the repeater list.
. To select the destination “UR” call sign

el EE S using the Your Call Sign memory.

. To select the destination “UR” call sign
Rl using RX History.
TX History To select the destination “UR” call sign

using TX History.

* Not displayed in the Simplex mode.
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My Station

My Call Sign

TX Message

[MENU] > SET > My Station > My Call Sign

The transceiver has a total of 6 memories to save

your own call signs for use in the DV mode. You can

enter a call sign of up to 8 digits.

Also, you can enter a note of up to 4 characters, for

operating transceiver type, area, and so on.

® See D-STAR GUIDE in the Basic manual for MY Call Sign
entry.

® To select another My Call Sign, push D-pad(!1) to select
a call sign, and then push [ENT] on the MY CALL SIGN
screen.
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[MENU] > SET > My Station > TX Message

The transceiver has a total of 5 memories to save
short messages for transmission with your voice
signal in the DV mode.
Enter a message of up to 20 alphanumeric characters
for each memory.
® See page 5-17 for TX message entry.
® To select other TX message, push D-pad(i1) to select
a memory, and then push [ENT] on the TX MESSAGE
screen.

TIP: To transmit no message, select “OFF.”
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DV Set

RX Bass (Default: Normal)

Auto Reply (Default: OFF)

[MENU] > SET > DV Set > Tone Control > RX Bass

Selects the receive audio bass filter level.
e Cut: Reduces low frequencies.

« Normal: Normal tone balance.

* Boost: Increases low frequencies.

RX Treble (Default: Normal)

[MENU] > SET > DV Set > Tone Control > RX Treble

Selects the receive audio treble filter level.
e Cut: Reduces high frequencies.

« Normal: Normal tone balance.

* Boost: Increases high frequencies.

RX Bass Boost (Default: OFF)

[MENU] > SET > DV Set > Tone Control >
RX Bass Boost

Turns the Receive Audio Bass Boost function ON or

OFF.

@ This function is different from the “Boost” setting of “RX
Bass.”

¢ OFF: Turns OFF the function.

¢ ON: This function boosts the receive audio bass.

TX Bass (Default: Normal)

[MENU] > SET > DV Set > Tone Control > TX Bass

Selects the transmit audio bass filter level.
e Cut: Reduces low frequencies.

< Normal: Normal tone balance.

* Boost: Increases low frequencies.

TX Treble (Default: Normal)

[MENU] > SET > DV Set > Tone Control > TX Treble

Selects the transmit audio treble filter level.
e Cut: Reduces high frequencies.

* Normal: Normal tone balance.

* Boost: Increases high frequencies.
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[MENU] > SET > DV Set > Auto Reply

Selects an option for the Automatic Reply function in

the DV mode. This function automatically replies to a

call addressed to your own call sign (MY), even if you

are away from the transceiver.

e OFF: Turns OFF the function.

* ON: Replies with your own call sign (MY).

(No audio reply is sent)

Replies with your call sign (MY) and any

Auto Reply message recorded on the

microSD (up to 10 seconds).

® The transmitted audio can be monitored.

@ If no microSD card is inserted, or no
message is recorded, only your call sign is
transmitted.

Replies with your own call sign and

transmits your position data using the

internal GPS receiver.

® When “GPS Select” is set to “OFF” or
“Manual,” the internal GPS receiver is
temporarily turned ON.

® When “ON” or “Voice” is selected, the Automatic Reply
function is automatically turned OFF when you push
[PTT]. When “Position” is selected, the Automatic Reply
function is not turned OFF, even if you push [PTT].

* \oice:

* Position:

DV Data TX (Default: Auto)

[MENU] > SET > DV Set > DV Data TX

Selects whether to manually or automatically transmit

data in the DV mode.

e PTT: Push [PTT] to manually transmit data.

¢ Auto: When data is input from a PC through the
[USB] port, the transceiver automatically
transmits it.

Fast Data (Default: OFF)

[MENU] > SET > DV Set > DV Fast Data > Fast Data

Selects whether or not to use the DV Fast Data
function for data communication in the DV mode.
The DV Fast Data function uses the data and the
audio frames to send data approximately 3.5 times
faster than the normal speed. So, no audio can be
sent.
¢ OFF: Sends data at a slow speed
(approximately 950 bps).
¢ ON: Sends data at a fast speed
(approximately 3480 bps).
® Even if “ON” is selected, when you push [PTT], the data
is sent at the slow speed, because the audio frame is
used for the audio transmission.
® The GPS data speed is set in “GPS Data Speed.”
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[DAVATETS

GPS Data Speed (Default: Slow)

DV Auto Detect (Default: OFF)

[MENU] > SET > DV Set > DV Fast Data >
GPS Data Speed

Sets the GPS data speed when the data is sent using

the DV Fast Data function.

« Slow: Sends GPS data at slow speed
(approximately 950 bps).

« Fast: Sends GPS data at fast speed
(approximately 3480 bps).

TX Delay (PTT) (Default: 2sec)

[MENU] > SET > DV Set > DV Fast Data >
TX Delay (PTT)

Sets the time for when the transceiver returns to
receive after sending DV data in the DV Fast Data
mode using [PTT].

e OFF: After releasing [PTT], the transceiver
returns to receive.
* 1 ~ 10sec: After releasing [PTT], the transceiver

sends data using the DV Fast Data
mode for this set period.

When the TX data is completely sent
within this set period, the transceiver
automatically returns to receive.

NOTE: This function is usable only when “DV Data
TX"is setto “PTT.”

Digital Monitor (Default: Auto)

[MENU] > SET > DV Set > Digital Monitor

Selects a receive mode when pushing [SQL] in the DV
mode.

¢ Auto: Receives in the DV mode or the FM mode,
depending on the received signal.

« Digital: Receives in the DV mode.

* Analog: Receives in the FM mode.

Digital Repeater Set (Default: ON)

[MENU] > SET > DV Set > Digital Repeater Set

Turns the Digital Repeater Set function ON or OFF.
When accessing a repeater that has a call sign that
is different from the transceiver’s setting, this function
reads the repeater’s transmit signal and automatically
sets the repeater call sign.

¢ OFF: Turns OFF the function.

« ON: Automatically sets the repeater call sign.
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[MENU] > SET > DV Set > DV Auto Detect

Turns the DV mode Automatic Detect function ON

or OFF. When in the DV mode, if you receive a non-

digital signal, this function automatically sets the

operating mode to the FM mode.

¢ OFF: Turns the function OFF. The operating mode
is fixed to the DV mode.

* ON: Automatically selects the FM mode for
temporary operation.

RX Record (RPT) (Default: ALL)

[MENU] > SET > DV Set > RX Record (RPT)

The transceiver can record the data of up to 50
individual calls. When the received signal includes a
status message (“UR?” or “RPT?”") that is sent back
from the access repeater, you can record up to 50
messages, or only the last call, in the Received Call
Record.

e ALL: Records up to 50 calls.

 Latest Only: Records only the last call.

[RX>CS] Key (Default: Call Sign Capture)

[MENU] > SET > DV Set > [RX>CS] Key

Selects the [RX—CS] Call Sign Capture key operation
when you hold down.

 Call Sign Capture: While holding down, the RX
History is displayed. After
releasing, the last received call
station’s call sign is set to “TO”
(destination).

When you hold down for 1
second, the RX History is
displayed. Rotate [DIAL] to
select a call sign to set to “TO”
(destination), and then push
[ENT].

* RX>CS List:

BK (Default: OFF)

[MENU] > SET > DV Set > BK

The Break-in (BK) function enables you to break

into a conversation, where the two other stations are

communicating with call sign squelch enabled.

¢ OFF: Turns OFF the function.

¢ ON: Turns ON the function.

® The BK function is automatically turned OFF when the
transceiver is turned OFF.
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[DAVASTE

EMR (Default: OFF)

[MENU] > SET > DV Set > EMR

The Enhanced Monitor Request (EMR) function

enables all transceivers that receive an EMR signal

in the DV mode automatically to open their squelch to

receive the signal.

¢ OFF: Turns OFF the function.

¢ ON: Turns ON the function.

® The EMR function is automatically turned OFF when the
transceiver is turned OFF.

EMR AF Level (Default: 19)

[MENU] > SET > DV Set > EMR AF Level

Sets the audio output level when an EMR
communication mode signal is received. When an
EMR signal is received, the audio will be heard at the
programmed level, or the transceiver’s audio level,
whichever is higher.

To disable the setting, set to “0.”

NOTE: After an EMR signal disappears, the audio
level will remain at the EMR level. In this case, rotate
[VOL] to adjust the audio level.
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SPEECH

RX Call Sign SPEECH

(Default: ON (Kerchunk))

DIAL SPEECH (Default: OFF)

[MENU] > SET > SPEECH > RX Call Sign SPEECH

Turns the RX Call Sign Speech function ON or OFF
for calls received in the DV mode.

® Information

« When the Digital Squelch function is used, the calling
station’s call sign is not announced if the received signal
is not addressed to your call sign, or does not include a
matching digital code.

When you receive a signal from a repeater (“UR?” or
“RPT?"), the caller station’s call sign is not announced.
While scanning, the transceiver resumes the scan during
an announcement.

Even if a note is entered after the call sign, it is not
announced.

When you receive a signal during an announcement, the
transceiver cancels the announcement, and you can hear
the received audio.

e OFF: The caller station’s call sign is not
announced, even when a call is
received.

The caller station’s call sign is
announced only when they make a
quick transmission.

The caller station’s call sign is

always announced.

¢ ON (Kerchunk):

« ON (All):

RX>CS SPEECH (Default: ON)

[MENU] > SET > SPEECH > RX>CS SPEECH

Turns the RX>CS Speech function ON or OFF.

The RX>CS Speech function announces the station

call sign that is selected from a Received Call Record

by pushing [RX—CS].

@ If a call is received during an announcement, the received
audio is muted, and the audio is not recorded onto the
microSD card.

¢ OFF: The station call sign is not announced.
¢ ON: The station call sign is announced.
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[MENU] > SET > SPEECH > DIAL SPEECH

Turns the Dial Speech function ON or OFF.

The Dial Speech function announces the frequency or

repeater call sign that is selected by rotating [DIAL].

® When using the DR function, the frequency is announced
if the Simplex mode is selected or the FM repeater does
not have a call sign.

® When you receive a signal during an announcement, the
transceiver cancels the announcement, and you can hear
the received audio.

* OFF: The frequency or repeater call sign is not
announced.

The frequency or repeater call sign is
announced, 1 second after rotating [DIAL].

In the VFO, Memory, or Call Channel mode,
the frequency is announced.

When using the DR function, the repeater call
sign is announced.

¢ ON:

MODE SPEECH (Default: OFF)

[MENU] > SET > SPEECH > MODE SPEECH

Turns the operating mode announcement ON or OFF.
® During a VFO scan, the operating mode is announced
when you change the mode.
¢ OFF: The selected operating mode is not
announced.
¢ ON: The selected operating mode is announced.

SPEECH Language (Default: English)

[MENU] > SET > SPEECH > SPEECH Language
Sets the speech language to English or Japanese.

Alphabet (Default: Normal)

[MENU] > SET > SPEECH > Alphabet

Selects the type of phonetic announcement.
* Normal: Normal code is used.
(Example: A as eh, B as bee)
 Phonetic Code: The Phonetic code is used.
(Example: A as Alfa, B as Bravo)
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SPEECH

SPEECH Speed (Default: Fast)

[MENU] > SET > SPEECH > SPEECH Speed
Sets the speech speed to Fast or Slow.

SPEECH Level (Default: 7)

[MENU] > SET > SPEECH > SPEECH Level

Sets the Voice Synthesizer audio output level to

between 0 (OFF), 1 (minimum) and 9 (maximum).

® The voice synthesizer audio output level is linked with the
[VOL] setting from the minimum audio volume up to this
set level.
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DTMF/T-CALL

You can set the DTMF tone code and DTMF Memory
channel for DTMF tone operation.
See page 15-5 for details.

DTMF Memory (Default: d0)

[MENU] > SET > DTMF/T-CALL > DTMF Memory

Displays a list of the DTMF Memory channels.
e T-CALL: 1750 Hz tone burst signal
¢ dO ~ d#: DTMF memory channel list

DTMF Speed (Default: 100ms)

[MENU] > SET > DTMF/T-CALL > DTMF Speed

Selects the DTMF transmit speed.

¢ 100ms: Transmits the DTMF codes at about 100
milliseconds per code
(5 characters per second).

¢ 200ms: Transmits the DTMF codes at about 200
milliseconds per code
(2.5 characters per second).

¢ 300ms: Transmits the DTMF codes at about 300
milliseconds per code
(1.6 characters per second).

* 500ms: Transmits the DTMF codes at about 500
milliseconds per code
(1 character per second).
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QSO/RX Log

QSO Log (Default: ON)

Separator/Decimal (Default: Sepl,] Decl.])

[MENU] > SET > QSO/RX Log > QSO Log

Selects whether or not to make a communication log
on a microSD card. The communication log is made
on the card, and saved in the “csv” format.

® This function requires a microSD card (User supplied).

¢ OFF: The QSO Log function is OFF.

¢ ON: The transceiver makes a log on the microSD
card. The transceiver starts making a log
when you begin talking.

TIP:
¢ The folder name is automatically created, as
[ID-50\QsoLog].
« The file name is automatically created, as shown in the
example below:
Log start date and time: 1st June 2023 15:30:00
File name: 20230601_153000.csv
« The log contents are not displayed on the transceiver.
* You can display the log contents on a PC.

RX History Log (Default: OFF)

[MENU] > SET > QSO/RX Log > RX History Log

Selects whether or not to make a DV mode’s receive
history log on a microSD card. The receive history log
is made on a microSD card, and saved in the “csv”
format.

® This function requires a microSD card (User supplied).

¢ OFF: The RX History Log function is OFF.

¢ ON: The transceiver makes a DV mode’s receive
history log on the microSD card. The
transceiver starts making a receive history log
when you finish talking.

TIP:
« The folder name is automatically created, as
[ID-50\RxLog].
* The file name is automatically created, as shown in the
example below:
Log start date and time: 1st June 2023 15:30:00
File name: 20230601_153000.csv
« The log contents are not displayed on the transceiver.
* You can display the log contents on a PC.
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[MENU] > SET > QSO/RX Log > CSV Format >
Separator/Decimal

Selects the separator and the decimal character for

the CSV format.

® The default value may differ, depending on the
transceiver version.

e Sep [,] Dec [.]: Separator is “,”

e Sep [;] Dec [.]: Separator is ;"

e Sep [;] Dec []: Separator is ;"

“wn

and Decimal is “.

“wn

and Decimal is “.

“wn

and Decimal is “,

Date (Default: mm/dd/yyyy)

[MENU] > SET > QSO/RX Log > CSV Format >
Date

Selects the date format between “yyyy/mm/dd,”

“mm/dd/yyyy,” and “dd/mm/yyyy.”

(y: year, m: month, d: day)

® The default value may differ, depending on the
transceiver version.
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QSO/RX Log

The call log contents are shown below:

Contents Example Descriptions

TX/RX TX RX Transmission and reception

Date 06/01/2023 13:51:48 | 06/01/2023 13:51:48 | Date and time the call was started.

Frequency 438.010000 438.010000 Operating frequency

Mode DV DV Operating mode (FM/FM-N/DV)

. Your latitude (unit: degrees)
My Latitude 34.764667 34.764667 (+: North latitude, —: South latitude)
. Your longitude (unit: degrees)

My Longitude 135.375333 135.375333 (+: East longitude, —: West longitude)

My Altitude 50.5 50.5 Your altitude (unit: meters)
Records to one decimal place.

RF Power LOW (Blank) TX output power level

S meter (Blank) S0 The relative signal strength of the receive signal
(in 14 levels)

RPT Call Sign | JP3YHJ JP3YHJ A Repeater call sign (DV mode only)

TX Call Sign CQCQCQ (Blank) TX Call sign (DV mode only)

RX Call Sign (Blank) JA3YUAA/50 RX Call sign/Note (DV mode only)
Caller’s latitude, if sent. (unit: degrees)

RX Latitude (Blank) 34.764667 (+: North latitude, —: South latitude)
Records only when you receive in the DV mode.
Caller’s longitude, if sent. (unit: degrees)

RX Longitude (Blank) 135.375333 (+: East longitude, —: West longitude)
Records only when you receive in the DV mode.

. Caller’s altitude, if sent. (unit: meters)
RX Altitude (Blank) 30.5 Records only when you receive in the DV mode.
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QSO/RX Log

The RX log contents are shown below:

Contents Example Descriptions
Frequency 438.010000 RX Frequency
Mode DV Operating mode (DV mode is fixed)
Caller JA3YUAA Call sign of the caller station (up to 8 characters)
/ ID50 Note after the call sign (up to 4 characters)
Called CQCQCQ Call sign of the called station
Rx RPT1 IP3YHH G ?;"czisgsnri?sgherrl cc)igls;?;]aorf etggacizlrller station, or the gateway repeater
Rx RPT2 JP3YHH A Access repeater call sign of the called station
Message Hello CQ D-STAR! | Message included in the received call (up to 20 characters)
Status (Blank) Normal: blank, Uplink: “RPT UP”, Access repeater reply: “UR?” or “RPT?”

Received date

06/01/2023 13:51:48

Date and time the call was received
The format may differ, depending on the setting.

BK * BK call: “*”, Normal call: Blank

EMR * EMR call: “*”, Normal call: Blank

Latitude 34.764667 Caller’s latitude, if sent. (unit: degrees) (+: North latitude, —: South latitude)
Longitude 135.375333 Caller’s longitude, if sent. (unit: degrees) (+: East longitude, —: West longitude)
Altitude 30.5 Caller’s altitude, if sent. (unit: meters) Records to one decimal place.
SSID -A Caller’s SSID, if sent. (0, -1 to -15, -Ato -2)

D-PRS Symbol Car Icon: Converts to text, None: Code

Course 123 Caller’s course (unit: degrees)

Speed 23.5 Caller’s speed (unit: km/h) Records to one decimal place.

Power 49 TX power (unit; watts)

Height 24 Antenna height (unit: meters)

Gain 6 Antenna gain (unit: dB)

Directivity Omni Antenna directivity (Omni, 45, 90, 135, 180, 225, 270, 315, or 360)
Object/ltem Name |HAM FES Object name or Item name (up to 9 characters)

Data Type Live Object Data type of Object or Iltem (Live or Kill)

Temperature 20.5 Temperature (unit: °C) Records to one decimal place.

Rainfall 253.7 Rainfall (unit: mm) Records to one decimal place.

Rainfall (24 Hours) |253.7 Rainfall (24 Hours) (unit: mm) Records to one decimal place.

Rainfall (Midnight) |253.7 Rainfall (Midnight) (unit: mm) Records to one decimal place.

Wind Direction 315 Wind Direction (unit: degrees)

wind Speed 10.0 Wind Speed (unit: m/s) Records to one decimal place.

Gust Speed 10.0 Gust Speed (unit: m/s) Records to one decimal place.

Barometric 1013.0 Barometric (unit: hPa) Records to one decimal place.

Humidity 85 Humidity (unit: %)

GPS Time Stamp | 12:00:00 Time data that the caller station acquires along with the position data

GPS Message

Osaka City/ID-50

Caller is “NMEA": Records the GPS message
Caller is “D-PRS: Records the D-PRS comment
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Power Save (Default: Auto (Short))

Dial Speed-UP (Default: ON)

[MENU] > SET > Function > Power Save

Sets the Power Save function to reduce the current
drain and conserve battery power. When the Power
Save function is activated, the call sign or the
beginning of the signal may not be received correctly.

e OFF: Turns OFF the function.
¢ Auto (Short): Sets the Power saving time to
“Short.”
15ms
Standby -
Reception— ===
Disabled —I
75 ms

No signal is received
for 5 seconds.

* Auto (Middle): Sets the Power saving time to

“Middle.”
15ms 15 ms
Standby - -
Reception-»jl—l_|l—|l_|—,'¢J_|
Disabled | | 75 ms | 150 ms

T 60s
No signal is received
for 5 seconds.

e Auto (Long): Sets the Power saving time to

“Long .!1
15ms 15 ms
Standby - ’||—|k
Reception— - -- I | I
Disabled | 75 ms | 300 ms

T 60s
No signal is received
for 5 seconds.

NOTE: The Power Save function is disabled when:
 Using an external DC power source.

e Scanning.

 Using the DV Gateway function.

» Using the VOX function.

Monitor (Default: Push)

[MENU] > SET > Function > Monitor

Selects an option for the [SQL] Monitor function.

(Basic manual Section 3)

¢ Push: Hold down [SQL] to monitor the frequency.
Release to stop monitoring.

e Hold: Push [SQL] momentarily to monitor the
frequency and push momentarily again to
cancel it.
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[MENU] > SET > Function > Dial Speed-UP

Turns the Dial Speed Acceleration ON or OFF.

The acceleration automatically increases the tuning
speed when you rapidly rotate [DIAL].

e OFF: Turns OFF the function.

¢ ON: Turns ON the function.

Auto Repeater (Default: ON (DUP))

[MENU] > SET > Function > Auto Repeater

The Auto repeater function automatically turns the

duplex operation and tone encoder ON or OFF.

® This item is displayed for only the USA version.

* OFF: Turns OFF the function.

* ON (DUP): Turns ON the duplex settings
only.

* ON (DUP, TONE): Turns ON the duplex settings
and the tone encoder function.

Remote MIC Key

[MENU] > SET > Function > Remote MIC Key

The function assignments for the [A], [B], [A], and [V]

keys on the optional HM-243LS REMOTE CONTROL

SPEAKER MICROPHONE can be changed.

See pages 12-19 and 12-20 for the assignable key

functions.

« During RX/Standby: The assigned key function is
enabled while receiving or in
the standby mode.

(Default: [A]: BAND
[B]: VFO/MR
[A]l: UP
[V]: DOWN)

e During TX: The assigned key function is

enabled while transmitting.

(Default: [A]l: T-CALL
[B]: -
[A]
VI )

TIP: Volume level adjustment while monitoring

¢ When “VOL UP"/*VOL DOWN" are assigned, push
these keys to adjust the volume level.

* When “VOL UP"/“VOL DOWN?” are not assigned, but
“UP"/“DOWN" are assigned, push these keys to adjust
the volume level.

e When “VOL UP"/*VOL DOWN"/“UP"/“DOWN?” are not
assigned, push [A]/[V] to adjust the volume level, if
“Monitor (Push)” or “Monitor (Hold)” is not assigned to
[AVV].
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The assignable key functions
e During RX/Standby

Function Descriptions
No function
UP Push to increase the frequency, Memory channel, repeater, or station call sign.
DOWN Push to decrease the frequency, Memory channel, repeater, or station call sign.
VOL UP Push to increase the volume level.
VOL DOWN Push to decrease the volume level.
SQL UP Push to increase the squelch level.
SQL DOWN Push to decrease the squelch level.

Monitor (Push)

Hold down to open the squelch. Release to close the squelch.

Monitor (Hold)

Push to open or close the squelch.

CALL

Push to select a Call Channel mode.

MR (00-00 CH)

In the Memory mode, push to select Memory channel 00-00.

MR (00-01 CH)

In the Memory mode, push to select Memory channel 00-01.

VFO/MR Push to select the VFO mode and the Memory mode.

DR Push to turn the DR function ON or OFF.

FROM (DR) In the DR screen, push to select “FROM.”

TO (DR) In the DR screen, push to select “TO.”

Home CH Push t_o Qirectly select the Home Channel that is set to the _selected mode (VFO/Memory) or DR screen.
® While in the Call Channel mode, or when no Home CH is set, an error beep sounds.

BAND Push to select an operating band.

SCAN Push to start the previously selected scan. While scanning, push to stop the scan.

Temporary Skip

Push to set the frequency to be skipped while scanning.
The selected frequencies are temporarily skipped for faster scanning.

Hold down for 1 second to set the last calling station’s call sign to “TO” (destination).
@ If “[RX—CS] Key” is set to “RX > CS List,” the received call sign is not captured. The RX History list

RX>CS is displayed instead.
® To select the call sign in the RX History using the optional remote control speaker microphone,
assign “UP"/"“DOWN.”
« In the VFO, Memory, or Call Channel mode, push to announce the frequency and operating mode.
« In the DR screen, push to announce the call sign.
SPEECH @ If the Simplex mode is selected, the frequency is announced.
If the FM repeater is selected, the frequency and operating mode, or the call sign and operating
mode are announced.
 Push to set the A or B band as the MAIN band.
MAIN/DUAL « Hold down for 1 second to turn the Dualwatch function ON or OFF.
MODE Push to select the operating mode.
LOW Push to select the transmit output power.
DUP Push to turn the Duplex mode ON or OFF, and the shift direction to DUP+ or DUP-.
« In the FM/FM-N mode, push to select the tone type.
TONE/D.SQL « In the DV mode, push to select the digital squelch type.
MW In the VFO mode or on the DR screen, hold down for 1 second to enter the Memory channel contents
to a blank channel.
REC » Push to start recording.
< While recording, hold down for 1 second to stop recording.
. « Push to transmit the voice audio recorded on the microSD card once.
Voice TX

« Hold down for 1 second to repeatedly transmit the voice audio.
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The assignable key functions

e During TX
Function Descriptions
No function
VOL UP Push to increase the volume level.
VOL DOWN Push to decrease the volume level.
¢ Push to transmit the voice audio recorded on the microSD card once.
Voice TX * Hold down for 1 second to repeatedly transmit the voice audio.
® To make a repeat transmission, [PTT] must be released after the transmission is started.
T-CALL Push to transmit a 1750 Hz tone.
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Key Lock (Default: Normal) Active Band (Default: All)
[MENU] > SET > Function > Key Lock [MENU] > SET > Function > Active Band
Selects the key lock type when the Key Lock function Selects whether or not to enable continuous frequency
is ON. selection of the operating frequency across all bands
using [DIAL].

NOTE: Regardless of the setting, you can still use

[&], [PTT], and [rmO] even if the Key Lock function is « Single: When you rotate [DIAL] on the band edge,

the displayed band’s higher or lower

ON. :
frequency is selected.
« Normal: All keys and dials, except [SQL] and [VOL] * All:  When you rotate [DIAL] on the band edge,
are locked. the next band is selected.
« No SQL: All keys and dials, except [SQL] are locked. The selectable frequencies are set to all
« No VOL: All keys and dials, except [VOL] are locked. bands, for continuous selection.

« HAM: When you rotate [DIAL] on the band
edge, the amateur band’s higher or lower
frequency is selected. You cannot select a

PTT Lock (Default: OFF) frequency out of the amateur band.

. ® To select another band when “Single” is selected, push
[MENU] > SET > Function > PTT Lock [QUICK], then select “Band Select.”

e ALL: All keys and dials are locked.

Turns the PTT Lock function ON or OFF. ® This setting is for the [DIAL] operation, so all frequencies
To prevent accidental transmissions, this function are scanned.

inhibits all transmissions.

e OFF: Turns OFF the function. MIC Gain (Internal) (Default: 2)

¢ ON: Inhibits all transmissions.
[MENU] > SET > Function > MIC Gain (Internal)

Busy Lockout (Default: OFF) Sets the internal microphone gain to between 1
- (minimum) and 4 (maximum), to suit your operation
[MENU] > SET > Function > Busy Lockout needs.
Turns the Busy Lockout function ON or OFF. Higher values make the microphone more sensitive to
This function inhibits a transmission while receiving a your voice.

signal, or when the squelch is open.
e OFF: Turns OFF the function.

« ON: Turns ON the function. MIC Gain (External) (Default: 2)

[MENU] > SET > Function > MIC Gain (External)

Time-Out Timer (Default: 5min) Sets the external microphone gain to between 1
- - - (minimum) and 4 (maximum), to suit your operation
[MENU] > SET > Function > Time-Out Timer needs.
To prevent an accidental prolonged transmission, Higher values make the microphone more sensitive to
the transceiver has the Time-Out Timer function. The your voice.

function inhibits continuous transmissions longer than
this set period of time.
e OFF: Turns OFF the function.
¢ 1to 30 min: The transmission is cut OFF after the
set period of time ends
(1, 3,5, 10, 15, or 30 minutes).
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VOX (Default: OFF)

Cl-V Address (Default: AE)

[MENU] > SET > Function > VOX > VOX

Turns the Voice Operated Transmission (VOX)
function ON or OFF.
The VOX function starts transmission without pushing

[PTT] when you speak into the microphone, and

then, automatically returns to receive when you stop
speaking.

e OFF: Turns OFF the function.

e ON: Starts transmission without pushing [PTT]
when you speak into the microphone. Then
automatically returns to receive when you
stop speaking.

VOX Level (Default: 5)

[MENU] > SET > Function > VOX > VOX Level

Sets the VOX gain level to between 1 and 10, or OFF.
Higher values make the VOX function more sensitive
to your voice.
e OFF: Turns OFF the VOX function.
¢ 1~ 10: 1 (The minimum sensitivity)

10 (The maximum sensitivity)

VOX Delay (Default: 0.5sec)

[MENU] > SET > Function > VOX > VOX Delay

Sets the VOX Delay to 0.5, 1.0, 1.5, 2.0, 2.5, or 3.0
seconds. The VOX Delay is the amount of time the
transmitter stays ON after you stop speaking, before
the VOX switches to receive.

VOX Time-Out Timer (Default: 3min)

[MENU] > SET > Function > VOX >
VOX Time-Out Timer

Sets the VOX Time-Out Timer to prevent an accidental
prolonged transmission. To disable the function, set to
“OFF.”
e OFF: Turns OFF the function.
«1,2,3,4,5,10, or 15min:
If a continuous transmission exceeds the set
period of time, the transmission is stopped.

Headset Select (Default: Other)

[MENU] > SET > Function > VOX > Headset Select

Selects the headset type to be connected.
¢ HS-95: Select when using the HS-95.
e Other: Select when using the HS-94 or HS-97.

12-22

[MENU] > SET > Function > CI-V > CI-V Address

Sets the CI-V address in hexadecimal code.

® To distinguish devices, each CI-V transceiver has its own
Icom standard address. “AE” is the default address of
the ID-50A/ID-50E. When 2 or more ID-50A/ID-50Es are
simultaneously controlled by a PC, set a different address
for each transceiver between 02 and DF (hexadecimal).

CI-V Baud Rate (SP Jack) (Default: Auto)

[MENU] > SET > Function > CI-V >
CI-V Baud Rate (SP Jack)

Sets the CI-V data transfer speed when remotely
controlling the transceiver through the [SP] jack,

to 4800, 9600, 19200 bps, or Auto. When “Auto” is
selected, the baud rate is automatically set according
to the controller’s data rate.

Cl-V Transceive (Default: OFF)

[MENU] > SET > Function > CI-V > CI-V Transceive

Turns the Transceive function ON or OFF.

@ To use the RS-MS1A, set to “ON.”

¢ OFF: The status is not output.

¢ ON: The status is output. When you change
a transceiver setting, the same change
is automatically set on other connected
transceivers or receivers, and vice versa.

Cl-V USB—REMOTE Transceive Address (Default: 00)

[MENU] > SET > Function > CI-V >
Cl-V USBh—REMOTE Transceive Address

If you remotely operate your transceiver through

a USB cable when “CI-V Transceive” is set to ON,
the devices in the same system are also externally
controlled through the [SP] jack.

To prohibit the external control of an Icom transceiver,
set this value to other than “00.”

The control signal is output from the [SP] jack.

Select an address between 00 and DF (hexadecimal).
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USB Connect (Default: Serialport)

[MENU] > SET > Function > USB Connect

Selects the mode when connecting the transceiver to

a PC with a USB cable.

e Charge Only:
You can only charge the transceiver using a USB
cable.

« Serialport:
You can program the transceiver, input/output
D-STAR data, output GPS information, input
weather data, and remotely control the transceiver
using the CI-V commands.

® Information
« You need to install the USB driver.

« Select the input/output data type in “USB Serialport
Function.”

« Confirm that “GPS Select” is set to “ON,” when you output
the received position data.
(IMENU] > GPS > GPS Set > GPS Select)
e SD Card Mode:
You can transfer the files between the inserted
microSD card and a PC, using a USB cable.
® A confirmation dialog is displayed. (p. 2-9)

NOTE:

» To charge from a PC, set “USB Power Input (Phone,
Tablet, PC)” to “ON.”

¢ Use a data communication compatible USB cable when
“Serialport” or “SD Card Mode” is selected.

* While in the SD Card Mode, the transceiver works
not as a transceiver but as a data storage device. It
temporarily stops recording and logging.

TIP: Download the USB driver and the installation
guide from the lcom website.
https://www.icomjapan.com/support/
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USB Serialport Function
(Default: CI-V (Echo Back OFF))

[MENU] > SET > Function > USB Serialport Function

Selects the Serialport function for the USB connection

to a data device, PC, and so on.

¢ CI-V (Echo Back OFF):
The CI-V command is input or output
through the USB port. Does not send
back the CI-V command input from the
USB port.

* CI-V (Echo Back ON):
The CI-V command is input or output
through the USB port. Sends back the
CI-V command input from the USB port.

* DV Data: The DV data is input or output to the USB
port.

NOTE: When “CI-V (Echo Back OFF)" or “CI-V
(Echo Back ON)” is selected, you cannot remotely
control the transceiver through the [SP] jack.

Heterodyne (Default: Normal)

[MENU] > SET > Function > Heterodyne

Selects the 1st Local Oscillator frequency.

Depending on a combination of the two operating
frequencies in the Dualwatch mode, the transceiver
might generate a spurious signal on a specific receive
frequency. This may cause the S-meter to fluctuate,
even when no signal is received, for example.

If this occurs, the Heterodyne function may help. The
Heterodyne function shifts the 1st Local Oscillator
frequency to the opposite side of the signal to change
the frequency combination.
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Battery Pack Select (Default: BP-271/BP-272)

LO/CALL Key Actions (Default: Standard)

[MENU] > SET > Function > Battery Pack Select

Selects the model of the attached battery pack to
display the optimized battery status.

Battery Pack Confirmation (Default: OFF)

[MENU] > SET > Function > Battery Pack Confirmation

Selects whether or not to display the Battery Pack
Select dialog the first time the transceiver is turned
ON after reattaching a battery pack.

(Default: ON)

[MENU] > SET > Function > Charging (Power ON)

Selects whether or not to charge the battery pack
when the optional external DC power cable (CP-12L
or OPC-254L) is connected to [DC IN], even if the
transceiver is ON.

Charging (Power ON)

USB Power Input (Phone, Tablet, PC) (Default: ON)

[MENU] > SET > Function >
USB Power Input (Phone, Tablet, PC)

Selects whether or not to use a mobile device or a PC
as an external power source.

Screen Capture [PWR] Key (Default: OFF)

[MENU] > SET > Function > Screen Capture [PWR] Key

Assigns the Screen Capture function to [(h].
e OFF: [(b] does not act as the Screen Capture key.
« ON: Pushing [(h] captures the transceiver display
onto a microSD card.
® The captured screen is saved in the “bmp”
format.

[MENU] > SET > Function > LO/CALL Key Actions

Selects whether or not to change the [CALL], [LO],
and [MR] keys operation to the same as the ID-51A/E.
« Standard: The key’s operations do not change.

¢ ID-51 Compatible (CS/LOW):

The key’s operation change as described

below.

[CALL]: Hold down for 1 second to
change the transmit power
levels.

[LO]:  Inthe DV mode, hold down for
1 second to display the CALL
SIGN screen.

[MR]:  Push to enter the Memory mode,
and then push again to enter the
Call Channel mode.
®For only the ID-50A

In the Call Channel mode,
push to enter the Weather
Channel mode.

20)77=\ (@3 - [CALL]
(8 s
©@—@

00000000000 0
900000000000 o

[LO]
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Backlight (Default: Auto (DC IN:ON))

RX Call Sign (Default: Normal)

[MENU] > SET > Display > Backlight

Selects an option for the transceiver backlight.

* OFF: The backlight does not light.

e ON: The backlight lights continuously.

e Auto: The backlight lights when you push a key or
rotate [DIAL], and reduces the brightness*
after the set period of time in “Backlight Timer.”

¢ Auto (DC IN:ON):

The backlight lights when you push a key or

rotate [DIAL], and reduces the brightness*

after the set period of time in “Backlight Timer.”

®When an external DC power source is
connected, lights continuously.

® When using the GPS Logger Only mode, “Auto” is

automatically selected.
* When “Dim Screen” is set to “OFF,” the backlight goes out
after the set period of time in “Backlight Timer.”

Backlight Timer (Default: 10sec)

[MENU] > SET > Display > Backlight Timer

Sets the Backlight Timer to 5, 10, or 30 seconds.

Depending on the “Backlight” setting, the backlight

lights for this set period of time, and then automatically

reduces the brightness.

® When “Dim Screen” is set to “OFF,” the backlight goes out
after this set period of time.

Brightness (Default: Bright)

[MENU] > SET > Display > Brightness
Selects the backlight brightness level.

Contrast (Default: 8)

[MENU] > SET > Display > Contrast

Sets the display contrast to between 1 (lowest) and
16 (highest).

Busy LED (Default: ON)

[MENU] > SET > Display > Busy LED

Selects whether or not to light the TX/RX indicator

while receiving a signal, or the squelch is open. To

conserve battery power, turn OFF this function.

® The indicator lights red while transmitting, regardless of

the setting.

* OFF: The indicator does not light, even if a signal is
received.

¢ ON: The indicator lights green while receiving a
signal, or the squelch is open.
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[MENU] > SET > Display > RX Call Sign

In the DV mode, selects whether or not to display the

call sign and the message of the caller station when a

call is received.

e OFF: Does not display the caller station’s call

sign and message.

The caller station’s call sign and message

automatically scroll once, and then

disappear.

The caller station’s call sign and message

automatically scroll once, and then the

call sign is displayed on the transceiver’s

display until the signal disappears.

The caller station’s call sign and message

automatically scroll once, and then the

call sign is displayed on the transceiver’s

display until the signal disappears.

When the signal disappears, the call sign

and the message are each repeatedly

displayed for 2 seconds.

® When “Normal,” “RX Hold,” or “Hold" is selected, and if
the call sign and name of the caller station is entered in
your memory, the name is displayed after displaying the
call sign.

* Normal:

« RX Hold:

* Hold:

RX Position Indicator (Default: ON)

[MENU] > SET > Display > RX Position Indicator

Selects whether or not to display the indicator when
position data is included in the signal received in the
DV mode.
¢ OFF: No indicator is displayed, even though the
position data is included in the received
signal.
¢ ON: The indicator is displayed when the position
data is included in the received signal.
® When “RX Call Sign” is set to “OFF,” the indicator is not
displayed, even though position data is included in the
received signal.
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RX Position Display (Default: ON (Main/Sub))

DV RX Backlight (Default: ON)

[MENU] > SET > Display > RX Position Display

Selects whether or not to display position data in

a dialog when the caller station’s position data is

included in the signal received in the DV mode.

¢ OFF: No data is displayed in a dialog.

* ON (Main/Sub):
When the caller station’s position data is
included in the signal, its data is displayed in
a dialog.

* ON (Main Only):
When the caller station’s position data is
included in the signal received in the MAIN
band, its data is displayed in a dialog.

® The time period to display the dialog depends on the “RX

Position Display Timer” setting.

RX Position Display Timer (Default: 10sec)

[MENU] > SET > Display > RX Position Display Timer

Sets the RX position data’s time period to display in a
dialog.

« 5/10/15/30sec: Displays the caller’s position for this
set period of time.

Displays the caller’s position until
you operate the transceiver.

* Hold:

Reply Position Display (Default: ON)

[MENU] > SET > Display > Reply Position Display

Selects whether or not to display the caller’s position

data when the data is included in the Auto Replay

signal.

« OFF: Does not display the caller’s position data.

« ON: Automatically displays the caller’s position
data.

RX Picture Indicator (Default: ON)

[MENU] > SET > Display > RX Picture Indicator

Selects whether or not to display the RX Picture
Indicator when a picture is included in the received
signal.
« OFF: No indicator is displayed, even if a picture is
included in the received signal.
¢ ON: The indicator is displayed when a picture is
included in the received signal.
® When “RX Call Sign” is set to “OFF,” the indicator is not
displayed, even if a picture is included in the received
signal.
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[MENU] > SET > Display > DV RX Backlight

Turns the DV RX Backlight function ON or OFF.

In the DV mode, this function turns ON the backlight

while displaying the calling station’s call sign or a

received message.

e OFF: Turns OFF the function.

¢ ON: The backlight automatically lights when
displaying the calling station’s call sign or a
received message. The backlight stays ON
while the call sign or message is scrolling.

NOTE: When you set this item to “ON,” set
“Backlight” to “Auto” or “Auto (DC IN:ON).”

TX Call Sign (Default: Your Call Sign)

[MENU] > SET > Display > TX Call Sign

Selects whether or not to display the My or Your call

sign while transmitting.

e OFF: Turns OFF the function.

« Your Call Sign: Displays and scrolls the call sign of

the target station.

e My Call Sign: Displays and scrolls your own call sign.

® When “Your Call Sign” is selected, and if the call sign and
name of the caller station is entered in your memory, the
name is displayed after the call sign, in any DV mode
except when using the DR function.

Scroll Speed

[MENU] > SET > Display > Scroll Speed

Sets the scrolling speed of the message, call sign, or
other text, that are displayed on the screen to “Slow”
or “Fast.”

(Default: Fast)

Opening Message (Default: ON)

[MENU] > SET > Display > Opening Message

Selects whether or not to display the opening
message at power ON.

When you set this item to “ON,” Icom logo, MY call
sign, and the model are displayed.
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Voltage (Power ON) (Default: ON)

Rainfall (Default: inch)

[MENU] > SET > Display > Voltage (Power ON)
Selects whether or not to display the voltage of the
battery or external DC power source at power ON.

NOTE: When the external DC power source voltage
is above 15.6V, “HI Voltage” is displayed. In that
case, immediately disconnect the DC power source.

Single Band Display (Default: Date)

[MENU] > SET > Display > Single Band Display

Selects to display the date or GPS information at the
bottom of the Single band display.

e Date: Displays the date.

« GPS Information: Displays the GPS information.

Latitude/Longitude (Default: ddd® mm.mm’)

[MENU] > SET > Display > Display Unit >
Latitude/Longitude

Selects the format to display the position data.

Altitude/Distance (Default: ft/mi)

[MENU] > SET > Display > Display Unit >
Altitude/Distance
Selects the format to display the distance and elevation.

® The default value may differ, depending on the
transceiver version.

Speed (Default: mph)

[MENU] > SET > Display > Display Unit > Speed

Selects the format to display the speed.
® The default value may differ, depending on the
transceiver version.

Temperature (Default: °F)

[MENU] > SET > Display > Display Unit > Temperature

Selects the format to display the temperature.
® The default value may differ, depending on the
transceiver version.

Barometric (Default: inHg)

[MENU] > SET > Display > Display Unit > Barometric

Selects the format to display the barometric pressure.
® The default value may differ, depending on the
transceiver version.
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[MENU] > SET > Display > Display Unit > Rainfall

Selects the format to display the amount of rainfall.
® The default value may differ, depending on the
transceiver version.

Wind Speed (Default: mph)

[MENU] > SET > Display > Display Unit > Wind Speed

Selects the format to display the wind speed.
® The default value may differ, depending on the
transceiver version.
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(Default: English)

Display Language

[MENU] > SET > Display > Display Language

Sets the screen display language to English or

Japanese.

® This item is displayed only when “System Language” is
set to “Japanese.”

System Language

(Default: English)

[MENU] > SET > Display > System Language

Sets the system language of the transceiver.

e English: The system language of the transceiver
is English. Only alphabetical characters
(Ato Z,ato z, 0to 9) and symbols (! “ #

$%& ()*+,-./:;<=>?2@[\]"_"

{|}~) can be displayed.

If Japanese characters (Kanji, Hiragana,

and Katakana) are included, the

display shows or“_"instead of that

character. In that case, you can only

delete “=" or “_"in the transceiver’s edit

mode.

The system language of the transceiver

is Japanese. Kaniji, Hiragana, and

Katakana characters, and the 2-bytes

symbols can be displayed. To display

such characters in the DR screen or

Menu mode, set “Display Language” to

“Japanese.”

® When this item is set to “English,” “Display Language” is
not displayed.

e Japanese:
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When you set the system language of the
transceiver to Japanese, the transceiver has the
capability to display both English and Japanese
characters. HOWEVER, if you select Japanese, all
menu items throughout the transceiver system will
be displayed in only Japanese characters. There will
be no English item names. Unless you are fluent in
reading Japanese characters, use this feature with
extreme caution.

If you have change the transceiver’s language to
Japanese and do not understand the menu system
in the new setting, you will have to change the
language back to English by doing a partial reset
of the transceiver CPU. A partial reset will not clear
your call sign databases.

To do a partial reset of the CPU, do the following steps:
1. Push [MENU]I.

2. Select “SET.”
MENLI a3
7
%
SET AEU-EE

3. Select the item (with the “etc” icon) shown below.
3/3

SET

G BHEGE *
B s — K *
Z (i

4. Select the bottom item shown below.
Z [xith 141
F iR v
00— '

5. Select the upper item shown below.

Uty b
H— L4 b

A— Utz v b

1/1

® DO NOT select the lower item. The lower item is
for the All reset function, and the All reset clears all
entries and returns all settings to their factory defaults.
6. Select the upper option.
Uty | 141

Ji—rw Uty b
LETm?

LT

* When the partial reset is completed, “PARTIAL
RESET” is displayed, then the display automatically
returns to the default screen.
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Volume Select (Default: All)

Beep Level (Default: 3)

[MENU] > SET > Sounds > Volume Select

Select whether or not to adjust the audio output level
independently, according to the operating status.

o All: The audio output level for the FM Radio,
A band (VFO A), and B band (VFO B) are
adjusted at the same time.

¢ FM Radio Separate:

The audio output level for the FM Radio

is independently adjusted. The audio

output level for A band (VFO A) and B

band (VFO B) are adjusted at the same

time.

The audio output level for the FM Radio,

A band (VFO A), and B band (VFO B) are
independently adjusted.

NOTE: When an EMR signal is received, the audio

output level for A band and/or B band may be set to

the selected level in “EMR AF Level,” depending on

this setting.

® The audio output level for the FM Radio is not changed,
because the EMR function is for the DV mode
operation.

e Separate:

When “All” or “FM Radio Separate” is selected:
The audio output level for A band and B band is set
to the selected level in “EMR AF Level.”

When “Separate” is selected:

Either the audio output level for A band or B band
that the signal is received on, is set to the selected
level in “EMR AF Level.”

FM Radio Level (Default: 0)

[MENU] > SET > Sounds > FM Radio Level

Sets the initial audio output level difference between

the FM Radio and the A and B bands when “Volume

Select” is set to “All.”

* +5 ~ +1: The FM Radio audio output level is higher

than the VFO mode audio.

The FM Radio audio output level is the

same as the VFO mode audio.

¢ -5 ~-1: The FM Radio audio output level is lower
than the VFO mode audio.

e 0:

Earphone Mode (Default: OFF)

[MENU] > SET > Sounds > Earphone Mode

Turns the earphone mode ON or OFF.

While in the earphone mode, the audio volume level is
automatically adjusted to the comfortable level when
the optional earphone is connected to the [MIC/SP]
jack.
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[MENU] > SET > Sounds > Beep Level

Sets the beep output level to 0 (OFF) or 1 (minimum)
~ 9 (maximum).

Beep/Vol Level Link (Default: OFF)

[MENU] > SET > Sounds > Beep/Vol Level Link

Selects whether or not the beep output level can be

adjusted by rotating [VOL].

¢ OFF: The output level is fixed to the level set in
“Beep Level.”

¢ ON: The output level can be adjusted by rotating

[VOL].

Key-Touch Beep (Default: ON)

[MENU] > SET > Sounds > Key-Touch Beep

Turns the confirmation beep ON or OFF.
¢ OFF: No beep sounds.
¢ ON: Abeep sounds when you push a key.

Home CH Beep (Default: ON)

[MENU] > SET > Sounds > Home CH Beep

Turns the Home CH Beep ON or OFF.

¢ OFF: No beep sounds.

¢ ON: A beep sounds when you select the Home

Channel.

@ In the VFO or Memory mode, when the Home Channel
frequency or the Home Channel Memory is selected, the
Home CH Beep sounds.

@ In the DR screen, when the Home Channel Access
repeater is set in FROM, the Home CH Beep sounds.

Band Edge Beep (Default: OFF)

[MENU] > SET > Sounds > Band Edge Beep

Turns the Band Edge Beep ON or OFF.

¢ OFF: No beep sounds.

¢ ON: Abeep sounds when you tune out of, or back
into the AIR, VHF, and UHF band’s frequency
range.

Scan Stop Beep

[MENU] > SET > Sounds > Scan Stop Beep

Turns the Scan Stop Beep ON or OFF.

¢ OFF: No beep sounds.

¢ ON: A beep sounds when a scan stops by
receiving a signal.

(Default: OFF)
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Standby Beep (Default: ON (to me:Alarm/High Tone))

DATE

[MENU] > SET > Sounds > Standby Beep

Turns the Standby Beep function ON or OFF.

This function sounds a beep after a received signal

disappears, in the DV mode.

* OFF: Does not sound a beep after a received signal
disappears.

* ON: Sounds a beep after a received signal
disappears.

* ON (to me:High Tone):
Sounds a high pitched beep when a received
signal that is addressed to your call sign (MY)
disappears. When any other received signal
disappears, a regular beep sounds.

* ON (to me:Alarm/High Tone):
Sounds alarm (PiRoPiRoPiR0) when a
received signal that is addressed to your
call sign (MY) disappears. When any other
received signal disappears, a regular beep
sounds.

® The standby beep sounds even when “Key-Touch Beep”

is set to “OFF.”
® The standby beep output level depends on the “Beep
Level” setting.

Sub Band Mute (Default: OFF)

[MENU] > SET > Sounds > Sub Band Mute

Selects whether or not to mute the SUB band audio
signal while receiving on the MAIN band, and/or
sound a beep when a signal disappears on the SUB
band.

e OFF: Turns OFF the function.

¢ Mute: While receiving on the MAIN band,
the SUB band audio signal is muted.

« Beep: When a signal disappears on the

SUB band, a beep sounds.
« Mute & Beep: While receiving on the MAIN band,
the SUB band audio signal is muted.
When a signal disappears on the
SUB band, a beep sounds.
® When you set this item to “Beep” or “Mute & Beep,” a
beep sounds, even if no signal is received on the MAIN
band.

[MENU] > SET > Time Set > Date/Time > DATE

Manually set the date to between 2020/01/01 and

2099/12/31.
® The day of the week is automatically set.

TIME

[MENU] > SET > Time Set > Date/Time > TIME

Manually set the time that is displayed at the top of the
screen. The time is displayed in the 24 hour format.
When “GPS Time Correct” is set to “Auto,” the GPS
receiver automatically sets the time by calculating the
received Universal Time of Coordinated (UTC) time
and “UTC Offset.”

GPS Time Correct (Default: Auto)

[MENU] > SET > Time Set > GPS Time Correct

Selects whether or not the time data is automatically

corrected by a received GPS sentence.

* OFF: Does not correct the time.

« Auto: Automatically corrects the time by calculating
the received UTC time and the “UTC Offset”
setting.

UTC Offset

[MENU] > SET > Time Set > UTC Offset

Sets the UTC offset time to between —14:00 and
+14:00.

(Default: £0:00)

Auto Power OFF

[MENU] > SET > Time Set > Auto Power OFF

Selects whether or not to automatically turn OFF the
transceiver after inactivity for this set period of time.
® “AUTO POWER OFF” is displayed and beeps sound
5 seconds before turning OFF the transceiver. If you
operate the transceiver during this period of time, the
Auto Power OFF timer is reset.
* OFF: Does not turn OFF the transceiver.
 30/60/90/120min:
Turns OFF the transceiver after inactivity for
this set period of time.

(Default: OFF)
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SD Card

Load Setting

Date (Default: mm/dd/yyyy)

[MENU] > SET > SD Card > Load Setting
Selects the saved data file to load.

Save Setting

[MENU] > SET > SD Card > Save Setting
Saves the setting data onto a microSD card.

Import

[MENU] > SET > SD Card > Import/Export > Import

Import the Memory channel contents, Radio memory
contents, UR call sign, repeater list, or GPS memory
data in the CSV format file.

Export

[MENU] > SET > SD Card > Import/Export > Export

Export the Memory channel contents, Radio memory
contents, UR call sign, repeater list, or GPS memory
data in the CSV format file.

Separator/Decimal (Default: Sep[,] Decl.])

[MENU] > SET > SD Card > Import/Export >
CSV Format > Separator/Decimal

Selects the separator and the decimal character for

the CSV format.

® The default value may differ, depending on the
transceiver version.

e Sep [,] Dec [.]: Separatoris “,”

e Sep [;] Dec [.]: Separator is *;”

* Sep [;] Dec [,]: Separator is “;”

wn

and Decimal is “.

wn

and Decimal is “.

wn

and Decimal is “,
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[MENU] > SET > SD Card > Import/Export >
CSV Format > Date

Selects the date format between “yyyy/mm/dd,”

“mm/dd/yyyy,” and “dd/mm/yyyy.”

(y: year, m: month, d: day)

® The default value may differ, depending on the
transceiver version.

SD Card Info

[MENU] > SET > SD Card > SD Card Info

Displays the microSD card capacity and the time
remaining for voice recording.

Screen Capture View

[MENU] > SET > SD Card > Screen Capture View
Displays the selected screen capture.

Firmware Update

[MENU] > SET > SD Card > Firmware Update
Displays the Firmware Update mode.

Format

[MENU] > SET > SD Card > Format

Formats the microSD card.
If you use a brand new microSD card, be sure to
format it in the transceiver.

Unmount

[MENU] > SET > SD Card > Unmount

Unmounts the microSD card.

Before you remove a card when the transceiver is ON,
be sure to electrically unmount it. Otherwise, the data
may be corrupted or deleted.
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Voltage

[MENU] > SET > Others > Information > Voltage

Displays the voltage of the battery pack and external

power source.

® When you attach the Li-ion battery pack, the charge
status of the battery pack and the battery voltage are
displayed.

® When you attach the optional battery case, the battery
case’s terminal voltage is displayed.

Version

[MENU] > SET > Others > Information > Version
Displays the transceiver firmware’s version number.

Clone Mode

[MENU] > SET > Others > Clone > Clone Mode

Enters the clone mode to read or write the CS-50 data
from or to the PC.
@® Restart the transceiver to cancel the clone mode.

Partial Reset

[MENU] > SET > Others > Reset > Partial Reset

Resets operating settings to their default values (VFO
frequency, VFO settings, menu contents).
® See page 15-18 for details.

All Reset

[MENU] > SET > Others > Reset > All Reset

Clears all data and returns all settings to their factory
defaults.

Memory channel contents, Repeater list, and so on
will all be cleared, so you will need to rewrite your
operating settings.

® See page 15-18 for details.
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Section 6 for details on how to
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and precautions.
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About the Share Pictures function

With this function, you can send a picture that is saved
on a microSD card, and view a received picture.

® Information

* You must insert a microSD card into the transceiver.

* To use this function, first format microSD card using the
transceiver.

* You cannot use this function while operating in the Access
Point mode.

NOTE:

» Even if no microSD card is inserted into the transceiver,
a picture can be received, but the picture is not saved in
RX Picture History.

@ A picture received before inserting a microSD card
is deleted when you insert an SD card into the
transceiver.

* DO NOT remove the microSD card from the transceiver
while using the Share Picture function. Otherwise, the
card data may be corrupted or deleted.

« If the card data is not in a supported format, or it is
corrupted, an error dialog is displayed.

In that case, select “YES” to delete the data that is not
in a supported format or corrupted.

About a picture file to use:
* File type: dat
* Picture size*: 640 x 480, 320 x 240, or 160 x 120 (px)
 File name: up to 23 characters
(except a filename extension)
*The transceiver cannot read a picture that is other than the
specified size, even if its aspect ratio is 4:3.
® The transceiver displays only 50 pictures, even if you
save more than 51 pictures onto the microSD card.
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About the free download software:

With the ST-ID50A (for Android), you can add text

and cut pictures down to size to send from the

transceiver. The edited picture can be transferred to

the transceiver through a USB cable.

@ Before using, read the software’s manual, and use the
software according to the instructions.

@ In this manual, the ST-ID50A is described as “Picture
Utility software.”

To transfer a picture to the transceiver:

Connect your mobile device and your transceiver

using a USB cable (User supplied).

® Confirm your USB cable is usable for data transfer and
not for charging only (p. 16-6).

Viewing the received picture:
The mobile device and the Picture Utility software is

required to view the received picture.
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Using the Picture screen

[MENU] > PICTURE

1. Push [MENU]I.
2. Select “PICTURE.”
» The Picture screen is displayed.
® Push [CLR] to close the Picture screen.

] < B 1200
=]
146.010
FSEIF
FHl
440.000 —
100% i 1715
15:33:00 (20 1
L I I I |
RX Picture zone* TX Picture zone
Select to display the Select to display the
RX PICTURE screen. TX PICTURE screen.

* When signals that contain picture data are received on the
MAIN and SUB bands at the same time, both pictures are
saved on a microSD card, but only the information of the
image received on the MAIN band is displayed.

TIP: You can operate the MAIN band even while the
Picture screen is displayed.
® Push D-pad(T) to move to the MAIN band
operation.
® Push D-pad(!) again to return to the Picture screen
operation.

In the Quick Menu window, you can select the
following options.

Item Action

Turns OFF the Share

OFF Pictures function.

Turns ON the Share
Pictures function.

Picture TX . ® The picture is sent while
Single TX transmitting. After the
sending is completed, this
function is turned OFF.

Repeat TX |The picture is repeatedly sent.

Sends the picture using the DV Fast

<< >> .
TXAl Data function.

Moves the TX Line marker back to the

<<Back To 1st>> 1st Line.

<<Exit Picture

Screen>> Closes the Picture screen.

When a received signal contains picture data:
When the received signal contains picture data, the
RX Picture icon ‘" is displayed.

@ You can turn OFF the RX Picture icon.

(IMENU] > SET > Display > RX Picture Indicator)
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The RX PICTURE screen:
® Push D-pad(i1) to display the RX Picture history.
(p. 13-7)

B PICTURE
[LAST) - History number
Size: 1602120 <— Picture Size
Quality: Low <€— Picture Quality
From: IM1ZLE
RCYR: COCOCo<€— Receiver

20 16:33:00) «—— Received time

The TX PICTURE screen:

® Push [ENT] to display the TX PICTURE SET
screen.

® Push D-pad(i1) to display the TX Picture history.
(p. 13-7)

TH PICTURE

v

T FICTURE SET 1/7
T Picture

210

Picture Size .
220240

Picture Quality

High (75%)"
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Preparing a TX picture

< Transfer from the mobile device
through a USB cable

1. Insert a microSD card into the transceiver’s slot,
and then turn ON the transceiver.

2. Connect the transceiver and your mobile device
through the USB cable, and then open the Picture
Utility software in the mobile device.
® See the ST-ID50A’s instruction manual for details of

the Picture Utility software.

3. Open a picture to transfer using the Picture Utility
software.

4. Touch the Transfer (&) button.

« Starts transferring, and the transferred picture is
saved on the microSD card.

® The file name is automatically set in the following
format: YYYYMMDD_hhmmss (YYYY: Year, MM:
Month, DD: Day, hh: hour, mm: minute, ss: second).

NOTE: Unmount the microSD card before removing
it. Removing without unmounting may lose or
damage the data.

NOTE: If you cannot transfer the picture, check the
following:

On the transceiver:

e The transceiver is turned ON.

The transceiver’s firmware is the latest version.

A microSD card is inserted into the transceiver.

The transceiver is in a normal operating mode.

® The transceiver cannot transfer the picture in special
modes, such as the clone mode, firmware update
mode, import or export mode, or setting save mode.

* “USB Connect” in the Set mode is set to “Serialport.”
(IMENU] > SET > Function > USB Connect)

On the mobile device:
» The transceiver is connected through the USB cable.

USB cable:
« Usable for data transfer and not for charging only.
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Sending the picture

Step 1. Selecting a picture to send

Step 2. Sending the picture

@ You can retransmit the picture in the TX PICT HISTORY
screen. (p. 13-7)

[MENU] > PICTURE

1. Push [MENU].

2. Select “PICTURE.”

3. Push D-pad(5) to select the TX Picture zone, and
then push [ENT].

o]

- B

146.010

12:00

FZEIF

Fi
440.000 .
-

TH PICTURE

.
adil

4. Push [ENT] again.
5. Select “TX Picture.”

Ficture Size ,
220240

Picture Quality
Standard (E0%)

v

TH Picture Select

L3

2/4

7
&
£
IS
&
&
e
i
&
e
i
&
i

6. Rotate [DIAL] to select a picture.

® You cannot view a picture if it is not in a supported
format (p. 13-2), or is corrupted.

7. Push [ENT].

8. Set “Picture Size,” “Picture Quality,” and
“Receiver.”
® See page 13-6 about each setting item.

9. To close the TX PICTURE SET screen, push
[MENUL.
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1. Push [QUICK].
2. Select “Picture TX.”

<<TH Al
<=Back To 1st=>

|<<Exit Picture Scre |

o (@] —Displayed while the Share
146.010 Pictures function is ON.
FSKIF
Fr
440,000 -
-

4. Hold down [PTT] to transmit.
® The picture is sent while transmitting.

5. Release [PTT] to receive.

Sending a picture using the DV Fast Data
function:

Select “<<TX All>>" in step 2 to send a picture using
the DV Fast Data function.

1200

-+ & 12:00

Wil transmitting
|remaining blocks.

CAMNCEL
I
29

ot T

® DO NOT select “<<TX All>>" when you send a picture
to other transceivers that can receive only slow speed
data.

® While transmitting voice audio by holding down [PTT] on
the microphone, the transceiver automatically changes
to the Slow Speed Data mode.

® Push [CLR] to cancel sending.
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Sending the picture

<& Moving the TX line marker

You can select the line to start sending.
® While sending a picture, you cannot move the TX line
marker.

1. Push D-pad($) to select the TX Picture zone, and
then push [ENT].

2. Push [QUICK].

3. Select “TX Picture Block Select.”

i Picture TH vE
: T}{ F'lu:tu re Set

H y 1
12TR Allz>
:

§ TR Picture History >

4. Rotate [DIAL] or push D-pad to select a line.

B T Pt ol W 1

1174 (Line 5)
1254 (Line 3)

1374 iLine 12)

5. Push [ENT].
6. To close the TX PICTURE screen, push [MENU].
» The TX starting line is displayed.

o) -+ B 12:00
EAHTEws

146.010

FEKIF

240,000 .

) 1 [ TX starting line
—i——i-— 2023981 ‘ 9

TIP: To reset the line selection, push [QUICK], and
then select “<<Back To 1st>>" in step 4.

00

OTX PICTURE SET

This screen is used to set a picture, size, quality, and
its intended destination to send.
® While sending a picture, you cannot change the settings.

1. Push D-pad($3) to select the TX Picture zone, and
then push [ENT].

2. Push [ENT] again.

3. Select the setting item.

TH F'ICTURE SET 12

Picture Size .
220240

Picture Quality R
Standard (50%)

4. Select an option.

Picture Size 141

20
220240
6404380

5. To close the TX PICTURE SET screen, push
[MENUL.

TIP: You can set each item to its default by pushing
[QUICK], and then selecting “Default” on the Quick
Menu window.

TX Picture

Select the picture to send, saved in the “Picture” folder

(“ID-50" > “Picture”) on the microSD card.

® When you set the TX Picture in the TX PICT HISTORY
screen, “(RE TX)" is displayed before the file name.

Picture Size (Default: 320 x 240)

Set the desired size of a picture to send to “160 x

120,” “320 x 240,” or “640 x 480.”

@ You cannot select a size larger than the size of the
picture.

Picture Quality (Default: Standard (50%))

Set the quality of a picture to send to “Low (25%),”
“Standard (50%),” or “High (75%).”

Receiver (Default: ----- )

Enter the receiver’s call sign to let all stations that receive
the picture know the picture’s intended destination.

NOTE: All stations that receive the signal can see
the picture, even if they are not set as the receiver.
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Viewing the picture history

< Viewing the RX Picture History

When you receive a DV call that has picture data, a
received picture log is saved. Up to 50 history data
can be saved. When you receive the 51st picture, the
oldest history data is deleted.

® The optional ST-ID50A application is required to view the
received picture.

NOTE: Confirm a microSD card is in the card slot.

[MENU] > PICTURE
1. Push [MENU].

2. Select "“PICTURE.”

3. Push D-pad($) to select the RX Picture zone, and
then push [ENT].

]

-+ B 12:00

[M&THT oo
146.010

R¥ PICTURE

[LAST)

Size: 1603120
Cluality: Low
From: M1 ZLEK
RCVR: CQCQCO

(20 15:33:00)

4. Rotate [DIAL] to select an RX picture history data.
5. Push [ENT].

R¥ PICT HISTORY '1;"'1
HNo. 0 -

Size: 1602120 €4—
Cuality: Low €——
Fram: IM1ZLE
RCVR: CQCOCO

20 15:33:00) «—— Received time

History number
Picture Size
Picture Quality

» The RX picture history number, picture size, picture
quality, the caller’s call sign, receiver set by the caller,
and RX date and time are displayed.

TIP: In the Quick Menu window, you can select the
following options.

e Delete: Deletes the selected RX picture history data.
« Delete All: Deletes all RX picture history data.
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< Viewing the TX Picture History

When you send a picture, the picture log is saved. Up
to 50 history data can be saved. When you send the
51st picture, the oldest history data is deleted.

NOTE: Confirm a microSD card is in the card slot.

[MENU] > PICTURE

1. Push [MENU].

2. Select “PICTURE.”

3. Push D-pad($) to select the TX Picture zone, and
then push [ENT].

# B

146.010

12:00

4. Rotate [DIAL] to select a TX picture history data.
5. Push [ENT].

TH PLCT HISTORY 2/2
Mo O <=

Size: 220240 €—
Quality: High €———
From: JAZY 1A,
RCVR: CQCOCg

(20 13:28:16) 4—— Received time

History number
Picture Size
Picture Quality

» The TX picture history number, picture size, picture
quality, the caller’s call sign, receiver, and TX date
and time are displayed.

TIP: In the Quick Menu window, you can select the

following options.

* Retransmit:  Sets the picture to “TX Picture.”

* Zoom Picture: Changes to enlarged display.

* Delete: Deletes the selected TX picture history data.

Delete All: Deletes all TX picture history data.

® You cannot delete when the selected TX picture
history data is set to “TX Picture” (RE TX).

® You cannot set the picture to “TX Picture” while
transmitting a picture.
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Band Scope function

Use the Band Scope function to visually search a
specified frequency range around the displayed
frequency. You can use this function to search for a
signal, and see the relative received signal strength
level.

On the single band display, you can confirm the signal
strengths over time by the waterfall function.

On the single band display within 137 ~ 174 MHz

and 375 ~ 479 MHz, you can hear the displayed
frequency’s audio during a sweep.

The Band Scope function has 2 sweep types.

¢ Single Sweep: Searches the specified
frequency range only once.
The Single Sweep starts from
the lower frequency, and the
sweep stops after reaching the
upper frequency.

Repeatedly searches the
specified frequency range.

e Continuous Sweep:

The transceiver’'s sweep bandwidth is + 15* x the

tuning step number, centered on the operating

frequency.

* You can change the displayed steps to + 20 steps.
(IMENU] > SET > Scope > Displayed Steps)

During a sweep in the Center mode:

Center frequency
(Example: 146.010 MHz)

12:00

FEEIF

%‘“i”e.il'):lo

Band Scope_[

i o

display

Strong level

R

Weak level

When selecting a
Band Scope zone
(with a line)

Sweep marker

While stopping a sweep:

12:00

146.00

ECCC LU L L

FZEIF

Operating frequency (moves)
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You can select the Band Scope display mode from
three modes, the Center mode, the FIX mode, and the
Scroll (FIX) mode.

Center mode:
Displays signals around the operating frequency
within the selected span.

146.010_

| m_, |

FIX mode:

Displays signals within a specified frequency range.

® Set the displayed frequency range on the MENU screen.
(p. 12-7)
(IMENU] > SET > Scope > FIX Mode Center Frequency)

Scroll (FIX) mode:
Displays signals within a specified frequency range.
When the operating frequency moves outside of the
screen, the displayed frequency range is automatically
shifted.
® Set the displayed frequency range on the MENU screen.
(p. 12-7)
(IMENU] > SET > Scope > FIX Mode Center Frequency)
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Band Scope function

NOTE: During the continuous sweep, the noise may
occur if you bring your hand or body close to the
screen.

< Using the Band Scope function

[MENU] > SCOPE

1. Push [MENU].
2. Select “SCOPE.”

MEM L 1/3
WOICE RECORD

FIARADIO L SCOPE

« Returns to the standby screen, and starts the
continuous sweep.
3. Push [QUICK].
4. Select “Scope Mode.”

B 1700

[

UScope OFF
Socope Mode
Single Sweep

| Stop Sweeping

5. Select the Band Scope display mode.
« Displays the selected display mode, and starts the
continuous sweep.
6. Push [ENT].
 Stops the sweep.
® Push [ENT] again, to resume the sweep for the
Continuous Sweep function.
7. When the sweeping stops, rotate [DIAL] to move
the sweep marker to a detected signal.
* You can hear the signal audio.
® While the sweep is paused, push [CLR] to turn OFF
the Band Scope function.

Band Scope screen operation:

Key Action
[DIAL] Rotate to select an operating frequency.
D-pad(t) Push Fo cancel the Band Scope zone
selection.
D-pad(l) I?ush to select the Band Scope zone (with a
line).
[ENT] Push to start or stop a sweep.
Push to open the Quick Menu window.
[QUICK] | ® When selecting the Band Scope zone,
only the Band Scope menu is displayed.
When selecting the Band Scope zone:
[CLR] » Push to stop the sweep during a sweep.
» Push to turn OFF the Band Scope
function while stopping a sweep.
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¢ Using the Waterfall display

On the single band display, you can turn the waterfall
display ON or OFF.

® Information

» The waterfall is displayed only while sweeping.

« During a sweep, the scales on both sides of the waterfall
zone are moved with the waterfall. While stopping a
sweep, the scales and the waterfall also freeze.

* You can select the Waterfall speed.

(IMENU] > SET > Scope > Waterfall Speed)

TIP:

« If the tuning step is set too wide, the signals in the

sweep range may not be displayed (they may be

skipped), even if they are strong signals. Therefore,

we recommend that you set the tuning step to 20 kHz

or less to use the Band Scope function. See the Basic

manual Section 3 for details on how to set the tuning
step.

On the AIR band, you cannot hear the displayed

frequency’s audio during a sweep. When “AF Output

(DUAL/AIR Band)” is set to ON, the received audio is

momentarily output during a sweep, and you will know

that a signal is received without looking at the display.

- You can turn “AF Output (DUAL/AIR Band)” ON or
OFF on the MENU screen. (p. 12-7)

- The FM Radio audio output may be interrupted due to
the AF Output (DUAL/AIR Band) function. In that case,
set “AF Output (DUAL/AIR Band)” to OFF, or set “Auto
Mute” to OFF.

(IMENU] > SET > Scope > AF Output (DUAL/AIR Band))

(IMENU] > FM RADIO > FM Radio Set > Auto Mute)
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Home Channel function

You can set an often-used frequency, Memory
channel, or repeater as a Home Channel in VFO
mode, Memory mode, and DR screen.

¢ Setting a Home Channel

1.

Select the VFO or Memory mode, or the DR
screen to set a Home Channel.

Select a frequency, Memory channel, or an access
repeater to be set as a Home Channel.

Push [QUICK].

Select “Home CH Set.”

i B

[ 1700

I'oice T¥ b
GP3 Information
GPS Position
Weather Informati

|Weather Alert (8
Home CH Set

Select “Set Frequency” (VFO mode), “Set
Channel” (Memory mode), or “Set Repeater” (DR
screen).

[ Y

Set Frequency

1200

» Sets a Home Channel, then returns to the standby
screen.

TIP: Selecting “Clear” in Step 4 clears the Home
channel setting.

ol 4 B 1700
lSet Freguency
Clear (146.010)
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<& Home CH Beep function

When a Home CH is selected by rotating [DIAL], a
beep sounds. You will know the Home CH selection
without looking at the display.

You can assign the [Home CH] key function to an
optional microphone key. (p. 12-18)
® You can turn OFF the Home CH Beep function on the
MENU screen.
(IMENU] > SET > Sounds > Home CH Beep)
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Using the DTMF memory

The transceiver can save up to 16 memories of a 24
digit DTMF code.

< Entering DTMF code

[MENU] > SET > DTMF/T-CALL > DTMF Memory

1. Push [MENU].
2. Select “DTMF/T-CALL” in the “SET” menu.
3. Select “DTMF Memory.”

DTMF/T-CALL
DOTMF Memuory

141

DTMF Speed 3

4. Selecta DTMF Memory to enter.

DTMF MEMORY 173
T-CALL

d0:

di:

dz:

d3:

d4:

® DO NOT push [ENT].
5. Push [QUICK].
6. Select “Edit.”

7. Enter a DTMF code, then push [ENT].
(Example: 123456A)

OTMF MEMORY
122456 A

» Saves the Memory, and returns to the DTMF
MEMORY screen.

® See page iii on how to enter characters.

@ To exit the MENU screen, push [MENU].

TIP: To clear the entered DTMF code, push [QUICK]
on the DTMF MEMORY screen, then select “Clear.”
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< Monitoring the entered DTMF code

You can check and hear the entered DTMF code.

[MENU] > SET > DTMF/T-CALL > DTMF Memory

Push [MENU].

Select “DTMF/T-CALL” in the “SET” menu.
Select “DTMF Memory.”

Select a DTMF Memory to monitor.

1/3

pPoONPE

OTMF MEMORY

® DO NOT push [ENT].
5. Push [SQL].
DTMF MEMORY

IdD:
1234564

143

dd:

* The DTMF code sounds.

« After sounding, returns to the DTMF MEMORY
screen.

@ To exit the MENU screen, push [MENU].

TIP: You can also check the DTMF code by pushing
[QUICK] and select “DTMF Monitor” on the DTMF
MEMORY screen in step 4.




14 OTHER FUNCTIONS

Transmitting the DTMF code

<O Transmitting the entered DTMF code

[MENU] > SET > DTMF/T-CALL > DTMF Memory

1. Push [MENUL.
2. Select “DTMF/T-CALL" in the “SET” menu.
3. Select “DTMF Memory.”

141

DTMF/T-CALL
DTMF Memary

DTMF Speed 4

4. Select a DTMF Memory to transmit.

DTMF MEMORY 143

T-CALL

» The selected DTMF channel is set to transmit.
5. Push [MENU].

 Exits the MENU screen.
6. While holding down [PTT], push [SQL].

146.010

123456A
440.000

FEERIF

» The selected DTMF code in step 4 is transmitted.
» Even if you release [PTT], the transceiver keeps

transmitting the code until all the code is transmitted.

TIP: In the standby screen, you can transmit a
DTMF code by pushing [QUICK], selecting “DTMF
TX,” and selecting a code.

14-6

¢ Transmitting a DTMF code (Direct Input)

=

Push [QUICK].
Select “DTMF TX.”

N

3. Select “Direct Input.”

1700

frml 4 B
U[Direct Input
d0: 12345864

4. Enter a DTMF code, then push [ENT].
(Example: 012345#)

] 4 B 12:00
FHl
0123458
LT LUR 10U E—,

* Transmits the entered DTMF code.
® The DTMF code scrolls during transmission.
® See page iii on how to enter characters.

TIP: About the 1750 Hz tone
When you select “T-CALL" on the DTMF MEMORY
screen, a 1750 Hz tone can be transmitted.

DTMF MEMORY 143

d0: 1234564
di:
dz:
d3:
d4:

While holding down [PTT], push [SQL].
e The 1750 Hz tone is transmitted.
@ You can hear the 1750 Hz tone from a speaker.
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Transmitting the DTMF code

< Selecting the DTMF transmit speed

You can select the DTMF transmit speed.
The image of transmitting the DTMF code

[MENU] > SET > DTMF/T-CALL > DTMF Speed

1. Push [MENU].
2. Select “DTMF/T-CALL” in the “SET” menu.

3. Select “DTMF Speed.” — —
Pi, Po, Pa Pi—, Po—, Pa—
DTMF/T-CALL 1/ _ _
DTMF Mermory ’ . .
OTMF Speed When “100ms” is selected, When “500ms” is selected,
the DTMF transmit speed the DTMF transmit speed
is fast. is slow.

4. Select a transmit speed. (Default: 100ms)

OTMF Speed 11
100ms
200ms

3007z

500ms

® To exit the MENU screen, push [MENU].
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Tone squelch operation

The tone squelch opens only when you receive a

signal that includes a matching subaudible tone in the

FM or FM narrow (FM-N) mode. You can silently wait
for calls from other stations using the same tone.
Also, the reversed tone squelch function mutes

the squelch when a signal including a matching
subaudible tone.

Step 1. Setting the tone squelch frequency

[MENU] > SET > DUP/TONE... > TSQL Freq

1. Push [V/IMHZ] to enter the VFO mode.
2. Push [MODE] to select the FM or FM-N mode.
3. Rotate [DIAL] to set an operating frequency.
4. Push [MENU].
5. Select "DUP/TONE..."” in the “SET” menu.
6. Select “TSQL Freq.”

DUF/TOME...  1/2

Oiffzet Freg 4

Fepeater Tone 4

TSOL Freg ’

Tone Burst *

DTCS Code '

DOTCS Polarity 4

7. Rotate [DIAL] to set a Tone Squelch frequency,
then push [ENT].

T3CL Freg

® Set to between 67.0 and 254.1 Hz.
® To exit the MENU screen, push [MENU].
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Step 2. Using the tone squelch

1. Push [QUICK].
2. Select “TONE.”

- B 1700

146010

FEKIF

FEZKIF

440,000

4. Operate normally.

 You will only hear the audio of stations that are using
the same Tone Squelch frequency. All other signals
will be muted.

About the Tone squelch types indication:
e TSQL: Enables the Tone Squelch function.
* TSQL-R: Enables the Reverse Tone Squelch function.
* TONE(T)/DTCS(R)
(“T-DTCS" is displayed, “T" blinks.):
When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the DTCS squelch opens
only for a signal that includes a matching
DTCS code and polarity. (Audio is heard)
e DTCS(T)/TSQL(R)
(“D-TSQL" is displayed, “D” blinks.):
When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching tone
frequency. (Audio is heard)
e TONE(T)/TSQL(R)
(“T-TSQL" is displayed, “T” blinks.):
When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching tone
frequency. (Audio is heard)
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DTCS code squelch operation

The tone squelch opens only when you receive a
signal that includes a matching DTCS code in the

FM or FM narrow (FM-N) mode. You can silently

wait for calls from others using the same tone. Also,

a reversed tone squelch function mutes the squelch
when you receive a signal including a matching DTCS
code.

Step 1. Setting the DTCS code

[MENU] > SET > DUP/TONE... > DTCS Code

Push [V/MHZz] to enter the VFO mode.

Push [MODE] to select the FM or FM-N mode.
Rotate [DIAL] to set an operating frequency.
Push [MENU].

Select “DUP/TONE...” in the “SET” menu.
Select “DTCS Code.”

DUR/TONE. .. 1/2
Offszet Freg *
Repeater Tane 4
TSQAL Freg 3
Tone Burst *
O L

»

ok wdpE

DTCS Folarity

7. Rotate [DIAL] to set a DTCS code, then push
[ENT].

DTCS Code

® Set to between 023 and 754.
® To exit the MENU screen, push [MENU].
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Step 2. Using the DTCS code squelch

1. Push [QUICK].
2. Select “TONE.”

ode type.

(oo - B 1Z:00
WEre [ores]

146.010

FEKIF

FZEIF

440.000

4. Operate normally.
 You will only hear the audio of stations that are using
the same DTCS code. All other signals will be muted.

About the DTCS code types indication:

« DTCS: Enables the DTCS Squelch function.

* DTCS-R: Enables the Reverse DTCS Squelch function.

* DTCS(T) (“DTCS” blinks):
When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the function is OFF.

* TONE(T)/DTCS(R)

(“T-DTCS” is displayed, “T” blinks.):

When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the DTCS squelch opens
only for a signal that includes a matching
DTCS code and polarity. (Audio is heard)

e DTCS(T)/TSQL(R)

("D-TSQL” is displayed, “D” blinks.):

When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching tone

frequency. (Audio is heard)
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VOX function

The Voice Operated eXchange (VOX) function toggles
the transceiver between transmit and receive by your
voice. This function provides hands-free operation.
You can use the VOX function with the optional
HS-94, HS-95, or HS-97 HEADSET and the
OPC-2006LS PLUG ADAPTER CABLE.

< Selecting the headset type

[MENU] > SET > Function > VOX > Headset Select

1. Push [MENU].
2. Select “Function” in the “SET” menu.
3. Select “VOX.”

FUMCTION

3/4

-4 r
LSE Connect ¢
LSB Serialport Fun v
Heterodyne 4
Battery Pack Select »

Select “Headset Select.”

WO
ek r
Wi Lewel 4
Wi Delay v
WIOE Time-Out Timer

Headset Select

Select an option.

Headset Select

141

Other

e HS-95: Select when using the HS-95.
¢ Other: Select when using the HS-94 or the HS-97.
® To exit the MENU screen, push [MENU].
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NOTE: BE SURE to turn OFF the transceiver when
plugging or unplugging the OPC-2006LS into or from
the [MIC/SP] jack.

OPC-2006LS
(Option)

* You can also use this function with the optional HS-95 or HS-97.
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VOX function

¢ Using the VOX function O Setting the VOX level
[MENU] > SET > Function > VOX > VOX NOTE: We recommend you set the Microphone
1. Push [MENU]. Gain level to 3, before setting the VOX level.
3. Select “VOX.”
FUNCTION 2 [MENU] > SET > Function > VOX > VOX Level
1. Push [MENU].
Sls; c ' 2. Select “Function” in the “SET” menu.
annect 4 " .
USE Serialpart Fun » 3. Select “VOX.
Heterodyne 4
Battery Pack Select » FUMCTION ____d/4
Cl-Y *
4. Select “VOX.” LSE Connect .
LISE Serialport Fun v
MOR 11 Heterodyne *
Battery Pack Select v
Wi Lewel 4
W Del v
WO TrmaE!iOut Timer 4. Select “VOX Level.”
Headset Select 4 VO 111
WO v
5. Select “ON.” WK Delay v
WO Time-Cut Timer
WOR 141 Headset Select ¢
OFF
oy |

5. While speaking into the microphone, rotate [DIAL]
to adjust the VOX level.

WO Level

6. To exit the MENU screen, push [MENU].
* When you connect the HS-94, HS-95, or HS-97 —
headset, “VOX” is displayed on the standby screen.

e Whi.le [eceiving a signal, or sounding a beep, « Displays “VOX" when the TX level audio is input.
the transceiver does not switch to transmit by your ® The VOX level can be adjusted between 1 (minimum)

vaice. and 10 (maximum), or turned OFF. (Default: 5)

@ Higher values make the VOX function more sensitive
to your voice.

6. To exit the MENU screen, push [MENU].

@ If the S-meter does not display the output power
level, and the transceiver does not transmit, adjust
the VOX delay time.

(IMENU] > SET > Function > VOX > VOX Delay)

® When the VOX function is ON, you can adjust the

VOX level by rotating [DIAL] while transmitting.

14-11



14 OTHER FUNCTIONS

VOX function

O VOX-related settings
You can set the “VOX Delay” and “VOX Time-Out
Timer” on the MENU screen.

VOX Delay:

[MENU] > SET > Function > VOX > VOX Delay

The VOX delay is the amount of time the transmitter
stays ON after you stop speaking. It enables normal
pauses in speaking. (p. 12-22)

VOR Delay 141

1.0sec
1.5zec
2. 0sec
2. 5sec
2.0szec

VOX Time-Out Timer:

[MENU] > SET > Function > VOX >
VOX Time-Out Timer

The VOX Time-Out Timer prevents prolonged
accidental transmission. (p. 12-22)

WO Time=-Out Timer 177
OFF
Tmin
2min

Zmin
drmin
Emin
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Weather channel operation (For only the USA version)

There are 10 weather channels for monitoring OWeather alert function

X‘;m'\.'si?rg?oicel\%zgrapg;ﬁgfﬁ;@gﬁggg'c NOAA broadcast stations transmit weather alert tones
n fon ( ) W ’ before important weather announcements.

When the weather alert function is turned ON, the

OSeIecting a Weather channel selected weather channel is monitored every 5

seconds for an announcement.
1. Push [MR] to enter the Weather Channel mode. When an alert signal is detected, the “ALT” and
® Pushing [MR] each time selects the Memory and

the WX channel are alternately displayed, and a
Weather Channel modes. .
beep sounds until you change the mode or weather

1200 channel, turn OFF the Weather Alert function, or turn
WX-01 OFF the transceiver.

The previously selected (used) weather channel
is checked periodically during standby, or while

qflhb.m][] i scanning.

1. Push [QUICK].

2. Rotate [DIAL] to select a weather channel. > Select “Weather Alert.”

« Displays the selected weather channel number
(“WX-01" ~ “WX-10").

frml

[GPS Information
GPS Pozition
Weather Informati

Weather Alert

<<REC Start>>

3. Select “ON.”
m & B 170N
ToFF
E
A 4

4 B 12:00

146.010

5
o=

440.000 ...

* Turns ON the Weather Alert function, and “WX" is
displayed.
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Screen Capture function

You can capture the transceiver display onto a
microSD card. Most of the screens used in this
manual are captured using this function.
However, some displays cannot be captured.

¢ Setting the Screen Capture function

[MENU] > SET > Function >
Screen Capture [PWR] Key

1. Push [MENUL.
2. Select “Function” in the “SET” menu.
3. Select “Screen Capture [PWR] Key.”

FUNCTION 474
Battery Pack Confire
Charging [Power v
IUSE Power Input [ v

Screen Capture [P#

LOJCALL Key Actior

4. Select “ON.”
Screen Capture 141
OFF

@ To exit the MENU screen, push [MENU].

< Capturing a screen

1. Display the desired screen to capture.

2. Push [()] to capture the screen.
» The captured screen is saved onto the microSD card
in the “bmp” format.

[&]
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< Viewing the captured screen
[MENU] > SET > SD Card > Screen Capture View

1.
2.
3.

Push [MENU].
Select “SD Card” in the “SET” menu.
Select “Screen Capture View.”

SO CARD 1/2
Load Setting *
Save Setting 4
I ports Export v
S0 Card Info 4
Screen Capture YWie
Firmweare Update

» The capture list is displayed.
» The latest screen capture is at the bottom of the list.
Select the desired screen capture to display it.

SCREEN CAPTURE 17417
2023523 RE15E0
20230523 631546
ZAZ3M52_ 104639

525 118685

*
*
3
¥

» The screen capture is displayed.

® While a screen capture is displayed, you can scroll
through all the screen captures by rotating [DIAL].

® To exit the MENU screen, push [MENU].

Checking the file information and deleting a file:
1.

Select the screen capture that you want to view
or delete.

® DO NOT push [ENT].

Push [QUICK].

Select an item from “File Information,” “Delete,”
and “Delete All.”

T 437547
M|File Information

Delete All

« File Information: Displays the file name, size,
and date of the selected screen

capture.
* Delete: Deletes the selected file.
* Delete All: Deletes all files.
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The transceiver has a data cloning capability. This
function is useful when you want to copy all of the
settings and entered contents from one
ID-50A/ID-50E to another. This section describes the
cloning method using a microSD card.

Step 1. Saving the master transceiver’s setting
data onto the microSD card.

[MENU] > SET > SD Card > Save Setting

1. Push [MENUL.
2. Select “SD Card” in the “SET” menu.
3. Select “Save Setting.”

S0 CARD 1/2
Load Setting v
Save Setting

I port/Export ,
5D Card Info *

Screen Capture Vie »
Firmweare Update »

4. Select “<<New File>>."
SAVE SETTING 1,2

My DaTh
Set2023033101

Set20230484_61
SetZ0230416_61
Set20230411_61

v

FILE MAME
SetZ@2307a5_a1

ABC

® The file name is automatically set in the following
format: SetYYYYMMDD_xx

(YYYY: Year, MM: Month, DD: Day, xx: serial number).
5. Push [ENT] to save the file with the displayed name.

» The confirmation dialog is displayed.
6. Select “YES.”

FILE MAME

Coa T T TIE ond

Save file?

ABC

« While saving, a progress bar is displayed, then
returns to the SD CARD screen after the saving is
completed.

@ To exit the MENU screen, push [MENU].

® Recorded voice memories are not included in the cloning
data. To play back the master transceiver’s voice memory,
insert the microSD card into a sub transceiver, or make a
copy onto the sub transceiver’s microSD card using a PC.

® Assumes that the microSD card has already been
inserted into the transceiver.

Step 2. Remove the microSD card from the master
transceiver, then insert it into the sub
transceiver.

=

Turn OFF the master transceiver.

2. Remove the microSD card from the master
transceiver.

3. Insert the card into the sub transceiver, then turn

ON the sub transceiver.

Master

NOTE:

e Turn OFF the transceiver before you insert or remove
the microSD card.

e DO NOT turn OFF the transceiver while saving or
loading the setting data. Otherwise, the data may be
corrupted or deleted.

TIP: The setting data is saved in the “icf” file format
that is used in the CS-50 PROGRAMMING SOFTWARE.
When the saved data on a card is copied to a PC,
you can edit it with the programming software.

For details, refer to the CS-50 instructions that can
be downloaded from the lcom website.

(Continue the steps on the next page.)
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Step 3. Loading the setting data into the sub
transceiver.

[MENU] > SET > SD Card > Load Setting

1. Push [MENU]. 7. Select “YES.”
2. Select“SD Card” in the “SET” menu. LOAD FILE 171
3. Select “Load Setting.”
=D CARD 172 Load file?
Load Setting
Sawve Setting 4
I port/Export ,
S0 Card Info 4
Sereen Capture Vie » « Starts checking and loading the data file.
Firmware Update « After loading, “COMPLETED!" is displayed.
) ) ) 8. Restart the transceiver to operate with the new
4. Select a data file to load into the transceiver. setting.

LOAD SETTING 242

SetZ02308427_61 ’
Set2023M520_G ’

@1

5. Select the loading content.

LOAD FILE 1/1

Except My Station
Repeater List Only

e ALL:
Loads all Memory channels, settings on the MENU
screen, and the Repeater List into the transceiver.
« Except My Station:
Loads all Memory channels, setting on the MENU
screen except MY call signs, and the Repeater List
into the transceiver.
* Repeater List Only:
Loads only the Repeater List into the transceiver.
6. Select “YES” or “NO.”

LOAD FILE 11

Keep "SKIF' settings
in Repeater List?
YES

* YES:
The skip settings of the Repeater List are retained.
(p. 5-39)

* NO:
The skip settings of the Repeater List are cleared.
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Resetting

Occasionally, erroneous information may be
displayed. This may be caused by static electricity or
by other factors.

If this problem occurs, turn OFF the transceiver. After
waiting a few seconds, turn ON the transceiver again.
If the problem still exists, perform a Partial reset.

If the problem still exists after performing a Partial
reset, perform an All reset.

O Partial Reset

A Partial Reset resets the operating settings to their
defaults without clearing the following:
* Memory Channel contents

« Call Channel contents

« Radio Memory contents

e Scan Edge contents

* Message data

GPS memory contents

Call sign memories

DTMF memory contents

Repeater list

[MENU] > SET > Others > Reset > Partial Reset

1. Push [MENU].
2. Select “Others” in the “SET” menu.
3. Select “Reset.”

OTHERS

Infarmation r
Clone ¥

Select “Partial Reset.”
RESET 141

Partial Feset
All Reset

» The confirmation dialog is displayed.
Select “YES.”

RESET

141

Partial Reset?

* “PARTIAL RESET" is displayed, and then the display
automatically returns to the default screen.

NOTE for the All reset: After performing an All
reset, you cannot use the DR function because

the Repeater List contents are also cleared. We
recommend you save the setting data onto a
microSD card, or to your PC using the CS-50
PROGRAMMING SOFTWARE before performing an All
reset. After the All reset is finished, load or write the
saved data into your transceiver.

O All Reset

An All reset clears all data and returns all settings to
their factory defaults. Memory channel contents, filter
settings, and so on will all be cleared, so you will need
to rewrite your operating settings unless you have a
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backup.

[MENU] > SET > Others > Reset > All Reset

1. Push [MENU].
2. Select “Others” in the “SET” menu.
Select “Reset.”

OTHERS

Information 4
Clone v

Select “All Reset.”
RESET 141

Partial Reset

« The confirmation dialog is displayed.
Select “YES.”

RESET

141

Mo .Li_1 O___1

lan reset? |

* “ALL RESET" is displayed, and then the display
automatically returns to the default screen.
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General

< Checking the firmware version
Check the firmware version on the VERSION screen.

< About updating the firmware

You can update the transceiver’s firmware using
a microSD card. Updating the firmware adds new
functions and/or improves performance parameters.
You can download the latest firmware from the lcom
website.

https://www.icomjapan.com/support/

IMPORTANT: To update the firmware, first format
your microSD card using the transceiver.

Then copy the downloaded firmware data from your
PC into the “ID-50" folder on the card.

15-2

1.
2.
3.

4, Select “Version.”

[MENU] > SET > Others > Information > Version

Push [MENU].
Select “Others” in the “SET” menu.
Select “Information.”

OTHERS 141

Informatian

Clone 3

Fezet 3

INFORMATION 11
Yoltage 4

Wersion

A 4
YERSIOMN
CRU:
[

GPs:

» The VERSION screen is displayed.
® To exit the VERSION screen, push [MENU].

TIP: You can also check the firmware version when
you turn ON the transceiver.
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General

<O Preparation

Access the following URL and download the firmware
file.

https://www.icomjapan.com/support/
® These instructions are based on Microsoft® Windows® 10.

1. Click the “Firmware/Software” link.

Firmware / Instruction

: Software * —

of Conformity

EU Declaration

Guides

Catalogs /
Brochures

Click

2. Enter “ID-50" into the Search box, and then click
[Search].
s o @ Enter
oo
3. Click the desired firmware file link.
4. Carefully read “Regarding this Download Service.”

Click “Agree,” and then click [Download].

Regarding this Download Service.

W

© Enter
@ Click

5. Click “Save as” in the displayed File Download
dialog.
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6. Select the location where you want to save the
firmware, and then click [Save] in the displayed
File Download dialog.

2 Seve s %
L BB Deskiop
Oy New folder ®
st Quick sccess . OneDrive
o OneDrive
. ranul
I Thiz PC 3
1L USB Drive (bt}
Q This FC
b Hework -
— Libraries
\r LIS Oreve (B}
—
USE Brave (F)
—
File narmes zip
Save mtype: Comprevsed (zipped) Folder [ 5ip] =
~ Hede Folden Iﬁm_chck

* The file starts downloading.
» The firmware and the firm utility are compressed in a
“zip” format folder. Unzip it before use.

<& Unzipping the firmware folder

1. Right-click the downloaded firmware folder (zip

format).
* The right-click menu is displayed.
2. Click “Extract All...”

Open

B ———Ciick

Pin to Start

« After unzipping, a folder is created in the same
location as the downloaded folder.

@ In the “50*” folder, “50*.dat” is created.
* Represents the release number.
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Updating the firmware

CAUTION: NEVER turn OFF the transceiver

while updating the firmware. If you turn OFF the
transceiver, or if a power failure occurs while
updating, the transceiver firmware may be damaged,
and, if so, you will have to send the transceiver back
to the nearest Icom distributor for repair. This type

of repair is out of warranty, even if the transceiver
warranty period is still valid.

Recommendation!

Fully charging of battery pack before starting the
firmware update is strongly recommended.

This is to avoid failure during the update, caused by
an unexpected power failure.

TIP: BE SURE to unzip the downloaded file.
See the previous page for details.

1. Copy the downloaded firmware data into the
“ID-50" folder on to a microSD card.

' [ =!Ds0
Home  snare  View
& v s> USB Drive (H:) » 1D-50 »
~
Mame
# Quick access
Capture
@ OneDrive Cor
[ This PC Gps
Picture
J 3D Objects
Qsolog
[ Desktop Reply
=] Documents RiLog
; Downloads Setting
J’! Music Voice
| Pictures VoiceRec
B videos VoiceTx
2 | neal Dicle (04 L] 50 dat COpy

n

Insert the microSD card into the transceiver.
3. Display the SD CARD screen.

[MENU] > SET > SD Card

4. Select “Firmware Update.”
S0 CARD 1/2
Load Setting *
Sawve Setting 4
I part/ Expart »
S0 Card Info ¢
Screen Capture Vie »
Firmware Update ¥
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5. After you read and agree with all the precautions,
select “YES.”

F‘l_\ A M
TFirmware
updating has
risks, and you do
za at wour own risk

L]

and responzibility.
If wou make a
IFMware LPOETe

v

[l i

A4 4=
Do you agree to all
of the above?

IFMWare JpOate ¥

« Scroll the screen and read all the precautions.
» The confirmation dialog is displayed.
When you select “YES,” the backup file is made on
the microSD card, and then the Firmware selection
screen is displayed.
6. Select the Firmware (Example: 50%).
* Represents the release number.

141

FIRMW.ARE LPDATE
]

» The final confirmation screen is displayed.
@ Carefully read all the displayed precautions.

7. After you read and agree with all the precautions,
select “YES.”

[ICRALLY & R | IAE s T A r4

Do you want to
start updating?

» The updating starts.

8. When the update is completed, “Firmware

updating has completed.” is displayed in the

dialog.

« The transceiver will automatically restart.

@ After the updating finishes, the operating screen is
displayed.

TIP: When “USB Connect” is set to “SD Card Mode,”
and the transceiver is connected to the PC through a
USB data cable, you can directly access the microSD
card that is set in the transceiver from the PC.

(IMENU] > SET > Function > USB Connect)
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You can find information for these options on the lcom
website.
https://www.icomjapan.com/support/

® Some options may not be available, depending on the
transceiver version.

Batteries/Chargers

BC-167SA/BC-167SD BATTERY CHARGER
The shape may be different, depending on the charger
version.

BC-202IP2 RAPID CHARGER
+ BC-123SA/BC-123SE (L-shaped type plug)
AC ADAPTER

BC-202IP3L RAPID CHARGER

+ BC-123SA/BC-123SE (Straight type plug)
AC ADAPTER (For single unit)

+ BC-228 AC ADAPTER (For multiple units)

BP-271 Li-ion BATTERY PACK

Voltage: 7.4V

Discharge capacity: 1150 mAh (minimum), 1200 mAh (typical)
Battery life: Approximately 4.25 hours (FM)

BP-272 Li-ion BATTERY PACK

The same as supplied.

Voltage: 7.4V

Discharge capacity: 1880 mAh (minimum), 2000 mAh (typical)
Battery life: Approximately 8 hours (FM)

BP-273 BATTERY CASE
Uses 3 LR6 (AA) alkaline batteries.

BP-307 Li-ion BATTERY PACK

Voltage: 7.2V

Discharge capacity: 3050 mAh (minimum), 3150 mAh (typical)
Battery life: Approximately 12.5 hours (FM)

Headsets/Earphones

HS-94/HS-95/HS-97 HEADSET
+ OPC-2006LS PLUG ADAPTER CABLE

HS-94: Ear hook type
HS-95: Neck and arm type
HS-97: Throat microphone

OPC-2006LS: Connects the HS-94/HS-95/HS-97 to the
transceiver for the VOX function.

HM-153LS EARPHONE MICROPHONE

HM-166LS EARPHONE MICROPHONE
Smaller than the HM-153LS.

SP-40 EARPHONE

+ OPC-2144 PLUG ADAPTER CABLE

When using the SP-40, you need the OPC-2144 slim L type
conversion cable.
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Speaker microphones

HM-183LS SPEAKER MICROPHONE
Meets IPX7 requirements for waterproof protection
(1 meter, 3.3 ft depth for 30 minutes).

HM-186LS SPEAKER MICROPHONE
Meets IPX4 requirements for waterproof protection
(Splashing water from any direction).

HM-243LS REMOTE CONTROL SPEAKER MICROPHONE

Cables

CP-12L CIGARETTE LIGHTER CABLE
With noise filter.

Fuse Coding: FUSE 125V 3A
Fuse Voltage Rating: 125 Volts

Fuse Current Rating: 3 Amperes

CP-23L CIGARETTE LIGHTER CABLE
For BC-202IP2, 12 V
® You cannot connect to the transceiver’s [DC IN] jack.

OPC-254L bC POWER CABLE
Directly connects to a DC power source.
Fuse Coding: FUSE 250V 3A
Fuse Voltage Rating: 250 Volts

Fuse Current Rating: 3 Amperes

OPC-515L DC POWER CABLE
For BC-202IP2
® You cannot connect to the transceiver’s [DC IN] jack.

OPC-2480 USB CABLE
+ BC-258A/BC-258E AC ADAPTER
USB cable and adapter for charging.

Others

AD-92SMA ANTENNA CONNECTOR ADAPTER
Connects an antenna or antenna cable that has a BNC
connector.

FA-S270C VHF/UHF ANTENNA
The same as supplied.

LC-202 CARRYING CASE
® You cannot use when the BP-307 is attached to the
transceiver.

MB-127 BELT CLIP
The same as supplied.
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Option List

About the free download software

CS-50 PROGRAMMING SOFTWARE

RS-MS1A (For Android devices) Android APPLICATION

RS-MS3A (For Android devices) TERMINAL MODE/ACCESS POINT MODE SOFTWARE
RS-MS3W (For Windows) TERMINAL MODE/ACCESS POINT MODE SOFTWARE
ST-ID50A (For Android devices) APPLICATION SOFTWARE

You can download each manual and guide from the Icom website.
https://www.icomjapan.com/support/

® Before using, read each manual and guide, and use it according to the instructions.
To add or expand a function, or to improve the performance, the software version may be upgraded.
Before you update your software version, see the instructions and cautions described on the Ilcom website.
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Optional HM-243LS REMOTE CONTROL SPEAKER MICROPHONE

The optional HM-243LS enables you to remotely
select operating frequencies, Memory channels, and
other functions.

You can assign some functions to the keys on the
HM-243LS for simple remote control operation.

NOTE:

* BE SURE to turn OFF the transceiver when plugging
or unplugging the microphone into or from the [MIC/SP]
jack.

« Firmly plug the microphone into the transceiver.

< Assigning a Remote Control function

Example: Assigning the “TO (DR)” function to the [A]
key.

[MENU] > SET > Function > Remote MIC Key

1. Push [MENU].
2. Select “Function” in the “SET” menu.
3. Select “Remote MIC Key.”

FUMNCTION 174
Fower Save 4
Manitor 4
Dial Speed-UP v
Auto Repeater ¥

L

*

Femote MIC Key

Key Lock

4. Select “During RX/Standby.”

Remote MIC Key 1)1

During TH D

5. Select “[A].”

During RH/ Stancby 101
[&]:BAND
[B]:¥FO/MR
[Ad:UP

[7]1: DOWN

3
L3
3
L3

v

[A] Key 3/

WFO/MR
CR

FROM (DR}
TO (DR}
Home CH

» The Assignable function list is displayed.
® About the functions, see pages 12-19 and 12-20.
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6. Select “TO (DR).”
[A] Key 3/6

WFO/MR
DR

Home C
BAMD

v

During RH/Standky 141
[Al: TO (DR}
[B]:“FO/MR
[A]:UP

[71: DO

¥
L3
L3
L3

* The “TO (DR)” function is assigned.
@ To exit the MENU screen, push [MENU].

TIP: To return to the default settings

¢ On the “During RX/Standby” screen or “During TX"
screen, push [QUICK] and select “Default All.”

« On the each key screen, push [QUICK] and select

“Default.”
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When using an application

The following applications are compatible with the Android device.
See each application’s manual for details.
Download the applications from your device.

<& About compatible applications

The following applications are compatible with ID-50A/

ID-50E. (As of July 2023)

RS-MS1A: You can use the extended D-STAR
functions to exchange pictures or
messages or display the received
D-PRS station data on a map

application.
RS-MS3A: You can use the DV Gateway function.
ST-ID50A: You can make a picture to be used for

the Share Picture function, transfer
the picture to the transceiver, or view
the received picture.
® The applications have been tested with the Android 8.x/9/
10/11/12. (As of July 2023)

¢ Required items

Android device:

Confirm your device meets following conditions:

- Android 8.0 or later is installed

- The device compatible with the USB host (USB
OTG) function

NOTE:
» The application may not be usable, even if your device
is compatible with the USB host function.
e Some functions may not work correctly:
- Depending on other applications installed in the
Android device.
- Depending on the memory capacity.

USB cable (User supplied):
Confirm your USB cable meets following conditions:
- Fits the transceiver’s USB port (Type-C) and your
device’s USB port (Micro-B/Type-C)
® A shorter cable is preferable, as the longer one may be
unable to transfer the data.
- The cable compatible with the USB host function.

Disclaimer:

« The application may not work properly, depending on the
OS version, installed applications, or other reasons.

« The indications or items may differ, depending on the OS
version or settings.

TIP: The USB host (USB OTG) function enables
using a USB device with an Android device. To
check the compatibility of your Android device with
the USB host function, ask the Android device’'s
manufacturer.
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When using an application

< Download procedures (Android device)

1.
2.
3.

Turn ON your Android device.

Touch “Play Store.”

Enter the application’s name in the search field.

® Do not abbreviate the application name to be sure to
find it.

Touch O\

» The application’s name will be displayed as the
search result.

@ If your Android device does not support the
application, its name may not appear on the search
result.

Touch the application to install.

« Displays the introduction screen of the application.

Touch <INSTALL>.

* Installation starts.

« After finishing the installation, the icon is displayed on
the screen.
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<&When using a USB cable

Connect the transceiver and your mobile device, as
shown below.

Android device*

77 USB cable*
(User supplied)
—— (] =-p
-
To the [USB] port To a USB port

*The device and cable compatible with the USB host (USB
OTG) function.

NOTE:

e Turn OFF the transceiver before connecting or removing
the cable.

* When using RS-MS1A, confirm the following items are set.
(IMENU] > SET > Function > CI-V)
Set “Cl-V Address” to the value same as the RS-MS1A
side. (Default: AE)
® RS-MS1A side: Application Settings — CI-V settings

(Default: Transceiver[AE])

Set “Cl-V Transceive” to “ON.”

(IMENU] > SET > Function > USB Serialport Function)
Set “USB SerialPort Function” to “Cl-V (Echo Back OFF).”

(IMENU] > SET > Function > USB Connect)
Set “USB Connect” to “Serialport.”

» Multiple applications related to the transceiver are not
usable simultaneously.

« Remove the USB cable when you do not use the cable.
Otherwise, the battery will be quickly exhausted.
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